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Preface 
Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology 

Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-085940.html 
contains the latest versions of the Agile PLM PDF files. You can view or download these manuals 
from the Web site, or you can ask your Agile administrator if there is an Agile PLM Documentation 
folder available on your network from which you can access the Agile PLM documentation (PDF) 
files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader version 9.0 or later. 
This program can be downloaded from the Adobe Web site http://www.adobe.com. 

 

The Oracle Technology Network (OTN) Web site 
http://www.oracle.com/technetwork/documentation/agile-085940.html can be accessed through Help 
> Manuals in both Agile Web Client and Agile Java Client. If you need additional assistance or 
information, please contact My Oracle Support (https://support.oracle.com) for assistance. 

Note Before calling Oracle Support about a problem with an Agile PLM manual, please have 
the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle 

Technology Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-
085940.html. 

Agile Training Aids 

Go to the Oracle University Web page 
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  

http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.adobe.com/
http://www.oracle.com/technetwork/documentation/agile-085940.html
https://support.oracle.com/
http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/education/chooser/selectcountry_new.html
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Chapter 1 

Introduction 

This chapter includes the following: 

 What’s in this Manual ........................................................................................................................................... 1 
 Overview of the Agile PLM Suite ......................................................................................................................... 2 
 What’s New for the User Experience in Agile PLM 9.2.2 ..................................................................................... 3 

 
 

What’s in this Manual 

This manual is an introduction to Agile Product Lifecycle Management (PLM) and its main features 
across the user solutions of the Agile PLM suite. Agile PLM is a comprehensive suite of enterprise 
business applications, and the information in this guide is both a starting point for learning Agile as 
well as a ―return-to‖ reference manual. 

This Agile Manual Precedes the Solution Manuals 

Chapters 2–5 provide information about the two primary client applications and introduce basic 
terms, concepts, and features that are used in Agile PLM. Chapters 6–10 cover features and 
functionality in Agile PLM 9.2.2 that all users will work with sooner or later. 

Agile PLM Basics 

Every new Agile user needs to have a good grasp of the material in either Chapters 2, 4, and 5, if 
primarily using Java Client, or Chapters 3, 4, and 5, if primarily using Web Client. Some solutions 
are accessed only through Web Client. Your Agile administrator has likely set up your Agile account 
with a ―preferred client.‖ 

 Chapter 2, Navigating in Agile Java Client on page 7 — Java Client user interface is fully 
described 

 Chapter 3, Navigating in Agile Web Client on page 27 — Web Client user interface is fully 
described 

 Chapter 4, Concepts and Terms in Agile PLM Solutions on page 65 — the basics in Agile PLM 
are surveyed 

 Chapter 5, Working with Business Objects on page 85 — creating objects, printing, sending, 
relationships, subscriptions 

You can change many of your user settings to help you manage your Agile user experience. A 
complete list of the settings in your user object is found in User Properties Defined on page 60. 

Cross-Solution Utilities in Agile PLM 

The material in Chapters 6–10, within each chapter, tends to run from elementary to advanced. You 
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will likely need to learn some things about reports, searches, workflows, and attachments in Agile 
early on; however, not everything in these chapters has to be – or can be – mastered at once. For 
example, you could learn how to work with attachments (ch.9) but find that you do not have to work 
with file folders (ch.10). 

 Chapter 6, Working with Agile Reports on page 123 — using and customizing the many out-of-
box reports in Agile PLM 

 Chapter 7, Finding Agile Data with Searches on page 143 — locating data and information in 
the Agile database 

 Chapter 8, Routing Objects with Workflows on page 207 — routing business objects for 
approval and to gather other kinds of information 

 Chapter 9, Working with Attachments on page 253 — Agile business objects can ―carry‖ 
additional data as attachments 

 Chapter 10, Working with File Folders on page 301 — more advanced capabilities with the 
Agile objects that hold attachment files and URLs 

The Agile end-user guides all assume that you have learned the basic information presented in this 
guide. For instance, although each PLM solution may have its own default workflows, saved 
searches, and predefined reports, the basic information in this manual is preliminary to the more 
specific information in the various user guides. 

Overview of the Agile PLM Suite 

The Agile PLM suite of solutions covers five primary areas of product lifecycle management: 

 Agile Product Collaboration (PC) — Management and collaboration of product record information 
throughout the product lifecycle, across internal organizations and the extended supply chain. 
Accessed through Java Client and Web Client. 

 Agile Product Governance & Compliance (PG&C) — Management and tracking of all substances 
and materials contained by any item or manufacturer part, allowing companies to meet 
substance restrictions and reporting requirements, design recyclable products, minimize 
compliance costs, and eliminate noncompliance on future products. Accessed through Web 
Client. 

 Agile Product Portfolio Management (PPM, formerly Program Execution) — Integration of program 
and product information, streamlining business processes across the product lifecycle and 
across a portfolio of programs. Accessed through Web Client. 

 Agile Product Quality Management (PQM, formerly Product Service & Improvement) — Integration 
of customer, product, quality, and regulatory information with a closed-loop corrective action 
system. Accessed through Java Client and Web Client. 

 Agile Product Cost Management (PCM) — Management of product costs across the product 
lifecycle and synchronization of product cost data and processes. Accessed through Web 
Client. 

Agile administrators use Agile Java Client to set up and maintain settings for these solutions. 

The Agile Application Server, the foundation of the Agile suite, manages data stored in the Agile 
database. All Agile data is contained or organized in business objects that are set up by the 
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administrator, and specified and used by the enterprise’s Agile users. For instance, the 
administrator configures the Parts class of objects, and users create and deploy specific instances 
of the kinds of Parts made available to them. ―Business objects‖ is a general term that implies 
objects created from the classes available to the enterprise, but other entities in Agile are also 
objects, such as workflows, searches, reports, and so forth. 

The following figure shows relationships between the Agile functional components, the primary 
client applications used to manipulate the data (Agile Java Client and Web Client), and the Agile 
Application Server (the database where the data is stored). 

Agile Java Client
(Java client)

Agile Web Client
(HTML client)

Application & 
Database  
Servers
(hold the Agile 
database)

Administrative 
settings

Product 
Collaboration

Product Quality 
Management

Product Cost 
Management

Product Portfolio 
Management

AGILE PLM FUNCTION

CLIENT APPLICATION 
USED TO WORK WITH 
DATA

DATA STORAGE

Product 
Governance & 
Compliance

 
 

What’s New for the User Experience in Agile PLM 9.2.2 

This section lists new elements of the user experience that are found in Agile PLM 9.2.2. 

Java Client and Web Client User Interfaces 

The user interfaces of the primary Agile clients are described in Navigating in Agile Java Client on 
page 7, and Navigating in Agile Web Client on page 27. 

 Bookmarks – you can create nested organizational bookmark folders in which to sort and save your 
bookmarks. You can rename bookmarks in order to give them names that are meaningful to you. 

 Parametric Search – Agile 9.2.2 includes easy-to-use parametric searches. The Agile 
administrator configures the parametric searches to present the most commonly used search 
attributes. Parametric searches can be saved. 

 New Rational Search Operators – New search operators include: Contains All, Between, Not Between. 
Updated search operators are In, Not In, Contains Any, and Contains None. 

 Tab content indicator – In Web Client, a simplified content indicator is used on all tabs. A grey dot 
indicates there is content on the tab. A red dot alerts users to problematic content on the tab. 
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For more information, see Web Client Tab Content Indicator Icons. 

 Relationships tab – the Relationships tab and Reference tab have been merged into one tab called 
the Relationships tab. All Agile objects (except Reports and Action Items) have Relationships 
tabs. Relationships may have an optional rule to define how the two objects affect one another. 
The Web Client Relationships tab includes a preview pane that allows you to view details about 
the selected related object. 

 Dashboard Management Extensions – This feature introduced in this release is similar to Process 
Extensions. Dashboard Extensions (DX) allow the Agile system to access internal or external 
content and configure the display format (tabular or charts) for authorized users to view and 
manipulate the outputs in Agile Web Client. Dashboard tabs and formats are defined in Agile 
Administrator. 

 Web Client Home Page – The inbox display has been simplified. The Web Client inbox is 
organized into three tabs: Notifications, Workflow Routings, and My Assignments. The My 
Assignments tab can be sorted by pre-defined views and by using the filter to sort the table by 
multiple criteria. Many assignment management actions and tasks can be performed on the My 
Assignments tab. 

 User-defined Web Client Home Page Quick Links – Each user can define his own list of ten most 
commonly used Links, Bookmarks, and Searches. 

 

What's New in Agile PLM 9.2.2.4 

 File folders and attachments: 

 Bulk download of business object attachments in Web Client by using Get All Files button to 
download a zip file of all the Attachment table rows. Bulk download of file folder files in 
Web Client by using Actions > Get All Files to download a zip file of all the Files table rows. 
When using Advanced File Productivity components, the user can choose to either 
download the files to a specified directory or download a zip file. 

 File folder Routing Slip tab is version-specific; each version can have a different set of 
approvers and observers. 

 In Web Client, file folder Actions > Version Browser feature opens a version browser window 
which lists information about all versions of the file folder. You can select files in the 
Version Browser window to view or compare. 

 The Checkin User field is available on the File Folders Title Block tab and the business object 
Attachments tab. Identifies the user who checked in the specified version. 

 The Designs class was added to the File Folders base class to support an Agile PLM 
Engineering Collaboration (EC) CAD integration. 

 Attached URLs can be up to 255 characters in length. 

 A Version Browser is added to the Web Client File Folder class objects and Design class 
objects Actions menu. The Version Browser displays information about all versions of the 
File Folder or Designs object. You can select Version Browser rows to view or compare. 

 Items: 

 The item Manufacturers tab includes an attachment icon column to indicate whether the 
manufacturer part has any attachments. 

 On the item BOM table, the reference designator (Ref Des) attribute is validated against a 
null Quantity (Qty) attribute. 
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 Reports: 

 The option to use BI Publisher when executing selected Standard Reports. 

 Searches: 

 The display of available search objects and search attributes in parametric searches and 
advanced searches is controlled by the user's Discovery privileges and field-level Read 
privileges. 
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Chapter 2 

Navigating in Agile Java Client 

This chapter includes the following: 

 Logging In and Out of Java Client ....................................................................................................................... 7 
 Java Client Windows, Menus, and Toolbars ........................................................................................................ 9 
 Java Client Tables ............................................................................................................................................... 12 
 Using the Inbox .................................................................................................................................................... 13 
 Using Bookmarks and the Recently Visited List .................................................................................................. 15 
 Changing Your User Settings .............................................................................................................................. 17 
 Address Book in Java Client ................................................................................................................................ 21 
 User Groups ........................................................................................................................................................ 23 
 Creating Supplier Groups .................................................................................................................................... 25 

Agile Java Client is distributed using only a browser and Java Web Start. The Product Collaboration 
and Product Quality Management (PQM) solutions can be accessed with Java Client. While you 
may prefer to work in Java Client on a regular basis, some utilities on the Tools menu (Agile Import, 
Export, FileLoad) and Reports open only in Web Client. Viewing Designs attached to item objects is 
available in Web Client only  

Logging In and Out of Java Client 

Agile PLM 9.2.2 has been installed on your company’s system, and the administrator has sent you 
a URL to connect to Java Client. There may already be a shortcut icon on your desktop, or there is 
an application path on your Start menu. If you do not have access to Java Client, see your 
administrator. 

Complete details for installing Java Client are in the appropriate Agile Installation Guide. 

To log in to Java Client: 

1. Start the Web browser and type the following, per information from your administrator: 

http://<webserver_hostname>/JavaClient/start.html 

2. You will receive a message about accessing the computer when you install and run Java 
Client. Click Launch. The Login window appears. 

3. Enter your username. Your username is not case-sensitive. 

Your username is assigned by your Agile administrator and can be an abbreviation of your full 
name. For example, the name Michael Jones may be abbreviated to MICHAELJ or MJONES. 

4. Enter your password. Your password is case-sensitive. 

Your password is initially assigned by your Agile administrator. If you have the appropriate 
privileges, you can change your password at any time. The administrator may require you to do 
so within a set number of sessions. (See Changing Your Password on page 40). 
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5. Click OK. 

 

The login process is complete. The Java Client window opens, as shown in the figure above. 

The next time you start Java Client, you are prompted to create shortcuts on the desktop and in 
the Start menu. It is recommended that you choose Yes for either or both shortcut types. 

You can also start Java Client using the Java Web Start icon on your desktop. Double-click the 
icon and you will see an option for Agile PLM. 

Note If you are having difficulty logging in to Java Client, one problem could be that your Java 
Web Start cache might be full. To clear the cache, open Java Web Start, choose File > 
Preferences, click the Advanced tab, and click Clear Folder. Then try launching Java Client. If 
you continue to have difficulty logging in, contact the Agile administrator. 

You can search for Agile data using the Simple Search field and Run Search button. To create a 
Quick Search, use the Search Option drop-down list to select a specific object type. Or, use the 

Advanced Search  button. You can choose an activity from the menu bar, main toolbar, or tab 
toolbar. For detailed instructions about searching, see, Finding Agile Data with Searches on page 
143. 

To close Java Client, click the Exit  button. 
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Java Client Windows, Menus, and Toolbars 

This section discusses some of the key user interface elements of Java Client. 

Java Client Menus 

You can use the following menus to perform various tasks based on your assigned roles and 
privileges: 

 File — Perform actions on Agile business objects, including New (Create), Open, Close, Save, 
Save As, Send, Scan Files, Batch Print, and Exit Java Client. Some Agile objects are items (parts 
and documents), changes (such as engineering change orders and price change orders), file 
folders (attachment objects), users, and suppliers. For more information about classes of Agile 
objects, see Introducing Agile Objects on page 65. 

Note The Scan utility (File > Scan Files) is available in Java Client only. See Agile Scan 

Utility on page 9. 

 Edit — Cut, Copy, and Paste data. Delete and Undelete an object. Create a Quick Search or an 
Advanced Search and Organize Searches (delete). Add and organize (that is, delete) Bookmarks. 

 View — View Notifications, Workflow Routings, and toggle the Windows Bar on or off: the Windows 
Bar shows all current open windows in Java Client. 

 Tools — Work with the Address Book; generate Reports and Analytics; access Agile Import, Export, 
and FileLoad (these are documented in Import & Export Guide). Process Extensions appear on a 
drop-down menu, which depends on a developer at your company (or an Oracle Consulting – 
Agile Practice consultant) having created process extensions. 

 Settings — Transfer Authority for other users or user groups to sign off your workflows; create and 
modify Personal Groups, Personal Supplier Groups, and Personal Criteria; view Deleted Personal 
Groups; view and modify your Current User settings; Change Password. 

Note Color Scheme and Options offer some standard Windows-based options. 

 Window — This is a standard menu that allows you to switch to the Previous Window or the Next 
Window, and to arrange your open windows in Cascade or Tile schemes. There are some 
keyboard equivalents if you prefer to use those. 

 Help — Manuals gives access to Agile documentation. About Agile displays information about the 
current release of Java Client. 

 

Agile Scan Utility 

From Java Client only, Agile’s Scan utility runs a Windows utility that scans documents using a 
TWAIN interface. The user specifies valid file types. Scanned images are designated as one of 
those file types, and they are added to the system as an attached file to a file folder object. Scan is 
described in Scan Utility on page 296. 
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Java Client Toolbars 

There are toolbars in the main Java Client window, in object windows, and in some object tabs. 

Depending on your assigned roles and privileges, you can use the toolbar buttons on the main 
toolbar to perform the tasks described in the following table. Toolbars in object windows contain 
buttons that pertain to the object. 

These are the buttons that appear on Java Client’s main toolbar. 

Button  Name  Descript ion  For more in fo rmat ion,  
see. . .  

 Inbox Displays Notifications or Workflow 
Routings. You can change this by 
clicking the View/Edit Current User 
button. 

Using the Inbox on page 13 

 New Object Opens the New window, where you 
select which type of object you want to 
create, and assign a number to the 
object. 

Agile Object Types on page 
67 

 Open 
Selected 
Objects 

Displays the tabbed window for the 
selected object(s). 

— 

 Cut Removes selected information and 
places it on the Clipboard. 

— 

 Copy Places a copy of the selected 
information on the Clipboard. 

— 

 Paste Places a copy of the Clipboard contents 
into editable fields and tables. 

— 

Quick 
Search 
Controls 

  
Quick Search class selection list. 

Select a base class of objects that will 
limit the Quick Search. Default selection 
is All. 

 

 
Search Attachment Contents 

Check this box to search attachment file 
contents. 

 

 
Search Criteria Entry field 

Enter the search text in this field. 

Base classes and other object 
types are presented in Installed 

Agile Classes, Base 
Classes, and Subclasses on 
page 68. 

Full Text Search for 
Content in Attachment 
Files on page 154  



 

 

9.2.2.6 11  

  

Button  Name  Descript ion  For more in fo rmat ion,  
see. . .  

 
Run Search Searches for objects that match the 

criteria in the Simple Search text box. 
Quick Searches and 
Wildcard Characters on page 
152 

 Advanced 
Search 

Searches for objects with fields that 
match (multiple) conditions of the 
search that you set up. A Where Used 
search finds assemblies that contain 
parts that meet your search criteria; a 
Relationship search finds objects 
related to the objects that match your 
search criteria. 

Advanced Searches on page 
165  

 Last Search 
Results 

Displays results of the most recent 
search you performed. 

— 

 Address 
Book 

Opens the Address Book window, 
where you can view, create, and modify 
user groups. 

Address Book in Java 
Client on page 21 

 Process 
Extensions 

Lets you run/access custom actions 
that were defined by someone else. 

For information about process 
extensions, see Agile 
Administrator Guide — "Process 
Extensions. 

 View/Edit 
Current User 

Lets you modify your Agile user profile. Changing Your User 
Settings on page 37 

 Exit Lets you log out of Java Client. — 

 
 

Windows Bar 

An optional windows bar appears below the main toolbar. 

 

The windows bar contains a button for each open Java Client window. Each button includes the title 
of the window and an icon reflecting the window’s contents. The button representing the current 
window is highlighted. To move to a different window, click its button in the windows bar. 

To close a window using the windows bar: 

 Right-click the button representing the window you want to close, and choose Close. 

 You can also use Shift-click and Ctrl-click to select multiple windows, right-click (over one of the 
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selected windows), and choose Close. 

 Finally, there is also a Close All option when you right-click over any window. 

You can hide or show the windows bar, and you can move it to the top or bottom of the Java Client 
desktop. 

To hide the windows bar: 

Right-click the window bar and choose Hide Windows Bar, or choose View > Windows Bar. 

To show the windows bar: 

Choose View > Windows Bar. 

To move the windows bar: 

Right-click the windows bar and choose Move. 

Hiding and Showing the Navigation Pane 

You may want to view the main window only (hide the navigation pane), then show the navigation 
pane again when you need to use it. 

To hide or show the navigation pane: 

1. On the boundary between the navigation and content panes, click the small left arrow (to hide) 
and the small right arrow (to show) the navigation pane. 

To adjust the width of the navigation pane: 

1. Hold the pointer on the boundary between the navigation and content panes. The pointer 
changes to a double-sided arrow. 

2. Drag until the pane is the desired width: it is limited to a maximum of about one-fourth the total 
screen width. 

 

Java Client Tables 

Java Client displays many types of information in tables. For example, search results, BOMs, and 
AML information appear in tables. 

Sort Order in Tables 

You can change the sort order of some Agile tables, for example, the Affected Items table. To sort a 
table, click the column header of the column by which you want to sort. For example, to sort the 
Affected Items table by item description, click the Item Description column header. You can change the 
width of the columns by selecting the line between column headers and dragging. 

Selecting Rows in Tables 

There are a number of tables in Java Client on which you can perform certain actions. For example, 
on the Affected Items table, you can remove items. From the Search Results table, you can open an 
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object and modify it or export it; you select the items on which you want to perform the action, then 
click the action to perform it. 

Tables on object tabs have a ―handle‖ column at the left, as shown in the following figure. You can 
select rows by using any of the following methods: 

 You can select all the rows with the top handle, or you can use Windows commands (Shift–
click and Ctrl–click) on the row handles to select the rows on which you want to perform the 
action. 

 You can select a row by clicking in the row or you can use Windows commands (Shift–click and 
Ctrl–click) in the rows you want. 

 You can drag-select (mouse-down or mouse-up as you drag across multiple rows). 

When you have selected the rows you want, the available actions are buttons in the menu bar 
above the table. 

 

For editable tables, select the rows you want and click the Edit button, and the Edit mode popup 
appears. In this mode, make any changes or updates and click OK. The table refreshes to reflect the 
changes. 

In Edit mode, Java Client displays the object ID and object Description, which identifies the data in 
the row that has the focus. 

To open and view objects in a table, use one of these methods: 

 To open one object, double-click the object’s row in the table. 

 To open an object with a specific tab on top: 

a. Select the object’s row in the table. 

b. Right-click. 

c. In the displayed menu, choose Open and the tab you want. 

 To open multiple objects: 

a. Select multiple rows in the table. 

b. Either press Enter on the keyboard, or right-click the mouse and choose Open. 
 

Using the Inbox 

As information passes through the Agile system, users receive news of status changes, requests, 
and notifications. When you first start Java Client, it is a good idea to view your Inbox. 
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To view your Inbox in Java Client: 

1. Click the arrow to the right of the  Inbox icon on the main menu bar. 

2. Click the Inbox section that you want to view, Workflow Routings or Notifications. 
 

Notifications 

The Notifications section of the Inbox lists Agile PLM notifications. Notifications inform you of some 
action or process that has taken place, such as subscriptions, RFQs, and project invitations. You 
also receive a notification when a program-related request is sent to your My Assignments tab. The 
Accept function does not apply to notifications. 

You can view or delete a notification. To view a notification, double-click it. To delete a notification, 
select it and click Delete. 

When configuring Agile PLM, the Agile administrator can choose whether notifications are sent to 
an email address, to the Agile PLM inbox, or to both. 

Workflow Routings 

The Workflow Routings section of the Inbox lists routable objects that require your review or action. 
For example, your Inbox may contain changes for which you are an approver. The out-of-box 
workflow routings are a combination of base classes and actions that define the kind of review, as in 
the table below. 

Note The searches selected in your User Profile Searches field also determine which workflow 
routings appear in your Inbox. For example, if Change Analyst Searches is one of your 
assigned searches, you see Change class object workflow routings in the Workflow 
Routings window. In a similar manner, if Quality Searches is one of your assigned 
searches, you see QCR and PSR workflow routings. For more information, see 
Changing Your User Settings on page 37 and User Properties Defined on page 60. 

  

Base c lass. . .  . . . inc ludes routable  objects  
f rom these c lasses . . .  

. . .combined  wi th  these  
act ions of  rev iew  

Change Change Orders, Change Requests, Site 
Change Orders, Price Change Orders, 
Deviations, and Stop Ships 

 

... That Require My Approval 

... That I Am An Observer Of 

... That Were Returned To Me 

... Transferred to Me 

... Escalated to Me 

 

Quality Change Request 
(QCR) 

Corrective and Preventive Actions and 
Audits 

Problem Service Request 
(PSR) 

Non-Conformance Requests and 
Problem Reports 

Package Packages 
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Base c lass. . .  . . . inc ludes routable  objects  
f rom these c lasses . . .  

. . .combined  wi th  these  
act ions of  rev iew  

Program Activities and Gates 

Transfer Order Content Transfer Orders and 
Automated Transfer Orders 

Declarations Substance Declarations, Part 
Declarations, JGPSSI Declarations, 
Homogeneous Material Declarations, 
Supplier Declarations of Conformance, 
IPC 1752-1 Declarations, and IPC 
1752-2 Declarations 

File Folders Designs and File Folders 

 

To open a workflow routing in the table, double-click its number. 

To export objects to a text or PDX file (if you have privileges), select the row and choose Tools > 
Export. 

The Print button prints the entire Inbox table. 

Using Bookmarks and the Recently Visited List 

If there are objects that you need to return to frequently, you can use Bookmarks and the Recently 
Visited list for quick access. 

Bookmarking 

Bookmarking lets you keep a list of objects that you return to frequently. You can click an object 
bookmark to quickly display that object. 

To bookmark an object in Java Client: 

1. Open the object. 

2. Choose Edit > Add Bookmark, or click the Add Bookmark button  in the object’s toolbar. 

The Add Bookmark dialog displays. 

3. Enter a name for the bookmark in the Name field. 

4. Select a folder in which to store it. 

You can always save a bookmark in the My Bookmarks folder. 

5. To create a new folder, click the  New button. In the Create New Folder dialog, enter a folder 
name and click OK. 

6. Click OK in the Add Bookmark dialog to save the bookmark. 

The object’s number is saved in the My Bookmarks list on the Searches tab in the navigation 
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pane. 

To open a bookmarked object in Java Client: 

Double-click the object’s number in the My Bookmarks list on the Searches tab in the navigation 
pane. The object opens. 

Organizing Bookmarks 

You can arrange your bookmarks in folders using the Organize Bookmarks window (Edit > Organize 
Bookmarks). 

To organize bookmarks in Java Client: 

1. Choose Edit > Organize Bookmarks. The Organize Bookmarks window opens. 
 

The Organize Bookmarks Window 

Use the features in the Organize Bookmarks window to create or remove folders and rename or 
remove bookmarks. 

Button  Descript ion  

Remove Removes the selected bookmark or folder. 

Rename Renames the selected bookmark or folder. 

New Adds a new bookmarks folder within the current folder. See Bookmarking on page 52 for 
more information. 

Save Saves the changes you made in the Organize Bookmarks window. 

Cancel Discards the changes you made in the Organize Bookmarks window and closes the window. 

 
 

Removing Bookmarks 

To remove a bookmark: 

1. In the Organize Bookmarks window, select the bookmark or folder you want to remove. 

2. Click the Remove button. 

3. Click Yes to remove the bookmark or folder. 

Note Removing a folder will also remove all of its children. 

4. When you are finished, click Save. 
 

Renaming Bookmarks 

To rename a bookmark: 

1. In the Organize Bookmarks window, select the bookmark or folder you want to rename. 

2. Click the Rename button. 
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3. Edit the name of the bookmark in the Enter Name field. 

4. Click OK. 

5. When you are finished, click Save. 
 

Recently Visited List 

When you view an object during a work session, it is added to the Recently Visited list. The 
Recently Visited list includes the last 10 objects viewed (or 25, 50, or 100, depending on your 
administrator’s setting of a Preference). 

To open a recently visited object in Java Client: 

1. Double-click the Recently Visited icon in the Search tab in the navigation pane. 

2. Double-click the object’s number in the list. The object opens. 
 

Changing Your User Settings 

This section includes information about creating or changing your User Profile, password, personal 
criteria, and escalations. 

Note Keep in mind that the Agile administrator may have set values in Agile PLM that impact 
what you are able to modify. Most changes made by the administrator are automatically 
implemented systemwide; however, if the administrator makes changes in your role 
assignment, or to the roles and privilege masks, these take effect for a user only after the 
user has logged out and logged back in to Web or Java Client. 

 

Changing Your User Profile 

Your user profile contains a variety of information about you, including your contact information, 
your Windows date and time preferences, and several Java Client onscreen display preferences. 
The Agile administrator determines whether you can edit your user profile. 

To edit or add information to your user profile:  

1. Open your user profile by choosing Settings > Current User on the computer from which you are 

logged in to Java Client, or click the View/Edit Current User button . 

2. Click the tab on which you want to make changes. 

3. To make changes to the General Info tab, edit any field that is available. Use the lists, browse 
buttons, and text boxes to enter the requested information. 

You can also make changes to the Escalations and Attachments tabs. For information about 
escalations, see Working with Escalations on page 18. For information about working with the 
Attachments tab, see Working with Attachments on page 253. 
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Note If you are working primarily in Java Client, check the System Preferences under the 
Preferences tab: Preferred Client should be set to Java Client and Receive Email 
Notifications should be set to Yes. This will ensure that you will receive email 
notifications in the same client you are working in. If there is a discrepancy and you are 
not able to change these properties, see your Agile administrator. 

 

Changing Your Password 

These instructions describe how to change your login password, which you can do at any time. The 
Change Approval Password option is enabled only when your Use Login Password for Approval user 
property is set to No. 

To change your login password: 

1. Choose Settings > Change Password. The Change Password dialog box appears. 

2. Type your old login password in the Old Password field. 

3. Type your new login password in the New Password and Retype New Password fields. (Passwords 
are case-sensitive.) 

If you want to change your approval password (and the Change Password dialog displays the 
Change Approval Password fields), fill in the fields as described above. 

4. Click OK. 

If you have not followed the rules defined on your Agile system for selecting passwords, you are 
prompted to correct your password. 

Persisted User Interface Settings 

For some user interface settings, the most recently used settings persist across sessions for each 
user. 

Examples include: 

 Add method – (Search, Type in Known Number(s), Create) 

 Edit Rows After Adding. 
 

Working with Escalations 

If your administrator has granted you the necessary privileges, you can set up escalations for 
yourself. Escalations allow changes to be forwarded automatically to a designated user if you do not 
respond within a set amount of time. You can also create escalations for your personal user groups. 

Your Agile administrator can add escalations to your user profile, and can edit existing escalations. 

To manage escalations for yourself: 

1. Choose Settings > Current User on the computer from which you are logged in to Java Client. 

Or, click the View/Edit Current User  button on the main toolbar. 

2. Click the Escalations tab. 
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3. To set up a new escalation, click the Add button, then select an escalation criteria and one or 
more users to be notified for that criteria. You can select a different person for each criteria, if 
you want. 

4. To edit an escalation, select it on the Escalations tab and click the Edit button . Add users to, 
or remove them from, the Notify Users list. 

5. To delete an escalation, select it and click the Delete button . 

To manage escalations for a personal user group: 

1. Choose Settings > Personal Groups. 

2. Double-click the group. 

3. When the user group window appears, click the Escalations tab. 

4. Follow steps 3–5 in the preceding procedure, ―To manage escalations for yourself.‖ 

5. To set up a new escalation, click the Add button, then select an escalation criteria and one or 
more users to be notified for that criteria. You can select a different person for each criteria, if 
you want. 

6. To edit an escalation, select it on the Escalations tab and click the Edit button . Add users to, 
or remove them from, the Notify Users list. 

7. To delete an escalation, select it and click the Delete button . 
 

Creating Personal Criteria 

A saved ―personal criteria‖ is a reusable database query very similar to an advanced search, in that 
the attributes used to create personal criteria are similar to the attributes used to create advanced 
searches. (For more information, see Advanced Searches on page 165.) They may also be thought 
of as ―filters‖ or ―qualifying descriptions‖ of objects that you are interested in tracking. 

Personal criteria are used to define signoff authority transfers. If you have the appropriate 
privileges, you can temporarily transfer your signoff authority for routable objects to one or more 
Agile users. For more information about signoff authority transfers, see Transferring Signoff 

Authority on page 234 and Defining Personal Criteria for Authority Transfers on page 237. 

Any criteria in Agile—personal or reusable—applies to one Agile class (and its children) or a 
particular subclass; therefore, you must create a separate criteria to apply to the objects of another 
class or another subclass. 

To create a personal criteria:  

1. Choose Settings > Personal Criteria. The Personal Criteria window appears. 

2. Click the Create button. The Create Criteria dialog box appears. 

3. Fill in the Name and Description fields, and select the object type that your personal criteria will 
apply to. This list includes all the Agile classes and user-defined subclasses. 

Note The personal criteria name must be unique. If you specify a personal criteria name 
that is already used, you get a duplicate name error message. 

4. Select the attribute you want from the Attribute drop-down list. The values that are available 
change according to the Agile class or subclass you selected in the previous step. Click OK in 
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the small dialog box. 

5. The Match If field specifies the search operator. The values that appear depend on what you 
selected from the Attribute list. Select from the listed operators, which will be a subset of the 
following: 

 Contains, Does Not Contain 

 Equal To, Not Equal To 

 Greater Than, Greater Than Or Equal To 

 Less Than, Less Than Or Equal To 

 Is Null, Is Not Null 

 Starts With, Does Not Start With 

 Like, Not Like 

6. In the Value field, select a value for the field you selected from the Attribute list. Click OK in the 
small dialog box. 

7. To add additional conditions, select AND or OR in the And/Or field. 

8. Repeat step 4 through step 7 until your personal criteria is complete. 

9. When the criteria is complete, click OK. 

Note Changing the criteria in the Object Type field resets the entire personal criteria. A 
personal criteria applies to one class or subclass. You must create a separate global 
criteria to apply to another class or subclass. 

If you want your criteria to be case-sensitive, select the Case Sensitive checkbox. This can 
simplify how you define personal criteria: 

 If you enter text in the Value field, the criteria will look for text that is an exact match, 
depending on the restraints of the value of the Match If field. 

 If you define a numerical value, checking Case Sensitive allows the Agile system to make 
use of internal database settings to find objects more quickly. 

Using case-sensitive searches improves performance of the system and is recommended 
when possible. 

The Add( ) button places parentheses around the specified condition or conditions, which changes 
the order in which the search conditions are evaluated. The Add( ) button functions like a formula 
within parentheses in an algebraic equation, following the standard algebraic order of operations. 
The grouped criteria within parentheses are resolved before any others. If you do not use 
parentheses when defining your personal criteria search, the search is processed row by row 
without any precedence of And/Or values. The first line is combined with the second based on the 
first line’s And/Or value. The result of the first two lines is then combined with the third line based on 
the second line’s And/Or value, and so on. 

Editing Personal Criteria 

Use this dialog box to edit the conditions in your personal criteria object. Defining or modifying a 
personal criteria object is similar to defining or modifying an advanced search. For detailed 
information about searches, see Finding Agile Data with Searches on page 143. 

You can perform the following modifications to your personal criteria object: 
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 In the search condition table, use Add, Insert, and Delete to add more Search Condition rows as 
needed, or to delete rows you do not want. 

 Click a cell in the Search Condition table to display the search criteria selection list. 

Working from left to right in the search condition row, click the drop-down list buttons to select 
the target Attribute (for example, CoverPage.Originator), the Match If search operator (for 
example, Equal To), and the Value (for example, John Smith). 

Depending on the selection in the Attribute list, the Value field may contain a list that is relevant 
to the selection, a calendar button, or a field where you can enter text or numbers. 

 Click the And/Or field to select And or Or from the list. Use And if both conditions must be met. 
Use Or if either or both conditions can be met. 

 Use the (  ) button to enclose selected rows in parentheses, which determines precedence in 
the way the search is performed. 

If you do not use parentheses when defining your personal criteria search, the search is 
processed row by row without any precedence of And/Or values. The first line is combined with 
the second based on the first line’s And/Or value. The result of the first two lines is then 
combined with the third line based on the second line’s And/Or value, and so on. 

 Select Case Sensitive if you want to perform a case-sensitive search where text capitalization 
matters. 

 
 

Address Book in Java Client 

The Address Book is a multi-list window that enables you select users and user groups for various 
functions. The situations in which you use the address book can include: 

 When you send email notifications 

 When you select people or groups to sign off a workflow 

 When you share, or grant, one or more of your roles to another user or user group for specific 
objects 

You can also create user groups in the address book. 

Overview of the Address Book 

You can access the address book by clicking the  button on the main toolbar, or by choosing 
Tools > Address Book, or when you are performing actions that involve sending an object or a 
notification (for example, routing a change). You can select individual users or user groups. The 
address book lists all the individuals and user groups that use Java Client and Web Client. 
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Note The Agile administrator can use Discovery privileges to limit the users you see in the 
address book. 

 
 

Selecting Users and User Groups from the Address Book 

You can select recipients individually or in groups. When you select a group, all the members of the 
group receive the email message. You can sort users by Last Name or First Name by clicking one 
of the radio buttons. 

To select users or user groups from the address book:  

1. To display a list of names on the Users tab, click the Check Names  button, which returns a list 
of all users. 

2. Select a person on the Users tab, or select a user group on the User Groups tab. 

To see more information about a user or user group, select it and click the View button. 

3. To add names directly to the Recipients list, type a known value (e.g., last name) in the Find 

Name field, then click the Check Names  button or the keyboard shortcut Ctrl+K; the system 
moves that name over to Recipients. 

4. You can also select a name, then click the Add  button to move your selection into the 
Recipients list. 

To select multiple names or user groups, use the Shift-click or Ctrl-click, then the Add button. 

To remove a name or multiple names, select using the same techniques and click the Remove 

 button. 
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5. On the User Groups tab, if you select a user group, and you want only the group name to appear 

in the Recipients list, use the  button. If you do this when selecting approvers, only the 
group as a whole becomes an approver, and any single member of the group can approve. 

If you select a user group, and you want to see every name in that group in the Recipients list, use 

the Add all the users in the selected group  button (this button only appears on the User Groups 
tab). If you do this when selecting approvers for a routable object, each individual becomes an 
approver. 

6. Continue selecting names and using the arrows until the Recipients list is correct. 

7. Click Save As to create a new user group that includes every individual’s name on the 
assembled list. This includes the individuals of any user group you included in the new group. 

8. Click Save to save the list. Click Close to close the address book. 

Note When you add a user group to a group, and save it, when you open the modified 
user group, all the names of the members of the added user group are there; the 
modified group does not record user groups that were added. 

 

User Groups 

This section explains how to create both personal and global user groups, as well as modifying and 
deleting them. See also Creating Supplier Groups on page 25. 

Note Your User Profile User Group tab lists the Global Groups of which you are a member. 
Your membership in the personal groups of individual users is not displayed on the User 
Group tab. See also Changing Your User Profile on page 17. 

 

Creating User Groups 

You can create personal user groups; with the appropriate privileges, you can create global user 
groups. 

To create a personal user group in Java Client: 

1. Choose Settings > Personal Groups. The Personal User Groups window appears. 

2. Click the New  button. The Create User Group dialog box opens. 

3. Using the Subclass drop-down list, select a subclass of the User Groups class. User Groups will 
be the only subclass available if your administrator has not created another one in the User 
Groups class. 

4. Fill in a name for the group in the Name field. 

5. Click  next to the Users field, and move users (from the Users list) or other user groups (from 
the Groups list) to the Recipient list. 

6. Click OK. The new user group object appears, with applicable fields populated. 

7. On the General Info tab, select or accept values from the drop-down lists. Enter a description 
and the maximum number of named users, if appropriate. 
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8. When you are finished, click Save. 

9. Continue to select, enter, or accept values for properties under the Users and Escalations tabs. 

To create a user group from the address book: 

1. Open the address book by clicking the  button on the main toolbar, or by choosing Tools > 
Address Book. 

2. Select and move users (from the Users list) or other user groups (from the User Groups list) to 
the Recipients list. 

3. Click Save As Group. The Save Group dialog box appears. 

4. Enter a name in the New Group field. Or you can select a group from the Existing Group field; the 
new version of the existing group will overwrite the original one. 

5. In the Save In area, select Personal Groups or Global Groups. 

6. The Subclass field contains only User Group. It will list other subclasses if the administrator has 
created new subclasses of the User Groups class. 

7. Click OK. The new user group is saved in the Global or Personal Groups folder. 
 

Completing or Editing User Groups 

To complete additional information about your user group, or to edit an existing personal user group: 

1. If the address book is still open, click Refresh. Otherwise, choose Settings > Personal Groups, or 

open the address book , and display the Groups tab. 

2. Navigate to the group you created by expanding the appropriate group folder. 

3. Select the group and click View. The group opens in a tabbed window. 

4. On the General Info tab, specify general information about the user group. 

5. You can click the Users tab to delete users. On the Users tab, select the name, and click the 

Delete button . 

6. To add or modify escalations for the user group, click the Escalations tab. For information about 
escalations, see Working with Escalations on page 18. 

7. Add or remove any attachment references for the user group on the Attachments tab. 

For information about attachments, see Working with Attachments on page 253. 

8. Click Close to close the user group window. 

Note With User Group "synch" function enabled, you cannot remove or add users on a user 
group's Users tab that have been synchronized (that is, where users have been added to 
a user group via LDAP). This feature only applies to iPlanet server. Contact your Agile 
administrator if you have questions about your ability to delete users from the Users tab of 
a group object. 
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Deleting Personal User Groups 

To delete a personal user group: 

1. Choose Settings > Personal Groups. 

2. Select the group and click . The selected group is deleted. 

To delete a personal user group from the address book: 

1. Open the address book  and display the Groups tab. 

2. Select the group you want to delete. Click View. 

3. Click . The selected group is deleted. 
 

Creating Supplier Groups 

You can create personal supplier groups; you cannot create a global supplier group in Java Client. 
Suppliers are other companies who are using Agile PLM to work with your company. 

Note Global supplier groups are created by the Agile administrator, as noted below. For more 
information about creating global supplier groups see Agile Administrator Guide. 

To create a personal supplier group: 

1. Choose Settings > Personal Supplier Groups. The Personal Supplier Groups window appears. 

2. Click the New  button. The Create New Supplier Group dialog opens. 

3. Fill in the Name and Description fields, and select Yes or No in the Enabled field. 

4. The Type field is grayed, with the value of Personal entered. (Supplier groups that are created 
from the Admin > User Settings > Supplier Groups node are ―global.‖ You can create global 
supplier groups only if you have sufficient privileges. For more information about global supplier 
groups, see Agile Administrator Guide.) 

5. For the Suppliers field, click the down-arrow, and move suppliers from the Choices list to the 
Selected list. 

6. Click OK, you are returned to the Create New Supplier Group dialog. Click OK again, the new 
supplier group object appears, with applicable fields populated. 
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Chapter 3 

Navigating in Agile Web Client 

This chapter includes the following: 

 Introducing Web Client ........................................................................................................................................ 27 
 Main Toolbar ........................................................................................................................................................ 33 
 Navigation Pane Toolbar ..................................................................................................................................... 35 
 Changing Your User Settings .............................................................................................................................. 37 
 Exploring the Home Page .................................................................................................................................... 41 
 Using and Organizing Bookmarks ....................................................................................................................... 52 
 Using the Recently Visited List ............................................................................................................................ 56 
 User Groups and the Address Book in Web Client .............................................................................................. 56 
 User Properties Defined ...................................................................................................................................... 60 

 
 

Introducing Web Client 

Agile Web Client is opened using only a browser. Web Client is the only client that supports these 
Agile solutions: 

 Program Portfolio Management, 

 Product Governance & Compliance, and 

 Product Cost Management. 

Both Web and Java clients support these Agile solutions: 

 Product Collaboration and 

 Product Quality Management. 

Agile Reports (Analytics and Reports) and some utilities—Agile Import, Export, FileLoad—can be 
accessed from either client but, when selected, open in Web Client. For example, in Java Client, 
choosing Tools > Import opens the Import utility in Web Client; Java Client remains open. 

Logging In to Web Client 

Agile PLM 9.2.2 has been installed on your company’s system, and you are ready to work in Web 
Client. There may be a bookmark already on your browser, or perhaps your Agile administrator has 
given you a starting URL, along with username (User ID) and password. 

Important If a URL is specified in the documentation or release notes, copy the upper- and 
lower-case characters exactly, including the full domain name specified. 

Also, if a popup blocker is installed on your machine, the login may halt. You would disable the 
popup blocker, then click the Retry button, which will display the application in a new window. 
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To start Web Client: 

1. Start your browser. 

2. Click the Web Client bookmark, if one exists, or type a URL that follows this pattern: 

http://Web Server.<domainname>.com/Agile/PLMServlet 

The Login page appears. 

3. Enter your username. Your username is not case-sensitive. 

Your username is assigned by your Agile administrator and can be an abbreviation of your full 
name. For example, the name Michael Jones may be abbreviated to MICHAELJ or MJONES. 

4. Enter your password. Your password is case-sensitive. 

Your password is initially assigned by your Agile administrator. If you have the appropriate 
privileges, you can change your password at any time. The administrator may require you to do 
so within a set number of sessions. See Changing Your Password on page 40. 

5. Click the Login button. If you make a mistake, click Clear and retype your username and 
password. 

The login process is complete, and the user Home page appears (―Welcome, <Your Name>‖). 

You can choose an activity from the user Home page, the navigation bar on the left, or the main 
toolbar at the top. For more information, see Main Toolbar on page 33 or Navigation Pane Toolbar 
on page 35. 

You can select a preferred start page; see Choosing Your Preferred Start Page on page 28. 

Choosing Your Preferred Start Page 

At any time you can change the start page that opens when you log in to Web Client. However, your 
administrator may restrict what properties you are able to change in your user object. 

To set or change your preferred start page: 

1. Click the Tools icon , and on the drop-down menu, click My Settings. 

2. On the Settings Home page, click User Profile. Your ―user object‖ appears, that is, the Agile 
database object that your administrator created to represent you. 

3. Click the Preferences tab. 

4. Click the Edit button. The properties on the page become editable. 

5. Under Display Preferences, click the drop-down arrow for Preferred Start Page. Select the page 
you want. 

The Preferred Start Page list includes the Home page and all the dashboard tabs for which you 
have view privileges. 

If you are not able to view any dashboard tabs, the only selection is Home. 

6. Now click the drop-down arrow for Preferred Inbox View. 

In Web Client, if you have selected Home as your start page, this setting determines which tab 

is displayed when you view the Home page by clicking the  Home button in the main menu. 

http://web/
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Choose My Assignments, Notifications, or Workflow Routings. 

Note If you chose a Dashboard page in step 5, that Dashboard page will be displayed 

when you click the  Home button in the main menu. However, you can use the 

 Home button drop-down list to display the Home page with the selected tab 
displayed: My Assignments, Notifications, or Workflow Routings. 

For more information about the Home page and these settings, see Exploring the Home Page 
on page 41. 

7. When you have finished, click Save (at the top of the page). Your preferences have been saved 
and you will see your chosen start page the next time you log in to Web Client. 

For more information about changing properties in your user object, see Changing Your User Profile 
on page 17. 

For more information about the other links in the list of My Settings, see Changing Your User 

Settings on page 37. 

Logging Out of Web Client 

To log out of Web Client: 

1. From the menu bar, click the  Logout button. 

2. You are returned to the Login page. To exit, close the browser from the upper-right corner. 
 

Bookmarking Web Client in Your Browser 

When the Web Client Login page opens in your browser, you can bookmark it to create a startup 
shortcut. Create a shortcut on your desktop, then click it the next time you want to open the Web 
Client. 

Web Client Tables 

Web Client displays many types of information in tables. For example, search results, BOMs, and 
RFQ information appear in tables. Often a table is what you see when you click a tab in an object, 
so as BOM tab displays the BOM table. 

To open and view objects in a table: 

 Click the Number link of the object. 

Web Client displays a tooltip (in both Read and Edit modes) that displays the object ID and object 
Description, which identifies the data in the row that has the focus. 

Sort Order in Tables 

You can change the sort order of some Agile tables, such as the Affected Items table. To sort a table, 
click the column header of the column by which you want to sort. For example, to sort the Affected 
Items table by item description, click the Item Description column header. On a returned-search table, 
all columns are ―live,‖ that is, clicking them sorts the table one way, clicking again sorts the other 
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way (ascending or descending order). 

Selecting Rows in Tables 

There are a number of Agile tables on which you can perform certain actions in Web Client. For 
example, on the Affected Items table, you can delete items. These tables have a ―handle‖ column at 
the left, as shown in the following figure. You can select rows by using any of the following methods: 

 You can select all the rows with the top handle, or you can use Windows commands (Shift–
click and Ctrl–click) on the row handles to select the rows on which you want to perform the 
action. 

 You can select a row by clicking in the row or you can use Windows commands (Shift–click and 
Ctrl–click) in the rows you want. 

 You can drag-select (mouse-down or mouse-up as you drag across multiple rows). 

When you have selected the rows you want, the available actions are buttons in the menu bar 
above the table. 

 

If a table is more than one page long, you can select rows on multiple pages to perform actions. 

For example, to remove items from the Affected Items table that spans two pages: 

1. Go to the first page and select all the items you want to delete. 

2. Go to the next page and select all the items you want to delete. 

3. Click Remove. 
 

Using Copy/Paste in Tables 

Copy/paste functionality in Web Client is applicable to changes (to edit Affected Items tab) and 
supplier responses. 

To use copy/paste in tables: 

1. Select rows to edit, then click Edit to display the table page in edit mode. 

2. If not already done, fill in the values that you will copy. 

3. Select the columns to copy by checking the Paste Column checkbox for each column. 
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4. Select the row you want to copy by highlighting the row. 

5. Click the Copy button. 

6. Select which columns to paste by checking or unchecking the Paste Column checkbox for each 
column. 

7. Select which row(s) to paste to. 

8. Click the Paste button. 

Note For information about using Web Client affected item table Fill Up and Fill Down buttons, 
see the chapter about the affected items of changes in Product Collaboration Guide. 

 

Web Client Tab Content Indicator Icons 

In Web Client, a grey dot icon  appears on the tab, next to the tab name, to indicate: 

 The tab has contents. For example, content icon on a BOM tab indicates that the item has child 
items added to the BOM tab. 

 The tab has active contents. For example, a content icon appears on the Changes tab of an item 
only when the item has pending changes (active changes). 

A red dot icon  appears on a tab to alert you that the tab has problematic content. 

 A red dot icon is displayed on the Compliance tab if an item or manufacturer part that has a 
specification that is non-compliant or is missing information. 

 A red dot icon is displayed on the item Changes tab if the item has a released Deviation or Stop 
Ship. 

 

Tab  Web  Cl ient  Tab  Indicato r  Found in  these c lasses  o f  
business ob jec ts  

Attachments (and Files)  = Object has attachments All objects except file folders 
(which contain attachment 
content) and reports. 

Changes  = Item has pending changes 

 = (Red icon) Item has released 
Deviation or Stop Ship 

Items and published prices. 

BOM  = Item has BOM items Items. 

Manufacturer  = Item has manufacturer parts Items & Sourcing Projects. 

Affected Items  
(in PCOs: Affected Prices) 

 = Change has affected items Changes, PSRs, QCRs. 

Sites  = Item has sites assigned Items. 

Prices  = Object has prices Items & Manufacturer Parts. 

Suppliers  = Object has suppliers Items & Manufacturer Parts. 
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Tab  Web  Cl ient  Tab  Indicato r  Found in  these c lasses  o f  
business ob jec ts  

Quality  = Item has active PSR or QCR Items. 

Compliance  = Object has specifications 

 = (Red icon) Object has non-compliant 
or incomplete specifications 

Items & Manufacturer Parts. 

Relationships  = Object has relationships All classes (except Actions Items 
and Reports) 

(For Programs classes, 
relationships are included on the 
Content tab.) 

Content  = Program has object content 
(relationships) 

Agile PPM Program objects 

For Program classes, 
relationships are included on the 
Content tab and relationships with 
rules are named deliverables. 

Discussions  = Program has discussions Agile PPM Program objects. 

Related PSR  = PSR has related PSRs Agile PQM Product Service 
Request (PSR) objects. 

PSRs  = Customer has active PSRs Customers 

First object tab ―Page One‖ 
for example: 

Cover Page 

Title Block 

General Information 

General Info 

In Web Client, optional tabs: 

Page Two and Page Three 

Not applicable 

Tab indicator icons are not used on these 
tabs. 

All objects have a ―Page One‖ that 
uses one of the names to the left. 

In Web Client, if Page Two and 
Page Three sections are enabled, 
they appear on the first object tab. 
Your Agile administrator may 
rename them. 

Where Used  Items, Manufacturer Parts, 
Discussions, File Folders. 

History  All. 

Workflow (routable objects 
only) 

 Changes, PSRs, QCRs, 
Packages, Transfer Orders, 
Programs 

Escalations  Users and User Groups 

Shares  Users and User Groups 

Subscriptions  Users 
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Using Online Help 

The Help menu  provides access to online Agile documentation set and online help tools: 

 Manuals – Opens the Oracle Agile Documentation web page, with access to online manuals for 
Web Client and Agile PLM. The documentation set contains detailed information about Oracle 
Agile PLM applications, concepts, procedures, and reference information. 

 About Agile – Displays technical information about the current release of Web Client. 
 

Main Toolbar 

There are toolbars in the main Web Client window, in object windows, and in some object tabs. 

Depending on your assigned roles and privileges, you can use the toolbar buttons on the main 
toolbar to perform the tasks described in the following table. Toolbars in object windows contain 
buttons that pertain to the object. 

Button  Name  Descript i on  For more 
in format ion,  see . . .  

 
Back Takes you to the previous page you viewed in your 

browser. (It does not, however, undo any changes 
you entered in Agile.) 

— 

 
Forward Takes you to the next page forward. It is disabled if 

you did not use the Back button to view the page 
currently in your browser. 

— 

 
Refresh You can refresh (update) objects, the Recently 

Visited list, Bookmark list, and Search Results 
page by clicking the Refresh button. 

There is a Validate button on the Cover Page of 
change objects in Edit mode. The Validate button 
saves the changes, validates the workflow, and 
reloads the workflow list. 

— 

 Home Brings you to your home page in Web Client as 
defined by Preferred Inbox View in your user 
properties, which has been selected by your 
administrator and can be changed by you. So, 
based on that setting, when you click the Home 
button, the main area displays your My 
Assignments, Workflow Routings, or 
Notifications. 

Above the main area, the standard Home page 
has the live links that you have defined as your 
Quick Links list. 

Choosing Your 
Preferred Start 
Page on page 28 

Exploring the 

Home Page on page 
41 

Quick Links on page 
41 

Product Portfolio 
Management User 
Guide 
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Button  Name  Descript i on  For more 
in format ion,  see . . .  

 

Create Lets you create objects in all the base classes and 
classes that your company has purchased and to 
which you have privileges. 

Introducing Agile 
Objects on page 65 

 

Search 
Attachment 
Contents 

In the quick search interface, this checkbox lets 
you Search Attachment Contents when checked. 

Base classes and other 
object types are 
presented in Installed 

Agile Classes, Base 
Classes, and 
Subclasses on page 
68. 

Web Client Quick 

Search on page 151  

Full Text Search 
for Content in 
Attachment Files 
on page 154 

 
Run Simple 
Search 

Searches for objects that match the criteria in the 
Simple Search text box. 

Quick Searches on 
page 149 

 
Advanced 
Search 

Looks for objects with fields that match (multiple) 
conditions of the search that you set up. A Where 
Used search finds assemblies that contain parts 
that meet your search criteria; a Relationship 
search finds objects related to the objects that 
match your search criteria. 

Advanced 
Searches on page 
165 

 
 Pre-configured parametric search drop-down list. 

Select a base class from the list to display the 
parametric search window. In the parametric 
search window, select an object type to display the 
object search criteria your Agile administrator has 
pre-configured for you. 

Web Client 
Parametric Search 
Window on page 160 

 

Last Search 
Results 

Displays results of the most recent search you 
performed. 

— 

 
Tools Drop-down menu with links to Address Book and 

My Settings. 

It also links to these Agile client utilities: Analytics 
and Reports, Import, Export, and FileLoad. 

If Product Portfolio Management is installed, 
further down the menu are: Microsoft Project 
Synchronization Setup and Microsoft Project 
Publish. 

Administration is visible only if you have been 
assigned the Administrator privilege (or 
Administrator role); it lets you access settings for 
the following Administrator nodes: Users, User 

User Groups and 
the Address Book 
in Web Client on 
page 56  

Changing Your 
User Settings on 
page 37 

Working with Agile 
Reports on page 123 

Agile Import, Export, 
FileLoad, and Microsoft 
Project links are 
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Button  Name  Descript i on  For more 
in format ion,  see . . .  

Groups, and Supplier Groups. documented in Agile 
PLM Import & Export 
Guide 

Analytics are 
documented in Portfolio 
Analytics User Guide 

Administration nodes 
are documented in 
Administrator Guide 

 
Help The Help > Manuals command you access to 

Agile 9 documentation. The Help > About Agile 
command displays version information. 

Using Online Help 
on page 33 

 Exit Lets you exit Web Client. — 

 
 

Web Client Session Timeouts 

Web Client sessions are set to time out, or disconnect, after a session is idle for a specified period 
of time. If you are interrupted while you are in the middle of a wizard operation (such as creating a 
change), and the session is idle and times out, your information will be lost. If you try to perform a 
Web Client action after the session has timed out, the login page appears. 

Occasionally, if you try to perform an action in Web Client after a timeout, you may see a second, 
smaller Web Client page. If this happens, simply close all dialog boxes and pages and log in again. 

For more information about extending the timeout (idle time) value for Web Client, see your 
administrator or the appropriate Agile Installation Guide. 

Navigation Pane Toolbar 

The left pane, called the navigation pane, provides access to searches—via Search Folders 
containing out-of-box solution-oriented searches, Bookmarks, and Recently Visited—and Analytics and 
Reports. As you perform certain actions in Web Client, such as stepping through wizards or 
configuring user settings, the navigation pane provides tools for navigating the process. 
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Showing and Hiding the Navigation Pane 

At times you may want to show the navigation pane or view the main window only (hide the 
navigation pane). 

To show or hide the navigation pane: 

 Click the Expand Left Navigation button (which points right), or the Collapse Left Navigation button 
(which points left). 

or: 

 When the navigation pane is collapsed, you can click the Search Folders or Reports and Analytics 
buttons to expand the navigation pane and display that menu of navigation folders or links. 

 Clicking the same button (Search Folders or Reports and Analytics) a second time hides the 
navigation pane; then clicking any of the buttons restores the navigation pane. 

To adjust the width of the navigation pane: 

1. Hold the pointer on the boundary between the navigation and content panes. The pointer 
changes to a double-pointed arrow. 

2. Drag until the pane is the desired width: it is limited to a maximum of about one-fourth the total 
screen width. 

Note Adjusting the width of the navigation pane is possible only in Internet Explorer. 

 

Search Folders 

The Search Folders section of the navigation pane contains saved searches you can use whenever 
needed. It includes predefined system searches and searches you have created, stored in folders; 
click one to view the search results. For more information about saved searches, see Saved 

Searches on page 147. 

Shortcuts 

Beneath the search folders are two ―shortcuts‖ areas: 

 My Bookmarks—Objects you have bookmarked for quick display later. To bookmark an object, 
choose Actions > Bookmark on an object’s page. For more information about bookmarking, see 
Using and Organizing Bookmarks on page 52. 

 Recently Visited—The last 10 objects you have viewed (or 25, 50, or 100, depending on your 
Agile administrator’s setting of a System Preference); click one to display it. For more 
information about the Recently Visited list, see Using the Recently Visited List on page 56. 

 

Analytics and Reports Folders 

The Analytics and Reports Folders section of the navigation pane gives you access to the types of 
reports for which you have privileges—and include Analytics folders if that is part of your Agile 
installation. You can view, edit, and delete existing reports. You create reports from the Create 
button; see Creating Objects on page 92. 
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Reports are documented later in this manual. 

Analytics requires separate licensing. A PLM Analytics folder may not appear in your view. There is a 
separate user guide for Analytics. 

Using the Wizard Process Flow Diagrams 

As you proceed through the steps of a wizard, click the Expand Left Navigation button to see process 
flow diagrams in the navigation pane. The process flow diagram displays each step in the task, and 
you can click the next step or a previous step in the diagram to go directly to it. The step you are 
currently on is highlighted. 

The following graphic shows the process flow diagram that appears in the navigation pane when 
you create an item. 

 

Note For information about adding data to an object you are creating, see Adding Data during 

Create with the Process Flow Diagram on page 94. 

 

Changing Your User Settings 

You access Web Client settings by clicking the Tools button  on the main toolbar. When you 
click Tools > My Settings, the Settings Home page appears, where you can access and edit your User 
Profile. 

Administrators or user administrators can access other user settings by choosing Tools > 
Administration > Users or other User Settings. For more information about working with User Settings 
(for user administrators), see the Agile PLM Administrator Guide. 
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Note Keep in mind that the Agile administrator may have set values in Agile PLM that impact 
what you are able to modify. Most changes made by the administrator are automatically 
implemented systemwide; however, if the administrator makes changes in your role 
assignment, or to the roles and privilege masks themselves, these take effect for a user 
only after the user has logged out and logged back in to Web or Java Client. 

To make changes to a setting: 

1. Open the Settings Home page from the Tools button  (on the main toolbar) > My Settings. 

2. Click the setting you want to change. The relevant information appears in the right pane. 

 

Here are the links on the Settings Home page and where you can find more information about them 
in this manual. 

Link  Where the  funct ion is  described  in  th is  manual  

User Profile Changing Your User Profile on page 17; see also Choosing Your 

Preferred Start Page on page 28 

Change Password Changing Your Password on page 40 

Transfer Authority Viewing Signoff Authority Transfers on page 40 

Organize Bookmarks Using and Organizing Bookmarks on page 52 

Organize Searches Editing and Managing Searches and Search Folders on page 198 

Organize Reports  Working with Agile Reports on page 123 

Personal Groups User Groups and the Address Book in Web Client on page 56 

Deleted Personal 
Groups 

Deleting Personal User Groups on page 59 

Personal Criteria Creating Personal Criteria on page 19; that discussion is specific to Java 
Client but the Web Client procedure is very similar 

Personal Supplier 
Groups 

Creating Personal Supplier Groups on page 60 

 

When you are working with Agile settings, a navigation path displays at the top of the main pane, 
indicating how you arrived at the current Web Client page. You can click a link in the path to return 
to the corresponding location. The navigation path in this figure shows that you can return to the 
Settings Home page by clicking Settings Home. 

 
 

Changing Your User Profile 

Your User Profile is simply the settings entered by the Agile administrator when your ―user object‖ 
was created. Your user profile is available for you to modify, within constraints set by the 



 

 

9.2.2.6 39  

  

administrator. It contains data under various tabs that is either purely informational or is used by the 
Agile applications: 

 General Information, for example, how to contact you; 

 User Preferences, including: 

 System Preferences, for instance, your preferred client to receive email notifications; 

 Format Preferences, for instance, your Windows date and time preferences; and 

 Display Preferences, for instance, whether you see icons or text in the toolbar (or both). 

 Other tabs are for Escalations, User Groups, Share, Subscription, Attachments, and History, which 
you will learn about in other chapters of this manual. 

You have an opportunity to enter information when you first log in to Web Client. Again, your Agile 
administrator determines to what extent you can edit your user profile. 

To edit or add information to your user profile: 

1. Open your user profile by clicking Tools > My Settings > User Profile. 

You can also click My User Profile under Quick Links on the Home page. 

2. Click the tab on which you want to make changes. For instance, to make changes to the 
General Info tab, click that tab. 

3. Click the Edit button on that page. Use lists, browse buttons, and text boxes to enter the 
requested information. 

4. When you have finished, click Save. If you wish to cancel your changes, click Cancel. 

You may change settings on other tabs, but you must click Save for each page you alter. If you 
click another tab after entering new values, you will be prompted to Cancel the move operation 
so you can Save the tab you are on. 

 To verify changes you make to your user profile, it is best to log out of Web Client and log back 
in. 

Note If you will be working primarily in Web Client, check this setting in your user profile: 
Preferences > System Preferences > Preferred Client; it should be set to Web Client. Also, 
Receive Email Notifications should be set to Yes. This will ensure that you will receive email 
notifications in the same client you are working in. If there is a discrepancy and you are 
not able to change these properties, see your Agile administrator. 

Important Product Portfolio Management, Product Governance & Compliance, and Product Cost 
Management solutions operate only from Web Client. If one of these solutions is to be 
your primary area of work, your administrator has likely already set Preferred Client to 
Web Client. If you change this setting to Java Client, all your email notifications would 
include a link that opens Java Client; yet you cannot work with PPM, PG&C or PCM 
objects in Java Client, so it may be counter-productive to change this setting. 

 

Main Toolbar (Web Client) 

A Display Preference lets you decide whether you want to see icons or text in the toolbar. The 
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choices are Icons Only, Text Only, or both Icons and Text. 

User Preferences 

A full list of the user preferences and their descriptions are found in User Properties Defined. 

Persisted User Interface Settings 

For some user interface settings, the most recently used settings are persisted across sessions for 
each user. These settings are stored in a web browser cookie when you log out of Web Client. 

Examples include: 

 Resizable table columns – Resizable table column widths are persisted across sessions for each 
user. 

 Add method – (Search, Type in Known Number(s), Create) 

 Edit Rows After Adding. 

 Continue Creation in Wizard. 

 Agile PPM – Details selections in the Create Program from Template wizard. 
 

Changing Your Password 

These instructions describe how to change your login password. The process is similar for changing 
your approval password using the Change Approval Password option, which is enabled only if your 
Use Login Password for Approval user property is set to No. 

To change your login password: 

1. Click Tools > My Settings > Change Password. The Change Login Password page appears. 

You can also click Change Password under Quick Links on the Home page. 

2. Type your old login password in the Login Password field. 

3. Type your new login password in the New Login Password and Confirm Login Password fields. 
(Passwords are case-sensitive.) 

If you want to change your approval password (and the Change Password dialog displays the 
Change Approval Password fields), fill in the fields as described above. 

4. Click OK. If you have not followed the rules set by the Agile administrator for selecting 
passwords, you are prompted to correct your password. 

 

Viewing Signoff Authority Transfers 

The Agile administrator or user administrator can have signoff authority transferred from you to 
another user, or from another user to you. This is useful when, for example, you are out of the office 
and unavailable to sign off on changes. 

To view transfers that have been set up: 

Click Tools > My Settings > Transfer Authority. 
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Exploring the Home Page 

Note The page that displays when you open Web Client can be changed, as described in 
Choosing Your Preferred Start Page on page 28. If you chose a Dashboard page as your 

Preferred Start Page, that Dashboard page will be displayed when you click the  Home 
button in the main menu. 

However, you can use the Home button drop-down  list to select a Home page tab (My 
Assignments, Notifications, or Workflow Routings), which displays the Home page tab with the selected 
tab on top. 

Quick Links 

Quick Links, at the top of the Home page, is a list of up to ten links that you use frequently. You 
define your own Quick Links list and you can edit and modify your Quick Links list at any time. Your 
Quick Links list can include predefined system links, saved searches in your Personal Searches 
folder, or bookmarks in your Bookmarks folder. 

To edit your Quick Links list: 

1. Click the Edit link next to the Quick Links: heading at the top of the Home page. The editable list 
appears at the top of the page. 

2. From the drop-down list choose the type of link you want to use. 

The three types of available links are: 

 Links – predefined Agile system links including My User Profile, Change Password, 
Analytics and Reports, and Dashboard. 

 Bookmarks – available values are all the bookmarks in your Bookmarks folders, listed 
individually. 

 Searches – available values are all the searches in your Personal Searches folders, listed 
individually. 

3. Use the arrow buttons to move links from the Available Values list to the Selected Values list. 

Or, double-click to move links from one list to the other list. 

4. You may include more than ten links in the Selected Values list, but only the first ten links in the 
list will be displayed in your Quick Links list. Reorder the list by selecting one or more links and 
using the up and down arrow buttons to move them up or down in the list. 

5. When you are finished, click the Save button. 
 

Home Page Inbox Tabs 

As information passes through the Agile system, users receive news of status changes, requests, 
and other notifications through email. Users with different roles and privileges receive different 
notifications. When you first start Web Client, it is a good idea to view the information collected for 
you on the Home page. 
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 Notifications tab – Notifications inform you of some action or process that has taken place or a 
notification can let you know that you have a request to accept or decline ownership of an 
action item or activity. Delete notifications after you have read them. 

 Workflow Routings tab – lists routable objects that require your review or action. Click the object 
number in the table to open it. 

 My Assignments tab – lists program leaf node objects assigned to you which are not yet 
complete and action items assigned to you which are not yet complete.  

 

Viewing the Home Page 

The Agile Home page provides access to Dashboard, Notifications, Workflow Routings, and My 
Assignments. Dashboard features are documented separately, see "Dashboard". 

To access the Home Page, click the  icon. The page that displays when you first open Web 
Client can be changed, as described in the Getting Started with Agile PLM Guide. If you choose a 
Dashboard page as your Preferred Start Page, that Dashboard page will be displayed when you 

click the  Home button in the main menu. 

To view your Inbox tabs in Web Client: 

You can open and view the Home page using any of the following methods: 

 At any time while you are using Web Client, click the small down-arrow next to the Home button 

 and select an inbox view: My Assignments, Notifications, or Workflow Routings. 

 If your preferred start page is a Home page tab, it is displayed when you login to Agile Web 
Client. 

 If your preferred start page is a Home page tab: 

a. In the menu bar, click the Home button . 

The Home page is displayed with your preferred inbox view tab on top. 

b. To view a different inbox view, click the Home page tab you want to view. 

Note If your preferred start page is a Dashboard tab, you will not see the Home page tabs 

when you click the Home button . Click the small down-arrow next to the Home button 

 and select a non-Dashboard inbox view: My Assignments, Notifications, or Workflow 
Routings. 

 

Notifications 

The Home page Notifications tab lists notifications that have been sent to you. Notifications inform 
you of some action or process that has taken place, such as subscriptions, RFQs, and project 
invitations. A notification can also let you know that you have a request that requires your attention 
in the My Assignments tab. Requests ask you to accept or decline ownership of an action item or 
activity. 
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Note To accept or decline a request, use the My Assignments tab. 

You can view or delete a notification. 

 To view a notification, click the Subject link. 

 To delete a notification, select its row and click  Delete. 

 

Icon o r  But ton  Descript ion  

  Delete Deletes the selected notifications. 

Select one or more rows in the Notifications table, and click this button to delete them 
from the table. 

 New Notification 

Icon in Notifications table row. Indicates that you have not yet opened this notification. 

 Read Notification 

Icon in Notifications table row. Indicates that you have previously opened this 
notification. 

 
 

Workflow Routings 

The Home page Workflow Routings tab lists routable objects that require your review or action. For 
example, your Workflow Routings table may contain changes for which you are an approver. The out-
of-box workflow routings are a combination of base classes and actions that define the kind of 
review, as in the table below.  

Note The searches selected in your User Profile Searches field also determine which workflow 
routings appear in your Inbox. For example, if Change Analyst Searches is one of your 
assigned searches, you see Change class object workflow routings in the Workflow 
Routings tab. In a similar manner, if Quality Searches is one of your assigned searches, you 
see QCR and PSR workflow routings. For more information, see Changing Your User 

Profile on page 17 and User Properties Defined on page 60. 

  

Base c lass. . .  . . . inc ludes routable  objects  f rom 
these  c lasses. . .  

. . .combined  wi th  these  
act ions of  rev iew  

Change Change Orders, Change Requests, Site 
Change Orders, Price Change Orders, 
Deviations, and Stop Ships 

... That Require My Approval 

... That I Am An Observer Of 

... That Were Returned To Me 

... Transferred to Me 

... Escalated to Me 
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Base c lass. . .  . . . inc ludes routable  objects  f rom 
these  c lasses. . .  

. . .combined  wi th  these  
act ions of  rev iew  

 

Quality Change Request 
(QCR) 

Corrective and Preventive Actions and 
Audits 

 

Problem Service Request 
(PSR) 

Non-Conformance Requests and Problem 
Reports 

 

Package Packages  

Program Activities and Gates  

Transfer Order Content Transfer Orders and Automated 
Transfer Orders 

 

Declarations Substance Declarations, Part Declarations, 
JGPSSI Declarations, Homogeneous 
Material Declarations, Supplier Declarations 
of Conformance, IPC 1752-1 Declarations, 
and IPC 1752-2 Declarations 

 

To open an object in the table, click its number. To export objects to a text or PDX file (if you have 
privileges), select the object rows and choose Tools > Export. The Print button prints the entire table. 

My Assignments 

The Home page My Assignments tab lists Activities and Action Items for which you are responsible. 
The My Assignments tab provides a set of tools that allow you to efficiently work with your 
assignments. You can sort the assignments table rows, or select one or more assignment rows in 
the table, and then perform an action on the selected assignments. For example, you can accept or 
decline a program activity assignment, or flag an assignment for easier tracking.  

The Home page My Assignments tab table includes: 

 Activity objects where: 

 The activity is In Process. The workflow status type is not Complete or Canceled. 

 The activity’s Template attribute is set to Active. Proposed or Template activities are not 
included. 

 The activity is a leaf node. Activities with children are not included. 

 You are the owner of the activity and the Delegated Owner field is blank. If you have 
delegated ownership, the Delegated Owner field contains the name of the delegated owner 
until the activity is accepted or declined. 

 You are the delegated owner of the activity. 

 You are a resource on the Team tab of the activity and your allocation is greater than 0%. 

 Action Items where: 

 The action item is assigned to you and it is not Complete or Cancelled. 

 The action item is assigned to you and it has been accepted. 
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 The action item is assigned to you and it has not been declined. 

 You are the creator of the action item and it has been declined by the assignee. 
 

My Assignments Table 

Your Agile administrator determines which columns appear in the My Assignments table. If you have 
questions about the My Assignments tab, contact your Agile administrator. 

By default, the My Assignments tab includes the following columns: 

Column name  Descript ion  

Flag Flag icon which you can set to manage your assignments. For more information, see 
Flagging Assignments. 

Name The name of the activity or action item. 

Click this link to open the activity or action item. 

Status Workflow status of the activity or action item. For example, an activity can be Not 
Started or In Process and an action item can be Not Accepted or Accepted. 

If you have the appropriate privileges, you can edit the Status column. For more 
information, see Editing Assignments. 

Due Date The date the activity or action item is due. 

You can sort the assignment list by due dates. For more information, see Using the 
View Options to Sort your Assignment List. 

If you have the appropriate privileges, you can edit the Due Date column. For more 
information, see Editing Assignments. 

% Complete For activities, the percentage of the task that has been completed. 

If you have the appropriate privileges, you can edit the % Complete column. For more 
information, see Editing Assignments. 

Related To For activities, the Related To column lists the parent activity and root parent activity. 

For action items, the Related To column lists the activity or discussion object to which 
the action item is associated. 

Click the links in this column to open the related activities or discussions. 

Actual Hours For activities, the number of hours expended on the activity. 

If you have the appropriate privileges, you can edit the Actual Hours column. For more 
information, see Editing Assignments. 

 
 

My Assignments Tab Tools 

The My Assignments tab tools include: 
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Tool  Descript ion  

      View View drop-down list. 

Use the list to sort your assignments by pre-defined views, for example, 
pending requests, flagged assignments, due dates, action items, or activities 
where you are a resource. 

For more information, see Using the View Options to Sort your Assignment List. 

 Edit 
Edit the selected row objects. 

Allows you to edit object fields displayed in the table, based on your privileges. 

For example, you can modify the Status, Due Date, and Actual Hours fields. 

For more information, see Editing Assignments. 

 Accept Accept the selected activities, program activity assignments, or action items. 

For activities, accept the ownership when you are the designated owner. 

For program activity assignments, accept the assignment as a resource for the 
activity. 

For action items, accept the action item when you are the assignee and the 
action item has not yet been accepted. 

For more information, see Accepting Assignments. 

 Decline Decline the selected activities, program activity assignments, or action items. 

For activities, decline the ownership when you are the designated owner. 

For program activity assignments, decline the assignment as a resource for the 
activity. 

For action items, decline the action item when you are the assignee and the 
action item has not yet been accepted. 

For more information, see Declining Assignments. 

 Mark Complete Mark as complete the selected activities or action items. 

For activities, sets the Complete field to 100% and changes the workflow status 
to Complete.  

For action items, changes their status to complete and removes them from your 
assignment list. 

For more information, see Mark Assignments Complete. 

 Show Filter 

 Hide Filter 

Displays or hides the filter definition fields. 

For detailed information about using the filter, see Using the Filter to Sort 

your Assignment List on page 52. 

 Print Prints the table sorted table. 

Allows you to print the assignment table that is currently displayed. 

For more information, see Printing the Assignment Table. 
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Tool  Descript ion  

More Actions... 

   Add to Flagged View 

Sets the flag for all the selected table rows. 

Allows you to flag multiple rows at one time. 

To display flagged rows, in the View drop-down list, choose Flagged. 

For more information, see Flagging Assignments. 

More Actions... 

   Add to Hidden 
Assignments View 

Allows you to hide assignments. 

Hidden assignments do not appear in the assignments table. 

For more information see Hiding and Unhiding Assignments. 

More Actions... 

   Remove From View 

Remove assignments from the Hidden view. 

When displaying the hidden assignment view, allows you to remove (unhide) 
the selected assignment rows. 

See also Hiding and Unhiding Assignments and Flagging Assignments. 

 Flag not set 

 Flag set 

Flag icon appears in each row of the assignment table. 

Set or unset the flag by clicking it. 

The flag helps you to organize your assignments and flag the ones you want to 
track. 

For more information, see Flagging Assignments. 

View Details View Details icon button.  

Appears in each activity row next to the activity name. 

Opens a popup window that displays important details about the object and 
allows you to edit, accept, or decline the object. The content of this window can 
be configured in Java Client Administrator. 

For more information, see Using the Show Details Dialog. 

 
 

Using the View Options to Sort your Assignment List 

Use the Home page My Assignments tab View drop-down list to sort you assignments and quickly find 
the assignments with which you want to work. For example, you can sort for pending requests or for 
overdue assignments. 

Agile provides the following pre-defined view categories. 

View  Descript ion  

All Displays all assignments, except hidden assignments. 

Pending Requests Displays only pending requests. 

Flagged Displays only the flagged assignment rows. 

You set or clear flags in order to manage your assignments. This 
View list choice displays only the rows that you have flagged. 
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View  Descript ion  

Due Today or Overdue 

Due this Week 

Due within 2 Weeks 

Due within 30 Days 

Due within 90 Days 

These View list choices display assignment table rows according 
to due dates. 

Hidden Assignments Displays only hidden assignments. 

You decide which assignments you want to hide on your 
assignments list. 

For more information, see Hiding and Unhiding Assignments. 

Activities where I am a Resource Displays activities where you have been assigned as a resource 
on the Team tab. 

Action Items Displays action items assigned to you. 

Action items are generated and assigned from activities and 
discussions. 

 
 

Editing Assignments 

You can use the Home page My Assignments tab Edit function to edit assignment attributes in the 
table. You must have the appropriate Modify privileges for the editable fields. 

For example, depending on your privileges, for an activity, you can edit the Status, the Percent 
Complete, Actual Hours, and Due Date. 

To edit My Assignment table rows: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. Select one or more rows in the table. 

3. Click the  Edit button. 

4. Make the desired modifications. 

Note The editable fields are determined by which fields your Agile administrator has 
included in the assignments table and your modify privileges. 

5. When you are finished, click Save. 
 

Accepting Assignments 

You can use the Home page My Assignments tab Accept function to accept multiple activities or 
action items at one time. The accept action applies to activities where you are the delegated owner, 
program activities assigned to you, and action items whose status is Not Accepted and you are the 
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assignee.  

To accept assignments on the My Assignment tab: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. Select one or more rows in the table. 

3. Click the  Accept button. 

The selected objects are accepted. 

Declining Assignments 

You can use the Home page My Assignments tab Decline function to decline multiple activities or 
action items at one time. The decline action applies to activities where you are the delegated owner 
and action items whose status is Not Accepted and you are the assignee. 

Note When you decline an activity, you must enter a reason. 

To decline assignments on the My Assignment tab: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. Select one or more rows in the table. 

3. Click the  Decline button. 

4. If one or more of the selected rows are activities, you must enter a reason why you are 
declining. Enter your reason in the popup dialog and click Send. 

 

Mark Assignments Complete 

You can use the Home page My Assignments tab Mark Complete function to mark as complete multiple 
activities or action items at one time. 

Note If you have not accepted an action item, you cannot mark it as complete. Accept the 
action item first, then mark it as complete. 

When you mark an activity as complete, the Percent Complete field is automatically set to 100%. 

To mark assignments as complete on the My Assignments tab: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. Select one or more rows in the table. 

3. Click the  Mark Complete button. 

Action items in status Not Accepted cannot be marked complete and an error message is 
displayed. 
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Printing the Assignment Table 

You can use the Home page My Assignments tab Print function to print the currently displayed 
assignments table. Use the View drop-down list or the Filter to sort the table, then print the displayed 
table rows. 

To print the My Assignment table: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. Use the View drop-down list or the Filter to sort the table to display the assignments you want. 

3. Click the  Print button. 

A printable version of table is displayed in a new browser window and the Print dialog appears. 

4. Click Print in the Print dialog. 

5. Close the new browser window when you are finished. 
 

Hiding and Unhiding Assignments 

On the Home page My Assignments tab, the More Actions...Add to Hidden Assignments View command 
allows you to hide assignment rows that you do not want to see. The assignments are still part of 
your assignment list, but they are displayed only when you choose Hidden Assignments in the View 
drop-down list. 

Hiding assignments can be a useful assignment management tool. For example, suppose you are 
assigned as a resource for an activity, but you are not the activity owner. You have completed your 
portion of the task, but other resources have not yet completed their portions of the task. Therefore, 
the assignment still appears on your My Assignments tab because it has not been marked as 
Complete. You can hide this assignment so it no longer appears on your assignments list, however, 
it will still appear on the assignment lists of other resources. 

Hiding an assignment removes it from all your My Assignments tab views except your Hidden 
Assignments view. Your Hidden Assignments view has no effect on the assignment lists of other users. 
You can hide assignments (add them to your hidden view), display your hidden assignments, and 
unhide hidden assignments (remove them from your hidden view). 

To add assignment rows to your Hidden View: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. If desired, use the View drop-down list or the filter to sort which assignment rows are displayed. 

3. Select one or more rows in the table. 

4. Choose More Actions... > Add to Hidden Assignments View. 

To view your hidden assignments: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 
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2. In the View drop-down list, choose Hidden Assignments. 

To remove assignment rows from your Hidden View: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. In the View drop-down list, choose Hidden Assignments. 

3. In the hidden assignments view, select the rows you want. 

4. Choose More Actions... > Remove from View. 
 

Flagging Assignments 

On the Home page My Assignments tab, the flag icon included in each row is a useful assignment 
management tool. Because you can sort assignments according to whether or not they are flagged, 
you can use the flag to indicate assignments that you want to track differently from other 
assignments. The flags on your assignment table appear only on your My Assignments tab, so you 
can decide how you wish to use them. 

To set or unset the flag in a single assignments table row: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. Click the flag icon in the row you want. 

 If the flag is not set , clicking it toggles the flag to set: . 

 If the flag is set , clicking it toggles the flag to not set: . 

To set the flags in multiple assignments table rows: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. If desired, use the View drop-down list or the filter to sort which assignment rows are displayed. 

3. Select the rows you want to flag. 

4. Choose More Actions... > Add to Flagged View. 

To unset the flags in multiple assignments table rows in the flagged view: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. In the View drop-down list, choose Flagged. 

3. In the flagged assignments view, select the rows you want. 

4. Choose More Actions... > Remove from View. 
 

Using the Show Details Dialog 

On the Home page My Assignments tab, the Show Details icon  (in each row next to the name of 
activity objects) opens a details dialog that displays additional information about the object and 
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allows you to perform actions on that object, for example, edit and bookmark. Your Agile 
administrator determines which attributes and actions are available in the details dialog of each 
object type. 

Using the Filter to Sort your Assignment List 

On the Home page My Assignments tab, the  Show Filter and  Hide Filter button toggles the 
display of the table filter. The table filter allows you to define filter criteria based on any column in 
the table. You can define multiple filter criteria, which are combined in an AND search of the table 
rows. 

For example, you can filter for assignments whose Related To column includes the word marketing 
and the % Complete column is less than 50. 

The format of each filter criteria row is similar to an Agile search criteria: 

<attribute> is <Match If Operator> <value to match> 

To use the My Assignments tab filter: 

1. Use the Home button  drop-down list and choose My Assignments to display your list of 
assignments. 

2. Click  Show Filter to display the Filter: criteria. 

3. In the first filter drop-down list, labeled --Select an Attribute--, choose from a list of the columns in 
the assignments table. 

4. In the next drop-down list, choose a Match If operator. The list of available Match If operators 
depends on the attribute type you chose as the --Select an Attribute-- drop-down list. 

5. In the remaining field, enter the filter values. 

 To add a filter criteria row, click  Add Row at the end of the row. A filter criteria row is 
added to the display. 

 To delete a filter criteria row, click  Delete Row at the end of the row. The row is deleted. 

6. Click Apply to filter the assignments table. Only assignments that match your filter criteria are 
displayed. 

7. To define different set of filter criteria, click Clear to clear the criteria and begin again. 
 

Using and Organizing Bookmarks 

If there are objects that you need to return to frequently, you can use Bookmarks and the Recently 
Visited list for quick access. For more information about the Recently Visited list, see Using the 

Recently Visited List on page 56. 

Bookmarking 

Bookmarking lets you keep a list of objects that you return to frequently. You can click an object 
bookmark to quickly display that object. 

You can also bookmark reports that you use frequently. 
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To bookmark an object in Web Client: 

1. Open the object. 

2. From the Actions menu, choose Bookmark. 

3. The Add to Bookmarks dialog box appears. 

4. Enter a name for the bookmark in the Bookmark Name field. 

By default, the Bookmark Name field contains the object’s number or name. You can edit or 
replace the bookmark name in this field now, or you can edit the bookmark name later. 

5. Then select a folder in which to store it. 

6. To create a new folder, click the  New button. In the Create New Folder dialog, enter a folder 
name and click OK. 

7. Click OK in the Add to Bookmarks dialog box to save the bookmark. 

The bookmark is saved in the My Bookmarks list in the Search Folders link on the navigation pane. 

Using a Bookmark 

To open a bookmarked object in Web Client: 

1. Click Search Folders in the navigation pane. 

2. Expand the My Bookmarks list by clicking  + . 

Or, highlight the  My Bookmarks folder and click the Expand All icon  in the navigation pane to 
display all bookmark subfolders and their contents. 

3. Click the object in the list of bookmarks. The object opens. 
 

Organizing Bookmarks 

You can organize bookmarks, including renaming them and organizing them into folders. 

Buttons on the Web Client My Bookmarks Toolbar 

The following table lists and describes the buttons on the My Bookmarks folder in the Web Client 
navigation pane. 

Button  Descript ion  

 Expand All 
Expands all the bookmark folders in the navigation pane to display all available bookmarks. 

 Collapse All 
Collapses all the bookmarks folders in the navigation pane. 

 Organize 
Bookmarks 

Opens the Organize Bookmarks window. 
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The Organize Bookmarks Window 

Use the features in the Organize Bookmarks window to create or remove folders, rename or 
remove bookmarks, and organize and move folders and bookmarks. 

Open the Organize Bookmarks window with either of the following methods: 

 Choose Tools > My Settings. On the Settings Home page, click the Organize Bookmarks link. 

 Or, click the pencil icon  in the left navigation pane next to  My Bookmarks. 

The Organize Bookmarks page appears. 

Button  Descript ion  

 Remove Removes the selected bookmarks and bookmark folders. 

See Deleting a Bookmark on page 54 or Removing a Bookmark Folder on 
page 55. 

 Rename 
Renames the selected bookmark or bookmark folder. 

See Renaming a Bookmark on page 54 or Renaming a Bookmark Folder on 
page 55. 

 New Adds a new bookmark folder within the current folder. 

See Creating a Bookmark Folder on page 55. 

(drag and drop) Allows you to reorder bookmarks and bookmark folders. 

See Moving Bookmarks and Folders on page 56. 

 Save Save the modifications you made in the Organize Bookmarks window. 

 Cancel 
Discards the modifications you made in the Organize Bookmarks window and closes the 
window. 

 
 

Deleting a Bookmark 

To delete a bookmark in Web Client: 

1. Click Tools > My Settings > Organize Bookmarks. 

Or, click the pencil icon  in the left navigation pane next to My Bookmarks. 

2. In the Organize Bookmarks window navigate to the bookmark you want to remove and select it. 

3. Click the  Remove button. 

4. When you are finished, click Save. 
 

Renaming a Bookmark 

To rename a bookmark in Web Client: 

1. Click Tools > My Settings > Organize Bookmarks. 
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Or, click the pencil icon  in the left navigation pane next to My Bookmarks. 

2. In the Organize Bookmarks window navigate to the bookmark you want to rename and select it. 

3. Click the  Rename button. 

4. In the text field, enter a new name and press the Return key. 

5. When you are finished, click  Save. 
 

Using Folders to Organize Bookmarks 

You can organize your bookmarks in folders to make them easier to locate and manage. You can 
use the existing folders or create new ones. 

Creating a Bookmark Folder 

To create a bookmark folder in Web Client: 

1. Click Tools > My Settings > Organize Bookmarks. 

Or, click the pencil icon  in the left navigation pane next to My Bookmarks. 

2. In the Organize Bookmarks window navigate to the folder in which you want to create a new 
folder. 

3. Click the  New button. 

4. In the text field, enter a new name and press the Return key. 

5. When you are finished, click  Save. 
 

Removing a Bookmark Folder 

You can remove or delete a folder, even if it is not empty. 

To remove a bookmark folder in Web Client: 

1. Click Tools > My Settings > Organize Bookmarks. 

Or, click the pencil icon  in the left navigation pane next to My Bookmarks. 

2. In the Organize Bookmarks window navigate to the folder you want to remove and select it. 

3. Click the  Remove button. 

4. When you are finished, click  Save. 
 

Renaming a Bookmark Folder 

To rename a bookmark folder in Web Client: 

1. Click Tools > My Settings > Organize Bookmarks. 

Or, click the pencil icon  in the left navigation pane next to My Bookmarks. 
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2. In the Organize Bookmarks window navigate to the folder you want to rename and select it. 

3. Click the  Rename button. 

4. In the text field, enter a new name and press the Return key. 

5. When you are finished, click  Save. 
 

Moving Bookmarks and Folders 

To move a bookmark or a bookmark folder into another folder or to a different location in the list in Web 

Client: 

1. Click Tools > My Settings > Organize Bookmarks. 

Or, click the pencil icon  in the left navigation pane next to My Bookmarks. 

2. In the Organize Bookmarks window, navigate to the search or folder that you want to move. To 
expand a folder, click its folder icon. 

3. Click the folder or search to select it. 

4. Drag the folder or bookmark to its new location and drop it onto: 

 Highlighted folder – the dropped folder or bookmark is moved into the highlighted folder. 

 Grey line between two names in the list of bookmarks and folders – the dropped folder or 
bookmark is moved to that location in the list. 

5. When you are finished, click Save. 
 

Using the Recently Visited List 

When you view an object during a work session, it is listed in the Recently Visited list. The Recently 
Visited list includes the last 10 objects viewed (or 25, 50, or 100 if the administrator re-set the 
systemwide Preference). 

To open a recently visited object in Web Client: 

1. Click Search Folders in the navigation pane. 

2. Expand the Recently Visited list. 

3. Click the object in the list of recently visited objects. The object opens. 
 

User Groups and the Address Book in Web Client 

The address book is a multi-list window that lets you select users and user groups for various 
functions. The situations in which you use the address book can include: 

 When you send email notifications 

 When you select people or groups to sign off a workflow 

 When you select users to act as change analyst, component engineer, originator, quality 
analyst, quality administrator, sourcing project owner, RFQ owner, program team member, 
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and so forth 

 When you share, or grant, one or more of your roles to another user or user group for 
specific objects 

You can also create user groups in the address book. 

Note User groups cannot be modified (adding or deleting users) in the Address Book, instead, 
you must use the Users tab of the group object. To modify a user group or delete a user 
group, use Tools > My Settings > Personal Groups to view your user groups. 

You can access the address book by clicking Tools > Address Book, or when you are performing 
actions that involve sending an object or a notification (for example, routing a routable object). You 
can select individual users or user groups. The address book lists all the individuals and global user 
groups that have been created in Agile PLM. 

When you email objects or send notifications, you can select recipients individually or in user 
groups. When you select a user group, all the members of the group receive the email message. 

Note Your Agile administrator can use Discovery privileges to limit the users you see in the 
address book. 

 

Selecting Users from the Address Book 

When you use the address book, you can select recipients individually or in groups. When you 
select a group, all the members of the group receive the message. 

To select users from the address book: 

1. Click Tools > Address Book to open the View Address Book page. 

2. Section 1 of the page is Find Users. In the Filter By drop-down list, select All Users, All Groups, 
or the name of a specific group. Leave the Name(s) field blank and click Find to see in the 
Available Values table: 

 All User — A list of all users. 

 All Groups — A list of group names. 

 A specific group — A list of the users in that group. 

3. To find specific names or groups, type all or part of a name you want to find and then click Find 
to see matches from which you can select. 

You can type multiple names, and even partial names, separated by a semi-colon. The exact 
matches are automatically selected. Those that are partial and can match more than one name 
(for instance, if you type Jeff and there are several ―Jeff‖ users) are displayed in the Available 
Values table. 

If you type a name that is matched by only one user in the address book, when you click the 
Find button, that user’s name goes directly to the Selected Values table. If you decide you do 

not want that user, select the name and click the  button. It moves to the Available Values 
table. 

Note You can also move names back and forth with double-clicks. 
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4. Section 2 of the page is Select Users. There should be names in the Available Values table 
from 1–Find Users. 

To go directly to a name in the table, type a value in the Type name or select from list field; the 
address book moves to a matching value in the table. 

Click the radio button for First or Last to sort the names in the Available Values table 
accordingly. 

5. Select a person or user group in the Available Values table. 

To select multiple names or user groups, use the Shift or Ctrl key. To see more information 
about a user or user group, select it and click the Details button. 

6. Use the  button to move your selection(s) into the Selected Values table. 

7. Continue selecting names and using the arrows until the Selected Values table is what you 
want. 

Remember, if you want to choose a user group, return to the Filter By field in 1–Find Users. 

If you want to create a group for another purpose, select the names of users and click the Save 
As Group button. 

8. Click OK to close the address book. 
 

Using the Details and Save As Group Buttons 

When you select a user name that appears in the Available Values or Selected Values lists and click 
the Details button, the user object opens. 

When you click the Save As Group button, the Save As dialog is brought up for you to create a 
personal or global user group. All user names that appears in the Selected Values lists are in the 
group. 

Creating Personal User Groups 

With the appropriate privileges, you can create personal user groups. You create user groups from 
the Settings page. 

Note You can create personal groups on-the-fly from the address book, which appears 
whenever you follow a process where you can select users. In the address book, click 
the Save As Group button and all users in the Selected Values list are in the new group. 

To create a personal user group:  

1. Click Tools > My Settings > Personal Groups. The Personal User Groups page appears. 

2. Click Create. The Create User Group wizard appears. 

3. Select the User Group subclass and type the name of the new group. 

4. Click Continue. 

5. In the Define the User Group page, specify general information about the user group, including 
description, status (Active or Inactive), and whether you want this group to be a resource pool 
(part of the Product Portfolio Management solution). 
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6. Click Next. 

7. On the Add Users page of the wizard, click the Add button  to add users and user groups to 
this new group. The address book appears. 

8. Select names in the Available Values list, and use the arrows to move them into the Selected 
Values list. For more information, see Selecting Users from the Address Book on page 57. 

9. When you have selected all the users you want to include in the new group, click Add in the 
address book window. 

10. Back in the wizard, click Finish. The new group appears on the Personal User Groups page. 

You may complete aspects of the user group by clicking the tabs and the Edit button. See 
Editing Personal User Groups on page 59. 

Editing Personal User Groups 

You can edit the groups you have created. 

To edit a personal group in Web Client: 

1. Click Tools > My Settings > Personal Groups. The Personal User Groups page appears. 

2. Click the name of the group you want to edit. The Group page appears. 

3. On the General Info tab, you can click Edit to change the general information about the group. 

4. You can click the Users tab to add or delete users. On the Users tab, click Add to add another 
user. To delete a user, select the user row and click Delete. 

5. To create or modify escalations, click the Escalations tab. 

6. You can add or remove attachments on the Attachments tab. 

For information about attachments, see Working with Attachments on page 253. 

Deleting Personal User Groups 

To delete a personal user group from the address book: 

1. Click Tools > My Settings > Personal Groups. The Personal User Groups page appears. 

2. Select the personal group you want to delete, and click Remove. The selected group is deleted. 

Note If the personal group is involved with elements like workflow approval or escalation, you 
will be prompted and prevented from deleting the group. In this case, you can set the 
group to Inactive status, which keeps the group from being involved in new events, but 
does not impact events in which it is already involved. 

From the Deleted Personal Groups node, you can view personal groups that you have deleted from the 
Agile system. When a personal group is deleted, it does not appear in the Address Book. You 
cannot edit a personal group that has been deleted; if it is undeleted, it can be edited again. 
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Undeleting Deleted Personal Groups 

A personal group may be ―undeleted‖ if, for instance, a project team (group) was no longer needed 
at the end of the project, and then the project is reinstated, and the same people are on the project 
team. Once the group is undeleted, of course, the users in the group can be changed. 

To undelete a personal user group: 

1. Click Tools > My Settings > Deleted Personal Groups. The Deleted Personal Groups page appears. 

2. Open a deleted personal group by clicking its name. 

3. Choose Actions > Undelete. The selected group is undeleted and now appears in the Personal 
Groups table. 

By undeleting the deleted user group, it appears again in the Address Book. 

Creating a New Group Using Save As on a Deleted Personal Group 

You can also create a new personal group from a deleted personal group. Once you have opened a 
deleted personal group, choose Actions > Save As. You will be prompted to give the deleted group a 
new name and save it. You can then modify it in the usual ways. 

Creating Personal Supplier Groups 

With the appropriate privileges, you can create personal supplier groups. You create personal 
supplier groups from the Settings page. 

To create a personal supplier group:  

1. Click Tools > My Settings > Personal Supplier Groups. The Personal Supplier Groups page 
appears. 

2. Click Create. The Create Supplier Group wizard appears. 

3. Type a name and a description of the new group, and select the supplier group type Personal. 

4. Click  next to the Suppliers field. The Identify Suppliers dialog appears. 

5. Find suppliers’ names using the search options offered: Search, Advanced Search, Saved 
Search, Bookmarks. Click Next. 

6. Select suppliers for the group by checking the box next to each one’s name (or select all with 
the topmost box). 

7. Back in the original wizard, click Finish. The personal supplier group is created and appears on 
your Personal Supplier Groups page. 

You may modify aspects of a supplier group by selecting the supplier group row and clicking the Edit 
button. 

User Properties Defined 

The table below lists and describes the properties common to all users in the Agile PLM system. 
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The General Info, Preferences, Escalations, and User Groups tabs are documented. Share, Subscription, 
Attachments, and History tabs are all automatically populated, and do not have fields or properties 
per se. If you are not able to set a field that you want, see your Agile administrator to go over your 
roles and privileges. 

Preferences for users are found on the Preferences tab of any user object. There are three sub-
categories of user preferences: system-related, format-related, and display-related. (These ―user 
preferences‖ should not be confused with Administrator > Server Settings > Preferences node of 
―systemwide preferences.‖) 

Property  Descript ion  

 
General Info tab, required fields 

User ID (username) The user’s Agile PLM login user identification, or username. 

First Name and Last 
Name 

The user’s public name. 

Status Indicates whether the user is enabled (Active) or disabled (Inactive). A disabled 
user cannot log in. 

Email The user’s valid email address for change notification/routing. Example: 
danny.design@agile.com.  

Note: The user will not receive any email notifications if there is no valid address in 
the Email field. 

 
General Info tab, optional user information 

Status Active or Inactive. (This is the same thing as Enabled or Disabled, respectively.) 

Title The user’s title, for example, Senior Engineer. 

Address fields There are four address fields that are used for informational purposes only: 
Address (street), City, Postal/Zip Code, and Geography. The Geography field is 
a series of drop-down lists. 

Phone number fields The user’s Business Phone, Home Phone, and Mobile Phone numbers (for 
informational purposes only). 

Fax The user’s fax number (for informational purposes only). 

Pager The user’s pager number (for informational purposes only). 

Secondary Email The Secondary Email is optional, but when the field is filled in, the user receives 
notifications at both email addresses. 

 
General Info tab, Profile fields 

Role(s) The user’s role assignments. This property determines a user’s access to the 
objects in Agile PLM from the point of discovery forward. 

Lists These lists link certain roles, like Change Analyst, to routable objects and their 
workflows, such as Changes. 

mailto:danny.design@agile.com
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Property  Descript ion  

Searches These lists control roles, searches folders, and queries. For example, Change 
Analyst Searches controls whether a user has, in Java or Web Client interfaces, a 
Change Analyst Searches folder and Change Analyst queries in the My Inbox 
Workflow Routings list. 

User Category Power, Concurrent, or Restricted. 

Use Login Password 
for Approval 

Each user has a login password and approval password (used to approve 
changes). 

Allow Escalation 
Designation Approval 

If the user has identified one or more designated escalation persons (DEPs), this 
setting determines when the DEPs can approve or reject a routable object. 

Home Organization The name of the company profile (organization name) for all users created from the 
Users node and the supplier name and supplier number for all users created from 
the Supplier Groups node. 

Site(s) 

and 

Default Site 

Sites are used for distributed manufacturing, and indicate all of the company’s 
locations where the user is involved; selecting from the drop-down list for this 
property populates the drop-down list for Default Site. Default Site is the user’s 
main base of work. 

Ship-To address fields Authorized Ship-To (called ―Site‖ in earlier versions of PCM), used only by PCM, 
indicates all company locations where the user can initiate sourcing activity; 
selecting from the drop-down list for this property populates the drop-down list for 
Home Ship-To. 

Home Ship-To is the primary location where the user is responsible for sourcing 
activities. 

Program Manager for 
Partners 

The partners for which this user is program manager (which is the change analyst 
for Package objects). 

Rate fields There are three Rates fields: Labor Rate, Overhead Rate, and Bill Rate. The 
drop-down lists in these fields show all currencies entered in the Currency 
Exchange Rates node. You can select a currency different from the user’s 
Preferred Currency (see Preferences tab). Used by PPM. 

Comment The Agile PLM administrator may enter a comment regarding the user. 

Program Type Types of programs the user can participate in. 

Region Regions the user has belongs to. 

Division Divisions the user belongs to. 

Product Line Product lines the user has access to. 

Customer Customers the user is associated with. 

Launch Year Product launch years the user is associated with. 

Category 7, Category 
8, Category 9, 
Category 10 

Optional Product Portfolio Management Dashboard fields. 

 
Preferences tab: System Preferences 
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Property  Descript ion  

Preferred Client This field controls the type of link provided in system notifications to the user. Select 
Web Client, Java Client, or Portal Client. 

Agile’s PCM, PG&C, and PPM solutions operate only in Web Client. Users who 
work primarily in those areas should have their Preferred Client set to Web Client. 

Preferred File Manager Select from the list of file servers. For best performance, select a file server that is a 
local server for the user. 

Preferred Portal URL Specify the URL used to access the Agile PLM portal. The user’s Agile PLM email 
notifications will contain a link to the portal URL. 

Receive Email 
Notification 

Controls whether the user can receive automatically generated email notifications 
from the system. 
Settings = Yes or No 

File Productivity 
Preference 

Controls whether the user has access to advanced productivity components, or 
standard components, or wants to be prompted in each situation. If set to Standard 
mode, non-supported files will not be opened automatically. Instead, the user is 
prompted to choose Save or Open. 
Settings = Prompt, Advanced, or Standard 

Note: this user preference will not appear in any user’s Profile if the systemwide 
preference Allow Download of Productivity Components is set to No. 

 
Preferences tab: Format Preferences 

Language English is available with all Agile PLM licenses. Agile PLM includes Japanese, 
Traditional Chinese, Simplified Chinese, French, or German, per your license. 

Workweek Settings This setting is for future use only, and is not referenced in any Agile PLM module. 

Note: This property is not applicable to any Agile PLM module including Product 
Portfolio Management and Microsoft Project schedules. 

Preferred Date Format The format in which dates are displayed to the user. 

Time Zone The time zone where the user is located. 

Preferred Time Format The format in which times are displayed to the user. 

Preferred Currency The currency in which prices/costs are displayed to the user. 

Number Format The format in which numbers are displayed to the user. An example of each format 
is displayed in the drop-down list. 

 
Preferences tab: Display Preferences 

Preferred Start Page Select between Home and the available dashboard tabs. 

Preferred Inbox View Select between My Assignments, Notifications, and Workflow Routings. 

Response Edit Mode Choose between Basic, Advanced Table Edit, and Advanced Wizard Edit. The 
Basic setting brings the user – generally a ―supplier‖ who does not work at the 
―buyer‖ company – to a simplified Web Client user interface. The two Advanced 
settings bring the user to the familiar Web Client UI. 
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Property  Descript ion  

Rows per Table 
Display 

The number of rows that appear in the user’s Agile Web Client user interface. 

Static Table Headers Set to Yes to carry table headers to additional pages. 

Maximum Rows 
Displayed 

The maximum number of rows displayed in any Agile PLM table, including search 
results. The default is 1000. If you set this property to a higher value, searches will 
take longer to display results. 

Main Toolbar (Web 
Client) 

Menu ―headings‖ on Web Client’s main toolbar can be seen as Icons Only, Text 
Only, or both Icons and Text. 

Encode Type Select from: Western European (ISO), Japanese (Shift JIS), Traditional Chinese 
(Big 5), Japanese (EUC), Simplified Chinese (GB2312), and Unicode (UTF-8) 

Show Time Sheet Set to Yes to display Timesheet tab in your Agile PLM Inbox.  

Requires the SmartRule Detailed Timesheet Entry to be enabled. 

 
Escalations tab 

Criteria 

and 

Notify Users 

Set Criteria and Notify Users, which is an individual user or user group (personal 
or global) to be notified when a workflow status exceeds its escalation time period 
without a signoff by the user. 

 
User Group tab 

Name and Status and 
Role(s) 

The user’s user group assignments for the address book. 
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Chapter 4 

Concepts and Terms in Agile PLM Solutions 

This chapter includes the following: 

 Introducing Agile Objects ..................................................................................................................................... 65 
 Installed Agile Classes, Base Classes, and Subclasses ..................................................................................... 68 
 Other Important Concepts in Agile ....................................................................................................................... 73 
 Product Collaboration Process ............................................................................................................................ 76 
 Product Portfolio Management Process .............................................................................................................. 79 
 Product Quality Tracking Process ....................................................................................................................... 80 
 Product Cost Management Process .................................................................................................................... 82 
 Product Governance and Compliance Process ................................................................................................... 83 

 
 

Introducing Agile Objects 

In the Agile system, you work with objects. Examples of objects are parts, documents, RFQs, and 
change orders. 

The objects you can view and the actions you can perform are determined by the server 
components installed on the Agile Application Server and the roles and privileges you are granted 
to access those components. Privileges can vary from field to field. If you have questions about 
your roles and privileges, contact your Agile administrator. 

How Objects Appear 

When you open an object, it appears with a number of tabs. Different types of objects have 
somewhat different tabs. Each tab contains fields that provide information about that object. For 
example, a part’s Title Block tab includes Number, Part Category, and Description fields, and a change’s 
Cover Page tab includes Originator, Status, and Reason For Change fields. 

Some tabs have fields and tables where you enter data; some fields and tables are filled in 
automatically. Some objects and commonly found tabs are mentioned in the platform-specific 
discussions later in this chapter. For more information about objects and their tabs, see Working 

with Business Objects on page 85. 
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Below is a typical object page in Java Client and the same object window in Web Client. 
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Agile Object Types 

Business objects that you create in Agile PLM are based on a framework of object types: base class, 
class, and subclass. The base class object type is a framework for classes; the class object type is a 
framework for subclasses. Each class has at least one default subclass; the subclass level is where 
you create specific objects. Every object created in Agile (by users or administrators) is an instance 
of an existing subclass. (Base classes and classes are never objects themselves.) 

The Agile system provides some three dozen default classes of business objects. The default 
classes of objects that are available for your company’s creation and use depend on which Agile 
products and licenses have been purchased. The Agile administrator—that is, any user who has 
been assigned the Administrator privilege mask or role—can create subclasses according to the 
needs of the enterprise; the administrator can also rename the existing (―out-of-box‖) base classes, 
classes, and subclasses. You may find that even a relatively new Agile installation has objects that 
have been created with names that are not reflected in this manual, for example, in the next three 
tables that describe the object types. 

The classes represent either a kind of action (business process) or kind of entity (business object). 
Everything that a user can create in Agile PLM—object or process—is treated as an object, and, 
again, each object is a specific instance of a subclass. The child subclass inherits the attribute 
settings of the parent class; where applicable, it inherits lifecycle phase and process extension. 
Tabs—tab names and tab visibility—are inherited from the parent class, but only if these are set at 
the class level; even out-of-box subclasses with the same parent class can differ slightly from their 
―siblings‖ because of tabs that the administrator has hidden or given different names. 

This table summarizes Agile’s hierarchy of object types. As an Agile user, you do not need to know 
much about base classes and classes, but it is helpful to have an idea of the hierarchy and naming 
behind the subclasses you will be working with. ―Items‖ and ―changes‖ are examples of frequently 
used base class names. 

Object  
type  

This  type 
inheri t s . . .  

Rename,  Create ,  
or  De lete  

Insta l led  examples  Notes  

Base 
Class 

Does not inherit; is 
the highest level of 
object type that 
user sees (for 
example, in 
searches). 

Administrator can 
rename base 
classes, but cannot 
create or delete any 
base class. 

1. Users base class 

2. Items base class 

3. Changes base class 

4. Suppliers base class 

 

Class ...general properties 
and process 
extensions of its 
parent base class. 

Administrator can 
rename classes, but 
cannot create or 
delete any class. 

1. Users class 

2. Parts class and 
Documents class 

3. Change Orders 
class, Change 
Requests class, Site 
Change Orders class, 
etc. 

4. Suppliers class 

The class object type 
(sometimes called 
main class) is the 
primary level of 
organization in Agile 
PLM. Each class 
represents a specific 
process or kind of 
entity (see 
Routable and 
Non-Routable 
Objects on page 
72). 
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Object  
type  

This  type 
inheri t s . . .  

Rename,  Create ,  
or  De lete  

Insta l led  examples  Notes  

Subclass ...all components 
(tabs), properties, 
and attributes of its 
parent class. 
Subclasses arrange 
the information & 
data that describes 
the specific object 
in the Agile system. 

Administrator can 
create and rename 
subclasses, and also 
delete any 
subclasses that have 
not been used by 
Agile users. 

1. User 

2. Part, Document 

3. ECO, ECR, SCO, 
etc. 

4. Broker, Distributor, 
Component Mfr., 
Contract Mfr., and  
Mfr. Representative 

When users create a 
new object in Agile, 
they specify one of 
the Agile-supplied 
subclasses or a 
subclass that the 
administrator has 
created (or renamed) 
per your company’s 
requirements. 
Subclass names 
cannot be used more 
than once within an 
Agile system. A few 
classes offer multiple 
out-of-box 
subclasses. 

 

The object type plays a part in user access and permissions. For example, you can restrict a user’s 
privilege to either the Changes base class, the Change Orders class, or the ECO subclass (or 
another, user-defined subclass of Change Orders class). 

Installed Agile Classes, Base Classes, and Subclasses 

The following two tables list all the possible installed object types in Agile PLM. Classes are 
grouped being routable or non-routable, which is discussed further on. Also covered in this section: 

 Discovery and Read Privileges 

 Routable and Non-Routable Objects 

The following two tables list all the possible installed object types in Agile PLM, grouped by the 
routable and non-routable distinction. Your company may have purchased server licenses to a 
subset of this list. A class appears grayed out in the administrator’s list of classes if your company 
has not purchased its server license. 

Base c lass   Class  Subc lass  Descript ion  

Routable objects: the means to direct or recommend changes to non-routable objects; these classes have a 
default workflow for changes to seek approval from other users; objects from these classes can be changed 
without approval. 

Changes 

 

Change Orders ECO Directives to change an item; can 
advance the revision (―rev‖) of an 
item 

Change Requests  ECR Requests for a change to an item 
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Base c lass   Class  Subc lass  Descript ion  

Deviations  Deviation Directives to temporarily substitute 
one item for another 

Manufacturer Orders MCO Changes to AML data, such as 
information about manufacturers or 
manufacturer part numbers 

Price Change Orders PCO Directives to change a published 
price; can advance the revision of a 
published price 

Site Change Orders SCO Changes to BOM and AML 
information for a specific site 

Stop Ships Stop Ship Directives to stop shipping/using an 
item 

Declarations 

 

Substance Declarations Substance 
Declaration 

Seeks compliance information for 
each substance within the 
specification 

Part Declarations Part Declaration Seeks part-level compliance 
information and other composition 
header-level information 
(manufacturing parameters) 

JGP Declarations JGP Declaration Seeks compliance information 
(weights) according to the JGP 
standard 

Homogeneous Material 
Declarations 

Homogeneous 
Material Declaration 

Seeks complete breakdown of parts 
on the Bill Of Substances and 
compliance information at the 
homogeneous material level 

Supplier Declarations of 
Conformance 

Supplier 
Declaration of 
Conformance 

Seeks compliance with specifications 
from customers and government 
agencies 

IPC 1752-1 Declarations IPC 1752-1 
Declaration 

A Joint Industry Guide (JIG) material 
composition declaration for electronic 
products 

IPC 1752-2 Declarations IPC 1752-2 
Declaration 

A homogeneous material 
composition declaration for electronic 
products 

Packages Packages Package Packages of data to share with 
partners 

Product 
Service  
Requests 

 

Problem Reports Problem Report Quality incidents with items or 
products 

Non-Conformance  
Reports 

NCR Quality conformance issues with 
items or products 
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Base c lass   Class  Subc lass  Descript ion  

Programs 

 

Activities Program; Phase; 
Task 

Components of project planning in 
Product Portfolio Management; 
activities are time-based objects to 
which resources can be assigned 

Gates Gate Project management milestones in 
Product Portfolio Management; gates 
identify cross-PLM deliverables of the 
product development process to 
enable executive reviews of 
programs 

Quality 
Change  
Requests 

 

Corrective and 
Preventive Actions 

CAPA Requests for corrective actions and 
preventive actions 

Audits Audit Proactive reviews of business 
processes 

Transfer 
Orders 

 

Automated Transfer  
Orders 

ATO Transfer or publication of a product 
record that is automatically triggered 
by a workflow 

Content Transfer  
Orders 

CTO Transfer or publication of a product 
record that is manually triggered 

 

Base c lass   Class  Subc lass  Descript ion  

Non-Routable Objects: objects in these classes are not routed to Agile PLM users with workflows; objects from 
some of these classes, however, are changed by a user submitting a workflow (from routable classes) for approval 
from other users. 

Customers Customers Customer Clients of the company 

Discussions Discussions Discussion Informal, threaded dialogue 

File Folders 

 

File folders File Folder Objects that include files or URLs; this 
class includes all file folder objects 
except historical report file folders 

Designs Design Objects used for CAD integration 

Manufacturers Manufacturers Manufacturer Qualified manufacturers 

Manufacturer 
Parts 

Manufacturer parts Manufacturer Part Parts provided by manufacturers 

Part Groups Part groups Commodity 

Part Family 

Containers of other parts (items or 
manufacturer parts) that share the 
same properties, such as prices, 
approved supplier lists, and 
composition. 

Note This object was named 
―Commodities‖ in previous 
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Base c lass   Class  Subc lass  Descript ion  

releases of Agile PLM. 

Prices 

 

Quote Histories Quote History Organizes bid prices from RFQ 
responses; cannot be revised by a 
PCO (see Changes) 

Published Prices Published Price; 
Contract 

Organizes prices of the company’s 
products; can be revised by a PCO 
(see Changes) 

Reports 

 

Standard Reports Administrator 
Report; 
Standard Report 

The out-of-box reports for 
administrators (Administrator Reports) 
and users (Standard Reports include 
Products, Sourcing, Quality, Process, 
Personal, and Global reports) 

Custom Reports Custom Report Reports created and used within 
company 

External Reports External Report Reports created outside Agile PLM 

Requests For 
Quote 

Requests for quote RFQ Requests for quote, which are 
assembled from sourcing projects and 
sent to suppliers for formal bids 

RFQ Responses RFQ responses RFQ Response Bids, that is, responses from suppliers 
to your company’s RFQs 

Sites Sites Site Manufacturing locations within the  
company, or closely partnered with the 
company 

Sourcing 
Projects 

Sourcing projects Sourcing Project Work preparatory to creating RFQs 
and capability for analysis across 
multiple RFQs 

Specifications Specifications Specification Lists of banned substances (or 
substances of concern) and their 
threshold values 

Substances 

 

Substances Substance A single chemical element used in 
composition of items, manufacturer 
parts, and part families 

Materials Material A compound chemical, a substance 
consisting of multiple substances 

Subparts Subpart A subunit of a component 

Substance Groups Substance Group A group of multiple substances, with a 
base substance that is what legislation 
is interested in, for example, ―Lead 
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Base c lass   Class  Subc lass  Descript ion  

and Lead Compounds‖ 

Suppliers Suppliers Broker; Distributor; 
Component Mfr.; 
Contract Mfr.;  
Mfr. Representative 

Qualified suppliers of manufacturer 
parts; used by PCM (which uses the 
out-of-box subclasses) and PG&C 
solutions 

Users Users User Individuals using the Agile PLM 
system 

User Groups User groups User Group Groups of people using the Agile PLM 
system, e.g., departments, teams, 
site-specific groups 

Your Agile administrator may have created or renamed subclasses. The administrator defines new 
objects by creating subclass objects under each object class. For example, under the Deviations 
class, you could see new subclasses such as ―MechDev,‖ ―SWDev,‖ and ―Part Switch‖ in addition to 
the default subclass, Deviation. 

Discovery and Read Privileges 

Together, the Discovery privilege, the Read privilege, and the Enforce Field Level Read privilege 
determine which Agile objects you can find and open, and which object fields you can view. 

The Discovery privilege lets you discover the existence of an object in the Agile database. If you do 
not have Discovery privilege for an object, you cannot view the object, and you cannot find, or 
discover, the object in the Agile database. This includes viewing users in the address book; there 
may be some users that you cannot view due to lack of privileges. 

Once you have the privilege to discover an object, your Read and Enforce Field Level Read 
privileges for that object determine whether you can open and view it, and which individual fields 
you can view. You may be able to read an object, but you may not have Read privilege for every 
field of that object. So it is possible for you to open an object and, at the same time, be unable to 
view specific fields of that object. For more information about the Discovery and Read privileges, 
see the Agile PLM Administrator Guide. 

Routable and Non-Routable Objects 

Each class represents a specific process or kind of entity: 

 Routable objects are created from classes that represent processes, such as a change in the 
change control process, or a transfer order, or a product service request. These objects can be 
routed to Agile users for approval or other input via workflows (see Workflows on page 77). 

 Non-routable objects are created from classes that represent entities or things, such as parts, 
sites, RFQs, users, prices, or reports. These objects can be ―flagged‖ for progress via lifecycle 
phases. Note, however, that non-routable objects—especially parts and documents—can be 
changed by the process of information-gathering via workflows, which are created through such 
routable objects as change orders or change requests. 
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Note File folder objects have lifecycle phases and, as they represent the entity of ―attachment 
wrapper,‖ are not considered routable objects; however, the File Folders class has a 
default, non-editable workflow with a single Review status (and no other status), which 
provides a Routing Slip tab where approvers can sign off and comment. 

 

Routing Managers 

Any object that can be routed for approval is a routable object. The user who oversees the routing 
and approval process is the routing manager. The various routing managers (see the table below) 
are simply roles assigned to users by the administrator. Once a user has been assigned a role of, 
say, change analyst, his name appears on the Change Analyst List and can be selected manually 
by a Java Client or Web Client user. Routing managers evaluate and assign routable objects, and 
they receive email notifications pertaining to the objects to which they are assigned. 

The following table lists routable objects and the corresponding default routing manager. 

Routab le  Object  (wi th  base c lass)  Defaul t  Rout ing 
Manager  

Changes base class: Change orders (ECOs), Change Requests (ECRs), 
Stop Ships, Deviations, Site Change Orders (SCOs) 

Change analyst    

Changes base class: Manufacturer Orders (MCOs) Component engineer     

Changes base class: Price Change Orders (PCOs) Price administrator     

Declarations base class: Part Declarations, Substance Declarations, 
Homogeneous Material Declarations, JGPSSI Declarations, Supplier 
Declarations of Conformance 

Compliance manager 

Packages base class: Packages Program manager     

Product Service Requests base class (PSRs):  
Problem Reports and NonConformance Reports (NCRs) 

Quality analyst     

Programs base class: Activities and Gates PE program manager     

Quality Change Request base class (QCRs):  
Corrective and Preventive Actions (CAPAs) and Audits 

Quality administrator   

Transfer Orders base class:  
Content Transfer Orders (CTOs) and Automated Transfer Orders (ATOs) 

Content manager 

  
 

Other Important Concepts in Agile 

Familiarity with the topics discussed in this section will help you use the full features of Agile. 

Login Security and Passwords 

Depending on how your Agile administrator has configured your password settings, you may have 
two separate passwords for login and approval, or you may have one password for both login and 
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approval. 

Your username and approval passwords are the same for both Java Client and Web Client. 

For system security, your administrator may configure the Agile system so that you are not allowed 
to log in after a specified number of password failures (entering the wrong password). The lockout 
applies to your login password only, not your approval password. 

Depending on system settings, one of the following occurs: 

 The login lockout lasts until a specified time has passed (for example, one minute). 

After the specified time has passed, a small Login dialog box appears, telling you that there 
have been too many login failures. Click OK and continue. 

 The login lockout lasts until your Agile administrator unlocks your account by changing your 
password. If you are locked out, Web Client does not accept further input for the time period 
specified by the Agile administrator (for example, one minute), before you can attempt to log in 
again. 

If you are having difficulty logging in to Agile, or had a failed logon and the lockout is lasting too 
long, see your Agile administrator. 

Object Subscriptions, Relationships, and Sharing 

―Sharing,‖ ―subscriptions,‖ and ―relationships‖ all describe operations with objects in Agile PLM that 
provide better collaboration and enhanced automation as they proceed through the manufacturing 
process. These features are detailed in Working with Business Objects on page 85. 

 Object sharing—Lets you grant one or more of your roles to another Agile user for specific 
objects and specific classes listed in object tabs. 

 Object subscription—You can subscribe to objects so that you are notified when certain events 
happen to that object. For example, you could subscribe to a change in order to be notified 
whenever the change was promoted to a new status. 

 Object-to-object relationships—Lets you set up communication between Agile objects, and the 
actions resulting from (triggered by) that communication. For example, the implementation of 
an ECO could trigger the close of a related ECR. 

 

File Folder Objects and Attachment Files 

Attachments to objects may contain information about the object or a manufacturing process. You 
can attach files and URLs by referencing them in a file folder object. The file folder holds pertinent 
content, or attachments. 

In previous versions of Agile, files and URLs that are attached—associated—to parts or other 
business objects are called attachments. In Agile 9, attachment files and URLs may be referred to 
generally as attachments, but it is important to remember that what is really attached to Agile 
business objects are file folders. 

You can still view, copy, delete, and print attachment files. With appropriate roles and privileges, 
you can mark up or redline an attachment file in the AutoVue for Agile viewer. See Viewing and 

Redlining Attachment Files in the AutoVue for Agile Viewer on page 288. 
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The Attachments tab of an Agile object lists attached file folders. The Files tab of a file folder object 
lists the files and URLs that are referenced, and it is where you add and remove files and URLs in 
the file folder. A file folder’s Where Used tab is populated automatically with any objects that have a 
link to the file folder. A single file folder object can be referenced from the Attachments tab of multiple 
objects. 

For more information, see Working with Attachments on page 253. For details about searching 
attachment content, see Full Text Search for Content in Attachment Files on page 154. Also see 
Viewer Supplement. 

Searching for Data 

When you want to find data in the Agile system, you perform a search. Agile provides several types 
of searches: 

 Simple searches find objects of all types that match the text you specify. 

 Quick searches find objects that match two basic conditions: the text and the object type that 
you specify. They also have the ability to search attachment file content. 

 Advanced object searches find all the objects with fields that match the conditions of the 
search. For example, you could search for parts where the Description field contains 
―Computer.‖ 

 Where-used searches (a specific type of advanced search) find the assemblies in which the 
BOM contains the items that match the search criteria. 

 Relationship searches (a specific type of advanced search) find objects related to the objects 
that meet the search criteria. For example, you can search for the problem reports that appear 
on the Relationships tab of changes that meet search criteria. 

 Attachment content searches find attachment objects that contain attachment files including the 
text specified in the search conditions. 

For instructions about searching, see Finding Agile Data with Searches on page 143. 

Agile Packages 

Agile packages are sets of product information that can be created, viewed, and routed through 
Agile to users up and down the supply chain. 

For example, suppose an electronic manufacturer service (EMS) provider must receive a certain set 
of documents to respond to a request for quotation from an original equipment manufacturer (OEM). 
The EMS defines the required documents in Java Client or Web Client. OEM employees then log in 
to Web Client, where they create Agile packages and are prompted to attach the required files. The 
Agile packages are submitted to the program manager at the EMS. 

The EMS is immediately notified when the OEM submits the packages. The EMS can review the 
packages and their contents. The packages pass through workflow stages in Agile, where they are 
routed for review, accepted, or returned to the submitting partner if additional work is needed. 

OEM personnel can monitor all this activity anytime they log in to Web Client for that EMS provider. 
The OEM can also use Agile Content Service (ACS) to automatically create and populate the Agile 
package in the Agile system of the EMS. 
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Exporting Data 

Users at Agile sites can export product definition data to a file. Export files can be comma-delimited 
text format (CSV) or Product Definition eXchange (PDX) format. 

PDX is the Product Definition eXchange standard designed for the e-supply chain. The standard is 
based on XML because it provides a simple yet powerful and flexible way to encode structured data 
into a format that is both human- and machine-readable. The PDX standard provides a way to 
describe product content (BOMs, AMLs, drawings, and so on), ECRs, ECOs, and deviations in an 
XML format. 

In a typical case, an OEM with Agile has a design to communicate to an EMS, also called contract 
electronics manufacturer (CEM), who builds the component or assembly. The product data might 
include items, BOMs, approved manufacturer lists, drawings, and so on. When a design changes, 
the manufacturer needs to communicate the changes to the EMS. The Export wizard can create a 
text file or PDX package of this information from the Agile database to be sent to the EMS. 

At the receiving end, the EMS then views that data (in Agile eXpress, if the file is a PDX package) 
and prints it or extracts it as needed for use in spreadsheets or other applications. The EMS can 
use Agile Import to import the PDX package or text file into the Agile database. 

Agile Import and Export are documented in Agile Import and Export Guide. 

For more information about the PDX standard, visit the PDX organization Web site at 
http://www.pdxstandard.org. 

Product Collaboration Process 

Agile’s Product Collaboration (PC) solution helps supply chain partners define, store, change, and 
manage product content information. The PC solution is central to Agile PLM, and most Agile users 
will need to be familiar with BOMs, AMLs, and the change control process. 

Bills of Material 

Bills of material (BOMs) show all the items (parts, documents) that make up the current part or 
subassembly. (Documents may or may not have bills of material, depending on your system 
settings.) Items on a BOM can be a single item or an assembly of several items. The BOM for each 
part appears on its BOM tab. 

Approved Manufacturer Lists 

An approved manufacturers list (AML) is the list of manufacturers that have been approved to 
supply a particular item. The list identifies the manufacturer part for that item. The AML for a part, 
plus the manufacturer’s part numbers and other information, appears on its Manufacturers tab. 

Change Control Process 

The change control process includes all procedures that manage changes or requests for change to 
any part, document, step, or instruction in your company’s manufacturing process. 

http://www.pdxstandard.org/
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Objects and Change Control 

Items are subject to change control, that is, modification by an approved and released change 
order. To modify an item’s BOM or Manufacturers tab, you must create a change against the item. 

The Title Block and Sites tabs of items are not under change control; this means, with the appropriate 
privileges, you can edit them at any time. Site objects and manufacturers are also not under change 
control. 

Affected Items 

The Affected Items tab of a change lists the items that are affected by the change. Users with 
sufficient privileges can use the Affected Items tab to: 

 List the items affected by the change, and assign a pending revision (or rev) to the affected 
items of the ECO 

 Open the affected items 

 Work with BOM, manufacturer, and attachment redlines 
 

Redlining BOMs, Manufacturers, and Attachment Files 

When you redline a BOM, you change it in some ways. For example, you can add or delete parts 
and assemblies from the BOM or change quantities of existing parts. Likewise, when you redline an 
AML, you can change associated manufacturer parts information. When you redline an attachment 
file, you mark it up in the AutoVue for Agile viewer by adding new drawing lines, adding annotations, 
or adding measurements. 

Redlining activities begin on the Affected Items tab of an ECO (for BOMs, AMLs, or attachment files), 
SCO (for BOMs or AMLs), or MCO (for AMLs). 

Workflows 

A workflow is a sequence of statuses that a routable object (such as a change) follows. Workflows 
automate many processes; for example, when a change is released, Agile users on the notification 
list receive automatic email with this information. 

Agile provides default workflows for routable objects, and your Agile administrator can create 
workflows. For each workflow made available to Agile users, the administrator specifies workflow 
name, ID number, names of the statuses, and the properties that define each status. 

Agile workflows are covered in detail in Routing Objects with Workflows on page 207. 

Change Control Tasks 

With the necessary server license, you can create changes against items and route them to Agile 
users for approval. Agile PLM lets you do the following: 

 Approve or reject the routed changes 

 Attach comments to changes 
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 Change the lifecycle phase of an item without changing its revision (MCO) 

 Add, edit, and delete bill of material, manufacturer, and price data on items 

 Change site-specific information on an item 

 Redline attachment files associated with an item. 
 

A Typical Change Control Process 

Agile supports change control processes, including default and custom Agile workflows. 

The following is an example of a typical change control process for a change using Agile workflows: 

1. An Agile user creates a change (for example, an ECO or MCO), and then selects a workflow to 
route this change. 

2. The user selects approvers (members of the change control board) and observers for the 
change, then submits it to the routing manager. 

3. The routing manager switches the change to the next status, which routes the change to the 
specified approvers and observers. 

4. The members of the change control board, or CCB, enter their approval or rejection on the 
Workflow tab of the change. 

5. If all the approvers approve the change, it is automatically promoted to the next status 
(depending on the AutoPromote setting). If any approvers reject the change, the routing 
manager is notified. The routing manager may elect to do any of the following: 

 Cancel the change by switching the status to Canceled. 

 Return the change to the originator by switching the status to Pending. 

 Release the change in spite of the rejection. 
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The following figure illustrates this change control process. Agile packages and content transfer 
orders can follow a similar process. 

 
 

Product Portfolio Management Process 

Agile Product Portfolio Management (PPM) is a Web Client application for program management 
that allows you to: 

 Plan a program in terms of its schedules, resources, and deliverables 

 Execute and manage multiple related programs and projects in a collaborative environment 

 Associate product deliverables – such as Items, RFQs, ECOs, and CAPAs – to tasks on a 
project plan 

 Establish project plan templates for rolling out best-practice processes 
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 Allocate work to users or resource pools and monitor capacity and future demand 

 Establish executive dashboards for cross-program rollups and quick access to high risk 
activities 

The program management process involves: 

 Scheduling 

 Task management 

 Issue management 

 Document management 

 Phase/Gate management 

 Resource management 

 Deliverable management. 
 

Common Terms in PPM 

Listed below are some of the common terms used in PPM: 

 Program: A set of related activities and gates that is created to monitor and manage progress 
on a specific project. 

 Phase: A segment of a program, also referred to as a stage. Phases are often used to define 
the activities required to create a set of deliverables. 

 Gates: Indicates the completion of a set of related activities, such as a phase. The status of a 
gate is closed until all its deliverables are complete, at which time it opens. 

 Task: A segment of work that one or more resources can complete over a period of time. Tasks 
may be embedded in programs, phases or other tasks. 

 Deliverable: An Agile PLM object whose state change can trigger a state change in the 
program element that contains it. Deliverables are used to control the status of gates. 

 Gantt Chart: A program management tool that helps you to plan, administer, and track 
programs from start to finish. 

 Content: Contains all program-related content including deliverables. 

 Activity: A program, task or phase. 

For more information on PPM, see Agile Product Portfolio Management User Guide.  

Product Quality Tracking Process 

The Agile Product Quality Management (PQM) solution consists of a comprehensive set of tools 
that allows companies to track and manage quality data across the enterprise. This includes 
customer complaints, field failures, product or manufacturing defects, and requests for 
enhancements or corrective and preventive actions. PQM unifies the company’s organizations in 
customer service, field sales, manufacturing, and engineering, and links the organization to its 
customers and partners. 
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PQM features offer these benefits: 

 Integration with external enterprise Customer Relations Management (CRM) systems—The 
ability to import customer complaints, manufacturing issues, and additional quality-related 
information from other enterprise applications streamlines the quality tracking process and 
offers a central repository for tracking product quality data. 

 Improved product quality—Tracking defects, finding trends, and determining the root causes of 
defects in a timely manner are the keys to effective defect reduction and improved product 
quality. 

 Improved customer satisfaction—The ability to track problem reports and customer complaints 
lets you respond quickly to customers and resolve problems quickly. 

 Lower production, repair costs, and warranty costs—Tracking and correcting defects can help 
reduce scrap, cycle time, and costs associated with rework and repair. 

 New features enable compliance with ISO-9000, FDA, and other regulations. 

The Agile PQM solution consists of Product Service Requests (PSRs) and Quality Change Request 
(QCRs). The two types of PSRs are Problem Reports and Non-Conformance Reports (NCRs). The 
two types of QCRs are Audits and Corrective and Preventive Actions (CAPAs). You can associate 
QCRs with problem reports. 

Common Terms in PQM 

Listed below are some of the common terms used in PQM: 

 Product Service Request (PSR): A PSR is used to report a defect or a quality incident about a 
product. The PSR can be either a Problem Report or a Non-conformance Report.   

 Problem Report (PR): Contains a basic description of a problem, issue, or incident that 
occurred, from the customer’s perspective.  

 Non-Conformance Report (NCR): Reports a basic material deviation from specifications or 
requirements in one or more products.  

 Quality Change Request (QCR): Creates and manages quality records that aggregate 
problems related to products, documents, suppliers, and customers. 

 Audit: The pro-active process of verifying compliance with quality requirements. 

 Corrective and Preventive Action (CAPA): A formal process of addressing any quality 
problem and analyzing the root cause to implement corrective and preventive action. 

 Related PSR: A list of all similar product service requests that are combined to form a single 
PSR. 

 Affected Items: A list of items that are affected by the change in either a PSR or a QCR. 

 Relationship tab: Creates a relationship with other Agile objects; the relationship is bi-
directional.  

 Relationship Rule: Specifying a rule for a relationship defines how the related Agile objects 
affect each other. Rules are optional; you can create a relationship between two objects without 
specifying a rule.  

 Preview Pane: When you add a relationship to an object, the details of the Relationship are 
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displayed in the Preview pane. It also displays the attributes and actions that can be performed 
on the relationship object.       

For more information on PQM, see Agile Product Quality Management User Guide. 

Product Cost Management Process 

Agile’s Product Cost Management (PCM) solution consists of the Product Sourcing and Price 
Management components. They allow you to integrate and leverage price and cost information 
within your company’s business processes in the Agile Web Client. 

A sourcing project holds the data you gather, such as items and assemblies, bills of material, and 
approved manufacturers lists. Using the project, multiple users can work as a team to complete 
sourcing and pricing activities, since the project lets multiple users view and modify the same 
components. Sourcing projects allow you to execute sourcing activities, including RFQs and 
analysis, on your Item Master content. 

The Price Management solution provides you with a single controlled process for managing price 
and terms information that can be leveraged across organizations, business processes, and key 
analyses. 

Common Terms in PCM 

Listed below are some of the common terms used in PCM. 

 Approved Manufacturer's List (AML): Lists all the preferred or alternate manufacturer parts that 
correspond to an internal part.  

 Sourcing Projects: An entry point for sourcing and pricing. Tracks data required for sourcing 
and pricing, to perform analysis for effective pricing. 

 Item Master: The entire collection of Items - Parts, Documents, and other user-defined 
subclasses of the Items class maintained under change control in the Agile system. 

 Project Items: Items added to a project. These can be items that exist in the Item Master, 
created within the project or imported into the project. 

 Project Data: Information about the supplier, item, manufacturer, manufacturer part number, 
revision, price information, RFQ response information of a project.   

 Subscriptions: Subscribing to an object sets you up to receive notification of events that happen 
to the object.  

 Target Price: The price you quote for an item with the standard cost in mind. Standard cost is 
the market cost per unit of the item or the manufacturer part. 

 Commodities: Lets you categorize parts for sourcing and analysis process. By associating each 
item with a commodity, you can distribute RFQs to suppliers based on the commodities they 
offer. 

 Request for Quotes (RFQs): Using RFQs, you request quotes for items involved in the project 
and suppliers respond to the Quote. RFQs can be sent to one or more suppliers.     

For more information on PCM, see Agile Product Cost Management User Guide.  
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Product Governance and Compliance Process 

Agile Product Governance and Compliance (PG&C) is designed to help OEM manufacturers audit 
the amount of regulated substances used in their products, and show that they responsibly dispose 
of, recycle, or reuse electronics containing those substances. 

PG&C helps companies address the growing number of environmental specifications and policies 
that affect product definition, the import and export of products, and the disposal of restricted 
substances. It provides a solution that manages the entire product compliance process: 

1. Collection of data from vendors through a Request For Information (RFI) 

2. Determination of compliance by analyzing data and comparing it to established standards 

3. Documentation of compliance by running reports 

The RFI process is initiated by Compliance Manager, who creates a new declaration, or modifies an 
existing declaration, to specify the components for a parts assembly. An RFI is comprised of a 
Material Declaration, which lists the parts in a product assembly and shows the substances and 
materials that comprise those parts. It is linked to specifications which may restrict how much of a 
particular substance that product assembly may contain. 

Common Terms in PG&C 

Listed below are some of the terms used in PG&C.  

 Specification: Tracks the different legislations with which an assembly or part must comply. 
Environmental specifications are substance-based, and contain a list of banned substances or 
substances of concern and their threshold values. In Agile, specifications are used to validate 
declarations and assess the compliance of parts by evaluating whether a given restricted 
substance in the composition of a part surpasses its specified threshold value.  

 Declaration: A structured way of bringing information concerning the environmental compliance 
of parts into Agile PLM. Each declaration is for a single supplier.  

 Composition: A composition represents the total collection of information contained in a 
completed declaration and is not a configurable "business object" in Agile PLM. 

 Substance: A substance is any chemical element or compound that is tracked within Agile 
PLM. 

 Bill of Substance (BOS): A way to manage compliance information-gathering with regard to the 
parts and materials used in the manufacturing process. 

 Alias: Informs the PG&C system of "substitute names" of substances. For example: When a 
supplier provides information about substances for a part, there is no guarantee that a 
substance with the same name exists in the buyer’s system. The system adds the invalid 
substance as an alias to the substance. Whenever the same invalid substance is imported, it 
automatically maps to the objects. 

 Supplier: A supplier is a company that provides compliance information about parts that are 
used in your company’s manufacturing process. 

For further information about PG&C, see Agile Product Governance & Compliance User Guide. 
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Chapter 5 

Working with Business Objects 

This chapter includes the following: 

 Interacting with Agile Objects: Actions and Tabs ................................................................................................. 85 
 Creating Objects .................................................................................................................................................. 92 
 Direct Addition of Objects to BOM, AML, and AI Tables ..................................................................................... 96 
 Modifying Date and Time Fields .......................................................................................................................... 97 
 Printing Object Tabs ............................................................................................................................................ 99 
 Emailing Objects .................................................................................................................................................. 100 
 Quick Access to Objects and Files ...................................................................................................................... 101 
 Discussion Objects .............................................................................................................................................. 102 
 Sharing Objects with Other Users ....................................................................................................................... 103 
 Subscribing to Objects ......................................................................................................................................... 105 
 Relationships and Dependencies Between Objects ............................................................................................ 107 
 Relationships Tab ................................................................................................................................................ 108 
 Deleting Agile Objects ......................................................................................................................................... 117 

 
 

Interacting with Agile Objects: Actions and Tabs 

Finding and opening Agile objects is a straightforward process: the easiest way is to run a simple 
search. You can type a word in the Simple Search field—on the main toolbar of both clients—that 
describes the Agile content you are interested in. For example, typing computer will return a list of all 
objects with the word ―computer‖ in their name or description. If you already know an object’s ID 
number, typing it in the Simple Search field returns the object. 

For more information about finding objects or data in Agile, see Finding Agile Data with Searches 
on page 143. 

Once you have found an object that you will want to refer to often, you can bookmark it to return to it 
easily. 

The two main ways of interacting with Agile business objects are, with an object open, via the 
Actions menu or via the fields and attributes on its various tabs. 

Actions Menu 

An important feature for working with objects in both clients is the More menu (Java Client) and the 
Actions menu (Web Client). Generally, objects in Web Client have an Actions button that opens to a 
drop-down list of available actions. In Java Client, right-click anywhere in the opened object to see a 
shortcut menu with the same commands as the More menu. 
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Note In Java Client, on most tabs, if you right-click outside any table rows within the object, 
that object’s main shortcut menu opens (Changes, Quality and Where Used tab excepted). 
However, on any tab with a table, you can also select a row in a displayed table and 
right-click, and a shortcut menu for the object referenced in that row opens. 

 

Command  Descript ion  

Save As Creates a new object based on the current object. 

Delete Deletes the object (a ―soft delete‖). For more information about deleting objects, see 
Deleting Agile Objects on page 117. 

Print Choose either All Tabs or the tabs you want. The list of tabs changes with the current 
object’s class. 

Copy URL to 
Clipboard 

In Web Client, copies the URL of the object to the clipboard, so it can be pasted 
elsewhere. 

For Internet Explorer: the URL is copied when you click the action; the prompt indicates 
it is copied. 

For Netscape: when you click the action, a popup displays the URL, manual Ctrl-c 
copies the URL. 

Incorporate and 
Unincorporate 

Available for items: incorporation locks the checkout and checkin capabilities of file 
folders on the Attachments tab of the item. This important capability is available only 
on the More menu. For more information about incorporating, see the Product 
Collaboration User Guide. 

Bookmark or Add 
Bookmark 

Saves a pointer to the object on your Bookmarks (or ―Favorites‖) list. 

Send Opens the address book and lets you select one or more users to send the object to, 
including a comment. A notification is then sent to the designated users with a link to 
the object. 

Share or Sharing Opens a page linked to the current object that lets you share the object or delete an 
existing share. For more information, see Sharing Objects with Other Users. 

Subscribe or 
Subscriptions 

Allows user to subscribe to receive a notification when certain attributes change. Offers 
a list of subscriptions for the current object: Lifecycle Phase Change or Status Change, 
Add File, Delete File, Checkin File, Checkout File, and Cancel Checkout File. See 
Subscribing to Objects on page 105. 

Export Opens to the Export wizard in Web Client (even if you have activated it from Java 
Client). 

Process Extensions Offers a list of currently available process extensions, which have been created by your 
administrator. 

Audit Status Audits the remaining statuses in the object’s workflow to test whether the workflow can 
advance through those statuses. 

Audit Release Audits the remaining statuses in the object’s workflow to test whether the workflow can 
be released per the existing conditions in the statuses. 
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Command  Descript ion  

View Workflows Shows eligible workflows for this (routable) object, in visual form. Offers drop-down list 
to select another workflow to view. 

Create Change Creates a new change order with the open item (part or document) already added to 
the Affected Items tab. 

Create Product 
Service Report, 
Create Quality 
Change Request 

Creates a new PSR or QCR with the open item already added to the Affected Items 
tab. 

Create Declaration Create a new Declaration with the open item already added to the Affected Items tab. 

Actions available from selecting a row in a table 

Open, Copy, or 
Paste 

Select a row in a table, then open the object on the selected tab, or copy the selected 
tab and paste it into another table. 

Print Select a row in a table, then print the object’s selected tab or tabs. 

Create Product 
Service Report, 
Create Quality 
Change Request 

Creates a new PSR or QCR with the item in the selected row already added to the 
Affected Items tab. 

 
 

Object Tabs 

Tabs are used to organize the content of Agile objects. A brief list of the most common tabs found in 
many objects across Agile PLM’s solutions follows. This table gives basic information about tabs 
that is elaborated on later in this manual and elsewhere in the Agile documentation set, such as the 
platform-specific user guides. Some Agile solutions—such as Product Cost Management and 
Product Portfolio Management—have specialized tabs not listed below. 

Note For more information about Web Client tab indicators (a grey or red dot that appears 
next to the tab name when you view the object), see Web Client Tab Content Indicator 
Icons. 

All the out-of-box business classes with all their default tabs are described in the Agile PLM 
Administrator Guide. 

Note Remember that part of Agile PLM’s flexibility includes the administrator’s ability to 
rename business classes and subclasses, tabs within objects, and fields within tabs, so 
some tabs listed below may have a different name within all classes or within a particular 
class of object that your company works with. 
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Important Your ability to see or work with any object or any tab in Agile is governed in large part 
by your roles and privileges. If you are having trouble opening, seeing, or modifying an 
object, tab, or field, see your Agile administrator. 

 

Tab  Descript ion:  what  in fo rmat ion th is  tab  col lects  Found in  these 
c lasses  of  business  

objects  

―Page One‖ The Cover Page tab is the Page One for all routable 
objects—the Change, PSR, QCR, Transfer Order, Package, 
and Program base classes—as well as RFQ and RFQ 
Response objects. 

The Title Block tab is the Page One for all item and file folder 
objects. 

The General Information tab is the Page One for all 
remaining (non-routable) classes. 

All objects have a ―Page 
One‖ that uses one of 
the names to the left. 

Page Two and 
Page Three 

Further information about the object. These are added by the 
administrator as extensions of ―Page One.‖ Page Two fields 
are the same for all objects in same business object class. 
Page Three fields are the same for all objects in the same 
subclass. Both ―Page Two‖ and ―Page Three‖ can be replaced 
by more specific names. 

Depends on how classes 
have been set up. 

History Summary of actions taken on this object. History is recorded 
for all objects in your Agile system’s database, and shows all 
actions by users and administrators. The History tab is 
populated automatically. 

All. 

Attachments 
(and Files) 

View, copy (get), or print attached files. Attach files and URLs 
to the current object by adding them to a file folder. Access 
Viewer to redline attached files (once the object is on an ECO, 
only from the Redline Attachment table on the Affected Items 
tab). 

Note The Files tab lists all contents of file folder objects; so, 
an item’s Attachments tab lists file folder objects, and 
file folder objects have a Files tab listing contents. (For 
more information, see Working with File Folders 
on page 301.) 

All objects except file 
folders (which contain 
attachment content) and 
reports. 

Changes Information about change objects that involve the item or 
published price object. 

Pending Changes and Change History tables are the two 
tables on the Changes tab. 

Items and published 
prices. 

BOM All the items that make up the current part. (Documents may 
or may not have bills of material, depending on your system 
settings.) Items on a BOM can be a single item or an 
assembly of several items. 

Items. 
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Tab  Descript ion:  what  in fo rmat ion th is  tab  col lects  Found in  these 
c lasses  of  business  

objects  

Manufacturer Lists manufacturers that have been approved to supply a 
particular item. The list identifies the manufacturer part for the 
current item. 

Items & Sourcing 
Projects. 

Where Used Lists other objects where the current object is used. The 
Where Used tab is populated automatically. To open an 
object listed on the tab, click its Number or Name link; in Java 
Client, double-click the row. 

The type of objects that appear on the Where Used tab 
depends on the current object: 

Item—Assemblies and manufacturing sites that use the item. 

Manufacturer—(Item/MPN Where Used tab) Parts and 
assemblies that use manufacturer parts provided by the 
manufacturer. 

Manufacturer Part—Parts and assemblies that use the 
manufacturer part. 

File Folder—Objects with attachments contained in the file 
folder. 

Discussion—Objects that use the discussion, including 
projects, RFQs, RFQ responses, activities, and gates. 

Items, Manufacturer 
Parts, Discussions, File 
Folders. 

Affected Items (in 
PCOs: Affected 
Prices) 

Lists the items that are affected by the current change object. 
Users with sufficient privileges can use the Affected Items 
tab to: 

List the items affected by a change and give the affected 
items of an ECO a pending revision (or rev) 

Open the affected items 

Work with BOM, manufacturer, and attachment redlines 

Affected Prices replaces Affected Items in PCOs. 

Note When you add an item to the Affected Items tab of a 
change, if the site you have selected during the ―add‖ 
process is not associated with the item, you are 
prompted to add the site association to the item. That 
site association remains in effect for that item, even if the 
change is canceled or if you remove the item from the 
Affected Items table of the change. 

Changes, PSRs, QCRs 
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Tab  Descript ion:  what  in fo rmat ion th is  tab  col lects  Found in  these 
c lasses  of  business  

objects  

Workflow 
(routable objects 
only) 

Shows where the routable object is in the assigned workflow 
(via a flow chart), and lists present and past signoff 
information. Add or remove approvers and observers. Move 
the object to another status in the workflow. 

Summary table lists signoff information for the current 
workflow status. 

Signoff History table lists past workflow and signoff 
information for the routable object. 

Changes, PSRs, QCRs, 
Packages, Transfer 
Orders, Programs 

Sites Shows where each object is being produced at specified 
manufacturing locations within the company. 

See the Note for Affected Items in this table. 

Items 

Escalations When a workflow status exceeds its escalation time period 
without a signoff, user groups or individual users can be 
notified. This tab shows whose escalations (other users’) can 
be signed off by the current user (myself). Note that the 
settings in a user’s Allow Escalation Designation Approval 
property (on the General Info tab) comes into play. 

Users and User Groups 

Shares A user’s or user group’s Shares tab – it exists for these 
objects only – lists those objects for which the user/user group 
has been granted ―shared roles‖ by a different user. The user 
(or members of the named user group) can then perform 
actions permitted by the roles for that object only. See Sharing 
Objects with Other Users. 

Users and User Groups 

Subscriptions See Subscribing to Objects on page 105. Users 
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Tab  Descript ion:  what  in fo rmat ion th is  tab  col lects  Found in  these 
c lasses  of  business  

objects  

Relationships 
(in programs: 
Content) 

The relationships and dependencies between this object and 
other routable objects or non-routable objects (with lifecycle 
phases). 

If the current object is a routable object, the Rule column 
displays the rule that defines how the workflow status or 
lifecycle phase of other objects affect the workflow 
progression of the current routable object, or how the 
workflow progression of the current routable object affects the 
workflow progression of the related objects. 

If the current object is a non-routable object (with lifecycle 
phases) and the related object is a routable object, you can 
specify a rule for the relationship, thus creating a dependency 
between the current non-routable object and the routable 
object. A relationship with a rule indicates a routable object 
whose workflow progression is affected by the lifecycle phase 
of the current non-routable object. 

A relationship with no specified rule does not limit or affect the 
workflow progression of the related routable object. You can 
use non-rule relationships to record objects that are somehow 
related to the current object, but do not have any 
dependencies with the current object. 

You cannot specify a rule for a non-routable object 
relationship with another non-routable (lifecycle phase) object. 

See Relationships and Dependencies Between Objects. 

In Product Portfolio Management objects (Programs), 
relationships are included on the Content tab. All Program 
object Content table rows with rules are named deliverables. 

You can add file attachments to the Content tab as program 
content. By default, the Program object Attachments tab is 
disabled and not visible. You can enable this tab from Java 
Client Administrator. Attachments that were already added in 
the Attachments tab are not displayed in the Content tab. To 
transfer existing attachments from the Attachments tab to the 
Content tab, contact your support team. 

All classes (except 
Actions Items and 
Reports) 

For Programs classes, 
relationships are 
included on the Content 
tab and relationships 
with rules are named 
deliverables. 

Prices Prices tab of an item includes information about price objects 
associated with the item, including ―priceline‖ information. 

Prices tab of a manufacturer part includes information about 
price objects associated with the manufacturer part. 

Items & Manufacturer 
Parts 
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Tab  Descript ion:  what  in fo rmat ion th is  tab  col lects  Found in  these 
c lasses  of  business  

objects  

Quality Information regarding PSRs and QCRs created with regard to 
the item. Those objects have these cross-linked tabs: 

Related PSR tab for PSRs 

PSR Items tab for QCRs 

PSRs tab for Suppliers and Customers 

Items 

 
 

Creating Objects 

To create an object, you must be assigned the Create privilege for the kind of object that you want 
to create. See your Agile administrator. 

In Java Client, you can create a business object in these ways: 

 use the New Object menu  to choose a base class and a class from the expanded lists 

 use the File > New command to choose a base class and a class from the expanded lists 

 use the File > Save As command if you have an object open 

In Web Client, you can create a business object in these ways: 

 use the Create menu to choose a base class and a class from the expanded lists 

 use the Actions > Save As command if you have an object open 

You can also create some objects as you add them to an Agile table. For example, you can create 
an item to add it to the BOM tab of a parent item or to the Affected Items tab of a change. 

There are some options to create objects from ―within‖ another object. For example, from within an 
item, the Actions menu includes Create Change, Create PSR, Create QCR, and Create Declaration. From 
within a manufacturer, you can choose Create Manufacturer Part. 

Once you create an object, that item exists until you delete it. If you create a new object, then 
decide you do not wish to keep it, be sure to delete the object; otherwise, the new object is still in 
the database and the object’s identifier (such as the item number) cannot be reused. See Deleting 

Agile Objects on page 117. 

Note Although all characters are supported within Agile PLM, and should not create issues 
within Agile PLM clients, it is recommended that you avoid using the following characters 
when creating objects, due to issues that could potentially arise in integrations or custom 
applications written on the SDK. 

         ,   comma      .  period (dot)      :   colon      ;   semicolon      =   equal sign 
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Creating Objects in Java Client Using the New Command 

The process for creating new business objects in Java Client involves two main steps: creating an 
empty object, then filling in the object tabs with information specific to the object. 

To create and complete an object in Java Client: 

1. Choose File > New on the main menu bar or click the New Object button  on the main toolbar. 

2. From the drop-down menu that opens, choose the base class for the business object you want 
to create. Any base class with two classes expands to offer choices in all possible child classes 
(for this reason, Transfer Order will offer Content Transfer Order but not Automated Transfer 
Order). The New dialog box opens. 

3. The New dialog specifies the object type and, for some objects, assigns an Autonumber. 

The autonumber format and sequence are determined by the Agile administrator. The 
administrator also determines whether using autonumbers is required or optional. 

4. Click OK. The new object appears with the Cover Page, Title Block, or General Information tab 
showing. 

Fill in information on the object’s tabs, as necessary. Some tabs are completed automatically, 
such as the Changes, Where Used, and History tabs. You do not enter information on these tabs. 

Note that in Java Client, the object has been created as of step 4 in the procedure. (In Web Client, 
objects are created through wizards.) All object-required fields are depicted by the name of the field 
appearing in bold type. If you attempt to close the object with any required fields empty, an error 
message will advise ―You have not completed all required fields. Please complete all fields in bold.‖ 

Creating Objects in Web Client Using the Create Command 

A wizard in Web Client leads you through the process of creating an object and specifying 
information on its tabs. 

To create and complete an object in Web Client: 

1. Click the Create button on the main toolbar. 

2. From the drop-down menu that opens, choose the base class for the business object you want 
to create. Any base class with two classes expands to offer choices in all possible child classes 
(for this reason, Transfer Order will offer Content Transfer Order but not Automated Transfer 
Order). The Create wizard opens. 

3. Follow the instructions onscreen to complete the wizard. Some points about the wizard: 

All object-required fields will be present in the first screen of the wizard – the ―required‖ aspect 
is depicted by the name of the field appearing in bold type. All these fields must be filled in to 
create the object. If you attempt to finish the wizard with any required fields empty, an error 
message will advise ―You have not completed all required fields. Please complete all fields in bold.‖ 

If you click the Continue Creation in Wizard checkbox, Continue or Next buttons are available. 

If you leave the Continue Creation in Wizard checkbox unfilled, the Finish button is available. You 
can click Finish at any point in the wizard, and the object will be created. Later, you can open 
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the object and enter more data. 

You can always click Cancel to end the wizard without saving the new object. 

The Autonumber format and sequence are determined by the Agile administrator. The 
administrator also determines whether using Autonumbers is required or optional. 

4. As you proceed through the steps of the Create wizard, the process flow diagram in the 
navigation pane is interactive. For information about using the process flow diagram, see 
Adding Data during Create with the Process Flow Diagram on page 94. 

5. Click Finish. The new object appears with the Cover Page, Title Block, or General Information tab 
showing. 

Fill in information on the item tabs, as necessary. Some tabs are completed automatically, such 
as the Changes, Where Used, and History tabs. You do not enter information on these tabs. 

Adding Data during Create with the Process Flow Diagram 

While you proceed through the steps of the Create wizard in Web Client, the process flow diagram 
(see Using the Wizard Process Flow Diagrams on page 37) in the navigation pane tracks the steps 
of the wizard. The steps that you have not reached can be accessed—if a step is enabled, you can 
open and close it at any time you are in the wizard, and you can fill in information or not as you 
choose. Some common steps you will see are Enter Cover Page Information, Add Attachments, and Add 
Affected Items. 

When you have clicked an ―Add step‖ in the process flow diagram, a dialog opens. This dialog will 
vary according to the kind of information you are adding, but it will be familiar and self-guiding, for 
example, using Available and Selected tables. 

Most of these dialogs have, of course, an Add button . If you click the drop-down triangle, you 
can choose Create new or Search. If you click the Add button itself, a full dialog opens, where Create 
and Search buttons are often present: 

 Create (button) and Create new (menu choice) open a dialog to create a new object. Follow the 
task preceding this topic. 

 Search (button and menu choice) opens a dialog with three Search tabs (see Add Files by 

Search Options on page 275). 

 For Add procedures that involve items (parts or documents), the Item Number(s): field can be 
used to type in known object ID numbers, one per line. After entering one or more ID number, 
click Add, you are returned to the Create wizard with the objects you listed added as 
appropriate. 

These ―Add‖ elements are meant to make certain procedures easier, but they could be somewhat 
confusing while you are learning Agile. The main thing is that you can go in and out of them without 
―harming‖ the wizard you are in. The Add steps become more useful as you work in Agile PLM 
every day. 

If you check the Edit Items After Adding checkbox, the newly added items will be displayed in Edit 
mode (after they are added to the table). 
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Add with Search Options 

In various ―create‖ or ―add‖ operations that are detailed in this manual, when you click the Add 
button, the dialog that opens may have a Search button. This is the procedure to decide what route 
to take to identify objects in the database that you can select in your ―add‖ operation. 

 Search (button and menu choice) opens a dialog with three Search tabs: 

 Search tab lets you run a simple search by entering a value in the field and clicking the 
Search button. 

Click the Advanced Search link to set up an advanced search. 

Click the Search Attachment Contents checkbox to include attachment files in your search. 

When the results of your search are returned, you can select and move objects from the 
Results table to the Selected table. 

Then Click OK, and you are returned to the Create wizard, and the objects you selected 
have been added where appropriate. 

 Saved Searches tab opens to your navigation pane where you can browse in search folders, 
select a search, and run it. Again, returned results may be moved to the Selected Items 
table, and click OK. 

 Shortcuts tab opens to your navigation pane where you can select objects from My 
Bookmarks or Recently Visited. The system displays shortcuts to only those objects that are 
appropriate to the operation you are performing. 

Generally you can run multiple searches before completing the wizard step. Also, after the object is 
created, you can still run multiple searches. 

Creating an Object Using Save As 

Using the Save As feature is a quick way to create an object that is similar to an existing object. 

Note In general, you should not use Save As to create an object in a different class or 
subclass from the original object. The different classes or subclasses may not have the 
same tabs or defined fields, and you may lose access to some data in the newly created 
object. 

 For example, parts generally have a BOM tab. By default, documents do not. When you 
save a part as a document, you cannot view the part’s BOM in the resulting document 
unless your Agile administrator has configured your system to permit documents to have 
BOMs. 

To create an object using Save As in Java Client: 

1. Select and open an existing business object. 

2. Choose File > Save As. The Save As dialog appears. 

3. The two fields in the Save As dialog box are (object) Type and (Auto)Number. Choose an 
available object type from the drop-down list, and click for an autonumber or fill in an ID number 
manually. 

4. Depending on the selected object type, the Save As dialog may display additional required 
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fields. Complete any required fields. 

5. Click OK. The new object is created and automatically opens. 

6. Make any appropriate modifications on the tabs of your new object. 

To create an object using Save As in Web Client: 

1. Select and open an existing business object. 

2. From the Actions menu, choose Save As. A dialog appears with the heading: ―Save [object] [ID 
number] As...‖ with defaults naming the object and number. 

3. The two fields in the dialog are Subclass and (Auto)Number. You can choose an available 
subclass from the drop-down list, and fill in an ID number manually if you want. 

4. Depending on the selected object type, the Save As dialog may display additional required 
fields. Complete any required fields. 

5. Click Save. The new object is created and automatically opens. 

6. Make any appropriate modifications to the tabs. 

If the Agile administrator has set the appropriate preferences, fields in the optional Page Two and 
Page Three sections are copied to the new object. For information about the behavior of Page Two and 
Page Three fields in your Agile system, see your Agile administrator. 

Save As copies data from a field in the existing object to the same field in the new object. If a field 
or list value in the existing object is not available in the new object, then that field or list value is not 
copied to the new object. 

Note Because Page Three data applies to a specific subclass only, if you use Save As to create 
a new business object in a different subclass, the Page Three data is not copied to the 
new object. 

 

Site Change Order Save As Limitations 

You cannot initiate Save As from a non-Site Change Order (SCO) change object in order to create 
an SCO object, nor can you initiate Save As from an SCO object in order to create a non-SCO 
change object. Because Site Change Orders (SCOs) affect only site-specific information, and other 
types of changes are not limited to site-specific information (for example, ECOs and MCOs), SCOs 
can be Save-As-created only from another SCO. The Site Change Order's site-specific only usage 
makes it incompatible with other change types when using the Save As feature. 

Direct Addition of Objects to BOM, AML, and AI Tables 

The Product Collaboration User Guide describes procedures for adding objects—for example, 
parts, documents, manufacturer parts—to BOM tables on items, AML tables on items, and Affected 
Items tables on changes. Generally, you have to search for each object to add it to a table. An 
additional method is called direct addition of objects. 

Note The ―direct addition‖ capability applies only to Java Client. However, this process in Java 
Client is very similar to Web Client’s Adding Data during Create with the Process Flow 

Diagram on page 94. 
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In the tables just listed, when you click the drop-down arrow next to the Add button , you are 
given the option to Search... for the object(s) you want to add, Create... an object you want to add, and 
to Type in known number(s)... of objects you want to add. 

When you select the latter, a popup dialog appears called, for example, Add BOM. This method is 
useful when you work with certain items or subassemblies every day, and you are familiar with their 
Agile numbers. You simply type in the number of the item that you want to add (one per line), and 
click the Add button. The item is added to the table and the popup dialog disappears. 

Item Addition Rules 

Whenever a user adds an item to a BOM or adds an affected item to a change, the user is 
prompted to set a warning mask (by choosing Yes or No). If an item then happens to violate an 
―Item Addition Rule,‖ the system knows how to handle it. 

These are some item addition rules, that is, the question stemming from a potential violation of the 
rule: 

 If there are duplicate items, would you still like to continue? 

 Some items may not be associated with some sites; would you like to add the association? 

 If one item does not exist, do you want to use it anyway? 

 Do you want to add items whose lifecycle phase is in the warning list to the BOM? 

 
 

Modifying Date and Time Fields 

In both Java and Web clients, you can modify date fields by using the calendar tool, as well as by 
typing in the field. 

Using the Calendar to Modify Date Fields in Java Client 

To use the calendar tool in Java Client: 

1. In a date field, click the calendar icon  to open the calendar (if it is enabled). 

2. Select a date from the calendar. Java Client enters the new date and sets the times to 12:00:00 
am. 

Note The default time format is ―12 hours‖ with am and pm. 

Double-clicking the date enters it directly to the field. 

3. To switch to a different month or year, click the appropriate Forward or Reverse button. 
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4. Click the red icon to close the calendar and clear any date you entered.  
Click the green icon to close the calendar and keep your date entry. 
There is also a button in the right bottom corner (not pictured) that sets the date back to the 
present day. 

 
 

Using the Calendar to Modify Date Fields in Web Client 

To use the calendar tool in Web Client: 

1. In a date field, click   to open the calendar (if it is enabled). 

2. Select a date from the calendar. Web Client enters the new date and sets the time to 12:00:00 
am. 

Note The default time format is ―12 hours‖ with am and pm. 

Double-clicking the date enters it directly to the field. 

3. To switch to a different month or year, click the Forward or Reverse button. 

4. Click the x button to close the calendar and clear any date you entered.  
Click the ^ button to close the calendar and keep your date entry. 
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Manually Modifying Date and Time Fields 

To edit the date and time: 

1. Select the date and time you want to change. 

2. Enter the new date in the format specified in your user profile (by default, mm-dd-yyyy). 

3. Press the Spacebar. 

4. Enter the time in the format specified in your user profile. This step is optional; if you do not 
enter a time, by default the time displays midnight in the specified format. 

Note Web Client does not accept the new date without a space between the date and 
time. 

To edit just the timestamp: 

1. Select the time you want to change. 

2. Enter the new time in the hh:mm:ss format. 

3. Press the Tab key or the Enter key. 
 

Printing Object Tabs 

You can print information from any tabbed object. 

Attachments are printed from their native applications or from the AutoVue for Agile viewer. For 
more information, see Printing Attachment Files on page 268. 

To print an object in Java Client: 

1. Open the object. 

2. To print all tabs, click the Print button  in the object window. To print a single tab only, click 

the down arrow next to the Print button  and select the appropriate option. 

Note If any of the tabs are blank, that is, contain no visible fields, you cannot print all tabs. 
Instead, select individual tabs to print. 

3. If you select the BOM, the Choose BOM Depth dialog box appears. Select the levels to print, or 
select the All depth checkbox to print all levels. Click OK. A preview of the printout appears in a 
separate dialog box. 

4. Click the Print button  in the Print dialog box. 

To print an object from within a table in Java Client: 

1. In a table, such as Search Results, select the row you want to print. If you want to print more 
than one object at a time, use the Ctrl and Shift keys to select the objects, and then right-click. 

2. Choose Print. 

3. Specify the data that you want to print—all tabs, or a specific tab of information. 
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Note If the selected objects belong to different subclasses (and therefore may contain 
different tabs), the specific first tab name is replaced by Page One. For example, for 
parts and documents, choosing Page One prints the Title Block. 

4. A preview of the printout appears in a separate dialog box. Click the Print button  in the Print 
dialog box. 

For information about the buttons in the Print dialog, click the Help button from within the dialog. 

To print an object in Web Client: 

1. Open the object. 

2. Choose Print from the Actions menu. Indicate whether you want to print all tabs or just the 
current tab. 

If you choose All tabs, specify whether you want the printout to include all levels (for example, of 
the BOM). 

3. Click OK. A preview of the printout appears in a separate window. A Print dialog box opens. 

4. Click the Print button. 

5. Make sure the appropriate print options are selected, and click Print. 
 

Emailing Objects 

You can email any Agile object to another user listed in the Agile address book. Email is sent to the 
email address specified in the Agile user profile. The email contains a URL that links to the mailed 
object, and the recipient can click the URL to view the object in Agile PLM. 

Note The Agile administrator sets your user profile Preferred Client preference to determine 
whether you receive links to Web Client or Java Client. 

To email an Agile object in Java Client: 

1. Open the object. 

2. Choose File > Send, or click the Send button.  

3. In the Send dialog box that opens, click To to open the address book. 

4. In the address book, use the right arrow to move names to the Recipients list, and click OK. 

For information about using the address book, see Selecting Users and User Groups from the 

Address Book on page 22. 

5. Enter any comments in the Comment field. 

6. Click Send to mail the object. 

To email an Agile object in Web Client: 

1. Open the object. 

2. Choose Actions > Send. 

An Available Values list appears on the Send page. Use the right arrow to move names to the 
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Selected Values list. 

3. Enter any comments in the Comments field. 

4. Click Send to mail the object. 
 

Quick Access to Objects and Files 

You can generate quick access URLs that provide direct pointers to either Agile objects or to Agile 
attachment files. 

These quick access URLs can be pasted into other applications or files such as spreadsheet files, 
word processing files, a company Intranet web page or WIKI page, or into an email. 

For information about quick access to Agile objects using quick access URLs, see: 

 Agile-Generated Quick Access Object URLs on page 101 

 Formats for User-Generated Smart Object URLs on page 101 

 Using Quick Access Object URLs on page 102 

For information about quick access to attachment files using attachment quick access URLs, see: 

 Generating Attachment Quick Access URLs on page 291 
 

Agile-Generated Quick Access Object URLs 

From Web Client, you can generate Agile PLM object quick access URLs from the Web Client 
Actions menu. 

To generate an Agile PLM object quick access URL: 

1. Login to Agile PLM Web Client and open the desired object. 

2. In the Actions menu, choose Copy URL to Clipboard. 

3. The URL is copied to your clip board. You can then paste it into another application or file, such 
as a word processing file, a spreadsheet file, or an email. 

 

Formats for User-Generated Smart Object URLs 

The Agile Smart Object URL feature is designed to enable effective collaboration through email, 
spreadsheets, documents, WIKIs, and so forth. Users or automated tools can generate smart 
readable URLs that point to a specific object in Agile. By using the following format, a user does not 
need to log into Agile to generate the object URL. Automated tools can also use this format to 
generate object URLs. 

Smart Object URLs can be used for objects available from Web Client. 

Smart Object URL Format 

URLs for pointing to Agile objects use the following format: 

http://server:port/VirtualPath/object/ObjectType/ObjectName 

http://server:port/VirtualPath/object/ObjectType/ObjectName
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The following table defines the Smart Object URL parameters: 

Parameter  Descript ion  

 

http://server:port/<VirtualPath>/object/<ObjectType>/<ObjectName> 

 

server 

port 

VirtualPath 

Server, port, and VirtualPath identify the Agile PLM instance. 

object The text "object" indicates to Agile that the URL is an object URL. 

ObjectType ObjectType refers to the subclass (type) of object, for example, ECO, Part, 
Manufacturer, File Folder, Program, Activity, or Discussion.  

ObjectName ObjectName refers to the unique identifier for the object. Depending on the 
object class, the unique identifier is either an object number or a name. 

Note Manufacturer Parts are a special class of objects that are uniquely 
identified by two parameters: a Manufacturer Name and a 
Manufacturer Part Number. Therefore, a URL referring to a specific 
Manufacturer Part uses the following format: 

http://server:port/VirtualPath/object/ObjectType/MfrName/MfrPart Number 

Agile PLM identifies and handles special tags (such as %20) added to URLs to handle special 
characters (such as spaces and other special characters such as asterisk "*") in an object's unique 
identifier. For example, the URL 

http://server:port/VirtualPath/object/Manufacturer/Philips%20Semiconductor 

resolves to the manufacturer "Philips Semiconductor". 

Using Quick Access Object URLs 

When a user clicks a Quick Access Object URL, the user actions are the same whether the URL is 
an Agile-generated quick access URL or a user-generated Smart Object URL: 

1. The user clicks the URL and the Agile PLM login screen is displayed in a browser window. 

2. The user enters her login information. 

3. Upon successful login, Agile PLM searches for the object specified in the link. 

(If the object is not found, Agile PLM displays an error and returns to the user's Home page.) 

When the object is found, Agile PLM verifies that the user has the appropriate privileges to read the 
object and displays the object's first tab, for example, the Title Page. 

Discussion Objects 

A Discussion can be created from the main toolbar Create menu, or from a business object’s 

http://server:port/%3cVirtualPath%3e/object/%3cObjectType%3e/%3cObjectName
http://server:port/VirtualPath/object/ObjectType/MfrName/MfrPart
http://server:port/VirtualPath/object/Manufacturer/Philips%20Semiconductor
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Discussions tab. Discussions were implemented for the Product Portfolio Management solution, and 
are also applicable to the Product Cost Management solution; however, discussions can be created 
without special licensing, and their utility can be applied to the other Agile PLM solutions, Product 
Collaboration, Product Governance & Compliance, and Product Quality Management. 

Discussions are always created and viewed in Web Client. To access a discussion while using Java 
Client, you can search to locate an existing discussion and open the object, which will open Web 
Client. Or you can simply open Web Client and proceed from there, including creating discussions. 
A discussion object always displays as a popup. 

The following objects classes have a Discussions tab: Sourcing Projects, Request for Quote, RFQ 
Responses, Activities, and Gates. 

Creating and Viewing Discussions 

When you create a discussion, starting at the Create menu (see Creating Objects in Web Client 

Using the Create Command on page 93), you fill in information on the Discussion tab and click OK. 
The new Discussion object appears as a ―pop-up,‖ that is, it displays differently than all other 
business objects in Agile. On the Discussion tab of a discussion, there are four main sections: 

 Page One–type information, such as the discussion’s ID number, Subject, Status, Priority, 
Subject, and Notify List 

 Message Thread table, which is a list of all the replies in the discussion 

 Message table, which is the specific reply message based on the row selection in the Message 
Thread table 

 Action Items table, which lists action items that have been associated with the discussion 

At the top are navigation buttons: Add Action Item, Add Attachment, Join, Print, and the Actions menu. 
The Join action adds the user to the Notify List.  

When you click the Preview Message checkbox, the Message Thread table expands to show the 
beginning of the reply message. The message is truncated; you can ―mouse over‖ the reply 
message to see the full reply message as a tooltip. You can also click on a reply message to see 
the full reply message in the Message table. 

Adding To and Editing Discussions 

When the owner/creator opens the Discussion popup, the Page One–type information is editable. 
The owner can update the discussion. 

When you select a specific reply in the discussion thread table, and then click the Reply button, you 
can add users to the Notify List—but not remove any—and enter a reply. The author of any reply 
can edit the reply at any time. 

Action Items can be created or deleted by users (on the Notify List) who have sufficient privileges. 

Sharing Objects with Other Users 

Sharing lets you grant one or more of your roles to another Agile user or user group for specific 
objects. The capability to share a given role requires being assigned the Grant privilege specific to 
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that object. You can share only your assigned roles, that is, the roles that are listed in the Roles field 
on the General Info tab of your user profile, and the roles that are listed in the Roles field on the 
General Info tab of any groups of which you are a member. 

You cannot share roles that have been shared with you by another user, and you cannot share 
roles that have been shared with a user group to which you belong. 

When a role has been shared with a user (or members of a user group), each user can then 
perform actions permitted by the roles for that object only; a user does not ―acquire‖ the role in any 
permanent or far-reaching way. 

A user’s or user group’s Share tab lists those objects for which the user has been granted ―shared 
roles‖ by a different user. Click the Share tab in your user profile to see objects being shared with 
you and what role(s) allow and define your interaction with each object. If you belong to a user 
group, you can see objects being shared with you via the user group by opening the group object 
and clicking the Share tab. 

To share an object in Java Client: 

1. Display the object. 

2. Right-click anywhere in the object and choose Sharing. 

Or, use the More menu and choose Sharing. 

The Share <named object> window appears. 

3. Click the Add button. The Add Access Control Entry dialog box appears. 

4. Click ; the Address book appears. Select the Names or Groups tab, and move those you want 
to the Recipients list. 

5. Click OK. All users in the Selected Users list will appear in the Users field. 

6. Now select an appropriate role or roles for your chosen users to have available in connection 
with this object. 

7. Click OK. The Share <named object> window appears again displaying the selected users and 
selected roles. 

8. Click Close. This returns you to the original object. Click Refresh. Note that when you right-click 
and choose Sharing, the Share window now shows you the complete list of users who have 
access to this object and the roles you specified. 

To share an object in Web Client: 

1. Display the object. 

2. In the Actions menu, choose Sharing. The Access Control List: Share with Users page appears. 

3. Click Add. The Identify Users page of the Add to Access Control List wizard appears. 

4. Use the Filter by drop-down list to choose All Users, All Groups, or a specific group. The list you 
selected appears, and you can select one by one or select multiple users/user groups. 

You may type a user’s name, fully or partially, but you have to select a group first to populate 
the Available Users list. 

The Save As Group button allows you to create a group on the fly of the users that appear in the 
Selected Users list. Note, however, that this process only creates a new user group (personal or 
global); it does not add the new group to the Share list. 
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5. Click Next. The Assign Roles page appears. Select appropriate role or roles for your chosen 
users to have available in connection with this object. 

6. Click Finish. The Share with Users page appears again displaying the selected users and 
selected roles. 

7. Click Return. This returns you to the original object. Note that choosing Actions > Sharing now 
shows you the complete list of users who have access to this object and the roles you 
specified. 

To remove a shared object from the Share tab of your user profile, select the object and click 
Remove. 

Subscribing to Objects 

Subscribing to an object sets you up to receive notification of events that happen to that object. For 
example, you might subscribe to a change in order to be notified when the change is released, or 
you might subscribe to an attachment in order to be notified when the attachment is checked in. 
You can also be notified when specified fields are modified. You select the events about which to be 
notified. If you want to be notified when certain fields change, you specify those fields. 

You must have the Subscribe privilege for a specific object class to be able to subscribe to that 
class’s objects. See your Agile administrator if you need to be assigned additional privileges. 

On the Subscription tab of your user profile, you can view the objects to which you have subscribed. 
To cancel or remove a subscription, select the object, and click Remove. 

Subscription events trigger two types of notifications: Email and Inbox. Email notifications are sent 
only if your Receive Email Notification preference is set to Yes; this field is on the Preferences tab of 
your User Profile. The ability to edit user information is determined by your privileges. 

Subscribing to an Item or Price Revision 

It is possible to subscribe to an item revision change and a price revision change. Since you cannot 
subscribe to specific status change (for example, changed to Released) for a change that ―revs‖ the 
Item (an ECO) or the Price object (a PCO), subscribing to the object itself—the part, document, or 
price—is the way you can be notified that the object has been ―rev’d.‖ 

Subscribing to Attachments via the File Folder 

Should you want to be notified of changes to a file folder, subscribe to its Checkin File events. The 
version number of File Folder objects automatically increments every time they are checked in. 
However, it is not possible to subscribe to file folder versions, which work differently than item 
revisions. So, subscribing to a file folder’s Checkins is the way you can be notified that the file folder 
has been altered; file folders are not subject to changes (objects from the various change classes). 

Subscribing to Objects in the Clients 

To subscribe to an object in Java Client: 

1. Display the object. 
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2. Right-click the object and choose Subscribe. 

Or, use the More menu and choose Subscribe. 

3. Indicate whether you want to be notified when the subscribed object is modified by selecting 
the appropriate Subscriptions checkboxes. You can select one or more: 

 Lifecycle Phase Change (or Status Change if it is a routable object) 

 Field Change 

Select from the displayed list of fields. Your Agile administrator determines which fields are 
available for subscription. 

 Revision Change (items and prices) 

 Add File 

 Delete File 

 Checkin File 

 Checkout File 

 Cancel Checkout File 

4. Click Save. A message indicates that your subscription was saved. 

To subscribe to an object in Web Client: 

1. Display the object. 

2. Choose Actions > Subscribe. The Define Subscriptions page appears. 

3. Indicate whether you want to be notified when the subscribed object is modified by selecting 
the appropriate Subscriptions checkboxes. You can select one or more: 

 Lifecycle Phase Change (or Status Change if it is a routable object) 

 Field Change 

Select from the displayed list of fields. Your Agile administrator determines which fields are 
available for subscription. 

 Revision Change (items and prices) 

 Add File 

 Delete File 

 Checkin File 

 Checkout File 

 Cancel Checkout File 

4. Click Save. 
 

Subscription in Product Portfolio Management 

The events you can subscribe to vary per object. Product Portfolio Management has the following 
Activity-specific subscription events that do not apply to other objects: 

 Add Discussion 

 Reply to Discussion 
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 Add News 

 Add Action Item 

 Modify Schedule 

The Apply to Children checkbox in activities and gates ―push‖ a subscription to all child objects. If you 
subscribe to an activity that has a schedule and select this checkbox, you will automatically 
subscribe to all of the activity’s programs, phases, and tasks (that is, any object created in the out-
of-box subclasses of Activities class). Because Page Two and Page Three fields can be defined 
differently for programs, phases, and tasks, any of the attributes that do not apply are ignored. 

Relationships and Dependencies Between Objects 

This section includes the following topics: 

 What are Relationships? on page 107 

 Relationships Tab on page 108 

 Relationships Tab Views on page 108 

 Relationship Tab Actions in Java Client on page 109 

 Relationship Tab Actions in Web Client on page 110 

 Using the Table Filter on page 111 

 Adding Relationships to Objects on page 112 

 Editing the Relationships Table on page 113 

 Removing Relationships on page 113 

 What is a Relationship Rule? on page 114 

 Relationship Rule Guidelines on page 114 

 Adding a Rule to a Relationship on page 115 

 Editing a Relationship Rule on page 116 

 Removing a Relationship Rule on page 116 

 Relationships in PQM on page 117 
 

What are Relationships? 

You can associate objects to each other by using the Relationships tab. A relationship between two 
Agile objects is bi-directional and is displayed on the Relationships tab of both objects. 

Note In Agile PPM, relationships are called deliverables and are managed on the PPM object 
Contents tab. For more information about the PPM Contents tab, see Agile Product 
Portfolio Management User Guide. 

Specifying a rule for a relationship defines how the related Agile objects affect each other. For 
example, you can define a relationship rule so that ECO_100 affects ECR_250. When ECO 100 
reaches the Implemented status, ECR_250 is promoted to the Complete status automatically. 
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Note Rules are optional; you can create a relationship between two objects without specifying 
a rule. 

A relationship is created when you add an object to a table in the Relationships tab of another object. 
The classes of objects that can reference each other on a Relationships tab are: 

 All object classes, except Reports and Action Items. 

 For Agile PPM Programs classes, relationships are named deliverables and are included on 
the Content tab. 

Your Agile administrator configures the Agile PLM system to enable the Relationships tab for each 
object class, making it visible. If you find that you want to create a relationship between objects and 
those tabs are not visible, see your Agile administrator. 

Once you create relationships between objects, you can also create an advanced search for such 
relationships. See Relationship Searches on page 190. 

A relationship without a rule is a simpler, less dynamic instance of object-to-object relationship; it 
simply lists references to other objects. It can be thought of as ―bi-directional‖ information, because 
relationships without rules do not trigger events. 

Relationships Tab 

By default, the Relationships table for each object class displays the following columns. Your Agile 
administrator may enable additional columns. If you have questions about the configuration of the 
Relationships tabs in your Agile system, see your Agile administrator. 

Defaul t  a t t r ibute  Descript ion  

Criteria Met If the relationship has a rule, the Criteria Met icon  in this column indicates that the 
criteria specified in the rule has been met. 

Name The object name or object number that uniquely identifies the related object. 

Description The description that appears in the Description field of the related object. 

Current Status The current workflow status or lifecycle phase of the related object. 

Rule The rule defined for the relationship. If no rule is defined, this column is blank. 

Type The object type (or subclass) of the related object. 

 
 

Relationships Tab Views 

Use the View drop-down list to sort the relationships table rows. See also Using the Table Filter on 
page 111. 

View opt ion  Descript ion  

All Relationships Displays all relationship table rows. 
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View opt ion  Descript ion  

All Relationships Displays all relationship table rows. 

Complete Displays relationships that have a rule specified and the criteria of the rule has 
been met. 

Pending Displays relationships that have a rule specified and the criteria of the rule has 
not been met. 

Rule Not Specified Displays relationships that do not have a rule specified. 

 
 

Relationship Tab Actions in Java Client 

In Java Client, buttons on the Relationships tab allow you to add, edit, and remove relationships and 
relationship rules. 

Button o r  Descript ion  

 

Edit Relationship 

Allows you to edit the selected rows. See Editing the Relationships 

Table on page 113. 

If your Agile administrator has enabled relationship table attributes in addition 
to the default attributes, you can edit the additional attributes if you have the 
appropriate privileges. 

 Add > Search 
Add a relationship to the table by searching for the object you want. See 
Adding Relationships to Objects. 

 Add > Create Add a relationship to the table by creating a new object. See Adding 

Relationships to Objects on page 112. 

 

Remove Relationship 

Removes the selected relationship table rows. See Removing Relationships. 

 

Edit Rule 

Edit the rules in the selected relationship table rows. See Editing a 
Relationship Rule. 

 

Add Rule 

Adds a rule to the selected row by opening the Relationship Rule dialog for 
you to specify a rule. See Adding a Rule to a Relationship. 

 

Remove Rule 

Remove the rules from the selected relationship table rows. See Removing a 
Relationship Rule. 

 

Show Filter 

Hide Filter 

Opens the filter tool, which allows you to sort the relationships table by 
multiple criteria. 

If the filter tool is presently displayed, clicking this button hides the filter tool. 

See Using the Table Filter. 

 
 



 

 

110 Agile Product Lifecycle Management 

  

Relationship Tab Actions in Web Client 

In Web Client, buttons on the Relationships tab and buttons in the preview pane allow you to add, 
edit, and remove relationships and relationship rules. 

Button o r  Descript ion  

 

Edit Relationship 

Allows you to edit the selected rows. See Editing the Relationships 

Table on page 113. 

If your Agile administrator has enabled relationship table attributes in addition 
to the default attributes, you can edit the additional attributes if you have the 
appropriate privileges. 

 Add > Search Add a relationship to the table by searching for the object you want. See 
Adding Relationships to Objects on page 112. 

 Add > Create New 
Add a relationship to the table by creating a new object. See Adding 

Relationships to Objects on page 112. 

  Remove Removes the selected relationship table rows. See Removing 

Relationships on page 113. 

Show Filter Opens the filter tool, which allows you to sort the relationships table by 
multiple criteria. See Using the Table Filter on page 111. 

Modify rule buttons which appear in the preview pane: 

Add Rule Add a rule for the selected relationship. See Adding a Rule to a 

Relationship on page 115. 

Edit Rule Edit the rule for the selected relationship. See Editing a Relationship 

Rule on page 116. 

Remove Rule Remove the rule from the selected relationship. See Removing a 

Relationship Rule on page 116. 

 
 

Relationships Tab Preview Pane in Web Client 

In Web Client, when you select a row in the relationships table, additional information about the 
related object is displayed in the preview pane, which is the lower pane under the table. 

For all Agile objects that are listed on the relationships table: 

 The relationship rule is displayed in the preview pane. Use the buttons in the preview pane to 
add, edit, or remove a rule. 

 The attachments table is displayed in the preview pane. 

In addition, specific Agile object types include additional information and actions in the preview 
pane: 

 For Item objects, you can view and perform actions: 

 Use the Revision drop-down list to select a different revision to view. 
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 Pending Changes table. You can use the Create Change button to create a new change for 
that item. 

 Attachments table. You can use the Remove, Add, Checkout, Cancel Checkout, Checkin buttons 
to work with the item’s attachments. 

 For Change objects, you can view: 

 Affected Items table. 

 For File Folder objects, you can view: 

 Files table. 

 For Agile PPM Gates objects, you can view: 

 Contents table 

 Signoff table 

 For Agile PPM Activity objects, you can view and perform actions: 

 Contents table. You can Open the content objects. 
 

Using the Table Filter 

The Relationships tab in both Java Client and Web Client includes a table filter. 

The  Show Filter and  Hide Filter button toggles the display of the table filter. The table filter 
allows you to define filter criteria based on any column in the table. You can define multiple filter 
criteria, which are combined in an AND search of the table rows. 

For example, you can filter for relationships whose Description column includes the word marketing 
and the Rule column is Not Null (the relationship has a rule). 

The format of each filter criteria row is similar to an Agile search criteria: 

<attribute> is <Match If Operator> <value to match> 

To use the Table filter: 

1. On the Relationships tab, click  Show Filter to display the Filter: criteria. 

2. In the first filter drop-down list, labeled --Select an Attribute--, choose from a list of the columns in 
the assignments table. 

3. In the next drop-down list, choose a Match If operator. The list of available Match If operators 
depends on the attribute type you chose as the --Select an Attribute-- drop-down list. 

For more information, see Search Operators and Attribute Types on page 175. 

4. In the remaining field, enter the filter values. 

 To add a filter criteria row, click the  Add Row at the end of the row. A filter criteria row is 
added to the display. 

 To delete a filter criteria row, click the  Delete Row at the end of the row. The row is 
deleted. 

5. Click Apply to filter the relationships table. Only relationships that match your filter criteria are 
displayed. 
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6. To define different set of filter criteria, click Clear to clear the criteria and begin again. 
 

Adding Relationships to Objects 

You can add objects to the relationships table of any object. The relationship is listed on the 
Relationships tabs of both objects. You must have the appropriate modify privileges for both objects 
in the relationship: the object to which you are adding the relationship and the related object. 

To add a relationship to an object in Java Client: 

1. Go to the Relationships tab of the object. 

2. To add by search, click the Add button drop-down list and select Search. 

a. In the Add Relationship dialog, choose a search method: 

 Enter the value to search for and click Search to perform a quick search. 

 Define an advanced search. 

 Run a saved search. 

 Select a bookmarked or recently visited item (Shortcuts). 

a. In the search results, select the objects you want, move them to the Select Related 
Objects list. 

b. When you are finished, click OK. All the objects in the Selected Related Objects list are 
added to the relationships table. 

3.  To add by creating a new object, click the Add button drop-down list and select Create. 

a. In these New dialog, select a type from the Type drop-down list. 

b. If appropriate, enter an object number and complete any required fields. 

c. Click OK. The new object is added to the relationships table. 

To add a relationship or reference to an object in Web Client: 

1. Go to the Relationships tab of the object. 

2. To add by search, click the Add button drop-down list and select Search. 

a. In the Add Relationship dialog, choose a search method: 

  Quick Search — Enter search criteria and click  to run search. See Web Client 

Quick Search on page 151. 

  Search Folders — Opens a Saved Searches dialog. From your search folders, select a 
saved search and click OK. See Saved Searches on page 147. 

  Bookmarks — Displays the Bookmark table. Click + to open bookmark folders. Select 
a bookmark, and click Add Selections. 

  Recently Visited — Displays the Recently Visited table. Select one or more rows, and 
click Add Selections. 

  Advanced Search — Opens the Advanced Search definition dialog. Define a search, 
and click Run. In the search results table, select one or more rows and click Add Selections. 
See Advanced Searches on page 165. 

  Parametric Search — Opens a parametric search dialog. Define a search, and click 
Search. In the search results table, select one or more rows and click Add Selections. See 
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Pre-configured Parametric Searches on page 157. 

a. When you are finished making your selections, click OK in the Add Relationships dialog. 
The objects are added to the relationships table. 

3.  To add by creating a new object, click the Add button drop-down list and select Create New. 

a. In the New dialog, select a type from the Type drop-down list. 

b. If appropriate, enter an object number and complete any required fields. 

c. Click OK. The new object is added to the relationships table. 
 

Editing the Relationships Table 

With the appropriate privileges, you can edit the non-default attributes of the relationships table of 
any object. Default relationship table attributes cannot be edited. For a list default relationship table 
attributes, see Relationships Tab on page 108. If no non-default attributes are enabled for the 
relationships table you are viewing, the Edit button may be disabled. 

Note You cannot add, edit, or remove relationship rules with the relationship table edit feature. 
For more information about relationship rules, see Relationships and Dependencies 
Between Objects. 

To edit a relationship in Java Client: 

1. Open the object you want and click the Relationships tab. 

2. In the table, select the rows you want to edit. 

3. Click the Edit button. The rows are in edit mode. 

4. Make the changes, and click Save. 

To edit a relationship in Web Client: 

1. Open the object you want and click the Relationships tab. 

2. In the table, select the rows you want to edit. 

3. Click Edit. The fields become editable. 

4. Make the changes, and click Save. 
 

Removing Relationships 

When you remove a relationship, it is removed from the Relationships tab of the current object and 
from the Relationships tab of the related object. Any rules associated with the relationship are also 
removed. 

To remove a relationship in Java Client: 

1. In the table from which you want to remove objects, select the object that you want to remove. 

2. Click the corresponding  Remove Relationships button. You are prompted to confirm your 
choice. 
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To remove a relationship in Web Client: 

1. In the table from which you want to remove objects, select the objects you want to remove. 

2. Click the corresponding  Remove button. You are prompted to confirm your choice. 
 

What is a Relationship Rule? 

Specifying a rule for a relationship defines the manner in which one Agile object can affect the 
workflow status of another Agile object. A relationship rule includes a Source Object, an Event, a 
Target Object, and a Result. The format of a relationship rule is shown in the following sentence: 

When <Source Object> is <Event>, set <Target Object> to <Result>. 

That is, an Event in the Source Object triggers a Result in the Target Object. 

 A Source Object can be either a routable object with a workflow (for example, a change order 
or a program object) or a non-routable object with a lifecycle phase (for example, a part or a 
document). 

 An Event is a change in the workflow status or a change in the lifecycle phase of the Source 
Object. 

 A Target Object is always a routable object with workflow statuses. 

 A Result is always a change in the Target Object’s workflow status. 

Here are some examples of relationship rules: 

When ECO_100 is Implemented, set ECR_334 to Closed. 

When ECO_565 is Released, set NCR_009 to Closed. 

When Part_945 is Production, set Task_Design_Assembly to In Process. 

When Document_934 is Prototype, set ECO_3445 to Released. 

When Part_D457 is Prototype, set Task_Promote_BOM_to_Prototype to Complete. 

When FileFolder0098 is Concept, set Audit_0061 to Initiated. 

The resulting change in the Target Object’s workflow status also requires that all other the 
conditions required for the workflow to advance have been met. For example, for a change order to 
be released, it must pass a release audit. If the relationship rule triggering event occurs, but the 
change order does not pass the release audit, its workflow status will not change. In a similar 
manner, if a change order passes its release audit, but the relationship rule triggering event has not 
occurred, the change order workflow status will not change. In both cases, when all the required 
criteria are fulfilled and the relationship rule triggering event has occurred, the Target Object’s 
workflow status will change. 

Relationship Rule Guidelines 

The following guidelines and restrictions apply to relationship rules: 

 You cannot define a rule for a workflow object if no workflow has been selected for that object. 
Rules are based on workflow statuses and workflow statuses are defined by each workflow. If a 
routable object is Unassigned (it has no workflow assigned) then there is no identified list of 
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statuses to select when defining a relationship rule. 

 Only one rule can be defined for each relationship table row. However, you can add the same 
object to the relationship table in multiple rows and define a different rule for each row. 

 If you want two objects to advance through their respective workflows simultaneously, you 
create relationship entries for each status. 

 The Criteria Met column in the relationship tables indicates that the Source Object’s triggering 
event has occurred. If the triggering event is that the Source Object’s workflow status changes 
to Status_02, but the workflow status was manually changed to Status_03, skipping over 
Status_02, the Target Object’s event (workflow status change) will not occur. If you remove the 
relationship row or you remove the relationship rule, the Target Object’s event can occur. 

 The Criteria Met field, once checked (the Complete icon  appears) is not ―unchecked‖ if an 
object is returned to earlier status for other reasons. 

 A relationship rule causes the Target Object only to advance in its workflow, never to return to 
a status it has already left. 

 A non-routable object with no workflow, for example, an item, can be a Source Object but it 
cannot be a Target Object. You can create a rule between a non-routable object and a routable 
object only when the non-routable object is the Source Object. 

 You can create a relationship without a rule between two lifecycle phase, non-routable objects. 
Agile PLM will not allow you to create a rule between two non-routable objects. 

 The relationship rule can be defined from the Relationships tab of either object. 

 You must have the appropriate ―modify relationship‖ privilege for both objects to create a 
relationship without a rule between two objects. To create a rule between two related objects, 
you must, in addition, have the appropriate ―modify rule‖ privilege for both objects. 

The ―modify rule‖ privilege allows you to specify a routable object as the Target Object in a rule. 
That is, it allows you to specify a rule that triggers a modification (Result) in the Target Object. 

When both objects in a relationship are routable objects, if you do not have ―modify rule‖ 
privilege for one of the objects in that relationship, in any rule you create, that object can be 
only the Source Object (because it will not be modified when the rule criteria is met); it cannot 
be the Target Object. 

Note If there are relationships with rules defined for multiple statuses of a single routable 
Target Object, the system checks that related events that apply to earlier result statuses 
have been met before advancing the workflow. For example, for a specific Target Object, 
if there are events defined for both Submitted and Released statuses, and the events for 
the Released status are satisfied, the system will not advance the Target Object’s 
workflow to Released status until the events for the Submitted status are also satisfied. 

 

Adding a Rule to a Relationship 

To add a rule to a relationship in Java Client: 

1. On the Relationships tab, select the table row of the related object to which you want to add a 
rule. 

2. Click the Add Rule  button. 
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Note If the Add Rule button is disabled, it is not possible to add a rule to the selected 
relationship because both objects are non-routable objects. 

3. In the Relationship Rule dialog, use the drop-down lists to define the rule. 

4. When you are finished, click OK. 

To add a rule to a relationship in Web Client: 

1. On the Relationships tab, select the table row of the related object to which you want to add a 
rule. 

2. In the preview pane, click the Add Rule button. 

Note If there is no Add Rule button in the preview pane, it is not possible to add a rule to 
the selected relationship because both objects are non-routable objects. 

3. In the Relationship Rule dialog, use the drop-down lists to define the rule. 

4. When you are finished, click Save. 
 

Editing a Relationship Rule 

To edit a rule to a relationship in Java Client: 

1. On the Relationships tab, select the table row of the related object to which you want to edit a 
rule. 

2. Click the Edit Rule  button. 

3. In the Relationship Rule dialog, use the drop-down lists to edit the rule. 

4. When you are finished, click OK. 

To edit a rule to a relationship in Web Client: 

1. On the Relationships tab, select the table row of the related object to which you want to edit a 
rule. 

2. In the preview pane, click the Edit Rule button. 

3. In the Relationship Rule dialog, use the drop-down lists to edit the rule. 

4. When you are finished, click Save. 
 

Removing a Relationship Rule 

To remove a rule to a relationship in Java Client: 

1. On the Relationships tab, select the table row of the related object to which you want to remove 
a rule. 

2. Click the Remove Rule  button. 

3. You are prompted to confirm your choice. 
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To edit a rule to a relationship in Web Client: 

1. On the Relationships tab, select the table row of the related object to which you want to remove 
a rule. 

2. In the preview pane, click the Remove Rule button. 

3. You are prompted to confirm your choice. 
 

Relationships in PQM 

This is some additional information about relationships as they are used in the PQM solution: 

Important When relationships are created between PQM objects, a blank rule is created for the 
relationship. You must edit the blank rule to define how you want the PQM objects to 
affect each other. 

 When a QCR affects the PSR, that is, when a QCR and PSR are related and the relationship 
rule follows the format: 

When <QCR source object> is <event>, set <PSR target object> to <result> 

all items from the PSR Affected Items tab are displayed on the PSR Items table of the QCR. If 
the PSR was used to aggregate multiple PSRs, then the related PSRs’ affected items are 
displayed. 

 When this QCR is affected by a PSR, that is, when the QCR and the PSR are related and the 
rule follows the format: 

When <PSR source object> is <event>, set <QCR target object> to <result>. 

all items from the PSR Affected Items tab and the related PSR’s affected items are not displayed 
on the PSR Items table of the QCR. 

Deleting Agile Objects 

Java Client and Web Client support ―soft‖ and ―hard‖ deletes. When you soft-delete an object in the 
database, it is not permanently deleted. A soft-deleted object is marked ―Deleted‖ in the database, 
and its object number is reserved. You cannot create another object with the same type and 
number as a soft-deleted object. 

Note You can undelete a soft-deleted object, if you have the appropriate privileges. If you 
need to do so, but do not have privileges, contact the Agile administrator. 

This section contains the following topics: 

 Soft-Deleting an Object on page 119 

 Undeleting an Object on page 120 

 Hard-Deleting an Object on page 120 

When you run a search, soft-deleted objects do not appear in the search results table. To locate 
soft-deleted objects, you must run the predefined deleted object searches in the Recycle Bin Searches 
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folder. 

Note You have access to the Recycle Bin Searches folder if Recycle Bin Searches is included in the 
Searches field of your user profile. If you have the appropriate privileges, you can edit 
your user profile and add Recycle Bin Searches to the list of searches in the Searches field. 
If you do not have the appropriate privileges to modify the Searches field in your user 
profile, ask the Agile administrator to modify your user profile. 

A hard-deleted object is permanently removed from the database. 

Caution You cannot undelete a hard-deleted object. 

Before you can delete an object, it must meet the conditions described in the following table. 

Note You cannot delete an object unless all of its relationships and subscriptions are removed. 

 

Class o r  
base c lass 
of  object  

You can  delete  th is  k ind  of  object  that  meets  the fo l lowing 
condi t ions:  

Item  The item has no released changes against it. 

 The item is not listed on the Affected Items tab of any pending change. (You must first 
remove the item from the Affected Items tab of each pending change before you can 
delete the item.) 

 The item has no content on its BOM tab for the current revision or any pending 
revisions. 

 The item has no content on its Manufacturers tab for the current revision or any 
pending revisions 

 The item is not used on any other item's Bill of Materials, that is, the item to be deleted is 
not a child item on the BOM tab of a parent item revision, including the latest released 
revision, past released revisions, or pending revisions of the parent item. 

Change  You are the change analyst or component engineer, and the Agile administrator has 
given change analysts or component engineers the appropriate privileges to delete a 
change. 

 The change is at the Pending status type or the Unassigned status. 

 You have Discovery and Read privileges for any items on the Affected Items table, 
otherwise, you cannot delete the change. 

Note To delete a change that has already been released, you must first unrelease the 
change. You need the appropriate privileges to unrelease a change by using the 
Workflow tab to switch it to a different status. 

Manufacturer  It is not listed on the Manufacturers tab of an item. (Check the Where Used tab of the 
manufacturing object.) 

 If the object is a manufacturer, no manufacturer parts are associated with it. 

Note If all manufacturer parts associated with a manufacturer have been deleted, then the 
manufacturer can be deleted as well. However, you will not be allowed to undelete the 
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Class o r  
base c lass 
of  object  

You can  delete  th is  k ind  of  object  that  meets  the fo l lowing 
condi t ions:  

soft-deleted manufacturer parts until the soft-deleted manufacturer object is 
undeleted. 

Site Note Unlike other Agile objects, site objects can be soft deleted, but soft-deleted sites 
cannot be undeleted or hard deleted. If you are no longer using a site, Agile 
recommends that you disable it. 

 The site does not appear on any item’s Sites tab. 

 The site is not associated with any other Agile object. 

 The site has a lifecycle of Disabled. 

Note If it meets the conditions listed above, a disabled site can be soft-deleted even when it 
is listed in the Sites or Default Site field of user profiles. The deleted site is 
automatically removed from the Sites list in any user profile where it is listed. 

Once the site has been associated with an item, you can change its status to Disabled, but 
you cannot delete it. 

Package  You are the program manager, and the Agile administrator has given program managers 
the appropriate privileges to delete a package. 

 The package is at the Pending status type or the Unassigned status. 

Transfer 
Order 

 The Agile administrator has given you the appropriate privileges to delete a transfer 
order. 

 The transfer order is at the Pending status type or the Unassigned status. 

PSR or QCR  The Agile administrator has given change analysts or component engineers the 
appropriate privileges to delete a PSR or QCR. 

 The PSR or QCR is at the Pending status type or the Unassigned status. 

 You have Discovery and Read privileges for any items on the Affected Items table; 
otherwise, you cannot delete the PSR or QCR. 

Note To delete a PSR or QCR that has already been released, you must first unrelease it. 
You need the appropriate privileges to unrelease a PSR or QCR by using the 
Workflow tab to switch it to a different status. 

RFQ  The RFQ has no released changes against it. 

 
 

Soft-Deleting an Object 

To soft-delete an object in Java Client: 

1. Select and open the object you want to delete. 

2. Click the Delete button , and respond Yes to the confirmation prompt. 
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The object is soft-deleted. It is no longer available for use. However, until it is hard-deleted, its 
number or name is reserved in the Agile database and cannot be reused. 

To soft-delete an object in Web Client: 

1. Select and open the object you want to delete. 

2. Choose Actions > Delete, and respond OK to the confirmation prompt. 

The object is soft-deleted. It is no longer available for use. However, until it is hard-deleted, its 
number or name is reserved in the Agile database and cannot be reused. 

See also: Deleting Agile Objects on page 117, Undeleting an Object on page 120, and Hard-

Deleting an Object on page 120. 

Undeleting an Object 

You can undelete soft-deleted objects. 

To undelete an object in Java Client: 

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder. 

2. Open the deleted object you want to restore. 

3. Click the Undelete button . 

To undelete an object in Web Client: 

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder. 

2. Open the deleted object you want to restore. 

3. Choose Actions > Undelete. 
 

See also: Deleting Agile Objects on page 117, Soft-Deleting an Object on page 119, and Hard-

Deleting an Object on page 120. 

Hard-Deleting an Object 

Soft-deleted objects still exist in the database. To remove an object permanently, you hard-delete it. 
While an object is still only soft-deleted, you can undelete it. Run the appropriate Deleted object 
search from the Recycle Bin Searches folder. 

To hard-delete a soft-deleted object (if you have the appropriate privileges) in Java Client: 

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder. 

2. Open the object. 

3. Click the Delete Object button , and respond Yes to the confirmation prompt. 

To hard-delete a soft-deleted object (if you have the appropriate privileges) in Web Client: 

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder. 

2. Open the object. 
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3. Choose Actions > Delete, and respond OK to the confirmation prompt. 
 

See also: Deleting Agile Objects on page 117, Undeleting an Object on page 120, and Soft-

Deleting an Object on page 119. 
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Chapter 6 

Working with Agile Reports 

This chapter includes the following: 

 About Reports ...................................................................................................................................................... 123 
 General Info Tab .................................................................................................................................................. 125 
 Layout Tab ........................................................................................................................................................... 126 
 Schedule Tab ....................................................................................................................................................... 134 
 Historical Report Tab ........................................................................................................................................... 135 
 History Tab .......................................................................................................................................................... 136 
 Working with Standard Reports ........................................................................................................................... 136 
 Working with Custom Reports ............................................................................................................................. 137 
 Working with External Reports ............................................................................................................................ 141 
 The Report Output Window ................................................................................................................................. 142 

 
 

About Reports 

Reports provide you with the basic information you need to analyze your business processes. By 
accessing and summarizing this information in a meaningful way, reports provide an insight into 
your business processes and can help guide better-informed decisions. Agile PLM provides a 
robust reporting platform that allows you to: 

 Measure and monitor business performances using standard out-of-the-boxes reports. These 
standard reports capture the best practices in product lifecycle management business 
processes. 

 Configure reports with Agile's custom reporting to obtain the specific information you need. 

 Use a single point of access to all relevant reports - even those developed outside of the Agile 
PLM application - through Agile's external reporting capability. 

 

Types of Reports 

Agile provides the following types of reports: 

Report  type  Image  
type  

Descript ions  

Standard Reports   Standard reports provide you with the information you commonly need 
to analyze your business processes. You select predefined criteria and 
specify the results you want. 

Each solution has its own set of reports. Specific reports are described 
in the user guides. 

For more information, see Working with Standard Reports on 
page 136. 
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Report  type  Image  
type  

Descript ions  

Custom Reports  You can create custom user-specific or company-specific reports 
directly within Agile. You define your query using the Query Definition 
feature, which is similar to an Advanced Search. The custom reports 
provide a high level of flexibility. You can select which objects to report 
on, define the filtering criteria, and specify report output. 

For more information, see Working with Custom Reports on 
page 137. 

External Reports 
 

You can create reports outside of Agile using any third-party solution, 
such as SDK or other tools. You can then create linked access directly 
within Agile to launch those external reports. This is accomplished 
through configuring process extensions in Agile Administrator and 
adding URLs. 

For more information, see Working with External Reports on 
page 141 and see Agile PLM Administrator Guide. 

 
 

How Your Roles and Privileges Affect Reports 

The reports that you are allowed to manage or run, and the content of those reports, are affected by 
the privileges assigned to you, for both business objects and report objects. 

You can create, view, edit and delete reports depending on the roles and privileges assigned to 
you. To run a report on a particular type of object, a user must be granted the following privileges: 

 Business object privileges 

If you do not have the Discovery privilege for a given business object, you cannot include that 
object in a report. Parts for which you do not have the Discovery privilege are displayed in the 
same way as they are displayed on BOMs. 

All the Discovery privileges that are set up for your Agile content will be observed when you run 
a report with that content, including all Discovery-related SmartRule settings and warnings that 
the Agile administrator has specified. For more information about Discovery privilege and 
SmartRules, see Agile PLM Administrator Guide. 

 Report object privileges for standard reports 

To run and view standard reports, you must have Run Report, Discover, and Read privileges 
for the standard report you want to run. Agile supplies a number of predefined roles that 
provide the ability to use specific types of business objects and to run standard reports relating 
to those business objects. For example, depending on your assigned roles, you may be able to 
run standard reports in the Products Reports folder, but not standard reports in the Quality 
Reports folder. 

 Report object privileges for custom reports 

In addition to Run Report, Discover, and Read privileges, custom reports require additional 
privileges: Create, Delete, Modify. The Undelete, SaveAs and Send privileges provide 
additional custom report capabilities.  
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 Report management privileges 

To modify and delete report schedules and layouts, or to create and delete global reports 
folders, you need the Manage Report privilege. 

To manage Static Template framework you need the Manage Report Templates privilege along 
with the Administrator and Manage Report privileges. In addition to performing the static 
template management you can also Create, Edit, Remove, Get, Replace template files. 

The Agile-provided predefined roles Report User and Report Manager contain the privileges you 
need to work with custom reports. 

Note In addition to assigning Agile-provided predefined roles, your Agile administrator is able 
to create customized roles for your company. Your assigned roles (either predefined 
roles or customized roles) determine which types of standard reports you can run and 
whether or not you are able to create and run custom reports. 

For more information about the privileges that affect reports or about roles and predefined roles, 
see Agile PLM Administrator Guide. If you have questions about your assigned roles and privileges 
or about your ability to run reports, contact your Agile Administrator. 

General Info Tab 

The General Info tab contains the general information about the reports. It has the following fields by 
default; your Agile Administrator may have modified the fields: 

 Name — the name of the report. 

 Report Type — indicates the report type (subclass) for each class of reports. 

 Standard Report Type — indicates the standard report type, either Standard or Administrator. 

 Custom Report Type — indicates the custom report type (subclass). The default is Custom 
Report; your Agile administrator may define additional custom report types. 

 External Report Type — indicates the external report type (subclass). The default is External 
Report; your Agile administrator may define additional external report types. 

 Description — text that describes the report. 

 Folder — click  to specify the report folder location. You can choose to share or not share 
the report folder location with users. 

 Query Definition — (Custom Reports only) allows you to define criteria on which to base the 
search. 

 Process Extension — (External Reports only) a drop-down list of Process Extensions that are set 
by your administrator. 

 Lifecycle Phase — the lifecycle phase of the report: Active or Inactive. 

 Custom Report — the lifecycle phase is Inactive if the report cannot be executed because 
it does not have a query defined or a layout defined yet. 

 External Report — the lifecycle phase is Inactive if no Process Extension is defined, and 
the report cannot be executed. 
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 Create Date — the date the report was created. 

 Modified Date — the date the report was last saved. 

 Create User — the name of the user who created the report. This field is blank on standard 
reports. 

This tab has the following buttons standard: 

 Edit — appears when the General Info tab is not in edit mode. To edit the General Info tab, click 
Edit. 

Custom reports include the following General Info tab edit variations: 

 Edit Information — appears when the custom report General Info tab is not in edit mode and 
you place the pointer over the Edit button. To edit the General Info tab, click Edit Information. 

 Edit Query — appears when the custom report General Info tab is not in edit mode and you 
place the pointer over the Edit button. To edit the query, click Edit Query. Make any changes 
to the query on the Define Query page. To save changes that you made on the Define 
Query page, click Finish. 

 Save — appears when the General Info tab is in edit mode. To save the changes that you made 
to the tab while it was in edit mode, click Save. 

 Cancel — appears when the General Info tab is in edit mode. To undo the changes that you 
made to the tab while it was in edit mode, click Cancel. 

You can use the Actions menu on the General Info tab to perform various actions on the standard 
report. These commands are Bookmark, Save As, Delete, Copy URL to Clipboard, Send, and Sharing. 

For more detailed information about bookmarking and other commonly used functions, see 
Navigating in Agile Web Client on page 27. 

Layout Tab 

Some standard reports do not include a Layout tab; the layout is predefined for you. For example, 
the IP Transfer does not include a Layout tab. 

Use the Layout tab to add or modify a standard report or a customized report layout with the fields 
your business requires in the required order. 

To create a layout, click Create. To edit the information on the Layout tab or to delete a layout, select 
the appropriate checkbox, and click Edit or Delete. 

 Standard report layouts 

Each standard report that includes a Layout tab which has a default layout. If you have the 
appropriate privileges, you can edit the default layout. 

You can create layouts for standard reports that are available only to you (personal layouts), or 
you can make the layouts available to all users (global layouts). 

To edit the layout fields, click the Layout  icon. You can select fields from the Available Values 
list. Some standard report layouts allow you to select values for a main heading and an 
additional subordinate heading. For more information, see Creating Standard Report Layouts 
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on page 127. 

 Custom report layouts 

The custom report default layout is used to create a new custom report. You can create layouts 
for custom reports that are available only to you (personal layouts) or you can make layouts 
available to all users (global layouts). 

To edit the layout fields, sorting and grouping, click the Layout  icon. You can select fields 
from the Available Fields list. You can change the filter criteria on the Select Layout Fields page. 
For more information, see Creating Custom Report Layouts on page 130. 

The Layout tab contains the following buttons: 

 Edit — lets you edit the attributes; like paper size, orientation on the Layout table. 

 Delete — deletes the layouts you have selected. 

 Create — lets you create a layout using the Create Report Layout wizard. 

The Layout tab has the following fields by default; your Agile administrator may have modified the 
fields: 

 Name — the name of the given the layout. 

 Access — indicates whether the layout is available to all users (Global) or only to you 
(Personal). 

 Paper Size — the size of the paper the report will be printed on, such as Legal or Letter. 

 Orientation — the page orientation: Landscape or Portrait. 

 Owner — the name of the user who created the report. 

To edit the Layout tab table: 

1.  Display the Layout tab. 

2.  Select the layouts you want to edit, and then click Edit. 

3.  In the Name, Access, Paper Size, and Orientation fields, make the desired modifications. 

4.  Click Save. 

Note External reports do not have a Layout tab. The third-party solution that generates the 
report also defines the report layout. If you have questions about external reports on your 
Agile PLM system, contact your Agile administrator. 

 

Creating Standard Report Layouts 

Use the Create Report Layout wizard to create a new layout for a standard report. 

About Standard Report Layouts with Multiple Headers 

Some standard report layouts include two headings in both the Available Values list and in the 
Selected Values list. The values under the first header are field attributes of the object the report is 
intended to locate. The values under the second header are field attributes of objects that are 
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subordinate to the report object. For example, in layouts for the Change Activity report, the values 
under Main Header Attributes are fields of the change objects upon which Agile PLM is reporting. The 
values under the Affected Items header are fields of the affected items of each change that appears 
in the report. 

When you run the Change Activity report, each change is listed in its own row. Under each change 
row are rows with a different background color that list each of the affected items of the change; 
these affected items appear on the Affected Items tab of the change object. In a similar manner, the 
Item Manufacturers report has a header for item field attributes and a subordinate header for field 
attributes of the manufacturer parts that are listed on the item’s Manufacturers tab. 

When you create a standard report layout with multiple headers, keep these tips in mind: 

 You can sort each header section independently. For example, you can sort the attributes 
under the main header without affecting the order of the attributes under the subordinate 
header. 

 The Available Values list is also organized by headers. You must select values under the 
appropriate Available Values header in order to add it under the corresponding Selected Values 
header. 

 Attributes under one header cannot be moved to be under a different header, although you can 
select as many attributes as you want under each header. 

 You are not required to specify any attributes under the subordinate header. For example, in a 
Change Activity report, if there are no values under the Affected Items header in the Selected 
Values list, then no affected items will be listed on the report; only a list of changes will appear 
on the report. 

 The Change Package report, which assembles all the information about a change in an easy-
to-read, printable format, includes more than two headers in the Available Values and Selected 
Values lists. Each tab of the change object has a header (for example, Cover Page, Affected 
Items, or Workflow). In addition, depending on which type of change you select in the Layout 
Type drop-down list, additional headers may also be available. For example, under Affected 
Items.BOM you can select field attributes of the items that appear on the BOM tabs of the 
affected items listed on the change’s Affected Items tab. For example, you might select 
Items.BOM.Qty and Items.BOM.Find Num. 

 

Generating Reports using BI Publisher 

Oracle Agile PLM 9224 introduces BI Publisher, a reporting tool. Using BI Publisher, standard and 
custom report layouts can be defined and generated in multiple output formats like WORD, PDF, 
HTML, EXCEL, and XML. In 9224, BI Publisher does not support all reports. Some of them continue 
using the existing reporting layout. The next release plans to use BI Publisher technology for all 
reports. 

Note Ensure to set Enable BI Publisher for Reports preference to Yes in Java Client for reports to 
be generated in multiple output formats. 

To generate reports in multiple output formats using BI Publisher: 

1. In the navigation pane, select the standard report you want customize.  

2. Click Layout tab. 
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3. Click Create. The Create Report Layout wizard appears.  

4. Populate details in all the fields.  

5. Click Save.  

6. Click Execute to run the report. 

7. To generate reports in multiple output formats, check Use BI Publisher check box. Additional field 
options with lists appear. 

Note Reports can also be generated using the existing reporting layout. 

8. Select a Layout from the list 

9. Select the Output Format in which the report will be generated from the list, like PDF, WORD, 
EXCEL, and HTML. 

Note The function 'Columns to repeat across pages' is supported for PDF output anonly. 
th Word format. Note  

Note that this functionality is supported for PDF output only. 

10. Check Save the Report check box to save report. The generated reports can then be stored or 
downloaded.  

For more details on BI Publisher see, http://xdo.us.oracle.com/?tab=Home. 

Template Behavior 

In Java Client, to enable the BI Publisher Report template, add Manage Report Template privilege 
to the 'Applied to' list of the Administrator privilege. 

Once the Administrator is assigned the Manage Report Template privilege in Java Client, you can 
navigate to Tools>Administration>Template Management>Report Template in the Web Client. 

Dynamic Template 

All custom reports and most of the standard reports use the Dynamic Template to define and generate 
reports in multiple output formats like PDF, WORD, EXCEL and HTML. 

Static Template 

In 9224, only the BOM Explosion Report and the Manufacturer BOM Report support Static template 
and generate files in RTF. An additional output format, the XML format appears in the list only when 
you select both Use BI Publisher and Use Template for Layout check boxes. 

Important If the file server is down, templates will not generate reports as they are stored in the 
file server.  

The following reports will continue using the existing reporting layout since they do not support BI 
publisher technology. 

 Change Package Report  

 Change Metrics  

 Change Backlog  

http://xdo.us.oracle.com/?tab=Home
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 Change Cycle Time  

 Quality Metrics  

 Quality Backlog  

 Quality Cycle Time  

 Failure Trend  

 RFQ Export  

 IP Transfer 

 Program Actual vs Budgeted Cost Report 

 Baseline Comparison Report 

 Portfolio Cost Report 

 Resource Pool Consumption Report 

 All PCM Reports 

For more details on BI Publisher see, http://xdo.us.oracle.com/?tab=Home. 

Note In 9224, BI Publisher does not support Websphere. 

 

Creating Custom Report Layouts 

Use the Create Report Layout wizard to create a new layout for a custom report. 

To create a custom report layout: 

1. In the navigation pane, select the report you want customize. Click Layout tab, and then click 
Create. The Create Report Layout wizard appears. 

2. Type a name for the layout. 

3. In the Access list, select the location for the layout. Your report layout can be Global—available 
to all—or Personal—available only to you. 

4. Select the paper size and orientation from the corresponding drop-down lists. 

5. Select the fields you want in the report. 

 To add values to the Selected Values list, select them in the Available Values list, and double-
click (or click the right arrow button). 

 To remove values from Selected Values list, select them and double-click (or click the left 
arrow button). 

 To change the order of fields, select a field and use the up arrow or down arrow button to 
move it. 

6. In the Sort By and Then By lists, you can specify how you want the report data to be sorted. 
Select Ascending or Descending to specify the sort order. You can also select the Group By check 
boxes to further organize the report data. 

 The first level Sort By list is applied to all the report rows. 

 The second level Then By is applied if there are any ties in the first level of sorting. 

 The third level Then By is applied if there are any ties in the second level of sorting. 

http://xdo.us.oracle.com/?tab=Home
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 Group By organizes the report by grouping the results according the value selected in the 
sort-by list. 

7. Click Save. 

Important Avoid using special characters in reports using BI Publisher, as they tend to fail. 

 

Creating a Standard Layout 

To create a standard report layout: 

1. In the navigation pane, select the report you want customize. Click Layout tab, and then click 
Create. The Create Report Layout wizard appears. 

2. Type a name for the layout. 

3. In the Access list, select the location for the layout. Your report layout can be Global—available 
to all—or Personal—available only to you. 

4. Select the paper size and orientation from the corresponding lists. 

5. If there is a Layout Type list, choose a layout type from the list. For example, the Change Activity 
report allows you to create layouts for change orders and price change orders. 

Note The Layout Type list appears on only a few specific report layouts. If you do not see a 
Layout Type list, ignore this step. 

6. To generate reports in multiple output formats check Use BI Publisher check box.  

Note Reports can also be generated using the existing reporting layout.  

7. Select the fields you want in the report. 

 To add values to the Selected Values list, select them in the Available Values list, and double-
click (or click the right arrow button). 

 To remove values from Selected Values list, select them and double-click (or click the left 
arrow button). 

 To change the order of fields, select a field and use the up arrow or down arrow button to 
move it. 

8. If there are multiple headers in the Available Values and Selected Values lists, select the 
appropriate values under each header and arrange them in the order you want. For more 
information, see About Standard Report Layouts with Multiple Headers on page 127. 

Note Multiple headers do not appear on all standard report layouts. If you see only one 
header (for example, Main Header Attributes) in the Selected Values list, ignore this 
step. 

9. When you are finished, click Save. 
 

Executing a Report 

To execute a report: 

1. In the navigation pane, select the standard report you want customize. Click Layout tab, and 
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then click Create. The Create Report Layout wizard appears.  

2. Populate details in all the fields. 

3. Click Save. 

4. Click Execute to run the report. The Run Report Wizard with the Select layout and Configuration 
Page appears. You are given the option to use BI Publisher to generate reports. Reports can 
also be generated using the existing reporting layout. 

5. To generate reports in multiple output formats, check Use BI Publisher check box. 

Important Before checking the Use BI Publisher check box, ensure to enable Automatic 
Prompting for File Downloads in IE settings to save generated output formats of the 
report on to the local machine.  

On checking Use BI Publisher check box, additional fields with lists appear.  

6. Select a layout from the Layout list. 

7. Select an output format from the Output Format list like WORD, PDF, EXCEL or HTML. 

8. Check Save the Report box to save report. 

9. Click Next. 

10. When you have populated all the fields, click Finish.  

A message appears: ―Server is generating the report. Please wait.‖ Once the Report is 
generated you can download the file and view it. 

11. Select the encoding type from the list. Click Continue. 

12. Follow directions in the Save As dialog boxes to save file to disk and choose a location to save 
it. 

13. Modify filename to include report date and time. 

14. When the download is complete, click Close in the dialog box. 

Note Reports generated are based on selections of layout and output format. In addition, 
the standard product reports BOM Explosion and Manufacturer BOM allow you to select 
BI Publisher templates that the Agile administrator has configured. 

 

Editing Standard Report Layouts 

You edit a report layout on the Report Layout Details page. For information about how to change 
the information in the fields on the Layout tab, see Layout Tab on page 126. 

To edit a standard report layout: 

1. Display the Report Layout Details page in one of the following ways: 

 In the navigation pane, select the report you want customize. Click the Layout tab, and then 

click the Layout  icon for the layout you want to edit. The Report Layout Details page 
appears. 

 Select the report you want to customize. Click the  Execute button. On the Select Layout 
and Configuration page of most Report wizards, click Layout Manager. The Report Layout 
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Details page appears. Click the Layout  icon for the layout you want to edit. 

2. Change the fields you want the report to include, as necessary. 

 To add values to the Selected Values list, select them in the Available Values list, and double-
click (or click the right arrow button). 

 To remove values from the Selected Values list, select them and double-click (or click the left 
arrow button). 

 To change the order of fields, select a field and use the up arrow or down arrow button to 
move it. 

3. If there are multiple headers in the Available Values and Selected Values lists, select the 
appropriate values under each header and arrange them in the order you want. For more 
information, see About Standard Report Layouts with Multiple Headers on page 127. 

4. Click Save to save your changes to the layout. 
 

Editing Custom Report Layouts 

You edit a report layout on the Report Layout Details page.  

To edit a report layout: 

1. Display the Report Layout Details page in one of the following ways: 

 In the navigation pane, select the report you want customize. Click the Layout tab, and then 

click the Layout Manager  icon for the layout you want to edit. The Report Layout Details 
page appears. 

 Select the report you want to customize. Click the  Execute button. On the Select Layout 
and Configuration page of the Custom Report wizard, click Layout Manager. The Report 

Layout Manager page appears. Click the Layout  icon for the layout you want to edit. 
The Report Layout Details page appears. 

2. Change the fields you want the report to include, as necessary. 

 To add values to the Selected Values list, select them in the Available Values list, and double-
click (or click the right arrow button). 

 To remove values from the Selected Values list, select them and double-click (or click the left 
arrow button). 

 To change the order of fields, select a field and use the up arrow or down arrow button to 
move it. 

3. Change the sort order and select or clear the Group By check box as necessary. 

4. Click Save to save your changes to the layout. 
 

Deleting Report Layouts 

You can delete report layouts that are no longer used. 

To delete a report layout: 

1. Display the Layout tab. 
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2. Select the layouts you want to delete, and then click Delete. A confirmation message appears. 
Click OK in the confirmation message. 

Note You must retain at least one layout. 

 

Schedule Tab 

Use the Schedule tab when you want a report to run based on a specific schedule or on a specific 
date and time. You can add, edit, or delete the schedules. 

You must have the appropriate privileges to work with the Schedule tab. 

This tab has the following buttons: 

 Edit — lets you edit the schedule. The Edit button affects only the schedules you have selected 
on the Schedule tab. 

 Delete — deletes the schedules you have selected. 

 Create — lets you add a new schedule frequency (Run Once, Every Day, Weekdays, Mondays, 
Tuesdays, Wednesdays, Thursdays, Fridays, Saturdays, Sundays, First Day of the Month, and 
Last Day of the Month) to the report schedule using the Report wizard. 

The Schedule tab has the following fields by default; your Agile administrator may have modified the 
fields: 

  — click to view the schedule details of the report being run for the schedule. They can be: 

 The layout selected 

 Fields filled out in the report wizard 

 Parametric fields (custom reports only) 

 Enable — select Yes to activate the schedule and run reports automatically, or select No to 
disable the automatic schedule. 

 Schedule Frequency — a drop-down list with the following options: Run Once, Every Day, 
Weekdays, Mondays, Tuesdays, Wednesdays, Thursdays, Fridays, Saturdays, Sundays, First 
Day of the Month, or Last Day of the Month. 

 Schedule Time — the date and time when the report should run. You specify the date only if the 
Schedule Frequency option is set to Run Once. For any other schedule, you specify only the time. 

 Share W/Users — list of users who will be notified when the report is generated (based on the 
schedule) and who will have access to the reports generated from the schedule. 

 Owner — the name of the user who created the schedule. 

To create a schedule: 

1. Display the Schedule tab for the report. 

2. Click Create. The Add Schedule wizard appears. 

3. Follow each step in the wizard in order to define and specify your report. These are the same 
wizard steps you use when you click the Execute button to run the report. For details about 
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running specific reports, see the appropriate user guide. 

The last wizard step in the Add Schedule wizard is the Define Schedule page. 

4. On the Define Schedule page, in the Schedule Frequency drop-down list, select Run Once, or 
select the recurring day you want the report to run. 

5. If you select Run Once, click the calendar button and select a date. Specify the time you want 
the report to run. The default time is 12:00 a.m. If you want to enter a time to run the report, use 
the time format hh:mm:ss AM or PM. For example, to run the report at 8 p.m., enter 08:00 PM 

6. If you select a recurring day you want the report to run, you can specify a time to run the report. 
The default time is 12:00 a.m. Use the time format hh:mm:ss AM or PM. For example, to run 
the report at 8 p.m., enter 08:00 PM 

7. Click  next to the Share with Users field to select the names of users who will have access to 
this report. 

8. Click Finish. 

Note External reports do not have a Schedule tab. If there is a schedule, the third-party solution 
that generates the report also defines the report schedule. If you have questions about 
external reports on your Agile PLM system, contact your Agile administrator. 

 

Historical Report Tab 

After you run a report, you can save the report results. The Historical Report tab displays all previously 
saved report instances with a date and time stamp and the name of the user who executed the 
report. To share a report, select the appropriate checkbox and click Sharing. To delete or view a 
report, select the appropriate check box, and click Delete or View. 

To save the generated report as a historical report, click the  Save button in the Report Output 
window. If you do not save a report, once you close the report results window, you cannot access 
that instance of the report again. 

If a historical report is generated according to a schedule, then the Type field in the report displays 
Schedule Generated. 

This tab contains the following buttons: 

 Sharing — lets you specify other users who can view the selected report instance. 

 Delete — deletes the selected report instance. 

 View — lets you view the generated Report Output window of the selected report. 

The Historical Report tab has the following fields: 

  — lets you view the generated Report Output window of the selected report. 

 Create Date — indicates the date and time the report was generated. 

 Type — indicates if the historical report is saved by the user or generated by a schedule. 

 Share W/Users — users who can view this report instance. 
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 Owner — the name of the user who created the report. 

Note External reports do not have an Historical Reports tab. If you have questions about 
external reports on your Agile PLM system, contact your Agile administrator. 

 

History Tab 

The History tab shows a summary of actions taken on the report. This tab is completed 
automatically. 

The History table has the following columns by default; your Agile administrator may have modified 
the table: 

 Action — the action that was taken. 

 User — the user who took the action. 

 Local Client Time — the time that the action was taken, according to the time zone of the user 
viewing the History table. 

 Details — the description of the action (for example, the description of the change that was 
made). 

 Comments — comments made by users. 
 

Working with Standard Reports 

Standard reports provide you with the information you commonly need to analyze your business 
processes. You select predefined criteria and specify the results you want. These out-of-the-box 
reports are applicable in most situations. You can run them as they are, modify the default layouts, 
or create your own layouts. You can run Agile reports from Agile Web Client or Java Client. 

Note When you run standard reports from Java Client, Agile PLM opens a Web Client window 
with the selected report displayed. 

 

Accessing Standard Reports 

Click the + button next to Reports in the left pane to view the top-level folders such as Products 
Reports and Process Reports. You can access reports from these folders. 

To execute a standard report, click the  Execute button and follow the wizard steps. If the 
standard report does not have any wizard steps, the report is generated immediately after you click 

the  Execute button. 

 For information about standard report layouts, see Creating Standard Report Layouts on page 
127 and Editing Standard Report Layouts on page 132. 

 For information about scheduling standard reports, see Schedule Tab on page 134. 
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 For information about standard reports Historical Reports tab, see Historical Report Tab on page 
135. 

 For information about running standard reports, refer to the appropriate user guide, listed in the 
following table. 

The Standard Reports folder contains the predefined folders as listed in the following table. 

Report  fo lder  Descript ion and  locat ion  to  f ind  more  in fo rmat ion  about  
speci f ic  reports  

Product Reports Contains the standard Product Collaboration (PC) reports. 

For more information about these reports, see Product Collaboration Guide. 

Administrator Reports Contains all administrator user reports. 

For more information about these reports, see Agile PLM Administrator Guide. 

Sourcing Reports Contains the standard Product Cost Management (PCM) reports. 

For more information about these reports, see Product Cost Management User 
Guide. 

Quality Reports Contains the standard Product Service and Improvement (PQM) reports. 

For more information about these reports, see Product Quality Management User 
Guide. 

Process Reports Contains reports for changes and transfer orders. 

For more information about these reports, see Product Collaboration Guide. 

For more information about the IP Transfer Report, see Agile Content Service User 
Guide. 

Program & Portfolio 
Reports 

Contains standard reports for Product Portfolio Management (PPM) solutions. Sub 
folders include End User Reports, Portfolio Reports, Program Reports, and 
Resource Pool Reports. 

For more information about these reports, see Agile Product Portfolio Management 
User Guide. 

If your company has installed Portfolio Analytics, then the Portfolio Analytics 
reports appear in the Analytics folder under the Program & Portfolio Reports 
folder. For more information, see Portfolio Analytics User Guide. 

Compliance Reports Contains the standard Product Governance & Compliance (PG&C) reports. 

For more information about these reports, see Agile Product Governance and 
Compliance User Guide. 

 

 
 

Working with Custom Reports 

You can create user-specific or company-specific reports directly within Agile. When you define 
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your query on the Define Query page of the Custom Reports Creation wizard, the search looks for 
objects with fields that match the search conditions that you set up. 

You can customize reports in the following ways: 

 Change the way each report looks by editing the report layout. 

 Specify a schedule (date and time) when you want a report to be executed. 

 Save and view report instances. 

 See what actions have been taken on the report. 
 

Creating a Custom Report 

If you have the appropriate roles and privileges, you can create any user-specific or company-
specific custom report from the Create icon on the main toolbar. 

To create a custom report: 

1. Click Create Report > Custom Reports. 

2. The Custom Reports Creation wizard appears. Select the subclass, and type a name for the 
report. 

3. Click the Continue Creation in Wizard check box. Click Continue. 

4. On the General Information page, enter a description. Click  next to the Folder field to select 
a folder in which to save the report. The Select Folder window appears. All the available report 
folders are listed on the left side in the Available Folders list. Select a folder from the Available 
Folders list and click the right arrow to move it to the Selected Folders list. Select one or more 
folder locations. Click OK. The folder field is populated with the selected folder name on 
General Information page. Click Next. 

5. The Define Query page appears. On this page, click the appropriate radio button to create a 
new query or select from an existing query, complete the remaining fields, and click Next. The 
options are described in the following section. 

6. The Select Output Fields page appears. In this wizard step, specify which fields to include in 
the report and how to sort the results table. To include a field, move it to the Selected Values list. 
In the Sort By and Then By lists, specify how you want the report data to be sorted. Select 
Ascending or Descending to specify the sort order. You can also select the Group By check boxes 
to further organize the report data. 

Note The settings specified in this step are saved as the Default Layout for the report. For 
more information about custom report layouts, see Creating Custom Report Layouts 
on page 130. 

7. Click Finish when you have completed the last step. 

View general information about the newly created report on the General Info tab. 

Creating a New Query 

To create your own query, select the Create New button on the Define Query page. For a new query, 
complete the Search Type and Search For fields, and specify at least one search condition. Click Next. 
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This wizard step contains the following options: 

 Search For — the type of object (class or subclass) that you want to search for—for example, 
ECO, document, or manufacturer part. 

 Search Type — the type of search that you are creating. An Object search finds Agile objects 
that match the search conditions. A Where-used search finds the assemblies that use the items 
defined by your search criteria. The assemblies in which the defined items are used appear in 
the search results. 

 Match Case — if checked, the search will be case-sensitive; that is, it will find uppercase or 
lowercase values exactly the way that you enter them. 

 Clear button — clears the information on this page. 

 Field — the field on which you want to search. The contents of this list depend on the Search 
For value. 

 Match If — a search operator, such as Equal To or Contains. The contents of this list depend on 
the value specified in the Field field. 

 The Prompt? field — check this box if you want to prompt the report user to fill in the value when 
the custom report is executed. If you check the check box, the Value field is disabled and you 
do not enter a value now as you create the custom report query; however, when you execute 
the custom report, you will be prompted to enter a value in a wizard step. See also Executing 

Custom Reports on page 140. 

 Value — the value for which you want to search. Click the  button and specify a value. 

 And/Or — used to specify multiple search conditions. If you want both conditions to be met, 
select And. If only one condition needs to be met, select Or. 

 Add ( ), Add [ ], and Remove ( ) buttons — tell the Web Client to group or ungroup conditions. In 
most searches, use parentheses to group conditions. Use brackets to group conditions in 
workflow searches. 

 Validate button — verifies if the query is valid. 

For more information about defining a query, see Finding Agile Data with Searches on page 143. 

Note Delete invalid data for queries as the Use Report subclass tends to hang if the data 
submitted is large. 

 

Conditions to Edit and Save a Query 

To edit a Query:  

1. Choose Edit Query under the General Info tab on the Cover page.  

2. In the Define Query page, edit the necessary fields.  

Note Layout settings can be affected when you edit a query. If you edit the values in the 
Search For, Search Type, or With Related Content fields, custom layout settings are 
reset to default layout settings. If you only edit the fields under Criteria Conditions, 
custom layout settings are retained. 
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3. Click Finish. 

The General Info page is then displayed with the latest details that have been entered in the Define 
Query page.  

Using a Saved Search 

If you select the Use Saved Search button on the Define Query page, click  to select an existing 
search to customize. The Define Query page appears. All the search criteria are copied from the 
saved search. You can modify the criteria to suit your needs. Default Layout output fields are copied 
from the output display of the saved search. 

Executing Custom Reports 

You must have sufficient privileges to execute a report. For more information about roles and 
privileges, see the Agile PLM Administrator Guide. The report outputs are displayed only in Web 
Client. 

To run a custom report: 

1. Select the report that you want to execute, and click the  Execute button. 

2. In the report wizard, select a layout or click the Layout Manager  icon to create a new layout. 
For more information, see Creating Custom Report Layouts on page 130. 

When you are done with this step, click Finish. If the Finish button is disabled, click Next. 

3. If there are any parametric fields in the report, the Enter Parameter Values wizard page 
appears. Fill in the required information. Click Finish. 

If there are no parametric fields in the report, this wizard step is omitted. 

4. Once the output appears, use buttons at the top of the Report Output window to save, export, 
or print the report. 

 Click the  Print button to print the generated custom report. 

 Click the  Export button to export the report as delimited text files (.CSV) or as Microsoft 
Excel Workbook files. 

 Click the  Save button to save the report instance. 

For more information, see Historical Report Tab on page 135. 

You can also use buttons to move from page to page in the report and to change the 
magnification. 

Note When a scheduled custom report fails a custom report failure notification is sent to all the 
Users with Administrator privileges. 

 

Deleting and Undeleting Custom Reports 

When you no longer need a report, you can delete it from the report folder. 
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To delete a custom report: 

1. Select the report you want to delete. 

2. From Actions menu, choose Delete. A warning message appears asking you to confirm that you 
want to delete this report. Click OK. 

To undelete a custom report: 

1. Under Searches in the navigation pane, select Deleted Reports from the Recycle Bin Searches 
folder. 

2. Open the deleted report you want to undelete. 

3. From Actions menu, choose Undelete. 

Note Although the report users can run reports and do analysis on assigned projects, 
including those to which they do not have direct access, they cannot delete reports that 
they do not own. Only the report manager can delete reports that belong to other users. 

 

Working with External Reports 

You can create reports and generate them from an external report engine. Process extension 
provides a URL address that can be initiated from within Agile reports and that will launch the 
specified Web address. Your Agile administrator sets the Process Extensions based on your 
requirements. If you have any questions or comments about the Process Extension settings, please 
contact your Agile administrator. 

Creating an External Report 

If you have the appropriate roles and privileges, you can create an external report from the Create 
icon on the main toolbar. In the Agile Web Client, you can connect to an external resource or URL 
to generate an external report. Before you create an external report, you must add the URL 
associated with the report to the Process Extension Library. For more information about Process 
Extensions, see the Agile PLM Administrator Guide. 

To create reports in the Agile Web Client, you must have the Create Reports privilege. 

To create an external report: 

1. Log in to Agile Web Client. 

Note You cannot create external reports in Agile Java Client. 

2. Click Create > Report > External Reports. The External Reports Creation Wizard appears. 

3. Select a subclass, and type a name for the report. 

4. Click the Continue Creation in Wizard checkbox. Click Continue. 

5. Enter the following general information: 

 Description — Enter a brief description of the report. 

 Process Extension — Select a Process Extension. The Process Extension you select is 
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associated with a URL, such as the location of Web-based report. The only Process 
Extensions that appear in this list are those that are designated as ―Initiate From: External 
Reports‖ in the Process Extension Library. 

 Folder — Select a folder in which to store the report. 

6. Click Finish. 
 

Executing an External Report 

You must have sufficient privileges to execute a report; see How Your Roles and Privileges Affect 

Reports on page 124. For more detailed information about roles and privileges, see the Agile PLM 
Administrator Guide. 

To run the newly created external report, click the  Execute button. The Process Extension that 
references a URL is invoked, and you see the Web page in a new browser window. 

The Report Output Window 

When you execute a report, you see the report displayed in a new browser window. Once the report 
output appears, you can use buttons at the top of the Report Output window to save, export, or print 
the report. 

 Click the  Print button to print the generated custom report. 

Follow the onscreen instructions to print the report. 

 Click the  Export button to export the report. Follow the onscreen instructions. 

The report can be exported in one of two formats: 

 File type CSV (comma delimited text file) 

 File type Microsoft Excel Workbook. 

Both file types can then be opened in Microsoft Excel. CSV files can also be opened with any 
application that uses the CSV file type. 

 To move from page to page, use the Page drop-down list and the  First Page,  

Previous Page,  Next Page, and  Last Page buttons. 

 To change magnification, use the  Zoom In and  Zoom Out buttons. 

 Click the  Save button to save the report instance. The saved report instance appears on the 
Historical Report tab. 

For more information, see Historical Report Tab on page 135. 

 Click the  Close button to close the report window. 
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Chapter 7 

Finding Agile Data with Searches 

This chapter includes the following: 

 Overview of Search Tools .................................................................................................................................... 143 
 Saved Searches .................................................................................................................................................. 147 
 Quick Searches ................................................................................................................................................... 149 
 Quick Searches and Wildcard Characters ........................................................................................................... 152 
 Full Text Search for Content in Attachment Files ................................................................................................ 154 
 Pre-configured Parametric Searches ................................................................................................................... 157 
 Saving a Search .................................................................................................................................................. 161 
 Using Save As to Save a Search ......................................................................................................................... 163 
 Advanced Searches ............................................................................................................................................. 165 
 Where-Used Searches for Items ......................................................................................................................... 179 
 Where-used Searches for File Folders ................................................................................................................ 188 
 Version-Specific Properties and File Folder Object Searches ............................................................................. 189 
 Relationship Searches ......................................................................................................................................... 190 
 Searching for Users and User Groups ................................................................................................................. 191 
 Searching for Routable Objects with Workflow Attributes ................................................................................... 192 
 Editing and Managing Searches and Search Folders ......................................................................................... 198 

 
 

Overview of Search Tools 

When you want to find specific Agile objects, content found in documents or attachments, or other 
kinds of information contained in the database, you perform a search. 

The main Searches folder has subfolders of saved searches. 

 In Java Client, to display the search window, click the Search tab in the left navigation pane. 
Select the top Search folder and click the Expand All  icon to display all the searches. Or, for a 
specific folder, click the  + icon to display the searches in that folder. 

 In Web Client, if the left navigation pane is not already displayed, click the Searches icon  to 
display the search folders. Click the Expand All  icon to display all the searches. Or, for a 
specific folder, click the +  icon to display the searches in that folder. 

For more information about the predefined searches in Agile PLM, see Saved Searches on page 
147. 

For more information about saving, editing and managing your personal searches, see Editing and 

Managing Searches and Search Folders on page 198. 

Types of Searches 

Several types of searches are available from the toolbar of both Java and Web Clients. 
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 Simple Search— Searches for objects whose name, number, or description matches the criteria 
in the main toolbar Search text box. See Quick Searches and Wildcard Characters on page 152. 
In a Simple Search, the object class drop-down list is set to All and a wildcard character is used 
in the main toolbar Search text box. 

When the object class drop-down list is set to All, the Search Attachments Context check box is 
inactive and not available. 

 Quick Search—Searches for objects whose name, number, or description matches the criteria in 
the main toolbar Search text box. See Quick Searches and Wildcard Characters on page 152. 

By default, the Search object class drop-down list is set to All, and Agile performs a Simple 
Search to search all objects in the database. Narrow your Quick Search by selecting a base 
class in the drop-down list that limits the search to any object with that base class as its 
―ancestor.‖ 

You can also extend the Quick Search to attachment files. See Quick Searches on page 149. 

 Pre-configured Parametric Search—From the Search... button drop-down list, select a base class 
that limits the search to any object with that base class as its ―ancestor‖ similar to a Quick 
Search. Click the +  to expand and display the parametric search your Agile administrator has 
configured. Your Agile administrator configures Agile PLM to present the most commonly used 
search attributes for that class or type. Select the search operator and search value for one or 
more of the displayed attributes. See Pre-configured Parametric Searches on page 157. 

 Last Search Results—Return to the results of the last search that you ran. 

 Attachment content search—You can use a quick, parametric, or advanced search to find 
specified content in attachment files. See Full Text Search for Content in Attachment Files on 
page 154. 

 Advanced Searches—For greater precision, you can perform an advanced search, which allow 
you to use more specific search conditions and multiple conditions which have not been pre-
configured in the parametric search. See Advanced Searches on page 165. 

 Where-used Searches—An option in Advanced Search, it searches specific levels of the BOM and 
revisions, such as ―All Levels Latest Released Revision Only.‖ See Where-Used Searches for 

Items on page 179 and Where-used Searches for File Folders on page 188. 

 Relationship searches—An option in Advanced Search, it finds objects that are related to the 
object that meets the search conditions. See Relationship Searches on page 190. 

 

User Roles and Searchable Objects and Attributes 

A user's assigned roles determine which Agile objects he can search for and which object attributes 
he can use for search criteria. 

How Discovery Privileges Affect Searches 

For Parametric Search and Advanced Search, the base classes, classes and subclasses that 
appear Search for: drop-down lists are determined by the user's Discovery privilege masks. 

Discovery privilege masks can be based on criteria for a specific subclass, class, or base class. If 
the user has a Discovery privilege mask based on a criteria for a specific class, then the user sees 
and can select any of the subclasses of that class in the Search for: drop-down list. Similarly, if a 
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user has a Discovery privilege mask based on a base class, then all classes and subclasses in the 
specified base class appear in the Search for: drop-down list and the user can select. However, if a 
user's Discovery privilege masks are limited only to specified subclasses, then the user sees the 
associated base class and class, but only those specified subclasses in the Search for: drop-down 
lists. The user may select the base class, class or subclass, however, if his discovery privileges are 
limited to a specific subclasses, only objects of the specified subclasses appear in the search 
results. 

How Field-Level Read Privileges Affect Searches 

The business object fields a user can view and select as search criteria in Parametric Searches and 
Advanced Searches is determined by the user's field-level Read privileges. 

In Advanced Searches, the searchable attributes appear in the Field drop-down list of each search 
condition. In Parametric Searches, the Agile administrator configures which attributes are displayed 
for selection in the parametric search display. In addition, the user must have the appropriate field-
level read privilege masks. If the user does not have read privilege for a specific field, that field does 
not appear in the Parametric Search display, and that field does not appear in the search condition 
Field drop-down list in Advanced Search. 

Search Results 

In Java Client, when you run a search, the results appear in a search results window. The window 

title bar displays the name of the search. The search Results icon  appears in the left corner of 
the window title bar. 

In Web Client, when you run a search, the results appear in the right pane. 

The maximum number of search results that can be displayed is based on the Maximum Query 
Results Displayed property in Agile Administrator under Admin > Server Settings > Preferences. In 
addition, your Maximum Rows Displayed (MRD) user preference controls how many rows are 
displayed for you. If the system found more than your MRD user preference allows, a message 
informs you that the results returned were more than allowed. Refine your search criteria as 
needed. 

For Quick Search and Simple Search, the search results are sorted when the number of search 
results displayed is less than or equal to 1,000. 

Note If a user’s Maximum Rows Displayed user preference is set to fewer rows than Maximum 
Query Results Displayed systemwide preference, the former value will override the latter 
value. If the system found more results than the MRD user preference allows, a 
message informs you of that fact. 

If you do not have Discovery or Read privilege for an object, it does not appear in search 
results. Depending on Agile Administrator SmartRule settings, you may see a warning that 
rows are missing due to insufficient privileges. For more information, see your Agile 
administrator.  

When you search for items (part or document objects), the items displayed are the latest released 
revision or the most recent pending revision (which was created when the item was added to the 
Affected Items tab of an ECO or an MCO). See also Searching on Rev-Specific Values on page 179. 
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Important The Specify Output Column privilege is removed from Agile PLM; therefore, all users 
can potentially specify output attributes in advanced searches. However, if you find 
that you cannot do so, you have probably been assigned the Enforce Field Level 
Read privilege by your administrator. 

To open and view objects in the results table in Java Client, use one of these methods: 

 To open one object, double-click the object’s row in the search results table. 

 To open an object with a specific tab on top: 

a. Select the object’s row in the search results table. 

b. Right-click. 

c. In the displayed menu, choose Open and the tab you want. 

 To open multiple objects: 

a. Select multiple rows in the search results table. 

b. Either press Enter on the keyboard or click the Open button  in the main toolbar. 

To open and view objects in the results table in Web Client: 

Click the Number link of the object. 

To print a list of objects found by the search: 

In Java Client, click the Print button  in the search results toolbar. 

In Web Client, click the Print button on the Search Results page. 

To view the results of the last search you performed: 

In Java Client, click the Last Search Results button.   

In Web Client, click the Last Search Results button.  
 

Exporting Search Results 

In both Java Client and Web Client, you can export some or all results of a search (Advanced 
Search or saved search) to a CSV (comma separated value) file for use in another application, for 
instance, Microsoft Excel or Microsoft Word. You can also export the search results in Microsoft 
Excel format. 

To export search results in Java Client and Web Client: 

1. Run a search. 

2. In the search results table, click the Export drop-down button and choose a file format: .CSV or 
Microsoft Excel 

3. In the File Download dialog that opens, click Open to view the exported file in the chosen 
format, or Save to save the file to your local drive. 
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Saved Searches 

Saved searches are advanced searches that have been saved for future use. They include the 
predefined searches shipped with Agile, global searches that your Agile administrator created, or 
personal searches you created yourself. 

Global searches are seen by all Agile users with appropriate Discovery and Read privileges. 
Personal searches are seen only by the user who created the search. Although personal searches 
are created on a local computer, they are stored on the server. This means you can log in to any 
computer that runs your usual client and see the personal searches you have created, even if those 
searches were created on a different computer. Only you can see them, under your own login. 

Predefined System Searches 

Agile comes with a set of predefined searches. You can use them as they are, or you can use them 
as a template to modify and save as your own custom searches. 

Which searches you see depends on your company’s licenses and your user profile settings, roles, 
and privileges. If you have the Global Search privilege, you can edit or delete the predefined system 
searches. If you do not have the Global Search privilege, you can still view the system searches. 

Note Some predefined system searches cannot be edited, viewed or saved because they 
internally defined and are not based on an advanced search. For example, the Recycle 
Bin searches for soft-deleted objects are not editable. 

The search Save As feature allows you to create a shortcut (link) to a non-editable system search, 
but does not allow you to make a copy of that search in your personal searches folder. For more 
information, see Using Save As to Save a Search on page 140. 

You also need to have the Searches property in your user profile include the kind of searches you 
want to see. Your administrator may have already set that up when your profile was created as an 
object in the Agile database; if not, follow this sequence: 

To add the capability to see a folder of searches: 

1. Display your user profile: 

 In Java Client, click the View/Edit Current User button  in the main toolbar. 

 In Web Client, choose Tools > My Settings. On the Settings Home page, click the User Profile 
link to display your profile. Click Edit (on the General Info tab). 

2. On the General Info tab, scroll down to the Profile section. 

3. At the Searches field, click the  or  button, per your client. 

4. Use the multilist dialog box to select the Searches you want access to. When you are done, 
click OK. 

5. Click Save. 

If you have questions about your ability to discover, read, or edit searches, see your Agile 
administrator. 
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The Global Searches folder has a subfolder named Workflow Search Samples with additional 
predefined searches. 

Name of  fo lder  Purpose of  searches  

Compliance Searches Searches that find product governance and compliance data. 

Global Searches > Workflow 
Search Samples 

Workflow Search Samples are described in Workflow Routings 
on page 14. Also see Searching for Routable Objects with 

Workflow Attributes on page 192. 

Change Analyst Searches Searches that find changes, items, and redlined attachment files. 

Component Engineer Searches Searches that find manufacturers and manufacturer parts. 

Workflow Routings Searches that find workflows, as described in Workflow 

Routings on page 14. Also see Searching for Routable 

Objects with Workflow Attributes on page 192. 

Content Manager Searches Searches that find content transfer orders and packages. 

Price Searches Searches that find prices. 

Program Searches Searches that find programs. 

Quality Searches Searches that find product service requests and quality change 
requests. 

Sourcing Searches Searches that find requests for quote and sourcing projects. 

Supplier RFQ Searches Searches that find supplier RFQ requests. 

Recycle Bin Searches Searches that find deleted objects in every base class in Agile PLM. 

Personal Searches Searches that you have created. 

 
 

Running a Saved Search 

In Java Client, when you run a saved search, the found objects are listed in the search results 
window with the name of the search in the window title bar. In Web Client, when you run a saved 
search, the found objects are listed in the right pane, below the name of the search. 

In Java Client, to use searches shipped with Agile, created by your Agile administrator, or saved by you: 

1. If the folders of saved searches are not displayed in the  Searches folder on the Search tab of 
the left navigation pane, double-click the Searches folder. 

Or, highlight the  Searches folder and click the Expand All icon  in the Searches toolbar to 
display all search subfolders and their contents. 

2. Double-click the name of the folder that you want to open. 

3. Double-click the name of a search in that folder to run it. Results appear in a search results 
window. 
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In Web Client, to use searches shipped with Agile, created by your Agile administrator, or saved by you: 

1. If the search tools are not already displayed, click the Search Folders button  in the navigation 
pane. 

2. Click a Searches folder to display the list of saved searches in that folder. 

Or, highlight the  Searches folder and click the Expand All icon  in the navigation pane to 
display all search subfolders and their contents. 

3. Click the name of a search in that folder to run it. Results appear in the right pane. 
 

Running Saved "Prompt at Runtime" Searches 

You can create and save searches that prompt you to fill in the values for which you want to search. 
Each time you run the saved search, you can specify different search values. 

When you run a saved ―Prompt at Runtime‖ search, a dialog appears that allows you to fill in search 
values. 

Fill in the fields provided, then click Run. 

To create and save a ―Prompt at Runtime‖ search, see Creating an Advanced Search in Java Client 
on page 167 or Creating an Advanced Search in Web Client on page 170. 

Quick Searches 

Use the main toolbar quick search features in both clients to run quick searches. Quick searches let 
you quickly locate objects in the Agile database. The quick search returns a list of all Agile objects 
whose name, number (ID), or description contain the search criteria that you specified. 

Quick Search Overview 

In a default quick search (main toolbar class drop-down list set to All, also referred to as a simple 
search) Agile searches all classes to find any object in the database that matches the criteria. When 
you choose a base class in the drop-down list, Agile limits the search to any object with that base 
class as its ―ancestor.‖ You can also extend the search to attachment files; see Full Text Search for 

Content in Attachment Files on page 154. 

Quick searches behave like Contains searches for text strings. The search criteria is treated as a 
single string and Agile PLM searches for names or descriptions that contain the search criteria 
string. In the case of ID numbers, Agile PLM searches for an exact match, however, you may use 
wildcard characters to specify part of an ID number as a search criteria. 

The columns included in the search results table depend on what you searched for. You can 
change the number of rows displayed per page of search results by choosing Tools > My Settings > 
User Profile (Web Client) or by using the View/Edit Current User button (Java Client) to display your 
user profile. On the Preferences tab of your user profile, edit the Rows per Table Display attribute. 

Using Wildcard Characters on page 152 gives some examples of values for quick searches and the 
returned results that can be expected. 
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For detailed information about using quick searches, see: 

 Java Client Quick Search on page 150 

 Web Client Quick Search on page 151 

 Using Wildcard Characters on page 152 

 Using Quick Search to Find Attachment File Content on page 155 
 

Java Client Quick Search 

The following table shows the Quick Search interface in the Java Client and summarizes what each 
feature does. 

 

Base Class drop-down list 

Use  to select a specific 
base class. Agile limits the 
search to any object with that 
base class as its ―ancestor.‖ 

All (default) – searches all 
object classes in the 
database. 

Search Attachment 
Text checkbox 

When you select a 
base class, this 
checkbox is enabled. 

If you want to include 
the content of 
attachment files in your 
search, check the box. 

Search Criteria field 

The search criteria text is 
not case-sensitive. You can 
enter as search criteria: 

 a product ID number 

 an entire word 

 multiple words 

 partial numbers or 
partial words, using the 
* and ? wildcards. 

Run Search 
button 

Runs the 
search you 
specify and 
displays the 
results in the 
Search 
Results 
window. 

See Perform a Quick 

Search in Java Client on 
page 151 for more 
information. 

See Full Text 

Search for Content 
in Attachment 

Files on page 154  for 
more information. 

See Quick Searches 

and Wildcard 
Characters on page 152 
for more information. 

See Search 

Results on 
page 145 for 
more 
information. 

The following table lists and describes the search buttons on the main toolbar in Java Client. 

Button  Name  Descript ion  

 
Run Search Runs a Simple Search or a Quick Search. See Quick Searches and 

Wildcard Characters on page 152 and Quick Searches on page 
149. 

 Search... Opens a dialog box to create an advanced search. See Advanced 

Searches on page 165. 

 
 Clicking the drop-down arrow displays a list of base classes to select for 

a pre-configured parametric search. See Pre-configured 

Parametric Searches on page 157. 

 Last Search 
Results 

Displays the results of the last search you performed. 
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Perform a Quick Search in Java Client 

To perform a quick search in Java Client: 

1. Enter the search characters in the Search Text field in the main toolbar. 

2. Use the Object Type drop-down list to select the type of object you want to search for. Select a 
base class to limit the search to any object with that base class as its ―ancestor.‖ 

When you select All, Agile performs a Simple Search and searches across all classes. The 
Search Attachment Text checkbox is disabled for Simple Searches. 

3. When you select an object type, the Search Attachment Text checkbox  is enabled. If you want 
to include the content of attachment files in your search, check the box. See Full Text Search 

for Content in Attachment Files on page 154 for more information. 

4. Click the Run Search  button. The search returns all objects in the specified base class 
where the ID number matches or a word in the description contains the search characters. 

5. To open an object in the search results table, double-click its row. 
 

Web Client Quick Search 

The following table shows the Quick Search interface in the Web Client and summarizes what each 
feature does. 

 

Base Class drop-down list 

Use  to select a specific 
base class. Agile limits the 
search to any object with that 
base class as its ―ancestor.‖ 

All (default) – searches all 
object classes in the 
database. 

Search Attachment 
Text checkbox 

When you select a 
base class, this 
checkbox is enabled. 

If you want to include 
the content of 
attachment files in 
your search, check 
the box. 

Search Criteria field 

The search criteria text is 
not case-sensitive. You 
can enter as search 
criteria: 

 a product ID number 

 an entire word 

 multiple words 

 partial numbers or 
partial words, using the 
* and ? wildcards. 

Run Simple Search 
button 

Runs the search you 
specify and displays 
the results in the 
Search Results 
window. 

See Perform a Quick 

Search in Web Client on 
page 152 for more 
information. 

See Full Text 

Search for 
Content in 
Attachment Files 
on page 154  for 
more information. 

See Quick Searches 

and Wildcard 
Characters on page 
152 for more information. 

See Search 

Results on page 
145 for more 
information. 

The following table lists and describes the search buttons on the main toolbar in Web Client. 
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Button  Name  Descript ion  

 
Run Search Runs a Simple Search or a Quick Search. See Quick Searches and 

Wildcard Characters on page 152 and Quick Searches on page 149. 

 
Search... Opens a dialog box to create an advanced search. See Advanced 

Searches on page 165 

 
 Move the mouse pointer over the drop-down arrow to display a list of base 

classes to select for a pre-configured parametric search. See Pre-

configured Parametric Searches on page 157 . 

 

Last Search 
Results 

Displays the results of the last search you performed. 

 
 

Perform a Quick Search in Web Client 

To perform a Quick Search in Web Client: 

1. Use the Object Type drop-down list to select the type of object you want to search for. Select a 
base class to limit the search to any object with that base class as its ―ancestor.‖ 

When you select All, Agile performs a Simple Search and searches across all classes. The 
Search Attachment Text checkbox is disabled for Simple Searches. 

2. When you select an object type, the Search Attachment Text checkbox  is enabled. If you 
want to include the content of attachment files in your search, check the box. See Full Text 

Search for Content in Attachment Files on page 154 for more information. 

3. Enter the search characters in the Search Criteria field. 

4. Click the Run Simple Search  button. The search returns all objects in the specified base 
class where the ID number matches or a word in the description contains the search 
characters. 

5. To open a returned object, click its link in the search results table. To display the next page of 
search results, click the Go to Next Page button . 

 

Quick Searches and Wildcard Characters 

You can use wildcard characters when you perform a quick search in Java Client (Java Client Quick 

Search on page 150) or Web Client (Web Client Quick Search on page 151). 

Using Wildcard Characters 

Agile accepts two wildcards: the asterisk (*) and the question mark (?), and they can be used in any 
of the searches. The question mark finds matches with any other single character. The asterisk 
finds matches with more than one character. 
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Note For systems on SQL Server, there are some limitations on searches that depend on the 
available resources of the database server. On SQL Server, the newly created or 
renamed object cannot be searched on immediately. There is a delay of 10–15 seconds. 

Also, on SQL Server, the wildcard search ―value*‖ is supported. The searches ―value?‖, ―*value‖, 
―?value‖, ―value*value‖, and ―value?value‖ are not supported. 

Here are some examples, using each of the wildcards and no wildcards: 

Search c r i te r ia  wi l l  be  retu rned  wi l l  not  be re tu rned  

Hello World Java output hello world Hello Dolly 

at Item is at Phoenix site bat, atlas 

?at bat, cat (and so on) splat 

*at bat, cat, splat, big hat batter, catfood, hatpin 

1001-0?2 1001-002, 1001-012, 1001-0A2 1001-0029 

1001-0*2 1001-012, 1001-0A2, 1001-0A12, 1001-03742 
(and so on) 

1001-0129 

Semi ABC Semi Haulers ABC Semiconductor 

Semi* ABC Semi Haulers, ABC Semiconductor ABC Nonsemi Haulers 

Note The only advanced search operator that allows wildcard characters is the Like operator. 
The Like operator is located in the Match If list. (See Advanced Searches on page 165.) 

If you need to search for objects that contain ―*‖, type the backslash character (\) in front of the * 
wildcard (so, ―\*‖) to indicate that you mean the * character, not the * wildcard. For example, to 
search for ―10*18‖, type  10\*18 . 

Note You cannot search for the ―?‖ character, that is, you cannot enter the string ―\?‖. Nor can 
you search for the backslash character by entering the string ―\\‖. 

 

Special Characters as Part of Words 

The following characters are considered to be part of the word or number in which they are found: 

_ underscore    - hyphen    ~ tilde    * asterisk    ’ apostrophe    @ at 
sign    # number    % percent    ^ caret    & ampersand 

For instance, if an item’s number is 10#40, the search treats it as a single word; ―10‖ and ―40‖ would 
not be found. So, if you use the * wildcard character, 1* would find 10#40 but 4* would not. 
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Caution Do not use wildcards to create searches that match too many rows in the database, 
for example, a search for ―P*‖. When you run a search with a wildcard, the criteria 
must be matched against all words in the index (formed by combining autonumbers, 
descriptions, and text in attachments), which can run into several million rows on a 
large database. It is a good idea to further refine such a search so performance of the 
database is not compromised. 

 If your wildcard search matches too many rows in the database, you may see an error 
message telling you that your wildcard query resulted in too many results, please refine 
your criteria and try again. In this case, enter a more specific search string and try again. 
The more clues you can provide, the more specific your search will be. For example, 
―Resistor*‖ is more specific than ―R*‖ and ―MOSFET Transistor‖ is more specific than 
―Transistor‖. 

 Wildcard searches that specify only one or two characters, including the space character 
and punctuation characters, may return this error. Whether or not a specific wildcard 
search matches too many rows in the database also depends on the size and complexity 
of your database. 

If you enter ―*‖ without any criteria, Agile PLM does not attempt to match all the words in 
the index. 

Note For multi-byte language Agile installations (Japanese and Chinese), simple searches 
and quick searches, that use wildcard characters to search for text strings that include 
the following special characters, produce inconsistent results or do not return the correct 
search results. 

 tilde   ~    grave accent  `    exclamation point  !    at sign  @    number sign  #    dollar 
sign  $    per cent sign  %    caret  ^    ampersand  &    asterisk  *    open 
parenthesis  (    close parenthesis  )    hyphen  -    underscore  _    equal sign  =    plus 
sign  +    back slash  \    vertical bar  |    open bracket  [    open brace  {    close 
brace  }    close bracket  ]    semicolon  ;    colon  :    apostrophe  ’    quotation 
mark  ‖    comma  ,    less than sign  <    period  .    greater than sign  >    forward 
slash  /    question mark  ?    

 Instead, use an advanced search to use wildcard characters to search for text strings 
that include these special characters. Specify Like as the search operator. The Like 
search operator allows you to use wildcard characters in advanced searches. When you 
have defined the advanced search, you can save it for later use. See Advanced 

Searches on page 165. 

 

Full Text Search for Content in Attachment Files 

You can search attachment files to find a particular word or phrase. You can use Quick Search or 
Advanced Search to find attachment file content. 
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Note Full Text Search (FTS) is available in localized versions. Agile PLM 9.2.x localized in 
French and German are supported for FTS, which works similarly to the English version 
as these languages are ―whitespaced-delimited.‖ Agile PLM 9.2.x localized in Japanese, 
Simplified Chinese, and Traditional Chinese are supported for FTS of Asian characters; 
however, in the Asian versions, FTS for English text may not be fully successful, for 
example, in wildcard searches using the characters described in Special Characters as 

Part of Words on page 153. 

When you search for attachment file content, the search results list each object that contains files 
matching the search criteria. Only the latest versions of attachments are listed. 

Note If an object contains multiple files, even if only one of the files contains the search text, 
the entire object is returned. The file that contains the text is not indicated, and you may 
need to look through all attachment files to find the appropriate one. 

 For non-English text in documents, Full Text Search is not supported for Stem search or 
Concept search. Moreover, attachment files that can be returned by a full text search 
must be created and saved in Microsoft Word (.DOC) or Excel (.XLS). Non-English–text 
attachment files created in .RTF or .TXT formats are not returned (although .TXT files 
may work if the encoding type is Unicode). 

 

Using Quick Search to Find Attachment File Content 

To include attachment file content in a quick search, select the Search Attachment Text checkbox. For 
detailed information about running quick searches, see Java Client Quick Search on page 150 and 
Web Client Quick Search on page 151. 

"Stop" Words 

The following words are called ―stop‖ words and are ignored by the system in searching against 
attachment files. So, a search for ―the mouse‖ will return all matches for ―mouse‖—which includes 
attachment content with the sequence ―the mouse‖ because the stop word ―the‖ is ignored. (To 
contrast, a simple search of objects – not attachments – for ―mouse‖ would not return ―the mouse‖. 

Note On SQL Server, the query string cannot contain any stop words. For example, you would 
not be able to input ―the mouse‖ as a query string. 

 

 a, about, after, all, also, an, and, 
any, are, as, at 

 if, in, inc, into, is, it, its  s, says, she, so, some, such 

 be, because, been, but, by  last  than, that, the, their, there, they, 
this, to 

 can, co, Corp, corp, could  more, most, Mr, mr, Mrs, mrs, 
Ms, ms, Mz, mz 

 up 

 for, from  no, not  was, we, were, when, which, who, 
will, with, would 

 had, has, have, he, her, his  of, on, one, only, or, other, out, 
over 

  
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Using Attachment Content Advanced Search Capabilities 

You can search for attachment files in which the file content matches the text criteria you specify. 
The following table shows an example of an advanced search in Web Client that will find 
attachment files that contain the words ―PCB‖ and ―Layout.‖ (For general instructions about creating 
advanced searches, see Advanced Searches on page 165.) 

            Search for: Items 

            Search Type: Object Search 

 

Field Match If Prompt? Value 

Attachments.Attached Document Text Contains all Words  PCB Layout 

To search for attachment file content, use the attribute Attachments.Attached Document Text. 

The following tables describe the attachment content search options available.  

Sett ing  F inds  Example  

Contains All Words 

 

Attachment files that contain 
all the words that you 
specify, in any order 

Search text: PCB layout 

Search results may include: 
  PCB layout 
  PCB design layout 
  layout of PCB 

Contains Any Word or 
Words 

Attachment files that contain 
at least one of the words that 
you specify 

Search text: PCB layout 

Search results may include: 
  PCB layout 
  PCB design layout 
  layout of PCB 
  PCB design 
  Circuit board layout 

Contains Phrase Attachment files that contain 
all the words that you 
specify, in the order specified 

Search text: PCB layout 

Search results include only: 
  PCB layout 

Does Not Contain (or  
Contains None Of) 

Attachments that do not 
contain the specified text 

Search text: PCB layout 

Search results never include: 
  ―PCB‖ or ―layout‖ 

About (for concept 
searching) 

Searches for words that are 
about the same concept as 
the specified word. 

Search text: sports 

Search results may include ―basketball‖ 
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Concept Search and Stem Search 

This table describes two specialized search settings, stem searching and concept searching. 

Note SQL Server systems do not support concept searching. 

 

Feature  Descript ion  Examples  

Concept 
searching 

Searches for words that are 
about the same concept as the 
specified word. 

Search text: sports 

Search results may contain: basketball, baseball 

Stem searching Searches for the root of the 
specified word and find all 
attachments that contain the 
root. 

Search text: index 

Search results may contain: indexing, indices 

Search text: run 

Search results may contain: running, ran 

 
 

Pre-configured Parametric Searches 

In an advanced search, you can choose from a complete list of the available search attributes. By 
contrast, in a pre-configured parametric search, a list of the most useful or commonly used search 
attributes are automatically displayed for you in the search window. For each parametric search 
attribute, you can select a Match If operator and a value for which to search. You define search 
values for only the attributes you wish to use in your search. You can leave the remaining 
parametric search attributes blank. 

Your Agile administrator defines the parametric search for all Agile PLM users in Agile 
Administrator. Each object class or type can have a different set of pre-configured search attributes. 
Contact your Agile administrator if you have questions about pre-configured search attributes in 
your Agile system. 

After you have defined your parametric search, you can save it in your Personal Searches folder for 
reuse. For more information about saving a parametric search, see Saving a Search on page 161. 

Parametric Search Window 

The search features in the parametric search window are similar to the quick search. 
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Important To display the pre-configured search attributes in the parametric search window, you 
must select an object type in the second drop-down list. This displays the pre-
configured parametric search attributes. Then, select Match If operators and search 
values for the parametric search attributes you want to use, and click Run. 

 Each search condition you define is added to the search (creating an AND search), 
including the quick search condition at the top of the page. 

 

Java Client Parametric Search Window 

 

Base Class drop-
down list 

Use  to select a 
specific base class. 
Agile limits the search 
to any object with that 
base class as its 
―ancestor.‖ 

Selecting All in this list 
disables the Object 
Type list. Agile 
searches all object 
classes in the 
database. 

Object Type drop-
down list 

Use  to select a 
specific object class or 
a specific object 
subclass (object type) 
to further limit the 
search. 

The available choices 
in this list are defined 
by the Base Class list 
selection. 

Important!   Selecting 
an object type in this 
list automatically 
displays any pre-
configured search 
attributes. 

Search 
Attachment Text 
checkbox 

When you select 
an Object Type, 
this checkbox is 
enabled. 

If you want to 
include the content 
of attachment files 
in your search, 
check the box. 

Search Criteria 
field 

The search criteria 
text is not case-
sensitive. You can 
enter as search 
criteria: 

 a product ID 
number 

 an entire word 

 multiple words 

 partial numbers 
or partial words, 
using the * and ? 
wildcards. 

Run Search 
button 

Runs the search 
you specify and 
displays the 
results in the 
Search Results 
window. 

See Perform a 

Quick Search in 
Java Client on page 
151  for more 
information. 

 See Full Text 

Search for 
Content in 
Attachment 
Files on page 154 
for more 
information. 

See Quick 

Searches and 
Wildcard 
Characters on 
page 152 for more 
information. 

See Search 

Results on 
page 145 for 
more 
information. 

The following search control buttons and menus appear at the bottom of the Java Client parametric 
search window: 

Button  Descript ion  

Run Run the search with the displayed criteria. 

Save Save the displayed search as an Advanced Search. The Save in Folder dialog 
appears. See Saving a Search on page 161. 

Reset Clears the displayed search criteria in the Search window. 
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Button  Descript ion  

More... Drop-down list displays additional actions. 

  Customize Output Display The Customize Output Display dialog allows you to select which attribute columns 
appear in the search results table and the order in which you want to appear. See C. 

Define a Custom Output Display on page 169. 

  Convert to Advanced 
Search 

Displays the Advanced Search dialog. The parametric search criteria you defined in 
the parametric search are pre-defined in the Advanced Search dialog. See Saving 

a Parametric Search as an Advanced Search on page 162. 

 
 

Running a Pre-configured Parametric Search in Java Client 

To define and run a pre-configured parametric search: 

1. In the main menu Search button  drop-down list, select the object class you want for your 
search. 

2. The parametric search window opens with no pre-configured search attributes displayed. 

See Java Client Parametric Search Window on page 158. 

Note You can use the collapsed parametric search display to run a quick search. (See 
Quick Search Overview on page 149.) 

3. To display the pre-configured search attributes, select an object type in the second drop-down 
list. 

The pre-configured search attributes for the selected object type are displayed in the search 
window. 

Use the  -  or  +  to the left of the Search For field to collapse or expand the list of pre-configured 
search attributes. 

4. For each attribute you want to include in your search, select a Match If operator. 

5. For each search attribute you want to include in your search, enter a search value. 

If you leave a search value blank, that attribute search criteria will not be used in your search. 

6. Click Run. 

The results are displayed in the search window below the parametric search definition. 

The parametric search is an AND search. Each search condition is included in the search with an 
AND operator. 
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Web Client Parametric Search Window 

 

Base Class drop-
down list 

Use  to select a 
specific base class. 
Agile limits the search 
to any object with that 
base class as its 
―ancestor.‖ 

Selecting All in this list 
disables the Object 
Type list. Agile 
searches all object 
classes in the 
database. 

Object Type drop-
down list 

Use  to select a 
specific object class or 
a specific object 
subclass (object type) 
to further limit the 
search. 

The available choices 
in this list are defined 
by the Base Class list 
selection. 

Important!   Selecting 
an object type in this 
list automatically 
displays any pre-
configured search 
attributes. 

Search 
Attachment Text 
checkbox 

When you select 
an Object Type, 
this checkbox is 
enabled. 

If you want to 
include the 
content of 
attachment files in 
your search, 
check the box. 

Search Criteria field 

The search criteria 
text is not case-
sensitive. You can 
enter as search 
criteria: 

 a product ID 
number 

 an entire word 

 multiple words 

 partial numbers or 
partial words, 
using the * and ? 
wildcards. 

Run Search 
button 

Runs the 
search you 
specify and 
displays the 
results in the 
Search 
Results 
window. 

See Perform a 

Quick Search in 
Java Client on page 
151 for more 
information. 

 See Full Text 

Search for 
Content in 
Attachment 

Files on page 
154 for more 
information. 

See Quick 

Searches and 
Wildcard 
Characters on 
page 152 for more 
information. 

See Search 

Results on 
page 145 on  
for more 
information. 

The following search control buttons and menus appear at the bottom of the Web Client parametric 
search window: 

Button  Descript ion  

Run Run the search with the displayed criteria. 

Save Save the displayed search as an Advanced Search. The Save in Folder dialog 
appears. See Saving a Search on page 161. 

Reset Clears the displayed search criteria in the Search window. 

More... Drop-down list displays additional actions. 

Customize Output Display The Customize Output Display dialog allows you to select which attribute columns 
appear in the search results table and the order in which you want to appear. See 
C. Define a Custom Output Display on page 172. 

Convert to Advanced Search Displays the Advanced Search dialog. The parametric search criteria you defined 
in the parametric search are pre-defined in the Advanced Search dialog. See 
Saving a Parametric Search as an Advanced Search on page 162. 
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Running a Pre-configured Parametric Search in Web Client 

To define and run a pre-configured parametric search: 

1. In the main menu, move the mouse pointer over the Search button  drop-down arrow to 
display a list of objects classes. Select the object class you want for your search. 

2. The parametric search window opens with no pre-configured search attributes displayed. 

See Web Client Parametric Search Window on page 160. 

Note You can use the parametric search display to run a quick search. (See Quick Search 

Overview on page 149.) 

3. To display the pre-configured search attributes, select an object type in the second drop-down 
list. 

The pre-configured search attributes for the selected object type are displayed in the search 
window. 

Use the  -  or  +  to the left of the Search For: field to collapse or expand the list of pre-configured 
search attributes. 

4. For each attribute you want to include in your search, select a Match If operator. 

5. For each search attribute you want to include in your search, enter a search value. 

If you leave a search value blank, that attribute search criteria will be not be used in your 
search. 

6. Click Run. 

The results are displayed in the search window below the parametric search definition. 

The parametric search is an AND search. Each search condition is included in the search with an 
AND operator. 

Saving a Search 

You can save both parametric searches and advanced searches using a similar save process or 
save as processes. A saved parametric search returns search results in the parametric search 
window, and a saved advanced search returns the search results in the advanced search results 
table. 

 When you run a saved parametric search, the search results are displayed in the parametric 
search window. You can expand the list of pre-configured attributes to modify or refine your 
search. If you want, you can save the search with the modifications you made. 

 When you run a saved advanced search, the search results are displayed in the advanced 
search results window. To modify the advanced search, use the Edit button in the search 
results table. 



 

 

162 Agile Product Lifecycle Management 

  

To save a parametric or advanced search in Java Client: 

1. Define the search conditions and click Save. 

The Save in Folder dialog box appears. 

2. Enter a name for the search in the Search Name field. 

3. Select a folder in which to store it. 

If you do not have sufficient privileges to save a search in the selected folder, you can select 
another. You can always save a search in the Personal Searches folder. 

4. To create a new folder, click the  New button. In the Create New Folder dialog, enter a folder 
name and click OK. 

5. Click OK in the Save in Folder dialog box to save the search. 

To save a parametric or advanced search in Web Client: 

1. Define the search conditions and click Save 

2. The Save Search As dialog box appears. 

3. Enter a name for the search in the Search Name field. 

4. Then select a folder in which to store it. 

If you do not have sufficient privileges to save a search in the selected folder, you can select 
another. You can always save a search in the Personal Searches folder. 

5. To create a new folder, click the  New button. In the Create New Folder dialog, enter a folder 
name and click OK. 

6. Click OK in the Save Search As dialog box to save the search. 
 

Saving a Parametric Search as an Advanced Search 

When the parametric search window is open, you can convert the parametric search to a new 
advanced search. The advanced search is created with all the parametric search conditions 
predefined in the advanced search. This allows you to define additional search criteria not available 
in a parametric search and save the advanced search for reuse. 

To save a parametric search as an advanced search in Java Client: 

1. With a parametric search window open, in the More button drop-down list, choose Convert to 
Advanced Search... 

You can either define a parametric search and convert it, or you can run a previously saved 
parametric search and convert it. 

2. The Advanced Search dialog appears. Define the advanced search. 

For more information about defining advanced searches, see Creating an Advanced Search in 

Java Client on page 167. 

3. When you are finished, in the Advanced Search dialog, click Save. 

The Save in Folder dialog box appears. 

4. Enter a name for the search in the Search Name field. 
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5. Select a folder in which to store it. 

If you do not have sufficient privileges to save a search in the selected folder, you can select 
another. You can always save a search in the Personal Searches folder. 

6. To create a new folder, click the  New button. In the Create New Folder dialog, enter a folder 
name and click OK. 

7. Click OK in the Save in Folder dialog box to save the search. 

To save a parametric search as an advanced search in Web Client: 

1. With a parametric search window open, in the More button drop-down list, choose Convert to 
Advanced Search... 

You can either define a parametric search and convert it, or you can run a previously saved 
parametric search and convert it. 

2. The Advanced Search window appears. Define the advanced search. 

For more information about defining advanced searches, see Creating an Advanced Search in 

Web Client on page 170. 

3. When you are finished, in the Advanced Search window, click Save 

4. The Save Search As dialog box appears. 

5. Enter a name for the search in the Search Name field. 

6. Then select a folder in which to store it. 

If you do not have sufficient privileges to save a search in the selected folder, you can select 
another. You can always save a search in the Personal Searches folder. 

7. To create a new folder, click the  New button. In the Create New Folder dialog, enter a folder 
name and click OK. 

8. Click OK in the Save Search As dialog box to save the search. 
 

Using Save As to Save a Search 

You can use More > Save As to: 

 Create a new copy of a previously saved search. 

 Create a shortcut (link) to a predefined system search in a system folder, for example, the 
Global Searches folder, in your personal searches folder. 

If the Agile administrator updates or modifies a global search, when you run the search from 
the shortcut in your personal searches folder, Agile uses runs the most recent updated search. 

 Create a shortcut (link) to a non-editable system search . 

Note When you use Save As and select a non-editable system search, creating a shortcut 
is the default action. 

 Create a shortcut to a saved search in a different personal searches folder. 
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To use save as to save a search in Java Client: 

1. Select the search you want to copy or link to, then initiate the save as process: 

 In the Search folder, select the search you want, right-click and choose Save As. 

 In the Search folder, select the search you want, right-click and choose Edit. In the More 
button drop-down list, choose Save As. 

 Run the search, then choose edit from the search results table: 

In a parametric search window, use the More button drop-down list, choose Save As. 

In an advanced search results table, click the Edit button. In the advanced search dialog, 
use the More button drop-down list and choose Save As. 

2. The Move to Folder dialog appears. The Create ShortCut checkbox is checked by default. To 
create a copy of the search, uncheck the checkbox. 

Note If you have selected a non-editable predefined system search, the checked Create 
ShortCut checkbox is disabled. You are not allowed to create a copy of a non-
editable system search using Save As. For more information, see Predefined 

System Searches on page 147. 

3. Select the folder you want for the saved search or shortcut. 

4. To create a new folder, click the  New button. In the Create New Folder dialog, enter a folder 
name and click OK. 

5. Click OK in the Move to Folder dialog box to save the search. 

To use save as to save a search in Web Client: 

1. In the Searches folder in the navigation pane, navigate to the search you want to edit. 

2. Click the Edit Search  icon to the right of the search name. 

Alternately, run the search, then choose edit from the search results table: 

 In a parametric search window, use the More button drop-down list, choose Save As. 

 In an advanced search results table, click the Edit Search  button. In the advanced 
search dialog, use the More button drop-down list and choose Save As. 

3. The Save Search As dialog appears. The Create Shortcut checkbox is checked by default. To 
create a copy of the search, uncheck the checkbox. 

Note If you have selected a non-editable predefined system search, the checked Create 
ShortCut checkbox is disabled. You are not allowed to create a copy of a non-
editable system search using Save As. For more information, see Predefined 

System Searches on page 147. 

4. Select the folder you want for the saved search or shortcut. 

5. To create a new folder, click the  New button. In the Create New Folder dialog, enter a folder 
name and click OK. 

6. Click OK in the Move to Folder dialog box to save the search. 
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Advanced Searches 

This section provides the details on using the advanced search capability. 

For information specific to searching for attachment file content, see Full Text Search for Content in 

Attachment Files on page 154. 

For information about where-used searches, see Where-Used Searches for Items on page 179. 
Where-used searches find assemblies that contain items that match the search criteria. 

For information about relationship searches, see Relationship Searches on page 190. Relationship 
searches find objects that are related to objects that match the search criteria. 

These are the topics in this section about advanced searches: 

 Overview of Advanced Searches on page 165 

 Basic Process to Create an Advanced Search on page 166 

 Some Caveats about Advanced Searches on page 166 

 Creating an Advanced Search in Java Client on page 167 

 Creating an Advanced Search in Web Client on page 170 

 Selecting Search Operators on page 173 

 Using And/Or Values in Advanced Searches on page 176 

 Using Parentheses in Search Definitions on page 177 
 

Overview of Advanced Searches 

Advanced searches look for all the objects with fields that match the conditions of the search. The 
object fields and attributes that you can use for advanced searches depend on whether you are 
searching for an object base class, class, or subclass. (For information about classes, see 
Introducing Agile Objects on page 65.) 

Caution Your company may need to examine the benefits of indexing specific columns in your 
database. If the enterprise has an extremely large database, and users discover that 
advanced searches are taking a long time (longer than 2 or 3 minutes), it is likely that 
the searching operation is going through every single column in the database. By 
indexing specific database columns, or setting a ―search order‖ of database columns, 
the searching capability can run faster for all users. See your Agile administrator if you 
suspect this is a problem. 

For example, Agile can search for the fields on the Title Block tab of items, the Cover Page tab of 
changes, and the General Info tab of manufacturing objects, as well as fields on the Manufacturers tab 
of items. In both Java and Web Client, if your company uses custom Page Two or Page Three fields 
(which appear on the Title Block or Cover Page tab in Web Client), they may be referred to by a 
different name on your system. Agile can also search those fields. 

When searching for changes, Agile can search for workflow attributes and statuses on changes. 
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Once you create and save a search, you can: 

 Run it by clicking it (Web Client), or double-clicking it (Java Client), in the navigation pane. 

 Edit it as described in Editing and Managing Searches and Search Folders on page 198. 
 

Basic Process to Create an Advanced Search 

Creating an advanced search is described in detail below for both Java Client and Web Client. The 
general procedure to creating an advanced search is as follows: 

1. Open the Advanced Search dialog from the button in the menu (steps 1 and 2 in the tasks 
below). 

2. Define the Search Criteria: the type of object, the kind of search (for example, an object search, a 
where-used search, or a relationship search), field names, conditions, and values you want to 
search for (steps 3–9). 

3. Define Options: specify the output fields you want displayed in the search results table (steps 
11–13). 

4. Save the search (name and folder), run the search, and print the search results (steps 10, 14, 
and 15). 

Also see the sections immediately following the ―create search‖ tasks: Using And/Or Values in 

Advanced Searches on page 176, and Using Parentheses in Search Definitions on page 177. 

Some Caveats about Advanced Searches 

Using Saved Searches to Create your Advanced Search 

Creating a successful advanced search can be challenging. Consider using a saved search that has 
some elements of the search you wish to create. When you start to create an advanced search, 
there is an option to Use a Saved Search; you browse to the search and it ―prepopulates‖ the 
search dialog box or wizard. Or you may prefer, with a search selected in Java Client, to click the 
View/Edit button, save the opened search with another name (and directory as needed), and develop 
your new search by modifying the old one. 

Difference in Caching Search Attributes in Java Client and Web Client 

You may encounter a situation where a field on Page Three of a business object is available for 
search in Web Client, but is not available in Java Client. This can happen when the administrator 
hides a field (changes Visible property to No), but has not yet logged out on his system, so the 
change has not gone into effect for Java Client users, while the change is immediately in effect for 
Web Client users. 

Complexity between Search Criteria and Output Display 

There is potential for ambiguity between the search criteria and the search results output display 
settings. The search criteria that you define – including the object type (step 3 below) coupled with 
the object attributes (step 6 below) –determine which objects the search finds. The output display 
attributes (step 11 below) determine how the found objects are listed in the search results table. 
The output display attributes do not alter the results of the search, they determine only the manner 
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in which those results are displayed. 

When you search for objects by defining criteria that uses data found on related tables, and select 
similar criteria to display in the output, you may find unexpected results. It is recommended that, 
whenever possible, you set up your search against the parent object and not its associated data. 

More specifically, if you search an object using an attribute of a related object – data that is pulled 
from other objects, such as BOM, Affected Items, Related PSRs, Changes, and so forth – as a 
search criteria, and for your output you choose to display attributes of the related object in your 
output, all the related objects will be listed, not just those that meet the search criteria. You will see 
the searched-for objects listed multiple times in the search results, once for each related object. 

For example, if you choose ―PSR‖ for object type and search against Affected Items (which is 
associated data) for some criteria such as ―quantity > 5,‖ and you display the affected item number 
and quantity, you may expect that only affected items with quantity > 5 will appear on the search 
results table; however, all the affected items of the found PSRs will be listed, resulting in the PSR 
itself being listed multiple times. 

Searching for Space Characters in Text Fields 

A space character by itself is not a valid search value. Agile PLM will return an error if one or more 
space characters are the only characters specified in the search condition Value field. 

However, you can specify a search value that includes a space character in conjunction with other 
characters. For example, you can search for ―blue box‖ to find the text string ―blue<space>box‖. 

Note To search for text strings that begin with a space, you can use the Like search operator 
in the Match If field and include a wildcard character in the Value field. 

When you use a wildcard in the search Value field, you must use the Like operator. The only 
advanced search operator that allows wildcard characters is the Like operator. 

For more information about wildcard characters, see Using Wildcard Characters on page 152. 

Creating an Advanced Search in Java Client 

To create an advanced search in Java Client: 

A. Select the Search Type, Java Client 

1. Click the Advanced Search button  in the toolbar. 

The Advanced Search dialog appears, ready for you to define the search criteria. The name 
Advanced Search appears in the title bar at the upper left of the dialog box. 

2. To create a completely new search, select Create New. 

You can also start with a saved search: select Use a Saved Search, click the ... button, and select 
the search you want to start with. 

3. In the Object Type drop-down list, select the type of object to find. You can specify a base class, 
class, or subclass object. 

4. In the Search Type drop-down list, make sure Object Search is selected. 
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Note If you select a search type other than Object Search, you must also select an object 
type in the With Related Content drop-down list. For more information, see Where-

Used Searches for Items on page 179, Where-used Searches for File Folders on 
page 188, and Relationship Searches on page 190. 

 

B. Define the Search Criteria, Java Client 

1. By default, the search condition table contains one row. (You can add as many rows as you 
need by clicking Add in the search builder window.) 

Click the row to enable the search criteria selection lists. 

2. Define a set of search criteria, or conditions: 

a. Click the first drop-down list  to select a target Field from the list. For example, Title 
Block.Number represents the Number field on the Title Block tab of a part or document. 

The Field list varies depending on the object selected in the Object Type field. For example, 
if you search for assembly drawings—a part—the Field list includes Title Block.Lifecycle 
Phase. If you search for ECOs—a change—the Field list includes Cover Page.Status. 

b. Click the second drop-down list to select a Match If search operator from the list. For more 
information, see Selecting Search Operators on page 173. 

c. The Prompt? field is enabled if appropriate, and the checkbox is unchecked by default. If 
you leave the checkbox unchecked, the Value field is enabled (see next step). If you check 
the checkbox, you are not going to fill in the Value field, and, when you run the saved 
search, you will be prompted to enter a value. 

d. In the Value field, select a value from the drop-down list and click OK. The value you 
selected populates the field. 

The Value field specifies the content or setting of the field selected from the field list. 
Depending on the selection in the field list, the value field may contain a list that is relevant 
to the selection, a calendar button, or a field where you can enter text or numbers. For 
example, if Field is set to Title Block.Lifecycle Phase, then the Value field lists the different 
lifecycle phases; if Field is set to Title Block.Description, then you can type text or numbers 
in the Value field. 

If you select Like as a Match If search operator, or if you are searching for attachment file 
content, you can use wildcard characters when entering a value. For information about 
using wildcards to search for objects, see Using Wildcard Characters on page 152. For 
information about searching for attachment file content, see Full Text Search for Content 

in Attachment Files on page 154. 

e. To add an operator setting of ―AND‖ or ―OR,‖ click the And/... field and select AND or OR 
from the list. 

Use AND if both conditions must be met. 

Use OR if either or both conditions can be met. 

If you have selected AND or OR but wish to remove the operator, click the And/... field and 
select the empty space, which will de-populate the field of either operator. 

If you do not use parentheses when defining your search, the search is processed giving 
precedence to AND values, that is, it processes all rows that end with AND before 
processing rows that end with OR. In other words, the first line is combined with the 
second and process order is based on the first line’s AND/OR value. 
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f. For more information, see Using And/Or Values in Advanced Searches on page 176.To 
add parentheses, select two adjacent rows using Shift-click. This enables the ( ) button. 
Click it and the proper parenthesis appears to the left of the first row and right of the 
second row. 

To remove parentheses, select two rows grouped by parentheses, and click the enabled 
Remove ( ) button. 

For more information about using parentheses, see Using Parentheses in Search 

Definitions on page 177. 

3. To add another row of search conditions, click Add. A new row is added at the end of the table. 
The AND/OR field at the end of the previous row is set to [blank] by default. 

4. To insert a search condition row, select a row and click the Insert button. The new row is 
inserted above the selected row. If you want to delete a search condition row, select one or 
more rows and click Delete. The selected rows are deleted. 

5. To perform a case-sensitive search where text capitalization matters, click the Match Case 
checkbox. 

If you want to perform a search where text capitalization does not matter, click to deselect 
Match Case. 

Selecting the Match Case checkbox can help your search run more quickly. If you enter text in 
the Value field, the search looks for text that is an exact match (uppercase and lowercase 
letters). If you select a value from a list (such as for Product Line), checking Match Case allows 
the system to use internal database settings to find objects more quickly. 

6. When you have finished adding search conditions, you can Save the search, or click Run to run 
the search without saving it. 

If you click Save, skip to D. Save and Run the Search, Java Client on page 170 and follow 
step a through step d to save the search. Saving the search now, before you define the Custom 
Output Display (see C. Define a Custom Output Display, Java Client on page 169), gives you 
the opportunity to name the Search Criteria you have defined, and to use that search with 
different output displays later. 

If you click Run without saving the search, the results are displayed in the search results 

window. To further edit the search or to save the search, click the View/Edit button . 

C. Define a Custom Output Display, Java Client 

1. When you have finished adding search conditions, select Custom Output Display... in the More.. 
button drop-down list. The Custom Output Display dialog appears for you to specify which 
fields to include in the search results. The Available Fields and Selected Fields tables are 
displayed. 

2. In the Custom Output Display dialog, in the Available Fields table, select the field names you 
want and use the right and left arrows to move field names to and from the Available Fields and 
Selected Fields lists. Double-clicking a field name also moves it from one list to the other list. 

The Selected Fields list specifies the field names that will appear in the search results table. 
Select one or more rows and use the up and down arrows to change the order of field names in 
the list, which reflects the order of the columns in the search results. 

3. To sort the search results, in the Selected Fields list, click in the Sort column for the field name 
by which you want to sort, and select a number from the drop-down list (for example, 1 means 



 

 

170 Agile Product Lifecycle Management 

  

sort by this field name first). You can sort by multiple field names; select a number in the Sort 
column for the each of the field names you want to use to sort. Click in the Direction column and 
select Ascending or Descending order. 

Note List and Multilist fields, such as Product Lines, cannot be sorted alphabetically. 

4. When you have finished specifying output display fields and sort order, click OK in the dialog 
box. 

 

D. Save and Run the Search, Java Client 

1. You may choose to click Save to save the search, or click Run to run the search without saving it 
first. 

a. If you click Save, the Save in Folder dialog box appears. 

b. Enter a name for the search. 

c. Then select a folder in which to store it. If you do not have sufficient privileges to save a 
search in the selected folder, you can select another. You can always save a search in the 
Personal Searches folder. 

d. Click OK in the dialog box to save the search. 

e. When you are ready to run the search, click Run in the search dialog box. 

The Search Results window shows all the objects that match the search criteria. 

2. To print the list of search results, click the Print button . 
 

Edit the Search After Running It, Java Client 

To edit the search after running it, do one of the following: 

 If the search results window is open, click the View/Edit button . 

 If you saved the search and closed it, in the Searches tab of the navigation pane, select the 

search and run it. Then click the View/Edit Search button  in the search results window, and 
edit the search. 

 

Creating an Advanced Search in Web Client 

To create an advanced search in Web Client: 

A. Select the Search Type, Web Client 

1. Click the Advanced Search button  in the toolbar. 

The Advanced Search dialog appears with the Search Criteria tab displayed. 

2. To create a completely new search, select Create New. 

You can also start with a saved search: select Use Saved Search, click , and select the 
search you want to start with. 

3. In the Search For drop-down list, select the type of object to find. You can specify a base class, 
class, or subclass object. 
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4. In the Search Type drop-down list, make sure Object Search is selected. 

Note If you select a search type other than Object Search, you must also select an object 
type in the With Related Content drop-down list. For more information, see Where-

Used Searches for Items on page 179, Where-used Searches for File Folders on 
page 188, and Relationship Searches on page 190. 

 

B. Define the Search Criteria, Web Client 

1. By default, the search condition table contains one row. (In Web Client, you can add as many 
rows as you need by clicking the And/Or field and selecting AND or OR from the list. See step 
2e below.) 

Click the row to enable the search criteria selection lists. 

2. Define a set of search criteria, or conditions: 

a. Click the first drop-down list  to select a target Field from the list. For example, Title 
Block.Number represents the Number field on the Title Block tab of a part or document. 

The Field list varies depending on the object selected in the Object Type field. For example, 
if you search for assembly drawings—a part—the Field list includes Title Block.Lifecycle 
Phase. If you search for ECOs—a change—the Field list includes Cover Page.Status. 

b. Click the second drop-down list to select a Match If search operator from the list. For more 
information, see Selecting Search Operators on page 173. 

c. The Prompt? field is enabled if appropriate, and the checkbox is unchecked by default. If 
you leave the checkbox unchecked, the Value field is enabled (see next step). If you check 
the checkbox, you are not going to fill in the Value field, and, when you run the saved 
search, you will be prompted to enter a value. 

d. Click the Value field, one or more value from the drop-down list and click Close. The value 
you selected populates the field. 

The Value field specifies the content or setting of the field selected from the field list. 
Depending on the selection in the field list, the value field may contain a list that is relevant 
to the selection, a calendar button, or a field where you can enter text or numbers. For 
example, if Field is set to Title Block.Lifecycle Phase, then the Value field lists the different 
lifecycle phases; if Field is set to Title Block.Description, then you can type text or numbers 
in the Value field. 

If you select Like as a Match If search operator, or if you are searching for attachment file 
content, you can use wildcard characters when entering a value. For information about 
using wildcards to search for objects, see Using Wildcard Characters on page 152. For 
information about searching for attachment file content, see Full Text Search for Content 

in Attachment Files on page 154. 

e. To add an operator setting of ―AND‖ or ―OR,‖ click the And/Or field and select AND or OR 
from the list. 

Use AND if both conditions must be met. 

Use OR if either or both conditions can be met. 

Note that a second line for your search is added as soon as you select AND or OR. 

If you have selected AND or OR but wish to remove the operator, click the And/... field and 
select the empty space, which will de-populate the field of either operator. 



 

 

172 Agile Product Lifecycle Management 

  

Note that the added line does not disappear. You can still set values for that row, and re-
select AND or OR. You can also delete the row using the button to the right. 

If you do not use parentheses when defining your search, the search is processed giving 
precedence to AND values, that is, it processes all rows that end with AND before 
processing rows that end with OR. In other words, the first line is combined with the 
second and process order is based on the first line’s AND/OR value. 

For more information, see Using And/Or Values in Advanced Searches on page 176. 

f. To add parentheses, click the appropriate radio buttons to locate both an open and close 
parenthesis. Then click the Add ( ) button. The proper parenthesis appears to the left of the 
first row and right of the second row. 

To remove parentheses, click the appropriate radio buttons for the two rows grouped by 
parentheses, and click the Remove ( ) button. 

For more information about using parentheses, see Using Parentheses in Search 

Definitions on page 177. 

3. To add another row of search conditions, click the And/Or field and select AND or OR. A new 
row is added at the end of the table. You can add as many rows as you like before populating 
them with criteria. 

4. To insert a search condition row, click the Insert Row in Search Criteria  button. The new row is 
inserted above the row where you clicked the button. If you want to delete a search condition 
row, click the Delete button for that row. 

5. To perform a case-sensitive search where text capitalization matters, click the Match Case 
checkbox. 

If you want to perform a search where text capitalization does not matter, click to deselect 
Match Case. 

Selecting the Match Case checkbox can help your search run more quickly. If you enter text in 
the Value field, the search looks for text that is an exact match (uppercase and lowercase 
letters). If you select a value from a list (such as for Product Line), checking Match Case allows 
the system to use internal database settings to find objects more quickly. 

6. When you have finished adding search conditions, you can use the buttons at the bottom of the 
dialog to Run, Save, or Cancel the search. 

If you click Save, skip to D. Save and Run the Search, Web Client on page 173 to save the 
search. Saving the search now, before you define the Custom Output Display (see C. Define a 

Custom Output Display, Web Client on page 172), gives you the opportunity to name the 
Search Criteria you have defined, and to use that search with different output displays later. 

C. Define a Custom Output Display, Web Client 

1. When you have finished adding search conditions, select Custom Output Display... in the More 
button drop-down list. The Custom Output Display dialog appears for you to specify which 
fields to include in the search results. The Available Fields and Selected Fields tables are 
displayed. 

2. Under Output Fields, in the Available Fields table, select field names you want and use the 
right and left arrows to move field names to and from the Available Fields and Selected Fields 
lists. Double-clicking a field name also moves it from one list to the other list. 

The Selected Fields list specifies the field names that will appear in the search results table. 
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Use the up and down arrows to change the order of field names in the list, which reflects the 
order of the columns in the search results. 

3. To sort the search results, in the Sort By field, use the drop-down list to select the field name by 
which you want to sort first, and click a radio button for Ascending or Descending. If you want, 
do the same in one or both ―Then By‖ fields. 

Note List and Multilist fields, such as Product Lines, cannot be sorted alphabetically. 

4. When you have finished specifying output fields and sort order, click OK in the dialog box. 
 

D. Save and Run the Search, Web Client 

1. You may choose to click Save to save the search, or click Run to run the search. 

a. If you click Save, the Save Search As dialog box appears. 

b. Enter a name for the search. 

c. Then select a folder in which to store it. If you don’t have sufficient privileges to save a 
search in the selected folder, you can select another. You can always save a search in the 
Personal Searches folder. 

d. Click OK in the dialog box to save the search. 

e. When you are ready to run the search, click Run in the search dialog box. 

The Search Results window shows all the objects that match the search criteria. 

2. To print the list of search results, click the Print button . 

 
 

Edit the Search After Running It, Web Client 

To edit the search after running it, do one of the following: 

 If the search results window is open, click the Edit Search button . 

 If you saved the search and closed it, in the Searches tab of the navigation pane, click the 

search, click the Edit Search button , and edit the search. 
 

Selecting Search Operators 

Search operators are specified in the Match If field. Available operators vary depending on the Field 
list selection. For example, if the Field setting is Title Block.Description, the Match If field includes the 
Contains operator along with several others; if the Field is set to Title Block.Lifecycle Phase, the only 
operators are In, Not In, Is Null, and Is Not Null. 

Operator  Descript ion  

Contains Finds any value that includes the contents of the Value field. For example, if you 
are searching for objects that contain the value ―cap‖ in their description, the search 
would find objects described as capacitor, High Capacity Drive, CAP plug, and so 
on. 

Equal To Finds only an exact match with the contents of the Value field. 
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Operator  Descript ion  

Like Allows wildcard searches that match any single character. 

Not Like Allows wildcard searches that exclude any single character. 

Starts With Finds values that begin with the characters in the Value field. 

Does Not Contain Finds any value that does not include the contents of the Value field. 

Not Equal To Finds any value other than an exact match with the contents of the Value field. 

Does Not Start With Finds values that do not begin with the characters in the Value field. 

Is Null Finds objects where the field selected from the Field list contains no value. 

Is Not Null Finds objects where the field selected from the Field list contains any value. 

Greater Than Finds dates later than, or duration (in hours) longer than, the contents of the Value 
field. 

Finds numbers larger than the contents of the Value field. 

Finds currency amounts larger than the contents of the Value field. 

Greater Than Or 
Equal To 

Finds dates that match or are later than, or duration (in hours) that matches or is 
longer than, the contents of the Value field. 

Finds numbers that match or are larger than the contents of the Value field. 

Finds currency amounts that match or are larger than the contents of the Value 
field. 

Less Than Finds dates earlier than, or duration (in hours) less than, the contents of the Value 
field. 

Finds numbers less than the contents of the Value field. 

Finds currency amounts less than the contents of the Value field. 

Less Than Or Equal 
To 

Finds dates that match or are earlier than, or duration (in hours) that matches or is 
less than, the contents of the Value field. 

Finds numbers that match or are less than the contents of the Value field. 

Finds currency amounts that match or are less than the contents of the Value field. 

Between Finds dates that match or are between the beginning date and ending date 
specified in the Value field. 

Finds numbers that match or are between the high number and low number 
specified in the Value field. 

Finds currency amounts that match or are between the high amount and low 
amount specified in the Value field. 
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Operator  Descript ion  

Not Between Finds dates that do not match or are not between the beginning date and ending 
date specified in the Value field. 

Finds numbers that do not match or are not between the high number and low 
number specified in the Value field. 

Finds currency amounts that do not match or are not between the high amount and 
low amount specified in the Value field. 

In Finds a list attribute that matches one of the list values specified in the Value field. 

Not In Finds a list attribute that does not match any of the list values specified in the Value 
field. 

Contains Any Finds a multilist attribute that matches any (at lease one) of the multilist values 
specified in the Value field. 

Contains All Finds a multilist attribute that contains all of the multilist values specified in the 
Value field. 

Note: To find an exact match, use the Equal To operator. 

To find a multilist attribute that is not empty, use the Is Not Null operator. 

Contains None Finds a multilist attribute that contains none of the multilist values specified in the 
Value field. 

Note: To find an empty multilist attribute, use the Is Null operator. 

 
 

Search Operators and Attribute Types 

The following table lists the search operators used for each attribute type. The following table 
explains how to recognize different attribute types by the manner in which you enter data into the 
field. 

Type  What  to  Enter  in  the F ie ld  

Date Enter date and time, enter the variable $TODAY to use today's date, or select date and time 
from a pop-up calendar. 

List Select one item from a list. 
Select one item from a cascading list. 

MultiList Select one or more items from a multiple-selection list. The list can be a cascading list. 

Note: here is now no limit to the number of list entries in a multi-list field; in previous service 
packs, multi-lists could only save and populate 31 list entries. 

Text Enter a single line of text; the allowable length varies, but generally it is up to 50 characters. 

MultiText Enter a block of text (up to 4,000 characters) that wraps across multiple lines. 

Numeric Enter a numeric value. 

Money Enter a monetary amount. 
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Type  What  to  Enter  in  the F ie ld  

The Agile PLM administrator can set default values (such as the current date, or current user) to automatically 
appear in a field when new objects are created. For more information, see Agile PLM Administrator Guide. 

The following table lists the search operators that apply to each attribute type. 

List  Mul t i l is t  Date ,  Number ,  Money  Text ,  Mul t i text  

In 

Not In 

Is Null 

Is Not Null 

Equal To 

Not Equal To 

Contains Any 

Contains All 

Contains None 

Is Null 

Is Not Null 

Between 

Equal To 

Less Than 

Less Than or Equal To 

Greater Than 

Greater Than or Equal To 

Not Equal To 

Not Between 

Is Null 

Is Not Null 

Equal To 

Like 

Contains 

Starts With 

Not Equal To 

Not Like 

Does Not Contain 

Does Not Start With 

Is Null 

Is Not Null 

 
 

 

 When the time stamp for the date is 12:00:00 AM, Agile PLM assumes the entire day (12:00:00 
AM to 11:59:59 PM) for the search. 

 If you enter a specific time, Agile PLM uses the exact time in the search. For example, Between 
08/20/2007 8:00:00 AM PST and 08/21/2007 5:00:00 PM PST. 

 In Advanced Searches, you may also use the search wildcard $TODAY by typing the wildcard 
into the search value field (as opposed to clicking the calendar button to display the calendar 
tool). 

 $TODAY evaluates true for today's date, all times from 12:00:00 AM to 11:59:59 PM. Date and 
time are determined by your Time Zone as defined in your user profile. 

 Use $TODAY-<integer> or $TODAY+<integer> to includes a number of days before or after 
today. The integers refer to whole days, not hours. For example, use the $TODAY wildcard to 
search for: 

 Items with a Release Date >= $TODAY-7, that is, all items released in the last week. 

 Changes with a Date Originated Between $TODAY-10 and $TODAY, that is, all changes 
created in the last 10 days. 

 

Using And/Or Values in Advanced Searches 

When you have two or more conditions defined in a search, the relationship between them is 
defined as either AND or OR. 
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 AND narrows the search by requiring that both conditions are met. Each item in the results must 
match both conditions. 

 OR broadens the search by including any object that meets either condition. Each item in the 
results table needs to match only one of the conditions, but may match both. 

When you define a search with ―Equal to‖ and AND, both parts of the definition must be true. For 
example, the following search results in zero objects found. 

 Title Block.Product Line(s) Equal to Taurus   AND  

 Title Block.Product Line(s) Equal to Scorpio    

This is because if the first part of the definition is true (that is, the object belongs only to the product 
line Taurus), then the second part of the definition cannot also be true (that is, the object cannot 
belong only to the product line Scorpio). 

In the example above, if you wanted to search for objects that belong to more than one product line, 
you could use Contains with And. The following search would find all the objects that belong to both 
the Taurus and Scorpio product lines because both sides of the definition could be true: 

 Title Block.Product Line(s) Contains Taurus   AND  

 Title Block.Product Line(s) Contains Scorpio    

 
 

Using And/Or — An Example 

Knowing when you want to use AND versus OR in constructing your search criteria can help you 
get the most accurate results from your search and save you valuable time. For example, the 
following figure shows a search that looks for parts that have both a part category equal to Electrical 
and a lifecycle phase equal to Inactive. 

 Title Block.Part Category Equal To Electrical  AND  

 Title Block.Lifecycle Phase Equal To Inactive    

If you replace And with Or, the search locates all parts with either a part category of Electrical or a 
lifecycle phase of Inactive. Depending on your database, this latter search might locate a very large 
number of parts. 

Using Parentheses in Search Definitions 

If you do not use parentheses when defining your search, the search is processed giving 
precedence to AND values, that is, it processes all rows that end with AND before processing rows 
that end with OR. 

In this case, shown in the following figure, Agile looks for objects with both a lifecycle phase equal 
to Production and a product line equal to Scorpio. Then, Agile searches the rest of the database for 
objects with a Description field that contains ―computer.‖ Found objects must have a lifecycle phase 
equal to Production and a product line equal to Scorpio or the word ―computer‖ in their Description 
field because the rows are processed in order. 

 Title Block.Lifecycle Phase Equal To Production  AND  
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 Title Block.Product Line(s) Equal To [Scorpio]  OR  

 Title Block.Description Contains computer    

Parentheses let you group search conditions to determine how the search is performed. 

To place parentheses around search conditions in Java Client: 

1. Select the rows that you want to enclose in parentheses. 

a. Click a row to select it. The row is highlighted. 

b. Use Shift-click or Ctrl-click to select one or more additional rows. 

2. Click the parentheses (  ) button. The parentheses are placed in the first and last rows selected. 

To place parentheses around search conditions in Web Client: 

1. In the row where you want to place an open parenthesis, select the radio button in the open 
parenthesis column. 

2. In the row where you want to place a close parenthesis, select the radio button in the close 
parenthesis column. 

3. Click the Add (  ) button. The parentheses are placed in the first and last rows selected. 

To remove parentheses from search conditions in Java Client: 

1. Select the rows with the open parenthesis and close parenthesis. 

a. Click a row to select it. The row is highlighted. 

b. Use Shift-click or Ctrl-click to select one or more additional rows. 

2. Click the Remove (  ) button. The parentheses are removed. 

To remove parentheses from search conditions in Web Client: 

1. Deselect the open and close parentheses radio buttons in the rows from which you want to 
remove parentheses. 

2. Click the Remove (  ) button. The parentheses are removed. 

For example, in the search conditions shown in the following figure, the second and third conditions 
are enclosed in parentheses. Agile first looks for objects with a lifecycle phase equal to Production, 
then searches that group for objects with either the specified product line or description. All found 
objects must have a lifecycle phase equal to Production, but they can have either a product line 
equal to Scorpio or a Description field that contains ―computer.‖ 

 Title Block.Lifecycle Phase Equal To Production  AND  

( Title Block.Product Line(s) Equal To [Scorpio]  OR  

 Title Block.Description Contains computer )   

If the parentheses are placed around different conditions, a different search occurs. For example, in 
the search conditions shown in the following figure, the parentheses are around the first and second 
conditions. Found objects will either have lifecycle phase equal to Production and product line equal 
to Scorpio, or the Description will contain ―computer‖ without regard to lifecycle phase or product 
line. 

( Title Block.Lifecycle Phase Equal To Production  AND  
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 Title Block.Product Line(s) Equal To [Scorpio] ) OR  

 Title Block.Description Contains computer    

 
 

Where-Used Searches for Items 

Where-used searches are specialized searches that find assemblies that include items that meet 
the search criteria. 

In an object search, the search conditions define the objects you want to find; the objects that meet 
those search conditions appear in the search results table. In a where-used search, the search 
conditions specify items that appear on the BOM(s) of the object(s) that you want to find. Therefore, 
a where-used search finds any assembly that uses the specified items. The assemblies that use the 
defined items appear in the search results table. 

For example, the intent of an object search is 

Create a list of items whose Description field contains Computer. 

The intent of a where-used search with the same search condition is 

Create a list of assemblies where the BOM contains items whose Description field contains 
Computer. 

These are the subsections of ―Where-Used Searches for Items‖: 

 Searching on Rev-Specific Values on page 179 

 Where-Used Search Types on page 180 

 Where-Used Set Operators on page 183 

 Creating a Where-Used Search in Java Client on page 185 

 Creating a Where-Used Search in Web Client on page 187 
 

Searching on Rev-Specific Values 

When you set up a Where Used search, you may well be seeking information about specific 
revisions of a part or other object. A revision, or ―rev‖, explicitly means that the part has been 
modified in some way by a change order. (These ideas are covered in Product Collaboration User 
Guide.) 

You may use or create criteria that includes revision-specific attributes, such as Rev, Lifecycle 
Phase, Rev. Release Date, Rev. Incorporate Date, as well as fields on the Manufacturers tab of the 
object. 

In general, Agile reviews only the latest revision of each item object. The ―latest rev‖ is the most 
recent revision of the object. If the object has been released (through a change order), this can be 
called a ―released rev.‖ Because an object might be released, unreleased, and released again 
(there can be multiple releases), you may want information about the ―latest released rev‖ – 
presumably the part or assembly that is closest to being finished. 

The latest revision can be any of the following, but only one case at a time (see Note below): 
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1. The latest released revision of the item: the item has been released, it has a revision number, and 
there are no change orders or MCOs pending against the item. A released revision occurs 
when the change (Change Order or Manufacturer Order) that created the revision is in its 
workflow at Released or Implemented status types. This is indicated by the revision letter 
showing in parentheses. 

2. The latest pending revision of the item: the item is on the Affected Items tab of one or more 
unreleased change orders or MCOs. A Pending revision occurs when the change that created 
the revision is in its workflow at one of these status types: Unassigned, Pending, Submit, 
Review, or Hold. This is indicated by the revision letter showing in parentheses. 

3. An Introductory rev with no pending changes: this Introductory item has no revision number or 
pending revision number. It has never been released and it is not on the Affected Items tab of a 
change order or an MCO. 

Note These revision types are listed in hierarchical order: if there is an instance of case 1, 
that is the latest rev. If there is no released rev but there is an instance of case 2, 
the system sees that as the latest rev. If there is no released or pending rev but 
there is an instance of case 3, Agile takes the Introductory rev as the latest rev. Note 
also that the Introductory rev is considered to be a released revision, so items at 
Intro rev are expected to be included in Where Used search results. 

 

Where-Used Search Types 

There are four types of ―where-used‖ searches, which are defined and described in the following 
sections. ―Level‖ refers to the BOM. 

 Where-Used – All Levels – Latest Released Revision Only on page 180 

 Where-Used – Top Level – Latest Released Revision Only on page 181 

 Where-Used – One Level – Latest Released Revision Only on page 181 

 Where-Used – One Level – All Released Revisions on page 182 

 
 

Where-Used – All Levels – Latest Released Revision Only 

This where-used search type returns a list of the latest released revision of assemblies that contain 
the named object (that is, assemblies where that object is used). Note that: 

 Pending revisions are not included. For items/assemblies with pending change order, the 
Where Used search result will return the item/assembly labeled Introductory (Intro) 
revision. 

 Introductory revisions are included, and they are treated as if they were released revisions. 

The object described by the search conditions is contained, directly or indirectly (defined below), on 
the BOMs of the returned assemblies. This search returns assemblies that contain the described 
object at any BOM level. 

Refer to the figure below. In Assembly 999, Part 222 is contained directly on the BOM of Assembly 
999. Also, Assembly 999 includes Subassemblies 777 and 888. 
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Part 333 is on Subassembly 777, therefore, Part 333 is indirectly contained on the BOM of 
Assembly 999. 

A Where-Used–All Levels–Latest Released Revision Only search for Part 333 returns both Assembly 999 
(where it is indirectly contained) and Subassembly 777 (where it is directly contained). 

 

 
 

Where-Used – Top Level – Latest Released Revision Only 

This where-used search type returns a list of top-level assemblies, latest released revision only. 
Note that: 

 Pending revisions are not included. For items/assemblies with pending change order, the 
Where Used search result will return the item/assembly labeled Introductory (Intro) 
revision. 

 Introductory revisions are included, and they are treated as if they were released revisions. 

The object described by the search conditions is contained, directly or indirectly, on the BOMs of 
the returned assemblies. 

For example, in the figure below, a Where-Used–Top Level–Latest Released Revision Only search for Part 
333 returns only Assembly 999, the top-level assembly. 

 

 
 

Where-Used – One Level – Latest Released Revision Only 

This where-used search type returns a list of latest released revision assemblies that directly 
contain the named object. Note that: 
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 Pending revisions are not included. For items/assemblies with pending change order, the 
Where Used search result will return the item/assembly labeled Introductory (Intro) 
revision. 

 Introductory revisions are included, and they are treated as if they were released revisions. 

The object described by the search conditions is contained directly on the BOMs of the returned 
assemblies. 

Refer to the figure below. Assembly 999 has been released five times, named by Revs A, B, C, D, 
and E; there is a pending rev, named by Rev (F). 

A Where-Used–One Level–Latest Released Revision Only search for Part 111 returns Assembly 999 
Rev E only, since Part 111 is directly contained on the BOM of the latest released revision – Rev E 
– of Assembly 999; previously released revisions of Assembly 999 also contain Part 111, but they 
are not included in the search results because they are not the latest released revision. 

Rev (F) also contains Part 111, but it is not included in the search results because it is a pending 
revision. 

 

 
 

Where-Used – One Level – All Released Revisions 

This where-used search type returns a list of all the released revision assemblies that directly 
contain the named object. Note that: 

 Pending revisions are not included. For items/assemblies with pending change order, the 
Where Used search result will return the item/assembly labeled Introductory (Intro) 
revision. 

 Introductory revisions are included, and they are treated as if they were released revisions. 

The object described in the search conditions is contained directly on the BOM of the released 
revision of the assembly, even if it is not the latest released revision. 
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For example, in the figure below, a Where-Used–One Level–All Released Revisions search for Part 222 
returns Assembly 999 Rev A and Rev C. Assembly 999 Rev B and Rev D are both released 
revisions, but they do not directly contain Part 222. Revision (F) does directly contain Part 222, but it 
is not included in the search results because it is a pending revision. 

 

 
 

Where-Used Set Operators 

Where-used set operators allow you to further define relationships between grouped search 
conditions. 

Union 

This operator is the equivalent of Or. For example, this allows you to find assemblies that contain 
only part 111, assemblies that contain only part 222, and assemblies that contain both parts 111 
and 222. The search results are the union of these two sets of assemblies. 
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Intersection 

This operator is the equivalent of And. For example, this allows you to find assemblies that contain 
both part 222 and part 333, but not assemblies with only part 222 or part 333. The search results 
are the intersection of these two sets of assemblies. 

 
 

Minus 

This operator is the equivalent of Not. For example, this operator allows you to find assemblies that 
contain part 333, but not part 444. The search results are the assemblies that contain part 333, 
excepting (that is, not) the assemblies that contain both part 333 and 444, nor the assemblies that 
contain only part 444. 

 

The following table illustrates how the set operators can be used. This search locates all assemblies 
that contain (part 111, part 222, or both) and part 333, but not part 444. 

 Title Block.Number Equal To 111   Union 

 Title Block.Number Equal To 222   Intersection 

 Title Block.Number Equal To 333   Minus 

 Title Block.Number Equal To 444    

This where-used search first finds assemblies that contain either part 111 or part 222 (or both). 
Next, in the resulting list of assemblies, the search then finds assemblies that also contain part 333. 
In that resulting list of assemblies, the search now subtracts any assemblies that contain part 444. 
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Creating a Where-Used Search in Java Client 

The process for creating a where-used search is similar to the process for creating an object 
search. 

To create a where-used search in Java Client: 

1. Click the Advanced Search button  in the toolbar. 

The Advanced Search dialog box appears with the Search tab displayed. 

2. In the Object Type list, select the type of object on which to base the where-used search. 

The object must be an item, a part, or a document. 

3. In the Search Type list, select the type of where-used search to perform. 

4. By default, the search condition table contains one row. (You can add as many rows as you 
need by clicking Add in the Advanced Search dialog box.) 

Click the row to display the search criteria selection lists. 

Click each drop-down list button , from left to right, to define the target Field, the Match If 
search operator, and the value. 

5. Define a set of search criteria, or conditions: 

a. Click the first drop-down list  to select a target Field from the list. For example, Title 
Block.Number represents the Number field on the Title Block tab of a part or document. 

The Field list varies depending on the object selected in the Object Type field. 

b. Click the second drop-down list to select a Match If search operator from the list. For more 
information, see Selecting Search Operators on page 173. 

c. If you select the Prompt ? checkbox, the value field is disabled and you do not enter a value 
for which to search. Instead, when you run the saved search, you are prompted to enter a 
value. 

d. In the last field, enter a value. 

The last search condition field, the Value field, specifies the content or setting of the field 
selected from the Field list. Depending on the selection in the Field list, the Value field may 
contain a list that is relevant to the selection, a calendar button, or a field where you can 
enter text or numbers. For example, if the first field is set to Title Block.Size, then Value lists 
different sizes; if the first field is set to Title Block.Description, then you can type text or 
numbers in the field. 

If you select Like as a Match If search operator, you can use wildcard characters when 
entering a value. For information about using wildcards to search for objects, see Using 

Wildcard Characters on page 152. 

e. If you want to add another row of search conditions, click Add. 

A new row is added at the end of the table. The And/Or field at the end of the row is set to 
[blank] by default. 

f. To modify the And/Or or Union/Intersection/Minus setting, click the And/Or field to select 
AND or OR from the list. Use AND if both conditions must be met. Use OR if either or both 
conditions can be met. For more information, see Using And/Or Values in Advanced 

Searches on page 176. 
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g. If you want to insert a search condition row, select a row and click Insert. 

The new row is inserted above the selected row. 

h. If you want to delete a search condition row, select one or more rows and click Delete. 

The selected rows are deleted. 

If you do not use parentheses when defining your search, the search is processed giving 
precedence to AND values, that is, it processes all rows that end with AND before 
processing rows that end with OR. In other words, the first line is combined with the 
second and process order is based on the first line’s AND/OR value. 

For more information, see Using And/Or Values in Advanced Searches on page 176. 

6. Choose Custom Output Display... in the More.. button drop-down list to specify which fields to 
include in the search results and save the search, or click Run to run the search without saving 
it. 

If you click Run, the search results window shows all the objects that match the search criteria.  

If you choose Custom Output Display... in the More.. button drop-down list, the Display Fields, 
Results Range and Case Sensitive settings are displayed. 

Note In these setup steps, Case Sensitive is selected by default. 

7. Under Display Fields, select fields and use the right and left arrows to move fields to and from 
the Available Fields and Selected Fields lists. Double-clicking a field name also moves it from one 
list to the other list. 

The Selected Fields list specifies the fields that will appear in the search results table. Use the up 
and down arrows to change the order of fields in the list, which reflects the order of the columns 
in the search results. 

8. To sort the search results, in the Selected Fields list, click in the Sort column for the field by which 
you want to sort, and select a number from the drop-down list (for example, 1 means sort by 
this field first). You can sort by multiple fields; select a number in the Sort column for the each of 
the fields you want to use to sort. Click in the Direction column and select Ascending or 
Descending order. 

9. If you want to perform a case-sensitive search where text capitalization matters, make sure 
Case Sensitive is selected. 

If you want to perform a search where text capitalization does not matter, click to deselect Case 
Sensitive. 

Selecting the Case Sensitive check box can help your search run more quickly. If you enter text 
in the Value field, the search looks for text that is an exact match (uppercase and lowercase 
letters). If you selected a value from a list (such as for Product Line), checking Case Sensitive 
allows Agile to use internal database settings to find objects more quickly. 

10. When you have finished specifying output fields and sort order, click Run to run the search, or 
click Save to save it. 

If you click Save, the Save in Folder dialog box appears. 

11. Enter a name for the search. Then select a folder in which to store it. If you do not have 
sufficient privileges to save a search in the selected folder, you can select another. You can 
always save a search in the Personal Searches folder. 

12. Click OK in the Save in Folder dialog box to save the search. 
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13. When you are ready to run the search, click Run in the search dialog box. 

The search results window shows all the objects that match the search criteria. If there is more 
than one page, click the right arrow at the top of the window to display the next page. 

14. If you want to print the list of search results, click the Print button . 

To edit the search after running it, do one of the following: 

 If you saved the search, on the Searches tab of the navigation pane, select the search, 

and click the View/Edit button . 

 If the Search Results window is open, click the View/Edit button  in the Search Results 
window. 

 

Creating a Where-Used Search in Web Client 

To create a where-used search in Web Client: 

1. Click Advanced Search . The Define Query page of the Advanced Search wizard appears. 

2. In the Search For list, select the type of object on which to base the where-used search. 

The object must be an item or a part or document. 

3. In the Search Type list, select the type of where-used search to perform. 

4. Select Match Case if you want to perform a case-sensitive search where capitalization matters. 

Selecting the Match Case checkbox can help your search run more quickly. If you enter text in 
the Value field, the search looks for text that is an exact match (uppercase and lowercase 
letters). If you selected a value from a list (such as for Product Line), checking Match Case 
allows Web Client to use internal database settings to find objects more quickly. 

5. Define a set of search criteria, or conditions: 

a. Select a target field from the list. For example, Title Block.Number represents the Number 
field on the Title Block tab of a part or document. 

b. Select a Match If search operator from the list. For more information, see Selecting Search 

Operators on page 173. 

c. If you select the Prompt ? checkbox, the value field is disabled and you do not enter a value 
for which to search. Instead, when you run the saved search, you are prompted to enter a 
value. 

d. Enter a value in the Value field. 

Value specifies the content or setting of the field selected from the Field list. Depending on 
the selection in the Field list, the Value field may contain a list that is relevant to the 
selection, a calendar button, or a field where you can enter text or numbers. For example, 
if Field is set to Title Block.Size, then Value lists different sizes; if Field is set to Title 
Block.Description, then you can type text or numbers in the Value field. 

If you select Like as a Match If search operator, you can use wildcard characters when 
entering a value. For information about using wildcards to search for objects, see Using 

Wildcard Characters on page 152. 

e. If you want to add another row of search conditions, use the And/Or field or Set field: 

Set the And/Or field to AND, OR, or none (empty field) to show whether the search 



 

 

188 Agile Product Lifecycle Management 

  

conditions for either or both rows must be met. Use AND if both conditions must be met. 
Use OR if either or both conditions can be met. If you do not use parentheses when 
defining your search, the search is processed giving precedence to AND values, that is, it 
processes all rows that end with AND before processing rows that end with OR. In other 
words, the first line is combined with the second and process order is based on the first 
line’s AND/OR value. 

For more information, see Using And/Or Values in Advanced Searches on page 176. 

6. When you have finished adding search conditions, choose Custom Output Display... in the More.. 
button drop-down list to specify which fields to include in the search results list and save the 
search, or click Run to run the search without saving it. 

If you choose Custom Output Display... in the More.. button drop-down list, the Customize Output 
Display dialog appears. 

7. In the Customize Output Display dialog, use the right and left arrows to move fields to and from 
the Available Values and Selected Fields lists. The Selected Fields list specifies the fields that appear 
in the search results list. Use the up and down arrows to change the order of fields in the list, 
which reflects the order of the columns in the search results. 

8. To sort the search results, select the field by which you want to sort from the Sort By drop-down 
list, and select Ascending or Descending order. To sort by more than one field, use the Then By 
drop-down lists. 

9. When you have finished specifying output fields and sort order, click OK. 

10. When you are finished defining the search, click Save. 

11. Enter a name for the search. Then select a folder in which to store it. If you do not have 
sufficient privileges to save a search in the selected folder, you can select another. You can 
always save a search in the Personal Searches folder. 

12. When you are ready to run the search, click Run. 

The Search results page shows all the objects that match the search criteria. If there is more 
than one page, click the right arrow next to the page number to display the next page. 

13. If you want to print the list of search results, click the Print button. 
 

Where-used Searches for File Folders 

Where-used searches for file folders are specialized searches similar to Relationship Searches on 
page 190 that find file folders that appear on the Attachments tabs of the objects defined in the 
search criteria. 

In a file folder object search, the search conditions specify object attributes of the file folders you 
want to find; the file folder objects that match those search conditions are returned in the search 
results. 

For example, the following search return file folders that Mary Smith has checked out: 
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Search set t ing  Speci f ied  as:  

 

Search for Object: 

File Folder 

Search Type: Object Search 

Search Condition: Title Block.Checkout User Equal to Mary Smith 

In a file folder where-used search, you select the object where the file folder is used, for example, 
Changes. This allows you to specify search conditions that include change object attributes, in 
addition to search criteria that specify file folder attributes. 

For example, the following search returns file folders that Mary Smith has checked out that appear 
on the Attachments tab of changes assigned to the Virgo product line. 

Search set t ing  Speci f ied  as:  

 

Search for Object: 

File Folder 

Search Type: Where Used Search 

With Related Content: Changes 

Search Condition: Title Block.Checkout User Equal to Mary Smith   And 
Where Used.Changes.Cover Page.Product Line(s) Equal to Virgo 

For detailed information about defining searches, see Advanced Searches on page 165. 
 

Version-Specific Properties and File Folder Object 

Searches 

File folder objects (File Folder class objects and Design class objects) have multiple versions. When 
you create a file folder object search that include search conditions based on version-specific 
properties, the search results table will include a row for each version of a file folder object where 
the search condition is true. Therefore, the file folder search results table may list the same file 
folder object multiple times. 

The following table lists the version-specific properties that automatically cause the search results to 
list a file folder object multiple times, regardless of whether or not the version-specific field appears 
in the search results table, as defined in the advanced search output display. 

Note These attributes are visible on the Title Block tab only if your Agile administrator has 
enabled them. They are typically enabled for Design objects. 
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Version-spec i f ic  f i l e  
fo lder T i t le  B lock  f ie ld  

Descript ion  

Label Version-specific text field which indicates a label identifier for the 
version. Users with the appropriate privileges can modify this field 
on any checked in or checked out version. 

Revision Version-specific text field which indicates the targeted Revision for 
the Design Version. 

Revision Date Version-specific date field which indicates a revision date for the 
Design Version. 

Note The search results table can also display an object multiple times depending on the 
Output Display as defined in an advanced search. For more information about the Output 
Display, see C. Define a Custom Output Display, Java Client on page 169, and C. 

Define a Custom Output Display, Web Client on page 172. 

See also the chapter Working with Design Objects on page 327. 

Relationship Searches 

Relationship searches are available for any class that has a Relationships tab, that is, all object 
classes except Action Items and Reports. 

In a relationship search you select the related object type, for example, Changes. This allows you to 
specify search conditions that include change object attributes, in addition to search criteria that 
specify the attributes of the searched-for object. 

Note If the Relationships tab is visible for the searched-for object, you will be able to select this 
search type in the search definition dialog. 

For example, the following search returns Non-Conformance Report (NCR) objects where the 
Severity field on the Cover Page tab of the NCR equals ―Minor‖ and the NCR Relationships tab, 
Affected By table includes change order objects whose Cover Page tab, Change Analyst field lists Larry 
Jones as the change analyst. 

Search set t ing  Speci f ied  as:  

 

Search for Object: 

Non-Conformance Reports 

Search Type: Relationships 

With Related Content: Changes 

Search Condition: Cover Page. Severity Equal to Minor   And 
Relationships.Change Orders.Cover Page.Change Analyst Equal to Larry 
Jones 

You set up an advanced search to find objects in relationship with each other that fit the criteria you 
specify in the search. See Advanced Searches on page 165. 
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Relationship searches allows you to include attributes from the objects on the Relationships tab in 
your search criteria and to search by Relationship tab attributes including, but not limited to: 

 Rule - Null or Not Null - Determine if there is a rule 

 Criteria Met - Yes or No - Determine if the criteria defined in the rule has been met 

 Relationship Type - Affects, Affected By, Reference 

You can select from the following relationship searches: 

For object  c lasses:  Ava i lab le  re lat ionsh ip  searches  

All object classes 

except  
Reports and Action Items. 

 

Relationships Search 

Programs 

(Agile PPM) 

Content Search 

File Folders Relationships Search 

Where Used Search     (See Where-used Searches for File Folders 
on page 188.) 

Transfer Orders Relationships Search 

Selected Content Search 

 Relationships Search allows you to include attributes from the objects on the Relationships tab in 
your search criteria, including search criteria about rules and the relationship type (Affected By, 
Affects, or Reference). 

 Selected Content Search allows you to include attributes from the objects on the Selected Content 
tab in your search criteria. 

 Content Search allows you to include Relationships Search attributes and additional Agile PPM 
content attributes in your search criteria. 

For detailed information about defining searches, see Advanced Searches on page 165. 

Searching for Users and User Groups 

You can search on Users and User Groups. In Quick Search, you can select Users or User Groups as 
the base class guiding the system per the search-text. You can define a pre-configured parametric 
search for users and user groups. In Advanced Search, when you select Users or User Groups in the 
Search For field, the drop-down list in the Field column is populated with object-specific attributes. 
As always, your roles and privileges govern what types of objects you can search for as well as 
which objects you can open. 

For more information about constructing advanced searches, see Advanced Searches on page 165. 
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Searching for Routable Objects with Workflow Attributes 

Workflow Routings on page 14 introduced and described the workflow-based sample searches. 
This section elaborates on this area. 

Agile comes with a large array of predefined search samples based on workflow attributes. These 
are designed to complete the majority of tasks for change analysts, observers, and approvers, but 
they can be used by any users if they are assigned the appropriate privileges. 

Note Your ability to use workflow attributes to create searches may be limited depending on 
the Agile Server licenses at your site, and which roles and privileges you have been 
granted. For more information, see your Agile administrator. 

These predefined workflow searches are also modifiable for use as templates. Building a search 
with workflow attributes is the same as building standard searches. However, you need to follow 
some special rules to build a successful search. For more information about building a search, 
begin with Advanced Searches on page 165. For information about using workflow attributes in 
searches, see Creating Grouped Conditions for Workflow Searches on page 195. 

It is highly recommended that you save the predefined searches with a new name before you 
modify them. This way you will always have a template to work from if you need to start over. 

Creating Workflow Searches 

You can search for changes by various attributes relating to the workflow in use for those changes. 
You can combine some of the workflow attributes with other workflow attributes in brackets to 
create a grouped condition, which further refines the way the workflow attributes work together. 

In general, you can use the workflow attributes with other non-workflow attributes; however, not all 
the workflow attributes work together in a search with other workflow attributes, or with non-
workflow attributes. If you have selected search attributes that cannot be used together, an error 
message is displayed. For information about creating grouped conditions, see Creating Grouped 

Conditions for Workflow Searches on page 195. 

The following table displays each workflow attribute, its operators, and the expected results of using 
it in a search. Use this table to verify that the attributes you wish to search will deliver the 
information you require. 

Note $CurrentStatus limits searches on workflow activities to the change’s current workflow 
status. $User limits searches on users or user actions to the current user, that is, the 
user running the search. 

 

Search at t r ibute  Match I f  
operato rs  

Va lue  The change found has these 
at t r ibutes  

Cover Page.Status In Any workflow status; any 
status type; Unassigned 

The specified status matches the current 
status on the Cover Page. 
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Search at t r ibute  Match I f  
operato rs  

Va lue  The change found has these 
at t r ibutes  

 Not In Any workflow status; any 
status type; Unassigned 

The specified status does not match the 
current status on the Cover Page. 

Is Null (None) The Cover Page.Status field is empty. 

Is Not Null (None) The Cover Page.Status field is not 
empty. 

Workflow.Workflow 
Status 

 

Equal To Any workflow status; any 
status type 
$CurrentStatus 

The specified status matches the current 
status of the change. 

Not Equal To Any workflow status; any 
status type 
$CurrentStatus 

The specified status does not match the 
current status of the change. 

Workflow.Next 
Status 

 

Equal To Any workflow status; any 
status type 

The specified status matches the next 
status of the change. 

Not Equal To Any workflow status; any 
status type 

The specified status does not match the 
next status of the change. 

Workflow.Approver 

 

Contains One or more users or 
user groups from the 
address book; $User 

The specified user or user group is 
included in the list of approvers. 

Does Not Contain One or more users or 
user groups from the 
address book; $User 

Specified user or user group is not 
included in the list of approvers. 

Is Null (None) The approver list is empty. 

Is Not Null (None) The approver list is not empty; there is at 
least one user, department, or group on 
the list. 

Workflow.Observer 

 

Contains One or more users or 
user groups from the 
address book; $User 

The specified user or user group is 
included in the list of observers. 

Does Not Contain One or more users or 
user groups from the 
address book; $User 

The specified user or user group is not 
included in the list of observers. 

Is Null (None) The observer list is empty. 

Is Not Null (None) The observer list is not empty; there is at 
least one user, department, or group on 
the list. 

Workflow.Notify 
Users 

 

Contains One or more users or 
user groups from the 
address book; $User 

The specified user or user group is 
included in the list of persons to notify. 

Does Not Contain One or more users or 
user groups from the 

The specified user or user group is not 
included in the list of persons to notify. 
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Search at t r ibute  Match I f  
operato rs  

Va lue  The change found has these 
at t r ibutes  

address book; $User 

Is Null (None) The Notify list is empty. 

Is Not Null (None) The Notify list is not empty; there is at 
least one user, department, or group on 
the list. 

Workflow.Signoff 
User 

 

Contains One or more usernames 
from the address book; 
$User 

The specified user performed the signoff 
action. 

Does Not Contain One or more usernames 
from the address book; 
$User 

The specified user did not perform any 
signoff action. 

Is Null (None) No users have performed any signoff 
actions. 

Is Not Null (None) At least one user has performed a signoff 
action. 

Workflow.Status 
Changed By 

 

In One username from the 
address book; $User 

The specified user caused the change to 
be moved out of this status. 

Not In One username from the 
address book; $User 

The specified user did not cause the 
change to be moved out of this status. 

Is Null (None) The change was autopromoted. 

Is Not Null (None) The change was manually promoted. 

Workflow.Duration 
 
Must be used in 
conjunction with 
Cover Page.Status. 

Number of hours. 
Any positive 
number; decimal 
point allowed. 

All numerical comparison 
operators: >, <, >=, <=, =, 
<> 

The change was moved to the specified 
status within the number of hours 
specified. 
Cannot be used with Cancel or Hold 
status types. 

Workflow.Approver 
Action 
 

Workflow.Observer 
Action 

Note: When used in 
a grouped condition 
with 
Workflow.Approver 
or with 
Workflow.Observer, 
these attributes 
represent the action 

Contains 

 

Awaiting Approval One or more approvers/observers have 
not signed off. 

Approved One or more approvers/observers have 
approved. 

Rejected One or more approvers/observers have 
rejected. 

Returned One or more approvers’/observers’ signoff 
request has been returned. 

Does Not Contain 

 

Awaiting Approval All approvers/observers have signed off. 

Approved No approvers/observers have approved. 

Rejected No approvers/observers have rejected. 
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Search at t r ibute  Match I f  
operato rs  

Va lue  The change found has these 
at t r ibutes  

of the particular user 
specified by the 
Workflow.Approver 
or 
Workflow.Observer. 

When not used in a 
grouped condition, 
these attributes 
represent the actions 
taken by all the 
approvers or 
observers. 

 

Returned No approvers’/observers’ signoff request 
has been returned. 

Equal To 

 

Awaiting Approval All selected approvers/observers have not 
signed off. 

Approved All selected approvers/observers have 
approved. 

Rejected All selected approvers/observers have 
rejected. 

Returned All selected approvers’/observers’ signoff 
request have been returned. 

Not Equal To 

 

Awaiting Approval Some selected approvers/observers have 
signed off. 

Approved Not all selected approvers/observers have 
approved. 

Rejected Not all selected approvers/observers have 
rejected. 

Returned Not all selected approvers’/observers’ 
signoff request have been returned. 

 
 

Creating Grouped Conditions for Workflow Searches 

One of the powerful functions that you can use for a workflow search is grouped conditions. This 
option allows you to build powerful search conditions based on certain pairs of workflow attributes. 
Grouped conditions are enclosed in brackets [   ]. 

For example, consider the following grouped condition: 

[ Workflow.Workflow Status Equal To Status Type.Implemented  OR  

 Workflow.Workflow Status Equal To Status Type.Released ] AND  

 Workflow.Status Changed By Equal To Sharon    

This grouped condition finds all changes where the status type is either Implemented or Released 
and Sharon is the person who changed the status. 

Use a grouped condition to refine a search based on workflow attributes. These three rules must be 
followed to create a grouped condition: 

 Two workflow attributes are used within a set of brackets. 

 The operator is set to And. 

 There are no non-workflow attributes used within the brackets. 
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To group two or more workflow attributes in Java Client: 

1. Select the rows that you want to group in brackets. 

a. Click a row to select it. The row is highlighted. 

b. Use shift-click or Ctrl-click to select the last row of the group. 

2. Click the [Group] button. 

The brackets are placed around the rows selected. 

To group two or more workflow attributes in Web Client: 

1. In the row where you want to place an open bracket, select the radio button in the open 
parenthesis column. 

2. In the row where you want to place a close bracket, select the radio button in the close 
parenthesis column. 

3. Click the Add [Group ] button. 

Brackets [   ] are placed around the group of workflow attributes. 

To ungroup two or more workflow attributes in Java Client: 

1. Select the rows enclosed in brackets. 

a. Click a row to select it. The row is highlighted. 

b. Use Shift-click or Ctrl-click to select the second row. 

2. Click the Remove ( )  button. 

The brackets are removed. 

To ungroup two or more workflow attributes in Web Client: 

1. Deselect the open and close parenthesis radio buttons in the rows from which you want to 
remove brackets. 

2. Click the Remove ( ) button. 

The following fields qualify for grouped condition searches: 

 Cover Page.Status 

 Workflow.Duration 

 Workflow.Workflow Status 

 Workflow.Next Status 

 Workflow.Signoff User 

 Workflow.Approver when it is set to a valid user’s name, and Workflow.Approver Action is set to 
Equal To or Not Equal To a specific action, and there are no non-workflow attributes within the 
brackets. 

 Workflow.Observer when it is set to a valid user’s name and Workflow.Observer Action is set to 
Equal To or Not Equal To a specific action, and there are no non-workflow attributes within the 
brackets. 

When used in a grouped condition, the workflow attribute that pertains to observers or approvers is 
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set to Contains and the operator for the second workflow attribute is set to either Equal To or Not 
Equal To, the grouped condition is evaluated in respect to only that specific approver or observer. 

If one of the workflow attributes in a grouped condition pertains to a status, and specifies a specific 
status, then the remaining workflow attributes in the grouped condition are evaluated in respect to 
only that specific status. For example: 

 Search 1: Find all changes where Cathy is an approver and she has approved that change. 
The approval action applies specifically to Cathy. Note that the use of brackets makes this a 
grouped condition: 

[ Workflow.Approver Contains [Cathy Agile]  AND  

 Workflow.Approver Action Equal To [Approved] ]   

 

 Search 2: Find all changes where Cathy is an approver and all approvers have approved that 
change. The approval action applies generally to all the approvers. (Note: this specific search 
does not work, it should be taken as a sample in the context of this discussion.) Note that there 
are no brackets; this is not a grouped condition: 

 Workflow.Approver Contains [Cathy Agile]  AND  

 Workflow.Approver Action Equal To [Approved]    

In Java Client, grouping is available whenever multiple search conditions are selected. If the Group 
button is disabled (grayed) the selected search conditions do not make up a valid grouped 
condition. Click the Group button to enclose the selected search conditions in brackets [  ]. If the 
selected search conditions enclosed in brackets do not make up a valid grouped condition, you see 
an error message when you run or save the search. 

In Web Client, grouping is available whenever multiple search conditions are selected. Click the Add 
button to enclose the selected search conditions in brackets [  ]. If the selected search conditions 
make up a valid grouped condition, Web Client adds brackets. If the selected search conditions do 
not make up a valid grouped condition, you see an error message. In a similar manner, if you use 
the Add button to enclose in parentheses selected search conditions that make up a valid grouped 
condition, the selected conditions are enclosed in brackets and become a grouped condition. 

Workflow attributes grouped within a set of brackets can be used in conjunction with other search 
conditions within a single search. 

When non-workflow attributes appear in parentheses along with workflow attributes, parentheses 
are considered precedences rather than a grouped condition. For example: 

( Workflow.Signoff User Contains Ann Agile  AND  

 Cover Page.Change Category Equal To Quick Phase-In ) OR  

 Cover Page.Product Line(s) Contains [Scorpio]    

 
 

Tips and Guidelines for Grouped Conditions 

In Java Client, when you attempt to define searches with illegal grouped conditions, Java Client 
disables the Group button. 
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In Web Client, when you attempt to save searches with illegal grouped conditions, Web Client 
substitutes parentheses (  ) for the grouped condition brackets [  ]. 

In some cases, when you attempt to save a search, you may see an error message. If you do, edit 
your search to correct the error and then save the search again. 

Additional restrictions apply to the use of workflow attributes: 

 Nested brackets are not supported. You may not include a grouped condition inside the 
brackets of another grouped condition. (You can, however, use a bracketed grouped condition 
inside a set of parentheses with other non-workflow search conditions.) 

 Each workflow attribute can be used only once within a grouped condition within a set of 
brackets. For instance, you may not use Workflow.Signoff User twice in the same set of 
brackets. 

 Workflow.Approver, Workflow.Observer, Workflow.Notify Users and Workflow.Signoff User may not be 
used in the same grouped condition. 

 Workflow.Approver Action and Workflow.Observer Action may not be used in the same grouped 
condition. 

 Workflow.Duration can be used only in a grouped condition within a set of brackets that contains 
only Workflow.Workflow Status with an operator of Equal To. 

 Workflow.Workflow Status can be used only along with another workflow attribute within a 
grouped condition. 

 Workflow.Status Changed By can be used only with Workflow.Workflow Status within a grouped 
condition. 

 Non-workflow attributes cannot be used in a grouped condition, although they may be used 
with workflow attributes when enclosed in parentheses. 

 The Match If logical operator Or cannot be used in a grouped condition. 

 If Workflow.Approver Action or Workflow.Observer Action is used in a grouped condition with 
Workflow.Signoff User, then the Match If operator for Workflow.Approver Action or Workflow.Observer 
Action must be Equal To or Not Equal To, and the Match If operator for Workflow.Signoff User 
must be Contains. 

 When you search for a specific user for Workflow.Approver, Workflow.Observer, or Workflow.Notify 
Users, if that user is the member of a group or department, the search also returns changes 
where the group or department is an approver, observer, or user to notify. For example, if Mary 
is a member of the Libra Project group, searching for changes where Mary is an approver also 
returns changes that list the Libra Project group as an approver. 

 

Editing and Managing Searches and Search Folders 

If you have sufficient privileges, you can rename, delete, and rearrange both searches and the 
folders, even some of the default system searches. 
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Buttons and Right-click Menu Choices in the Java Client Search Toolbar 

When you select a search in Java Client, most of the buttons on the Search toolbar in the left pane 
are enabled; additional functions are enabled on the right-click menu.  

The following table lists and describes the buttons used in the Search toolbar in Java Client. 

Button  Name  Descript ion  

 New Adds a new search folder within the current folder (you can 
select another folder in the Save In Folder dialog). 

Available in both Search toolbar and right-click menu. 

 Edit Search 

Right-click menu only 

Opens the selected search in edit mode. 

Available in right-click menu only. 

 Save As 

Right-click menu only 

Saves the selected search, with standard Save As dialog box 
that prompts for a filename and directory. 

Available in right-click menu only. 

 
Rename Lets you rename the selected search (all searches) or the 

selected user-defined subfolder. 

Available in both Search toolbar and right-click menu. 

 Move To Folder Moves the selected search or subfolder to the folder you specify. 

Available in both Search toolbar and right-click menu. 

 Delete Removes the selected user-created search or user-created 
subfolder. 

Available in both Search toolbar and right-click menu. 

 Organize Search 

Right-click menu only 
when the top Search 
folder is selected. 

Opens the Organize Search dialog which allows you to 

•Create, rename, or remove folders. 

•Rename or remove searches. 

•Reorder folders and searches depending on your 
privileges. 

Available in right-click menu only. 

 
Expand All 

Available only when the 
top Search folder is 
selected. 

When the Searches folder is highlighted, expands all the 
subfolders. 

Available in both Search toolbar and right-click menu 

 
Collapse All 

Available only when the 
top Search folder is 
selected. 

When the Searches folder is highlighted, collapses all the 
subfolders. 

Available in both Search toolbar and right-click menu 
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Button  Name  Descript ion  

 Refresh Left Panel 
Tree 

Refreshes the navigation pane of Java Client’s user interface 

Buttons on the Web Client Search Toolbar 

The following table lists and describes the buttons on the Searches page in Web Client. 

Button  Descript ion  

 Expand All 
Expands all the search folders in the navigation pane to display all available 
searches. 

 Collapse All 
Collapses all the search folders in the navigation pane. 

 Organize Searches 
Opens the Organize Searches window. 

 
 

Organizing Searches 

Searches can be organized in the Organize Searches window. 

To open the Organize Search window in Java Client: 

1. Select the Searches folder  at the top of the Search tab in the left navigation pane. 

2. Right-click and choose  Organize Search in the menu. 

The Organize Search window opens. 

To open the Organize Searches window in Web Client: 

1. In the Search Folders navigation pane, click the  Organize Searches icon next to the Searches 

folder.  

Or 

In the Web Client main menu, Click Tools  > My Settings > Organize Searches. 

The Organize Searches window opens. 

The Organize Searches Window 

Use the features in the Organize Searches window to create or remove folders, rename or remove 
searches, and sort and move folders and searches. 

Button  Descript ion  

Remove Removes the selected searches and search folders. 

See Deleting a Search on page 203 or Removing a Folder on page 204. 

Rename Renames the selected search or search folder. 

See Renaming a Search on page 202 or Renaming a Folder on page 205. 
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Button  Descript ion  

Add New 
Folder 

Adds a new search folder within the current folder. 

(drag and drop) Allows you to reorder searches and search folders. 

See Moving Searches and Folders on page 206 below. 

Save Save the modifications you made in the Organize Searches window. 

Cancel Discards the modifications you made in the Organize Searches window and closes the 
window. 

 
 

Editing Searches 

When you edit a search, you are changing the combination of conditions Agile looks for. You might 
want to edit a search to either broaden or narrow the scope of the search or change the output 
fields. 

Note Whether a search is editable depends on your privileges. 

When editing a search you can: 

 Alter the values of search criteria 

 Add conditions to the search condition table 

 Insert conditions into the interior of the search condition table 

 Delete conditions from the search conditions table 

 Substitute an And for an Or and vice versa 

 Add or remove output columns in search results 

 Modify the sort order of search results 
 

Editing a Search in Java Client 

To edit a search in Java Client: 

1. In the Search folder, navigate to the search you want to edit. 

2. Select the search, right-click and choose Edit Search in the menu. 

3. To edit search conditions, click the row you want to edit. To edit the search, follow the steps in 
Creating an Advanced Search in Java Client on page 167, Creating an Advanced Search in 

Web Client on page 170, or Where-Used Searches for Items on page 179. 

To delete a condition, select the row you want to delete, and click Delete. 

4. When you are finished, click Save. 

Note If the search results window is open, click the View/Edit button in the search results 
window, and edit the search. 
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Editing a Search in Web Client 

To edit a search in Web Client: 

1. In the Searches folder in the navigation pane, navigate to the search you want to edit. 

2. Click the Edit Search  icon to the right of the search name. 

3. To edit the output columns or the sort order, from the More button drop-down list, choose 
Customize Output Display... 

4. To edit search conditions, follow the steps in Advanced Searches on page 165 or Where-Used 

Searches for Items on page 179 to edit the search. 

To delete a condition, click the  Remove Row from Search Criteria button at the end of the row. 

To insert a condition, click the  Insert Row in Search Criteria at the row below which you want to 
insert the new conditions. 

5. When you are finished, click Save. 
 

Renaming a Search 

You can rename a saved search to better indicate the type of objects the search is designed to 
locate. 

To rename a search in Java Client Search tab: 

1. In the Search tab, select the search you want to rename. 

2. Right-click and select  Rename in the menu. 

3. In the dialog, enter a name for the folder and click OK. 

To rename a search in Java Client Organize Searches window: 

1. Select the Searches folder , right-click and choose  Organize Search in the menu. 

2. In the Organize Search window navigate to the search you want to rename and select it. 

Note Your assigned roles and privileges control which searches and folders you can 
rename. You can always rename searches and folders in your Personal Searches 
folder. 

3. Click the Rename button. 

4. Edit the name of the search in the Enter Name field. 

5. Click OK. 

6. When you are finished, click Save. 

To rename a search in Web Client: 

1. In the Search Folders navigation pane, click the  Organize Searches icon. 

2. In the Organize Searches window navigate to the search you want to rename and select it. 
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Note Your assigned roles and privileges control which searches and folders you can 
rename. You can always rename searches and folders in your Personal Searches 
folder. 

3. Click the  Rename button. 

4. In the text field, enter a new name and press the Return key. 

5. When you are finished, click  Save. 
 

Deleting a Search 

In Java Client, you can delete a search on the Searches tab if you have the appropriate privileges 
for that search. 

In Web Client, you can delete a search from the Organize Searches page. 

To remove a search in Java Client Search tab: 

1. In the Search tab, select the search you want to delete. 

2. Right-click and select  Delete in the menu. 

3. When the confirmation prompt appears, click Yes. 

The search is deleted. 

To remove a search in Java Client Organize Search window: 

1. Select the Searches folder , right-click and choose  Organize Search in the menu. 

2. In the Organize Search window navigate to the search you want to remove and select it. 

Note Your assigned roles and privileges control which searches and folders you can 
remove. You can always remove searches and folders in your Personal Searches 
folder. 

3. Click the Remove button. 

4. When you are finished, click Save. 

To remove a search in Web Client: 

1. In the Search Folders navigation pane, click the  Organize Searches icon. 

2. In the Organize Searches window navigate to the search you want to remove and select it. 

Note Your assigned roles and privileges control which searches you can remove. You can 
always remove searches and folders in your Personal Searches folder. 

3. Click the  Remove button. 
 

Using Folders to Organize Searches 

You can organize your searches in folders to make them easier to locate and manage. You can use 
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the existing folders or create new ones. 

Creating a Folder 

To create a search folder in Java Client Search tab: 

1. In the Search tab, select the folder in which you want to create a new folder. 

2. Right-click and choose  New Folder in the menu. 

3. In the Folder Name field, enter a name for the folder and click OK. 

To create a search folder in Java Client in the Organize Search window: 

1. Select the Searches folder , right-click and choose  Organize Search in the menu. 

2. In the Organize Search window navigate to the folder in which you want to create a new folder. 

Note Your assigned roles and privileges control the folders in which you can create new 
subfolders. You can always add folders in your Personal Searches folder. 

3. In the Folder Name field, enter a new name. 

4. Click OK. 

5. When you are finished, click Save. 

To create a search folder in Web Client: 

1. In the Search Folders navigation pane, click the  Organize Searches icon. 

2. In the Organize Searches window navigate to the folder in which you want to create a new 
folder. 

Note Your assigned roles and privileges control the folders in which you can create new 
subfolders. You can always add folders in your Personal Searches folder. 

3. Click the  New button. 

4. In the text field, enter a new name and press the Return key. 

5. When you are finished, click  Save. 
 

Removing a Folder 

You can remove or delete a folder, even if it is not empty. 

To remove a folder in Java Client Search tab: 

1. In the Search tab, select the folder you want to delete. 

2. Right-click and choose  Delete in the menu. 

3. When the confirmation prompt appears, click Yes. 

The folder and its contents are deleted. 
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To remove a folder in Java Client Organize Search window: 

1. Select the Searches folder , right-click and choose  Organize Search in the menu. 

2. In the Organize Search window, navigate to the folder you want to remove and select it. 

Note Your assigned roles and privileges control which folders you can remove. You can 
always remove searches and folders in your Personal Searches folder. 

3. Click the Remove button. 

4. When you are finished, click Save. 

To remove a search or folder in Web Client: 

1. In the Search Folders navigation pane, click the  Organize Searches icon. 

2. In the Organize Searches window navigate to the folder you want to remove and select it. 

Note Your assigned roles and privileges control which folders you can remove. You can 
always remove searches and folders in your Personal Searches folder. 

3. Click the  Remove button. 

4. When you are finished, click  Save. 
 

Renaming a Folder 

To rename a folder in Java Client Search tab: 

1. In the Search tab, select the folder you want to rename. 

2. Right-click and select  Rename in the menu. 

3. In the Enter Name field, enter a name for the folder. 

4. Click OK. 

To rename a search in Java Client Organize Searches window: 

1. Select the Searches folder , right-click and choose  Organize Search in the menu. 

2. In the Organize Search window navigate to the search you want to rename and select it. 

Note Your assigned roles and privileges control which searches and folders you can 
rename. You can always rename searches and folders in your Personal Searches 
folder. 

3. Click the Rename button. 

4. In the Enter Name field, enter a name for the folder. 

5. Click OK. 

6. When you are finished, click Save. 
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To rename a search in Web Client: 

1. In the Search Folders navigation pane, click the  Organize Searches icon. 

2. In the Organize Searches window navigate to the folder you want to rename and select it. 

Note Your assigned roles and privileges control which folders you can rename. You can 
always rename searches and folders in your Personal Searches folder. 

3. Click the  Rename button. 

4. In the text field, enter a new name and press the Return key. 

5. When you are finished, click  Save. 
 

Moving Searches and Folders 

To use the Search window buttons to move a search or a search folder into another folder in Java Client: 

1. Select the Searches folder , right-click and choose  Organize Search in the menu. 

2. In the Organize Search window, navigate to the folder or search you want to move. 

3. Click the folder or search to select it. 

4. Drag the folder or search to its new location and drop it onto: 

 Highlighted folder – the dropped folder or search is moved into the highlighted folder. 

 Grey line between two names in the list of searches and folders – the dropped folder or 
search is moved to that location in the list. 

5. When you are finished, click Save. 

To move a search or a search folder into another folder in Web Client: 

1. In the Search Folders navigation pane, click the  Organize Searches icon. 

2. In the Organize Searches window, navigate to the search or folder that you want to move. To 
expand a folder, click its folder icon. 

3. Click the folder or search to select it. 

4. Drag the folder or search to its new location and drop it onto: 

 Highlighted folder – the dropped folder or search is moved into the highlighted folder. 

 Grey line between two names in the list of searches and folders – the dropped folder or 
search is moved to that location in the list. 

5. When you are finished, click Save. 
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Chapter 8 

Routing Objects with Workflows 

This chapter includes the following: 

 About Workflows .................................................................................................................................................. 207 
 Status List ............................................................................................................................................................ 208 
 Default Workflows ................................................................................................................................................ 210 
 Example of a Customized Workflow .................................................................................................................... 212 
 Using Workflows in the Change Control Process ................................................................................................ 213 
 Working with Workflows ....................................................................................................................................... 215 
 After a Routable Object is Released .................................................................................................................... 247 
 Switching Routable Objects to Their Final Status ................................................................................................ 247 
 Redlining through ECOs, MCOs, PCOs and SCOs ............................................................................................. 248 
 Deleting Routable Objects ................................................................................................................................... 249 
 Printing Routable Object’s Data ........................................................................................................................... 251 

 
 

About Workflows 

Workflows automate the change control process by performing or completing tasks that you 
previously performed manually. For example: 

 When you create a routable object, you can select the appropriate workflow from the list of 
available workflows for that routable object. 

 When the routable object moves into a Review or Released status type, the lists of approvers 
and observers can be automatically selected. 

 When all the approvers have signed off for a Review or Released status type, and all the 
required fields have been completed, the routable object can be automatically promoted to the 
next status with the AutoPromote feature. 

 By defining a workflow with multiple Review or Released status types, you can sequentially 
route an object to different lists of approvers and observers. 

 When all required fields have been filled in on a routable object, it can be autopromoted to the 
next status. 

 When an approver does not respond within the specified reminder period set by the Agile 
administrator, a reminder email will be sent automatically. 

 If the approver does not respond within the specified escalation period set by the Agile 
administrator, the routable object will be sent to that user’s designated escalation person. The 
designated escalation person can then approve or reject the routable object in place of the 
original approver. 

 You can transfer your authority to approve the routable object to another user for a specified 
period of time. If you have the appropriate privileges, you can transfer signoff authority for other 
users. 
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Status List 

At its most basic level, a workflow consists of: 

 A unique name 

 A list of matching criteria 

 A list of statuses 

The status list defines the ordered list of statuses (or steps) that the routable object must go through 
during the change control process. The Agile administrator can define each workflow to have as 
many statuses as required. Each status is of a particular status type. Some status types may be 
used only once in a workflow, while others may be used multiple times. 

The following table lists and defines the different status types. 

Status type  Const ra ints  Def in i t ion  

Before a workflow is selected for a routable object 

Unassigned ―Placeholder‖ Unassigned is the default initial status name before a 
routable object has been matched with a workflow. 

Basic Status Types (Active) 

Pending Required. 
 
Used once. 

 An originator is developing the routable object. 

 A workflow must begin with a Pending status type; 
it is the first status in every workflow. 

Submit Not required 
Unlimited use. 

The Submit status type sends the routable object to 
the specified routing manager, who determines 
whether or not to promote the routable object to the 
next status. 

Review Not required. 
 
Unlimited use. 

The Review status type routes the routable object to 
CCB members (approvers and observers). When all 
approvers have signed off, and required fields have 
been completed, the routable object is automatically 
promoted to next status in the status list if 
AutoPromote is on. If the AutoPromote is off or it is 
manually moved by the routing manager.  
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Status type  Const ra ints  Def in i t ion  

Released Not required. 
 
Unlimited use. 

 When a routable object enters the first Released 
type status, the software performs a series of 
checks; it also creates new revisions of the affected 
items (ECOs) with the new BOM, incorporates 
redlines into a new ―rev,‖ or updates the 
manufacturer part information (MCOs). 

 Like the Review status type, the Released status 
type may have approvers and observers and be 
routed for signoff and may be autopromoted. 

 Only the first Released status actually releases the 
routable object. Subsequent Released status 
types—given distinguishing status names—provide 
additional review/approval cycles for the released 
routable object. 

 Returning a released routable object to any of the 
first three status types unreleases  the routable 
object—removes approvals that were gathered. 

Complete Not required. 
Used once. 

 If Complete status type is used, it must be the last 
active status in the workflow, and it may be used 
only once. 

Cancel 

 

Hold 

Not required. 
They are a means to 
inactivate a routable object. 
They always follow the final 
active status (e.g., Complete) 
in the status list. 

Note: List Cancel before Hold 
in the status list if both are 
present (although a routable 
object might well be held 
before it is canceled). 

 The Cancel and Hold status types provide two 
ways to remove a routable object from the 
workflow. They are added to the end of the status 
list as they are never part of the active sequence of 
statuses. 

 Hold temporarily removes a routable object from 
the workflow and allows you to reinsert it later. 

 Cancel permanently removes a routable object 
from the workflow. If the routable object includes 
affected items with redline changes, the redlines 
are discarded. 

 If a routable object has been released, moving to 
the Hold or Cancel type status unreleases the 
routable object. 

 You manually move a routable object to Cancel or 
Hold from any other status in the workflow 
(assuming it is listed as a valid next status under 
the Manual Valid Next Status property). 

 When moved to Hold, it stays there until you 
manually move it back into the workflow. These 
moves require proper Change Status privileges. 

 
 

Viewing Workflows 

You can view all the workflows used at your company from any open routable object. In Java Client, 
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click the View Workflows button  on the toolbar of the object window. In Web Client, choose the 
View Workflows command on the Actions menu. This feature allows you to browse through the 
available workflows and their status lists at any time. You can examine the various workflows before 
you select one for a routable object. You can also view workflows if you have already specified one 
for the object. 

To view all workflows and their status lists in Java Client: 

1. Open the routable object you want to work with. 

2. Click the View Workflows button. The View Workflows dialog box appears, displaying a flowchart 
of the statuses in the default workflow for that object type. 

3. To see the statuses for a different workflow, select it from the Select Workflow drop-down list. 

4. When you have finished viewing the workflows, click Close. 

5. If you want to select a workflow for the object, on the Cover Page tab, select a workflow from the 
Workflow drop-down list, and click Save. The Workflow tab now displays the flowchart for the 
workflow you selected. 

To view all workflows and their status lists in Web Client: 

1. Open the routable object you want to work with. 

2. Choose Actions > View Workflows. The View Workflow page appears, displaying a flowchart of 
the statuses in the default workflow for that object type. 

3. To see the statuses for a different workflow, select it from the Please select a Workflow drop-down 
list. 

4. When you have finished viewing the workflows, click Cancel. 

5. If you want to select a workflow for the object, on the Cover Page tab, click Edit, select a workflow 
from the Workflow drop-down list, and click Save. The Workflow tab now displays the flowchart for 
the workflow you selected. 

 

Show/Hide Workflows within a Class 

When you open the Workflow tab of a routable object, a second  button is called Hide/View 
workflow chart in Java Client and Show/Hide Workflow Overview in Web Client. Here this button is a 
toggle: in an ECO, if the workflow is not visible and you click the button, the ECO’s workflow 
appears — and the same is true for the workflow of any ECO you open at this point. If you click the 
Show/Hide Workflow button again, the workflows are hidden in all ECOs. The switch controls the 
View/Hide mode for all objects in that Agile class (for example, ECOs, PCOs, or Problem Reports). 
This is on a ―per machine‖ basis, that is, it is not dependent on which user is logged on or other 
factors. 

Default Workflows 

Agile PLM includes default workflows for each routable object type. Default workflows provide the 
same change control process as previous Agile releases. 
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Sequence  Defaul t   
Change  
Orders,  

Defaul t  
Si te  

Change 
Orders  

Defaul t  
Change 

Requests  

Defaul t  
Dev iat ions  

Defaul t  

Stop  
Ships  

Defaul t  
Manufacturer  

Orders  

1st Pending Pending Pending Pending Pending 

2nd Submitted Submitted Submitted Submitted Submitted 

3rd CCB CCB CCB CCB CCB 

4th Released Released Released Released Released 

Final Implemented Closed Expired Resumed First Article Completed 

The Hold and Canceled statuses are optional and are not part of the sequential status list: 

Optional Canceled Canceled Canceled Canceled Canceled 

 Hold Hold Hold Hold Hold 

 

Sequence  Defaul t  ATOs  Defaul t  CTOs  

1st Pending Pending 

2nd Released Review 

3rd  Released 

Final Complete Complete 

 

Sequence  Defaul t   
Problem 

Reports  and  
NCRs  

Defaul t  CAPAs  Defaul t  Audi ts  

1st Pending Identified Preparation 

2nd Submitted Acknowledged Initiation 

3rd Review Investigated Analysis 

4th Released Implemented Issued 

5th  Validated Correction 

6th   Validation 

Final Closed Closed Closed 

The Hold and Canceled statuses are optional statuses that are not part of the sequential status list: 

Optional Canceled Canceled Canceled 
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Sequence  Defaul t   
Problem 

Reports  and  
NCRs  

Defaul t  CAPAs  Defaul t  Audi ts  

 Hold Hold Hold 

 

Sequence  Defaul t   
Act iv i t ies  

Defaul t  Gates  

1st Not Started Closed 

2nd In Process In Review 

Final Complete Open 

The Canceled status is an optional status that is not part of the sequential status list: 

Optional Canceled Canceled 

 

Sequence  Defaul t  Packages  

1st Pending 

2nd Submitted 

3rd Review 

4th Accepted 

Final Closed 

The Hold and Canceled statuses are optional statuses that are not part of the sequential status list: 

Optional Canceled 

 Hold 

The Default File Folders workflow has one status, Review. This workflow and the Default ATOs 
workflow are read-only. 

Example of a Customized Workflow 

The following figure shows an example of a customized workflow. Notice that this workflow has 
three different Review status types and two different Released status types. A routable object using 
this workflow is: 

 Routed through an approval cycle (Review status type) before it is submitted to the change 
analyst. 

 Routed through two approval cycles (Review status type) before it is released, with a different 
group of approvers for each approval cycle. 

 Released when it moves into the first Released status type. 
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 Moved into the second Released status type after the required fields have been filled in and, at 
this status, routed for approval a final time before moving into the Complete status type. 

Customized Agile workflows allow great flexibility in defining change control processes to meet your 
company’s needs. 

 
 

Using Workflows in the Change Control Process 

When a routable object is first created, it has no workflow assigned to it; therefore, it has no 
workflow status. Until you select a workflow for the routable object, it remains unassigned, and the 
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Unassigned status stamp is displayed in the upper right corner of the Cover Page tab. 

You can edit an unassigned routable object the same way you edit a routable object in a Pending 
status type: fill in fields, add items to the Affected Items tab, add files to the Attachments tab, and so 
on. 

When you have finished editing an Unassigned routable object, or a routable object in the Pending 
status type, and you are ready to start the routable object moving through the change control 
process, use the Next Status button. 

Selecting a Workflow 

Until you select a workflow for a routable object, the routable object remains unassigned, and the 
Unassigned status stamp is displayed in the upper right corner. 

To select a workflow for an unassigned routable object in Java Client: 

1. Open the routable object that you want to assign a workflow to. 

2. When working with an unassigned routable object, you can use either of these methods to 
select a workflow: 

 On the Cover Page tab, select a workflow from Workflow drop-down list. 

Click Save in the object window. 

 Or, click the Next Status button above the tabs. 

If there is no workflow assigned, you are prompted to select one in the Select Required 
Fields dialog drop-down list. 

Complete any required fields, for example, select a Change Analyst. 

Click OK. 

Note All the workflows that match the routable object are shown in the drop-down list. The 
drop-down list may vary depending on whether the Agile administrator has created 
any custom workflows. 

The status of the routable object switches to the first status in the selected workflow, which is 
always a Pending status type. 

Note As long as the routable object is in the Pending status type, you can select a different 
workflow. 

 To select a different workflow for a routable object that is not in either the Unassigned 
status or the Pending status type, you must switch the status to the Pending status type 
first. (See Returning a Routable Object to the Originator on page 238.) 

To select a workflow for an unassigned routable object in Web Client: 

1. Open the routable object to which you want to assign a workflow. 

2. When working with an unassigned routable object, you can use either of these methods to 
select a workflow: 

 On the Cover Page tab, click the Edit button. 
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Select a workflow from Workflow drop-down list. 

Click Save. 

 Or, click the Next Status button above the tabs. 

If there is no workflow assigned, you are prompted to select one in the Select Required 
Fields wizard drop-down list. 

Complete any required fields, for example, select a Change Analyst. 

Click OK. 

Note All the workflows that match the routable object are shown in the drop-down list. The 
drop-down list may vary depending on whether the Agile administrator has created 
any custom workflows. 

The status of the routable object switches to the first status in the selected workflow, which is 
always a Pending status type. 

Note As long as the routable object is in the Pending status type, you can select a different 
workflow. You can also select the blank field in the Workflow drop-down list, which 
switches the routable object to the Unassigned status and cancels the previous workflow 
selection.  

To select a different workflow for a routable object that is not in either the Unassigned 
status or the Pending status type, you must switch the status to the Pending status type 
first. (See Returning a Routable Object to the Originator on page 238). 

Working with Workflows 

This section includes the following topics: 

 Auditing Routable Objects on page 218 

 Switching a Routable Object from One Status to Another Status on page 216 

 Demoting a Routable Object on page 221 

 Completing the Status Change on page 222 

 Handling Routed Changes on page 225 

 Approving Routable Objects on page 228 

 Rejecting Routable Objects on page 231 

 Reminder Period and Review Escalation Period on page 233 

 Designated Escalation Person on page 234 

 Transferring Signoff Authority on page 234 

 Defining Personal Criteria for Authority Transfers on page 237 

 Returning a Routable Object to the Originator on page 238 

 Canceling a Routable Object on page 239 
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 Uncanceling a Routable Object on page 240 

 Putting a Routable Object on Hold on page 241 

 Releasing Routable Objects on page 241 

 Unreleasing Routable Objects on page 243 

 Multiple Released Status Types on page 244 

 Adding Comments to the History Tab on page 245 

 Changing a Routable Object’s Subclass on page 245 
 

Switching a Routable Object from One Status to Another Status 

Routable objects move through the change control process by moving through the statuses in the 
workflow status list. Routable objects make the transition from one status to another status in two 
ways: 

 The routable object is autopromoted from its current status to the next status in the workflow 
status list. 

 An Agile user switches the routable object from one status to another status manually. 

For details about switching a routable object from the Unassigned status, see Selecting a Workflow 
on page 214. 

A routable object is manually switched from one status to another in one of the following ways: 

 The Next Status button switches the routable object from the current status to the next 
sequential status in the workflow status list. Click this button, and the appropriate change status 
dialog box (Java Client) or page (Web Client) is displayed. 

 The Workflow tab allows you to switch the routable object from the current status to any status 
allowed by the settings in the workflow (manual valid next status). The status need not be the 
next status in the workflow status list. For example, you might switch a routable object from a 
Submit status type to a Hold status type. 

Whether you use the Next Status button or the Workflow tab, you must have the appropriate privileges 
to switch a routable object from one status to another status. See your Agile administrator if you 
have questions about your privileges. 

Switching the Status of a Routable Object 

You can use the Workflow tab or the Next Status button to switch the status of a routable object to any 
valid next status. 

To switch a routable object to any valid next status in Java Client: 

1. Open the routable object. 

2. Audit the routable object to ensure that there are no errors that prevent switching to another 
status. If any errors are found, fix them. See Auditing Routable Objects on page 218. 

3. Click the Workflow tab. 
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Note The valid next statuses (underlined statuses) that appear on the Workflow tab are 
determined by workflow property settings and your privileges. To review the entire 

status list, click the View Workflows button  in the toolbar. Click Close to close the 
View Workflows dialog box. 

4. Click one of the valid next statuses from the chart on the Workflow tab, or click the default next 
status (underlined). Or click the Next Status button above the tabs to accept the default next 
status in the sequence. 

5. When the Change Status dialog box appears, add the appropriate approvers, observers, users 
to notify, and comments. See Adding and Removing Approvers and Observers on page 226. 

6. Click the dialog button that completes the status change, for example, Submit, Route, or Release. 

The routable object moves to the selected status, which is the yellow status on the Workflow 
tab. 

To switch a routable object to any valid next status in Web Client: 

1. Open the routable object. 

2. Audit the routable object to ensure that there are no errors that prevent switching to another 
status. If any errors are found, fix them. See Auditing Routable Objects on page 218. 

3. Click the Workflow tab. 

Note The valid next statuses that appear on the Change Status page are determined by 
workflow property settings and your privileges. To review the entire status list, 
choose Actions > View Workflows. Click Cancel to close the View Workflow page. 

4. Select one of the valid next statuses from the chart on the Workflow tab, or click the Next Status 
button to accept the default next status in the sequence. 

5.  When the Change Status page appears, add the appropriate approvers, observers, users to 
notify, and comments. See Auditing Routable Objects on page 218. 

6. Click OK. 

The routable object moves to the selected status, as which is the orange status on the Workflow 
tab. 

You can use the Next Status button to switch the status of a routable object. 

Save Routing Slip Content when Advancing Change 

When you manually advance a workflow to the next status, the routing slip appears to be filled in. 
This contains approvers, observers, ―notify‖ users, and comments, and you may spend several 
minutes completing the slip. When you click Route, Agile performs an automatic workflow status 
audit and presents you with a dialog if a problem is found. You are asked if you want to continue: 
previously, if No was selected, you were returned to the routable object and lost all the work. As of 
Agile 9.2.1, if you select No, you are returned to the routing slip, allowing you to copy the routing 
slip data and paste it to a temporary location, such as a word processor file. 
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Auditing Routable Objects 

You can audit a routable object at any status in the workflow. Before switching the routable object to 
a different status, always audit the object to detect any errors that may prevent switching to a 
different status.  

With appropriate privileges, you can perform two types of audits—a status audit and a release audit. 

The status audit is performed automatically when you use the Change Status function or the 
workflow attempts to autopromote to the next status. You can perform a status audit at any time by 
using the Audit Status button or menu selections. It performs the following checks: 

 Makes sure the Exit Required Fields for the current status are filled in. 

 If the current status is a Review status type or a Released status type, makes sure that all 
approvers have approved. 

 Checks the workflow settings of the Pass Release Audit property for the current status. If Pass 
Release Audit is set to either Yes or Warning, Agile PLM also performs a release audit. 

 

Agile PLM performs a release audit automatically when the routable object is promoted to the first 
Released type status in the workflow. You can perform a release audit at any time by using the 
Audit Release button or menu selections. 

The release audit performs the status audit for both the current status and the release status. 

It performs the following additional checks: 

 For ECOs, checks if the proposed new revision number on the Affected Items tab already exists. 

 For ECOs, SCOs, PCOs and MCOs, checks if there are manufacturer redlines that will be lost 
after the routable object is released. 

 For ECOs and SCOs, checks if there are BOM redlines that will be lost after the routable object 
is released. 

 For ECOs, SCOs, PCOs and MCOs, checks if there are conflicts due to another ECO, SCO, or 
MCO being released first. 

 For ECOs, SCOs, and MCOs, if the BOM Multi-level Recursive SmartRule is set to Disallow, 
checks for recursive BOM structures, that is, when a subassembly includes one of its parent 
items from an upper level of the BOM tree structure on its own BOM. (A recursive BOM 
structure, if carried to its logical conclusion, would repeat indefinitely). 

The BOM tree is evaluated from top to bottom. The Audit Release error message indicates, for 
each affected item with a recursive BOM, the first item found in the BOM tree whose first-level 
BOM table includes an item that appears at a higher level in the BOM tree, thus causing a 
recursive BOM structure. Although there may be multiple instances of recursive BOM structure 
in an affected item BOM tree, only the first found instance is displayed in the audit results. 

 For ECOs, SCOs, and PCOs, depending on SmartRule settings, checks for duplicate items, 
duplicate find numbers and duplicate reference designators caused by a change rebase. 
(When there are multiple pending changes for the same item, when one change is released, 
the remaining pending changes are rebased on the latest released change.) 

 For ECOs, SCOs, and MCOs, checks for duplication of the same manufacturer part on an item. 
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(MultipleItemsPerManufPart is set to Warning or Disallow.) 

(Duplication of the same manufacturer part on an item occurs when an item has multiple 
pending changes which associate the same manufacturer part to that item and one change is 
released. The remaining pending changes are rebased on the latest released change. The 
remaining pending changes now include manufacturer part redline modifications to add a 
manufacturer part that already exists on the released item's Manufacturers table.) 

 For ECOs, SCOs, and MCOs, checks for the use of the same manufacturer part on multiple 
items. (MultipleItemsPerManufPart is set to Warning or Disallow.) 

(Duplication of the same manufacturer part on multiple items occurs when multiple changes 
add the same manufacturer part to two or more items' Manufacturers tables, either by redline 
addition or redline replacement. When one of the changes is released, the manufacturer part's 
Where Used table is rebased to refer to the newly released item. The remaining pending 
changes now include manufacturer part redline modifications that would allow a single 
manufacturer part to be used by multiple items.) 

 For ECOs, SCOs, and PCOs, if the Item Release First SmartRule is set to Disallow or Warning, 
then the routable object is checked to see if the child components have been released. 

 Checks if any of the attachments of the routable object remain checked out. 

 For every affected item, checks if any of the attachments remain checked out. 

 Checks the Effectivity Date Order and Effectivity Gap SmartRule settings. 

 Checks if items on the Affected Items tab have any other pending routable objects. 

 For ECOs, validates the affected item's Sites tab Make/Buy setting with the site's Site AML Allowed 
and AML Required on Buy settings. For more information, see Product Collaboration User Guide. 

 

Modifying the Make/Buy Field on the Item Sites Tab 

If you have the appropriate modify privileges, you can modify the Make/Buy field in an item's Sites 
table, even if the item has been released. However, the Make/Buy setting is not revision-specific. 
When you modify the Make/Buy setting on any item revision, it is also modified for all revisions. The 
following restrictions apply when modifying the Make/Buy setting: 

 When the item is included on the affected items table of a change order, the release audit 
validates the site's Site AML Allowed and AML Required on Buy settings with the item Sites tab 
Make/Buy setting for that revision. Past revisions are not audited. (A release audit is performed 
automatically when the change order is released.) 

 Because the Make/Buy setting is not revision-specific and can be changed without using a 
change order, any validation violations caused by a modification to Make/Buy remain on the 
latest released revision of the item and may not be detected until the next time the item is 
added to a change order and the change order is release audited. 

 

Note When a routable object moves from the current status (including the Pending status type, 
the first status in the workflow) to the next status in the workflow, the system 
automatically performs a release audit depending on the workflow Pass Release Audit 
property settings for the current status. 

In Java Client, the audit results box remains open until you close it. This allows you to refer to the 
audit results as you modify the routable object. 
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Note Your Discovery and Read privileges determine which objects and which fields you can 
see in the audit results box. If you do not have the appropriate privileges, you may see 
the words ―No Privilege‖ displayed. 

 

See also Switching a Routable Object from One Status to Another Status on page 216. 

To audit the current status of a routable object in Java Client: 

1. Open the routable object you want to audit. 

You may audit a routable object from any tab. 

2. Click the Audit Status  button above the tabs. Or right-click in the Agile Java Client window; 
in the menu that appears, choose Audit Status. 

The Audit Results for Audit Status dialog box appears. 

If there are errors, correct them and audit again. 

3. To close the Audit Results dialog box, click OK. 

To audit the current status of a routable object in Web Client: 

1. Open the routable object you want to audit. 

You may audit a routable object from any tab. 

2. Choose Actions > Audit Status. 

A note appears on the tab. 

If there are errors, correct them and audit again. 
 

To audit the routable object for release in Java Client: 

1. Open the routable object you want to audit for release. 

You may audit a change from any tab. 

2. Click the Audit Release button  above the tabs. Or right-click in the Agile Java Client window; 

in the menu that appears, choose Audit Release . 

The Audit Results for Audit Release dialog box appears. 

If there are errors, correct them and audit again. 

3. To close the Audit Results dialog box, click OK. 

To audit the routable object for release in Web Client: 

1. Open the routable object you want to audit for release. 

You may audit a change from any tab. 

2. Choose Actions > Audit Release. 

A note appears on the tab. 

If there are errors, correct them and audit again. 
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Autopromotion Failure 

When all the approvers have signed off for a Review or Released status type, and all the required 
fields have been completed, the routable object can be automatically promoted to the next status 
with the AutoPromote feature. 

If autopromotion fails, the routing manager receives a notification. The routing manager should 
investigate why autopromotion failed and take the necessary action to move the routable object 
forward in the workflow. 

Autopromotion may fail for one or more of the following reasons: 

 An attachment on the routable object, for example, a change order, remains checked out. 

 Either checkin the attachment or cancel the checkout, then use Next Status to move the 
routable object to the next status in the workflow. See Switching a Routable Object from 

One Status to Another Status on page 216. 

 For one or more affected items of the routable object, an attachment remains checked out. 

 Either checkin the attachment or cancel the checkout, then use Next Status to move the 
routable object to the next status in the workflow. See Switching a Routable Object from 

One Status to Another Status on page 216. 
 

Redline Conflicts 

If an affected item has two or more unreleased changes and each of those changes includes 
redlines to the item. The redlines are in conflict, for example, both ECOs include redlines to the 
quantity of the same BOM item. 

Or an affected item has two or more unreleased changes with redlines and there are no redline 
conflicts while both changes are unreleased. However, if the current change is released, it will 
cause the other change to have redline conflicts with the most recently released revision of the item. 

The change analyst can determine how to resolve the conflict: 

 Examine the pending changes and decide which redlines you want to keep. You can remove 
redlines or you may decide to remove the item from the Affected Items table of one of the 
changes. Advance the status manually. 

 Or, manually advance the status of one of the changes. A warning appears that tells you that 
releasing the change will cause another change to lose redlines. Ignore the warning and 
release the change; the redlines are removed from the remaining change. 

 

Ability to Fail Autopromote More than Once within same Change Status 

This feature notifies whomever is specified in the status’s If Autopromote Fails, Notify setting each 
time a change order fails to autopromote if new approvers were added since the last autopromote 
failure. Additionally, History is updated if Autopromote fails when a new approver is added but 
doesn’t complete all workflow-required fields. 

Demoting a Routable Object 

You promote a routable object by moving it through the sequential list of statuses in the workflow, 
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as described in the previous section. If the workflow allows it, and if you have the appropriate 
privileges, you can also use the Workflow tab to demote a routable object by moving the routable 
object to a previous status in the workflow status list. From that previous status, the routable object 
then moves through the workflow again. For an example, see Returning a Routable Object to the 

Originator on page 238. 

Note If the routable object has entered the first Released status type, moving the routable 
object to a previous status in the workflow status list unreleases the routable object, and 
may have undesirable consequences. For more information, see Unreleasing Routable 

Objects on page 243. 

Agile administrative settings determine what happens when a routable object again moves through 
a status with approvers and observers (Review status type or Released status type) after status 
demotion. Depending on the settings, the following rules apply: 

 Demotion Approvers Removal SmartRule: 

 Remove: any ad hoc approvers and observers added during the first time through the 
Review status type or Released status type are removed for the second Review status 
type or Released status cycle. 

 Retain: ad hoc approvers and observers added during the first time through the Review 
status type or Released status type are kept on the approvers and observers lists for the 
second Review status type or Released status type cycle. 

 Demotion Signoff Removal SmartRule: 

 Remove: When a routable object enters the Review status type or Released status type the 
second time, all approvals and rejections from the first routing cycle are removed, and the 
approvers and observers must sign off again. (The approvals and rejections from the first 
routing cycle are still shown on the Workflow tab.) 

 Retain: When a routable object enters the Review status type or Released status type the 
second time, all the approvals and rejections from the first routing cycle are retained in the 
second routing status cycle and displayed in the signoff summary table. The approvers 
and observers who have already signed off do not need to sign off again. 

 

Completing the Status Change 

Whenever you switch a routable object from one status to another, you must complete the Change 
Status dialog box (Java Client) or page (Web Client). The Change Status dialog box or page for all 
status types includes a Notify field and a Comments field. For the Review status type and Released 
status type, additional fields for approvers and observers are included. 

By default, you can switch a routable object to a Submit status type only if you are the originator, or 
if you have the appropriate privileges. Typically, the routing manager has the appropriate privileges 
to submit routable objects. 

Note If the routing manager field (for example, the Change Analyst field) on the Cover Page of 
the routable object is left blank, and if the workflow is defined to notify the default routing 
manager, then when you switch to a Submit status type, the routable object is submitted 
to every user on the routing manager drop-down list. 

You must include at least one change analyst in the Notify field of the Change Status dialog box or 
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page. 

Only the originator and users with the appropriate privileges can submit a routable object. 

You cannot submit a routable object to a routing manager who does not have Discovery and Read 
privileges for that routable object. (See the Agile PLM Administrator Guide for details.) 

By default, you can switch a routable object to a Submit status type only if you are the originator, or 
if you have the appropriate privileges. Typically, the change analyst or component engineer has the 
appropriate privileges to submit routable object. 

To complete the Change Status dialog box in Java Client: 

1. Select a new status by using either the Next Status button or the Workflow tab. See Switching the 

Status of a Routable Object on page 216. 

The Change Status dialog box appears. 

The Notify field may already contain a list of names, as specified in the workflow, or the Notify 
field may be blank. In either case, you can add names to the Notify field if you choose to do so. 

2. To add names to the Notify list, type the names of the users to be notified (with semicolons 
separating the names). 

Or click the Notify button to open the address book. 

You may select individual usernames or user groups. See Adding and Removing Approvers 

and Observers on page 226. 

3. Add any comments in the Comments field. 

4. Click the dialog button that completes the status change, for example, Submit, Route, or Release. 

To complete the Change Status page in Web Client: 

1. Select a new status by using either the Next Status button or the Workflow tab. See Switching the 

Status of a Routable Object on page 216. 

The Change Status page appears. 

The Notify field may already contain a list of names, as specified in the workflow, or the Notify 
field may be blank. In either case, you can add names to the Notify field if you choose to do so. 

2. To add names to the Notify list, type the names of the users to be notified (with semicolons 
separating the names). 

Or click  to open the address book. 

You may select individual usernames or user groups. See Adding and Removing Approvers 

and Observers on page 226. 

3. Add any comments in the Comments field. 

4. Click OK. 
 

Completing the Status Change for a Review or Released Status 

When you switch a routable object to a Review status type or a Released status type, you are 
routing it for signoff review to a list of approvers and observers. This list of approvers may also be 
called the CCB, or change control board.  
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When the Change Status dialog box (Java Client) or page (Web Client) appears, workflow property 
settings may have already assigned a list of users as approvers, observers, and users to notify. If 
you choose, you may add to this list. If these fields are blank, complete them. When the routable 
object is routed, it is attached to an email message and sent to all the approvers, observers, and 
users to notify. The email message contains an icon representing the change; double-clicking the 
icon opens the routable object. Approvers are required to either accept or reject the routable object. 
Observers may also accept or reject the routable object, but their response is not required. Users 
who are notified are not required to take any action. 

To complete the Change Status to Review or Released dialog box in Java Client: 

1. Select the Review status type or the Released status type by using either the Next Status button 
or the Workflow tab. See Switching the Status of a Routable Object on page 216. 

The Change Status dialog box appears. 

2. Complete the Approvers, Observers, and Notify fields. These fields may already contain names as 
defined by the workflow; with appropriate privileges, you may add names. Type the names, 
separated by semicolons. 

Or click the Approvers, Observers, or Notify buttons to open the address book for each field. 

From the Users or Groups tab, you may select individual usernames or user groups. See Adding 

and Removing Approvers and Observers on page 226. 

3. Add any comments in the Comments field. 

4. If appropriate, select the Urgent checkbox. This adds ―URGENT‖ to the subject of the email (if 
users are using Microsoft Outlook). 

5. Click the dialog button that completes the status change, for example, Route or Release. 

The routable object is routed to all the approvers and observers, and their names are placed on 
the Workflow tab. All users in the Notify field receive email informing them of the new status of 
the routable object. 

To complete the Change Status to Review or Released page in Web Client: 

1. Select the Review status type or the Released status type by using either the Next Status button 
or the Workflow tab. See Switching the Status of a Routable Object on page 216. 

The Change Status page appears. 

2. Complete the Approvers, Observers, and Notify fields. These fields may already contain names as 
defined by the workflow; with appropriate privileges, you may add names. Type the names, 
separated by semicolons. 

Or click  to open the address book. 

You may select individual users, usernames or user groups. See Adding and Removing 

Approvers and Observers on page 226. 

3. Add any comments in the Comments field. 

4. If appropriate, select the Urgent checkbox. This adds ―URGENT‖ to the subject of the email (if 
users are using Microsoft Outlook). 

5. Click OK. 

The routable object is routed to all the approvers and observers, and their names are placed on 
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the Workflow tab. All users in the Notify field receive email informing them of the new status of 
the routable object. 

Discovery Privileges of Approvers, Observers, and Users to Notify 

If any of the users you select as approvers, observers, or users to notify do not have the appropriate 
Discovery or Read privileges for the routable object, an error message appears when you attempt 
to route or release the routable object. The error message lists the users that do not have the 
appropriate privileges and informs you that their names have been automatically removed from the 
distribution list. 

For more information about Discovery and Read privileges, see the Agile PLM Administrator Guide. 

Handling Routed Changes 

The following sections describe procedures you perform when routing changes: 

 When to Add Approvers and Observers on page 225 

 Adding and Removing Approvers and Observers on page 226 
 

When to Add Approvers and Observers 

Routing managers may want to monitor routable objects assigned to them to make sure that the list 
of approvers and observers is complete. Workflows may assign approvers and observers according 
to the attributes of the affected items of a routable object; you can add approvers that were not 
automatically assigned by the workflow. 

For example, at Acme Incorporated, each product line has several projects in development at one 
time. Acme uses a field to identify which project or projects each item (part or document) belongs 
to. The Libra Product Line workflow looks at the project assigned to the affected items on an ECO 
to determine which default approvers and observers to assign. 

Mary Green creates ECO 333. She adds six Orion project objects to the Affected Items tab: three 
parts and three documents. Mary finishes preparing ECO 333 and switches it to the next status, 
where the routable object (ECO 333) is submitted to Bob Smith, the default change analyst. 

To select approvers for the Orion project, the Libra Product Line workflow examines each item on 
the affected items table to determine if the field contains Orion. If all the items on the affected items 
table belong to the Orion project, then the list of Orion approvers, as defined in the workflow, is 
automatically added to the Workflow tab when ECO 333 is submitted to Bob. 

However, in the case where some of the objects on the affected items table are documents, Acme 
requires that Orion team members in the Publications department (a user group) must also sign off 
the routable object. Since not all ECOs include documents to sign off, the Libra Product Line 
workflow does not automatically add to every ECO approvers from the Publications department. 

Bob Smith, the change analyst, examines the ECO 333 and notices that some of the affected items 
are documents. Bob clicks Add Approvers/Observers on the ECO 333 page and adds all the members 
of the Orion Publications group as approvers. Bob can add approvers to any future Review or 
Released status type; the ECO does not need to be in the Review or Released status type to add 
approvers or observers. 
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See Adding and Removing Approvers and Observers on page 226 for detailed instructions for 
adding approvers and observers. 

Adding and Removing Approvers and Observers 

After a routable object has been routed for approval and enters a Review or Released status type, it 
may be necessary to either add or remove approvers or observers. This requires both of the 
following: 

 The Ad Hoc Approvers/Observers property in the workflow is set to Yes. 

 You have the appropriate privilege granted to you by your Agile administrator. 

Note You cannot add a user as an approver or observer if that user does not have Discovery 
and Read privileges for that routable object. 

 Ad hoc approvers or observers can be added to or removed from the routable object only 
when it is in a Submitted, Review, or Released type status. Ad hoc approvers or 
observers cannot be added to or removed from the routable object when it is in the 
Pending type status. 

You cannot add the same user to both the Approvers and the Observers list. If you attempt to add 
the same names to both lists, Agile PLM warns you and prompts you to delete the duplicate names 
from the list you select (approvers or observers). 

To add an approver or observer in Java Client: 

1. Select and open the routable object. 

2. On the Workflow tab, select the status you want the additional people to approve. 

3. Click the Add Approver/Observer button . 

4. The Add Approvers and Observers dialog box appears. 

5. Complete the Approvers and Observers fields. Type the names of the approvers or observers to 
add to the list (with semicolons separating the names). 

Or click the Approvers or Observers button to open the address book for each field. 

From the Users or Groups tab, you may select individual usernames or user groups 

6. If you want to add an entire user group as an approver, you can either add the group itself or 
the members of the group. This determines whether only one member or all members of the 
group must sign off. 

a. Click the Group tab in the address book. 

b. Select one or more group names. 

(To select user names, expand a group by clicking the plus sign +.) 

c. To add the group name to the recipient list, click the  button. The group name is 
added to the recipients list. Only one user in the group needs to sign off. 

d. To add the members of the group to the recipient list, click the  button. The 
usernames of the members of the group are added to the recipient list. Each user in the 
group must sign off. 
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7. Add any comments. 

8. Click OK. 

To add an approver or observer in Web Client: 

1. Select and open the routable object. Click the Workflow tab. 

2. Click the Add Approvers/Observers button. 

The Add Approvers or Observers page appears. 

3. Select the status you want the additional people to approve. 

4. Complete the Approvers and Observers fields. Type the names of the approvers or observers to 
add to the list (with semicolons separating the names). 

Or click  to open the address book. 

You may select individual usernames or user groups. 

To add an entire user group as an approver: 

a. In the Select Group drop-down list, select All Groups, and click Find. All the groups in the 
address book appear in the Available Values list. 

b. In the Available Values list, select either UserGroupName - All or UserGroupName - Any, 
where UserGroupName is the name of the user group you want to select. This determines 
whether all users in the group need to sign off (All) or only one member of a group needs 
to sign off (Any). Click the right arrow to move the group to the Selected Values list, and click 
OK. 

5. Add any comments. 

6. Click OK. 

Note When you add a user group as an approver such that only one member of the group 
needs to signoff (UserGroupName - Any), escalation behavior is determined by the user 
group's profile settings for Allow Escalation Designation Approval (After Escalation or 
Always) and the user group's assigned escalation persons. However, when you add a 
user group as an approver such that all members of the group must signoff 
(UserGroupName - All), Agile PLM automatically adds each member of the group as an 
individual approver and, therefore, escalation behavior depends on the user profile 
settings and assigned escalation persons of each individual user. 

To remove an approver or observer in Java Client: 

1. Select and open the routable object. 

2. On the Workflow tab, under the appropriate status, select the approvers or observers you want 
to remove from the list. 

3. Click the Remove Approver/Observer button.  

4. When prompted to confirm the removal action, click Yes. 

Note You can remove an approver only if that approver has not yet approved or rejected 
the routable object. 
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To remove an approver or observer in Web Client: 

1. Select and open the routable object. 

2. Click the Remove Approvers/Observers button. 

The Remove Approvers or Observers page appears. 

3. Select the status for which you want to remove approvers or observers. 

4. Enter the names of approvers or observers to be removed from the list. Type the names (with 
semicolons separating the names). 

Or click  to open the address book. The approvers or observers appear in the Available 
Values list. Select the usernames or groups you want to move, and click the right arrow to move 
them to the Selected Values list, and click OK. 

5. Enter any comments. 

6. Click OK. 

Note You can remove an approver only if that approver has not yet approved or rejected 
the routable object. 

 

Approving Routable Objects 

When you approve a routable object, the approval and any comments are shown on the Workflow 
tab. 

To approve a routable object in Java Client: 

1. Open the routable object. 

2. Click the Approve button  to open the Approve dialog box. 

3. Enter any comments in the Comments field. 

Completing the Comments field may be either required or optional, depending on workflow 
settings. 

4. Click any of these checkboxes if you want to notify these people: Notify Change Analyst, Notify 
Originator, Notify Reviewers. If you select Notify Reviewers, you can use the drop-down list to 
choose a different workflow status. 

5. Depending on the Agile PLM system settings and workflow definitions, and the conditions 
under which you are signing off, the Approval dialog may include the following fields or lists that 
you must fill in: 

a. Escalated From: A list of escalations for approver users or groups for which you are the 
Designated Escalation Person.  

 Click the down arrow next to the Escalated From field.  

 To select the users or groups for which you wish to approve, in the dialog box that 
appears, select a user or group in the Choices list or the Selected list and click the 
right or left arrows to move the your selections from one list to the other. If you if you 
do not wish to approve for any escalations, leave the Selected list blank. 

 Click OK. 
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b. Transferred From: A list of transfer authorities for approver users or groups for which you are 
the Transfer To person.  

 Click the down arrow next to the Transfer From field.  

 To select the users or groups for which you wish to approve, in the dialog box that 
appears, select a user or group in the Choices list or the Selected list and click the 
right or left arrows to move the your selections from one list to the other. If you do not 
wish to approve for any transfers, leave the Selected list blank.  

 Click OK. 

c. Approval Group(s): A list of the approver groups of which you are a member.  

 Click the down arrow next to the Approving for Group(s) field.  

 To select the users or groups for which you wish to approve, in the dialog box that 
appears, select a user or group in the Choices list or the Selected list and click the 
right or left arrows to move the your selections from one list to the other. If you do not 
wish to approve for any groups, leave the Selected list blank. 

 Click OK 

d. Signoff for Self: When you are also an individual approver, a checkbox is displayed next to 
your name.  

 Check the checkbox to indicate that you are approving for yourself, in addition to any 
group, escalation, or transfer approvals. If you do not wish to approve for yourself, 
uncheck the checkbox. 

e. Dual Identification: Depending on system settings, you may be required to enter dual types 
of identification.  

 The first identification type is your approval password. Enter your approval password 
in the Password field. 

 The second identification type depends on Agile PLM settings and may be either your 
userID (username) or your login password. 

Note When presented with multiple signoff possibilities (escalations, transfers, groups, or 
self) you must select at least one group or person for whom you are approving. 

6. Click Approve. 

To approve a routable object in Web Client: 

1. Open the routable object. 

2. Click the Approve button to open the Approve page. The Approve and Reject buttons appear after 
the routable object is moved to a certain status, for example, a problem report moves from the 
Submitted to the Review status. 

3. Enter any comments in the Comments field. 

Completing the Comments field may be either required or optional, depending on workflow 
settings. 

4. Click any of these checkboxes if you want to notify these people: Notify Change Analyst, Notify 
Originator, Notify Reviewers. 

5. Depending on the Agile PLM system settings and workflow definitions, and the conditions 
under which you are signing off, the Approval page may include the following fields or lists that 
you must fill in: 

a. Escalated From: A list of escalations for approver users or groups for which you are the 
Designated Escalation Person.  
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 Click the  button next to the Escalated From field.  

 To select the users or groups for which you wish to approve, in the dialog box that 
appears, select a user or group in the Available Values list or the Selected Values list 
and click the right or left arrows to move the your selections from one list to the other. 
If you if you do not wish to approve for any escalations, leave the Selected Values list 
blank. 

 Click OK.  

b. Transferred From: A list of transfer authorities for approver users or groups for which you are 
the Transfer To person.  

 Click the  button next to the Transfer From field.  

 To select the users or groups for which you wish to approve, in the dialog box that 
appears, select a user or group in the Available Values list or the Selected Values list 
and click the right or left arrows to move the your selections from one list to the other. 
If you if you do not wish to approve for any transfers, leave the Selected Values list 
blank. 

 Click OK. 

c. Approving for Group(s): A list of the approver groups of which you are a member.  

 Click the  button next to the Approving for Group(s) field.  

 To select the users or groups for which you wish to approve, in the dialog box that 
appears, select a user or group in the in the Available Values list or the Selected 
Values list and click the right or left arrows to move the your selections from one list to 
the other. If you if you do not wish to approve for any groups, leave the Selected 
Values list blank. 

 Click OK 

d. Signoff for Self: When you are also an individual approver, a checkbox is displayed next to 
your name.  

 Check the checkbox to indicate that your are approving for yourself, in addition to any 
group, escalation, or transfer approvals. If you do not wish to approve for yourself, 
uncheck the checkbox. 

e. Dual Identification: Depending on system settings, you may be required to enter dual types 
of identification.  

 The first identification type is your approval password. Enter your approval password 
in the Password field. 

 The second identification type depends on Agile PLM settings and may be either your 
userID (username) or your login password. 

Note When presented with multiple signoff possibilities (escalations, transfers, groups, or 
self) you must select at least one group or person for whom you are approving. 

6. Click Approve. 

When all the approvers have approved, the routable object is ready to move to the next status in the 
status list. 

 If the AutoPromote property for the status is set to Yes, and the required fields are filled in, then 
the routable object is automatically promoted to the next status in the status list. 

 If the AutoPromote property for the status is set to No, then an email message notifies the 
change analyst, component engineer, or other routing manager that all the approvers have 
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approved the routable object. 
 

Rejecting Routable Objects 

When you reject a routable object, the rejection and any comments appear on the Workflow tab, and 
the specified users receive an email message. Usually, this is the change analyst or component 
engineer. The email message states that you have rejected the routable object. 

If a routable object is first rejected but then later approved, the Workflow tab shows only the approval 
and not the rejection. However, the History tab shows both actions. 

To reject a routable object in Java Client: 

1. Open the routable object. 

2. Click the Reject button  to open the Reject dialog box. 

3. Enter any comments in the Comments field. 

Completing the Comments field may be either required or optional, depending on workflow 
settings. 

4. Depending on the Agile PLM system settings and workflow definitions, and the conditions 
under which you are signing off, the Reject dialog may include the following fields or lists that 
you must fill in: 

a. Escalated From: A list of escalations for approver users or groups for which you are the 
Designated Escalation Person.  

 Click the down arrow next to the Escalated From field.  

 To select the users or groups for which you wish to reject, in the dialog box that 
appears, select a user or group in the Choices list or the Selected list and click the 
right or left arrows to move the your selections from one list to the other. If you if you 
do not wish to reject for any escalations, leave the Selected list blank. 

 Click OK. 

b. Transferred From: A list of transfer authorities for approver users or groups for which you are 
the Transfer To person.  

 Click the down arrow next to the Transfer From field.  

 To select the users or groups for which you wish to reject, in the dialog box that 
appears, select a user or group in the Choices list or the Selected list and click the 
right or left arrows to move the your selections from one list to the other. If you if you 
do not wish to reject for any transfers, leave the Selected list blank. 

 Click OK. 

c. Approval Group(s): A list of the approver groups of which you are a member.  

 Click the down arrow next to the Approving for Group(s) field.  

 To select the users or groups for which you wish to reject, in the dialog box that 
appears, select a user or group in the Choices list or the Selected list and click the 
right or left arrows to move the your selections from one list to the other. If you if you 
do not wish to reject for any groups, leave the Selected list blank. 

 Click OK 

d. Signoff for Self: When you are also an individual approver, a checkbox is displayed next to 
your name.  

 Check the checkbox to indicate that you are rejecting for yourself, in addition to any 
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group, escalation, or transfer rejections. If you do not wish to reject for yourself, 
uncheck the checkbox. 

e. Dual Identification: Depending on system settings, you may be required to enter dual types 
of identification.  

 The first identification type is your approval password. Enter your approval password 
in the Password field. 

 The second identification type depends on Agile PLM settings and may be either your 
userID (username) or your login password. 

Note When presented with multiple signoff possibilities (escalations, transfers, groups, or 
self) you must select at least one group or person for whom you are rejecting. 

5. Click the Notify button to add any users to be notified. 

6. Click Reject. 

To reject a routable object in Web Client: 

1. Open the routable object. 

2. Click the Reject button to open the Reject page. 

3. Enter any comments in the Comments field. 

Completing the Comments field may be either required or optional, depending on workflow 
settings. 

4. Depending on the Agile PLM system settings and workflow definitions, and the conditions 
under which you are signing off, the Reject page may include the following fields or lists that 
you must fill in: 

a. Escalated From: A list of escalations for approver users or groups for which you are the 
Designated Escalation Person.  

 Click the  button next to the Escalated From field.  

 To select the users or groups for which you wish to reject, in the dialog box that 
appears, select a user or group in the Available Values list or the Selected Values list 
and click the right or left arrows to move the your selections from one list to the other. 
If you if you do not wish to reject for any escalations, leave the Selected Values list 
blank. 

 Click OK. 

b. Transferred From: A list of transfer authorities for approver users or groups for which you are 
the Transfer To person.  

 Click the  button next to the Transfer From field.  

 To select the users or groups for which you wish to reject, in the dialog box that 
appears, select a user or group in the Available Values list or the Selected Values list 
and click the right or left arrows to move the your selections from one list to the other. 
If you if you do not wish to reject for any transfers, leave the Selected Values list 
blank. 

 Click OK. 

c. Reject for Group(s): A list of the approver groups of which you are a member.  

 Click the  button next to the Rejecting for Group(s) field.  

 To select the users or groups for which you wish to reject, in the dialog box that 
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appears, select a user or group in the Available Values list or the Selected Values list 
and click the right or left arrows to move the your selections from one list to the other. 
If you if you do not wish to reject for any groups, leave the Selected Values list blank. 

 Click OK 

d. Signoff for Self: When you are also an individual approver, a checkbox is displayed next to 
your name.  

 Check the checkbox to indicate that you are rejecting for yourself, in addition to any 
group, escalation, or transfer rejections. If you do not wish to reject for yourself, 
uncheck the checkbox. 

e. Dual Identification: Depending on system settings, you may be required to enter dual types 
of identification.  

 The first identification type is your approval password. Enter your approval password 
in the Password field. 

 The second identification type depends on Agile PLM settings and may be either your 
userID (username) or your login password. 

Note When presented with multiple signoff possibilities (escalations, transfers, groups, or 
self) you must select at least one group or person for whom you are rejecting. 

5. Click the  button next to the Notify field to add any users to be notified. 

6. Click Reject. 

When at least one approver has rejected a routable object, the following actions occur, as specified 
in the workflow property settings: 

 The users specified in the workflow properties are notified that the routable object has been 
rejected. 

 If the AutoPromote property is set to Yes, then the routable object is not promoted to the next 
status in the status list. 

 Depending on the workflow property settings, the object may switch to a specified status when 
it has been rejected. 

 

Reminder Period and Review Escalation Period 

The reminder period and the review escalation period are periods of time defined for each Review 
or Released status type in each workflow. For example, the reminder period for the CCB status in 
the Default Change Orders workflow is 48 hours, and the review escalation period is 96 hours. The 
reminder period and the review escalation period begin when the routable object enters a Review or 
Released status type. The reminder period is shorter than the escalation period so the approvers 
have time to respond before the escalation period elapses. 

Each Review or Released status type has its own reminder period and review escalation period. If a 
workflow has several Review or Released status types, each one may have a different length of 
time for both its reminder period and review escalation period. 

When the reminder period elapses, if an approver has not approved or rejected the routable object, 
a reminder email is sent to the approver. The change analyst or component engineer receives a 
similar email. 

When the escalation period elapses, if an approver has not approved or rejected the routable 
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object, an email is sent to the appropriate designated escalation person. A similar email notifies the 
change analyst or component engineer that the routable object has been escalated to the specified 
designated escalation person. The designated escalation person may approve or reject the routable 
object in the place of the original approver. 

When reminder and escalation notifications are sent, the actions are recorded on the History tab. 

Designated Escalation Person 

Each user or user group may have multiple designated escalation persons. A designated escalation 
person can be an individual user or user group. 

Your Agile administrator determines whether your designated escalation persons are able to sign 
off a routable object for you at any time, or only after the escalation period has elapsed. See your 
Agile administrator if you have questions about your designated escalation persons. 

For information about defining escalations, see Navigating in Agile Java Client on page 7. 

If the review escalation period elapses, the approver’s designated escalation persons are notified by 
email that the approver has not responded. Now the designated escalation persons may approve or 
reject the routable object in the place of the original approver. If the designated escalation person 
approves or rejects the routable object, then the name is recorded on the Workflow tab and the 
History tab as the Signoff user. 

Note If the designated escalation person is a user group, only one member of the group needs 
to sign off the routable object. When the routable object has been signed off, the routable 
object no longer appears in the Inbox of the other members of the group. 

 

Transferring Signoff Authority 

If you have the appropriate privileges, you can temporarily transfer your signoff authority for the 
routable object to one or more Agile users. For example, if you know you will be on vacation for a 
week, you can give other users the authority to sign off routable objects for you while you are gone. 
You can specify which routable objects to transfer to which user. 

In addition, if you have the appropriate privileges, you can also transfer signoff authority for other 
users. For example, if Mary will be on vacation, you can give Bob the authority to sign off routable 
objects for Mary while she is gone. 

Note Signoff authority is transferred for users who are assigned approvers on a routable 
object. Signoff authority is not transferred for observers. 

To transfer signoff authority for yourself or others in Java Client: 

1. Choose Settings > Transfer Authority in the main menu bar. The Transfer Authority dialog box 
appears, which lists the transfer authority definitions you have the ability to modify or delete. 

2. Click the New button. The New Transfer Authority dialog box appears. 

3. Select yourself or another user to transfer authority from, then select the user who is receiving 
signoff authority. 
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Note Users who are receiving the authority must have the appropriate privileges to sign 
off the routable objects transferred to them. If you have questions about privileges, 
see your Agile administrator. 

4. In the Select Criteria list, click to select the type of information to transfer. 

To view the filter conditions for the selected criteria, click the View button in the Criteria pane. 
The criteria is displayed, much like a search definition, in a read-only dialog box. You can verify 
whether the selected transfer criteria will find the routable objects you want to transfer. Click 
Cancel to close the dialog box. 

Note The list of criteria is quite extensive. If you have questions about which criteria would 
best suit your needs, contact your Agile administrator, who manages all global 
criteria. Alternatively, consider defining a personal criteria that you can then use for 
transferring authority. See Defining Personal Criteria for Authority Transfers on 
page 237 for information about creating personal criteria. 

5. Specify a start date and an end date. 

6. Under Affected Changes, specify whether you want all routable objects in your Inbox to be 
transferred, or only routable objects that arrive in your Inbox within the date range you 
specified. 

7. Click OK to complete the transfer. 

The new transfer authority definition appears in the Transfer Authority dialog box. 

8. Click Close. 

To transfer signoff authority for yourself or others in Web Client: 

1. Click Tools > My Settings > Transfer Authority. The Transfer Authority page appears. 

2. Click the Create button. The Create Transfer Authority page appears. 

3. Select yourself or another user to transfer authority from, then select the user who is receiving 
signoff authority. 

Note Users who are receiving the authority must have the appropriate privileges to sign 
off the routable objects transferred to them. If you have questions about privileges, 
see your Agile administrator. 

4. In the Criteria list, click to select the type of information to transfer. 

Note The list of criteria is quite extensive. If you have questions about which criteria would 
best suit your needs, contact your Agile administrator, who manages all global 
criteria. Alternatively, consider defining a personal criteria that you can then use for 
transferring authority—click Tools > My Settings > Personal Criteria. See Defining 

Personal Criteria for Authority Transfers on page 237 for information about creating 
personal criteria. 

5. Specify a start date and an end date. 

6. In the Affected Changes list, specify whether you want all routable objects in your Inbox to be 
transferred, or only routable objects that arrive in your Inbox within the date range you 
specified. 

7. Click Finish to complete the transfer. 
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Routable Objects Affected During the Transfer Period 

If the Transfer Authority Affected Changes property is set to All Changes During Time Period, the 
following conditions define the routable objects are transferred: 

 The routable object meets the criteria defined in the transfer authority.  

 The routable object enters a workflow status that has a list of approvers (a Review-type 
status or a Released-type status) during the time period defined in the Transfer Authority. 

 The From user is an approver for that workflow status. 

 If the Transfer Authority Affected Changes property is set to All Changes, the following conditions 
define the routable objects are transferred: 

 The conditions listed above for All Changes During Time Period. 

 In addition, all criteria-defined routable objects that were awaiting signoff by the From user 
at the time the Transfer Authority was created (in a Review-type status or a Released-type 
status).  

 Routable objects that are created during the Transfer Authority time period that do not also 
enter a Review-type or Released-type status during the time period are not transferred to the 
To user. 

The Start and End dates are time specific. If you enter today's date as the start date, and the time 
component of the date is in the past, Agile PLM creates the Transfer Authority with the current date 
and time. 

Modifying Signoff Authority Transfers 

With the appropriate privileges, you can modify or delete signoff authority transfers at any time. For 
each authority transfer, you can modify the person who receives signoff authority, the start and end 
dates, and whether or not to transfer routable objects already in the Transfer To user’s Inbox. 

You can also modify and reuse any expired authority transfer at a future date. 

Your Transfer Authority privileges determine which authority transfers you can modify: 

 If you have privileges to create only your own authority transfers, you can modify only your own 
authority transfers. 

 If you have privileges to create authority transfers for other users, you can modify any authority 
transfers created by any user. 

To modify signoff authority in Java Client: 

1. Choose Settings > Transfer Authority in the main menu bar. The Transfer Authority dialog box 
appears, which lists the transfer authority definitions you have the ability to modify or delete. 

2. Click to select the transfer authority definition you want to change, then click the Modify button. 
The Modify Transfer Authority dialog box appears. 

3. Change the settings as needed. 

Note Users who are receiving the authority must have the appropriate privileges to sign 
off the routable objects transferred to them. If you have questions about privileges, 
see your Agile administrator. 
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4. Click OK to complete the transfer. 

The modified transfer authority definition appears in the Transfer Authority dialog box. 

5. Click Close. 

To modify signoff authority in Web Client: 

1. Click Tools > My Settings > Transfer Authority. The Transfer Authority page appears. 

2. Select the rows you want to modify, then click the Edit button. 

3. Change the settings as needed. 

Note Users who are receiving the authority must have the appropriate privileges to sign 
off the routable objects transferred to them. If you have questions about privileges, 
see your Agile administrator. 

4. Click Save. 
 

Deleting Signoff Authority Transfers 

To delete one or more transfers of signoff authority in Java Client: 

1. Choose Settings > Transfer Authority in the main menu bar. The Transfer Authority dialog box 
appears, which lists the transfer authority definitions you have the ability to modify or delete. 

2. Click to select the transfer authority definition you want to change, then click the Delete button. 

3. When prompted, click Yes. 

4. Click Close to close the Transfer Authority dialog box. 

To delete one or more transfers of signoff authority in Web Client: 

1. Click Tools > My Settings > Transfer Authority. The Transfer Authority page appears. 

2. Select the rows you want to delete, then click the Delete button. 
 

Defining Personal Criteria for Authority Transfers 

A criteria is similar to an advanced search. The attributes used to create criteria are similar to the 
fields used to create advanced searches. Criteria can also be thought of as ―filters‖ or ―qualifying 
descriptions‖ of, in the case of escalations or authority transfers, the changes that will be escalated 
or transferred. 

For example, you could create a personal criteria for all ECOs that affect a specified product line. 

To create a personal criteria in Java Client: 

1. Choose Settings > Transfer Authority in the main menu bar. The Transfer Authority dialog box 
appears, which lists the transfer authority definitions you have the ability to modify or delete. 

2. Either click the New button or select a row and click the Modify button. The New or Modify 
Transfer Authority dialog box appears. 

3. In the Criteria pane, click the New button to display the New Personal Criteria dialog box. 

4. Enter a name for the criteria. 
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Note The personal criteria that you create appear in the Transfer Authority criteria list 
preceded by your name, making them easier to locate. For example, if Bob Jones 
enters ―All Leo Projects,‖ the criteria appears in the Transfer Authority criteria list as 
―Bob Jones.All Leo Projects.‖ 

5. Enter a description for the criteria. 

Using the sample name above, the description might be ―All changes in the Leo product line.‖ 

6. You define criteria in the New Personal Criteria dialog box the same way that you define search 
conditions in the Advanced Search wizard. Fill in the fields. For more information about 
searching, see Finding Agile Data with Searches on page 143. 

7. Click OK. 

The new criteria appears in the Criteria pane in the Transfer Authority dialog box. You can now 
select this criteria when defining or modifying a transfer authority. 

To create a personal criteria in Web Client: 

1. Click Tools > My Settings > Personal Criteria. 

2. Click the Create button. 

3. Enter a name for the criteria. The Create Personal Criteria window appears. 

Note The personal criteria that you create appears in the Transfer Authority criteria list 
preceded by your name, making it easier to locate. For example, if Bob Jones enters 
―All Leo Projects,‖ the criteria appears in the transfer authority Criteria list as ―Bob 
Jones.All Leo Projects.‖ 

4. Enter a description for the criteria. 

Using the sample name above, the description might be ―All changes in the Leo product line.‖ 

5. You define criteria in the Create Personal Criteria wizard the same way that you define search 
conditions in the Advanced Search wizard. Fill in the fields. For more information about 
searching, see Finding Agile Data with Searches on page 143. 

6. Click Finish. 

The new criteria appears in the Criteria drop-down list. You can now select this criteria when 
defining a transfer authority (Tools > My Settings > Transfer Authority). 

Returning a Routable Object to the Originator 

You return a routable object to the originator by switching the status to the Pending status type. 
Before you can switch a routable object back to the Pending status type, you need the appropriate 
privileges. Usually, the change analyst and component engineer have these privileges. If you need 
them and do not have them, see your Agile administrator. 

When a change analyst or component engineer switches a routable object from a workflow status 
(not from the Unassigned status) to the Pending status type (the first status in the workflow status 
list), the originator is notified. The originator is now able to edit the routable object, including editing 
items on the Affected Items tab and selecting a different workflow. 

When the originator completes edits to the returned routable object and then switches it to the next 
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status in the workflow status list, the routable object moves through the workflow status list and 
enters the Review status type or Released status type cycle a second time. For details about what 
happens when the routable object enters the Review status type or Released status type cycle 
again, see Demoting a Routable Object on page 221. 

To return a routable object to the originator in Java Client: 

1. Open the routable object. 

2. On the Workflow tab, click Pending (or a status of type Pending) in the chart on the Workflow tab. 

See Switching a Routable Object from One Status to Another Status on page 216. 

When the Change Status dialog box appears, complete the Notify field and add comments. 

3. Click OK. 

The status of the routable object switches to the Pending status type. 

Note Approvals and rejections from previous routing cycles appear on the Workflow tab, 
but they are not active. Only approvals and rejections for the latest routing cycle on 
the Workflow tab are allowed. The History tab also shows the actions of the earlier 
routing cycles. 

You cannot return a routable object to an originator who does not have Discovery and Read 
privileges for that object. (See the Agile PLM Administrator Guide for details.) 

To return a routable object to the originator in Web Client: 

1. Open the routable object. 

2. On the Workflow tab, click Pending (or a status of type Pending) in the chart on the Workflow tab. 

When the Change Status page appears, complete the Notify field and add comments. 

3. Click OK. 

The status of the routable object switches to the Pending status type. 

Note Approvals and rejections from previous routing cycles appear on the Workflow tab, 
but they are not active. Only approvals and rejections for the latest routing cycle on 
the Workflow tab are allowed. The History tab also shows the actions of the earlier 
routing cycles. 

You cannot return a routable object to an originator who does not have Discovery and Read 
privileges for that object. (See the Agile PLM Administrator Guide for details.) 

Canceling a Routable Object 

You can use the Workflow tab to cancel a routable object by switching the status to the Cancel 
status type if both of the following are true: 

 The Cancel status type has been defined in the workflow as one of the valid next statuses. 

 You have the appropriate privileges. (See your Agile administrator if you have questions about 
your privileges.) 

For example, you create an ECO to modify an assembly and route it through workflow, but later 
decided not to modify it. So you can cancel the routable object itself. The reasons the ECO is 



 

 

240 Agile Product Lifecycle Management 

  

canceled would be recorded in the comments of the canceled ECO. But still you can keep the 
canceled ECO in Agile database. 

Note If you cancel a released routable object, the revision is removed from the item revision 
list of the affected items. A routable object with affected items that has been canceled 
cannot be uncanceled (moved to a different status in the workflow). The canceled 
routable object appears on the Change History table of the item’s Changes tab. If there 
are redline edits associated with the routable object, redlines are dropped (discarded) 
and you cannot access the redline table of a canceled routable object. This differs from a 
routable object on hold; see Putting a Routable Object on Hold on page 241. 

Canceling a routable object is not the same as deleting it. A routable object can be canceled due to 
a fundamental flaw or rejection by several approvers, but it remains in the database. See also 
Deleting Routable Objects on page 249. 

When a routable object is canceled, it no longer has the current status, and the remaining statuses 
on the status list are skipped. All the remaining statuses on the status list show the name of the 
person who moved the routable object to Canceled under the Status Changed By column on the 
Workflow tab. 

To cancel a routable object in Java Client: 

1. Open the routable object. 

2. On the Workflow tab, click Cancel in the chart. 

When the Change Status dialog box appears, complete the Notify field, and add comments. 

1. Click OK. 

The status of the routable object switches to the Cancel status type. 

To cancel a routable object in Web Client: 

1. Open the routable object. 

2. On the Workflow tab, click Cancel in the chart. 

When the Change Status page appears, complete the Notify field, and add comments. 

3. Click OK. 

The status of the routable object switches to the Cancel status type. 

Uncanceling a Routable Object 

You uncancel a routable object by using the Workflow tab to switch the status. You can switch to any 
status provided that: 

 The status has been defined in the workflow as one of the valid next statuses. 

 You have the appropriate privileges. (See your Agile administrator if you have questions about 
your privileges.) 

 There are no items on the Affected Items tab of the routable object. 
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Note If you cancel a released routable object, the revision is removed from the item revision 
list of the affected items. A routable object with affected items that has been canceled 
cannot be uncanceled (moved to a different status in the workflow). This differs from a 
routable object on hold; see also Putting a Routable Object on Hold on page 241. 

To uncancel a routable object in Java Client: 

1. Open the routable object. 

2. On the Workflow tab, select a status in the chart. 

When the Change Status dialog box appears, complete the Notify field, add approvers and 
observers if appropriate, and add comments. 

3. Click OK. 

The status of the routable object switches to the selected status. 

To uncancel a routable object status change in Web Client: 

1. Open the routable object. 

2. On the Workflow tab, select a status in the chart. 

When the Change Status page appears, complete the Notify field, add approvers and observers 
if appropriate, and add comments. 

3. Click OK. 

The status of the routable object switches to the selected status. 

Putting a Routable Object on Hold 

The process of switching a routable object to the Hold status type is similar to the process of 
canceling an object. See Canceling a Routable Object on page 239 for detailed instructions. 

When you put a routable object on hold, select the Hold status type instead of the Cancel status 
type. 

For information about taking a routable object off hold, follow the directions described in 
Uncanceling a Routable Object on page 240. 

Note A routable object with affected items that has been put on hold can be switched from a 
Hold status type to another status in the workflow. If you put a released routable object 
on hold, the revision remains on the item revision list of the affected items. This is a 
substantial difference between Cancel and Hold. 

The routable object on hold appears in the Pending Changes table on the item’s Changes tab. 

Releasing Routable Objects 

You can release routable objects by using the Next Status button on the Workflow tab. See Switching 

a Routable Object from One Status to Another Status on page 216. 

If the AutoPromote property of the preceding Review status type is set to Yes, the routable object is 
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automatically released when all required fields are filled in and all approvers have approved the 
change. 

Before a routable object can be released, the system checks for the following: 

 The Category field and all other required fields are filled in. (Your Agile administrator 
determines which fields are required in the workflow property settings.) 

 The routable object passes the release audit. 

In addition, when a routable object releases an item, the system checks to see which sites the item 
is being released for, as indicated on the Affected Items tab of the routable object. The system then 
checks the following: 

 The value in the Make/Buy field on the items’ Sites tabs, to determine if any of the sites are 
specified as Buy. A warning is displayed when an AML is required for a Buy item. 

 The Site-Specific AML field of the sites, to determine if any of the sites are required or allowed to 
have a site-specific AML. 

You can use the Audit Release button (Java Client) or the Audit Release command on the Actions menu 
(Web Client) to verify that the routable object passes the release audit and that all required fields 
have been completed. For details, including the conditions a release audit checks, see Auditing 

Routable Objects on page 218. 

Note If you do not have Discovery and Read privileges for an item on the Affected Items tab of 
the routable object, you cannot release that routable object. 

To release a routable object in Java Client: 

1. Open the routable object. 

2. If you want, audit the routable object (click the Audit Release button, or right-click and choose 
Audit Release). 

3. On the Workflow tab, select the Released status type from the workflow status chart. 

Or click the Next Status button . 

4. Complete the Notify field, and enter any comments in the Comments field. 

Complete the Approvers and Observers fields if you want an additional signoff cycle after the 
routable object has been released. Otherwise, leave these fields blank. 

See Completing the Status Change on page 222. 

5. Click Release. 

To release a routable object in Web Client: 

1. Open the routable object. 

2. If you want, audit the routable object (choose Actions > Audit Release). 

3. On the Workflow tab, select the Released status type from the workflow status chart. 

4. Complete the Notify field and enter any comments in the Comments field. 

Complete the Approvers and Observers fields if you want an additional signoff cycle after the 
routable object has been released. Otherwise, leave these fields blank. 
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See Completing the Status Change on page 222. 

5. Click OK. 

If not all the required fields have been completed, you are prompted to complete them. 
Otherwise, the status of the routable object switches to Released. 

For information about multiple Released status types, see Multiple Released Status Types on page 
244. 

Unreleasing Routable Objects 

You can use the Workflow tab to unrelease a routable object by switching the routable object from a 
Released or Complete status type to a Pending, Submit, Review, Cancel, or Hold status type. 

Routable objects can be interrelated in complex ways, for example, by their release order or by 
being listed on the Relationships tab one or more additional routable objects. Unreleasing any 
routable object can have unforeseen consequences. 

Caution Unreleasing a routable object is not a recommended practice. Use extreme caution when 
unreleasing routable objects if you are using Agile Content Service (ACS) or 
ChangeCAST. After you have released a routable object and it’s been passed to your 
ERP system, unreleasing the routable object has no effect on the information in the 
ERP system. ACS and ChangeCAST do not pass the updated information about 
unreleasing a routable object to the ERP system, and any audit trails, records of tasks, 
or dependencies between objects are not restored. 

You can unrelease a routable object, provided that: 

 The workflow assigned to the routable object has been configured by the Agile administrator to 
allow you to switch a Released or Complete routable object to another status type. (The default 
workflows do not allow this procedure.) 

 You have the appropriate privileges. 

 No other changes have been made and released against the same items. 

For example, when you are working with items and changes, if other changes have been created 
and released against the same items, you must first unrelease those later changes. Unrelease 
those changes in the reverse order in which they were created. 

If you do not have Discovery and Read privileges for an item on the Affected Items tab of the routable 
object, you cannot unrelease that routable object. 

To unrelease a routable object in Java Client: 

1. Open the routable object. 

2. On the Workflow tab, select a status from the chart. Do not select a Released or Complete 
status type. 

Note Selecting the Pending status type allows you to edit the unreleased routable object, 
including selecting a different workflow. 

3. Complete the Notify field, and enter any comments in the Comments field. If appropriate, add 
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approvers and observers. 

See Completing the Status Change on page 222. 

4. Click OK. 

To unrelease a routable object in Web Client: 

1. Open the routable object. 

2. On the Workflow tab, select a status from the chart. Do not select a Released or Complete 
status type. 

Note Selecting the Pending status type allows you to edit the unreleased routable object, 
including selecting a different workflow. 

3. Complete the Notify field, and enter any comments in the Comments field. If appropriate, add 
approvers and observers. 

4. Click OK. 
 

Multiple Released Status Types 

A workflow can have multiple Released status types. When the routable object enters the first 
Released status type, all the release checks are performed (described in Auditing Routable Objects 
on page 218), and any BOM or manufacturer data redlines data goes into effect in the affected 
items. The routable object is now released. 

For subsequent Released status types, no additional checks or release actions are performed; the 
routable object remains released. However, the released routable object may be routed for 
additional approval cycles. This allows for individual approval cycles after release but before the 
routable object moves to the Complete status type. The routable object remains released as long as 
it moves from a Released status type to either another Released status type or to a Complete 
status type. 

Note Moving a routable object from a Released status type to a Pending, Submit, Review, 
Hold, or Cancel status type unreleases the routable object. 

 

Use Case of First Released Status 

This use case explains how the system refers to multiple Released statuses. The ―first Released 
status‖ does release the workflow. The other Released statuses provide for additional review 
signoffs; they can also have Entry Required fields. 

Let there be a workflow with multiple Released statuses – call them R1, R2, and R3 – and there are 
Entry Required fields set for each Release status. Also, a ―non-first Released status‖ – in this case, 
R2 or R3 – has been permitted to be a Valid Manual Next Status from one of the pre-Released 
statuses (that is, you can skip the first Released status, the one that actually releases the workflow). 
Then, when you select that workflow and it moves from Pending status to R3 status, the system 
checks the Entry Required fields of the first Released status, R1. 

It works this way because the workflow should not be released without checking the first Released 
status’s Entry Required fields, because that’s where objects are changed in the database because 
of the released Change. For example, when an item’s lifecycle is changed, its revision (rev) should 
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be incremented, and even if you are attempting to leapfrog over R1, R1’s requirements are still 
important; if R1’s Entry Required fields were ignored, you could end up with an improperly released 
item. 

Adding Comments to the History Tab 

If you have the appropriate privilege and the routable object has a Comment button, you can add a 
comment to the routable object's History tab and send that comment to the users you select. 

To add a History tab comment in either Java Client or Web Client: 

1. Open the routable object and click its Comment button. 

2. In the displayed dialog or wizard, enter your comments in the Comment field. 

3. Use the checkboxes to select default users to notify, such as the change analyst or the list of 
reviewers. Each type of routable object includes a selection of default users appropriate for that 
type of object. 

4. Use the Notify field to specify additional users to notify. 

5. When you are finished, click Comment. 
 

Sending Comments to all Previous and Current CCB Members 

When sending comments (by using the Comment button) from a Review or Released type status in a 
change, you can specify whether the comments are to be sent to only the current review or 
released status reviewers – that is, for the workflow’s current status – or if comments are to be sent 
to all reviewers in both current and previous Review and Released statuses. In the Comment dialog 
(Java Client) and the Comment wizard (Web Client), a drop-down box (after the ―Notify Reviewers 
for‖ checkbox) contains Current Status and Current and Previous Statuses for selection. 

Changing a Routable Object’s Subclass 

Your Agile administrator can create new subclasses of routable objects. If you have the appropriate 
privileges, and the routable object is still in the Pending status type, you can change the subclass of 
a routable object to another subclass in the same class. For example, if your administrator has 
created the ECN (engineering change notice) subclass, you can change the subclass of a routable 
object in the Change Orders class from ECO to ECN. 

Note When you change the subclass of a routable object, some of its data fields may change, 
and all previous information about the Page Three section is cleared. 

To change the subclass of a routable object in Java Client: 

1. On the Cover Page tab of the routable object, select a new subclass from the Object Type drop-
down list. For example, for Change Type, you can select ECO or ECN. 

 If the Page Three tab is visible, a warning message appears, alerting you that all Page Three 
data is cleared. 

 Click Yes to continue changing the subclass and to allow Page Three data to be cleared. 

 Click No to cancel the change subclass process. No changes are made to the object. 

2. If the new subclass has an autonumbering scheme assigned by your Agile administrator, Agile 
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asks if you want to continue using the same object number. 

 Click Yes to change the subclass but retain the existing number. 

 Click No to change the subclass and assign a new autonumber. If more than one 
autonumbering scheme applies, you are prompted to select the autonumbering scheme 
you want. 

If the new subclass does not have an autonumbering scheme assigned by your Agile 
administrator, the process is completed with the subclass being changed but the number not 
being changed. 

Note When you click the AutoNumber button , the number changes automatically. The 
autonumbering scheme assigned to the subclass you selected is used, or you are 
prompted to select one (if multiple schemes have been designated). 

3. Agile PLM automatically numbers the routable object and displays the new number in the 
Number field, and the event is entered on the History tab of the routable object. 

To change the subclass of a routable object in Web Client: 

1. On the Cover Page tab of the change, click Edit, and select a new subclass from the Object Type 
drop-down list. For example, for Change Type, you can select ECO or ECN (engineering change 
notice). 

2. If the Page Three section (on the Cover Page tab) is visible and has data, a warning message 
appears, alerting you that all Page Three data is cleared. 

 Click OK to continue changing the subclass and to allow Page Three data to be cleared. 

 Click Cancel to cancel the change subclass process. No changes are made to the object. 

3. If the new subclass has an autonumbering scheme assigned by your Agile administrator, Agile 
Web Client asks if you want to select a new autonumber for the new subclass (unless 
autonumbering is required by your system, in which case you see a different warning 
message). 

 Click OK to continue the process of changing the number. 

 Click Cancel to change the subclass and use the AutoNumber button to change the number. 

If the new subclass does not have an autonumbering scheme assigned by your Agile 
administrator, the process is completed with the subclass being changed but the number not 
being changed. 

If autonumbering is required in your system, and more than one autonumber source is 
designated for the new subclass, a different warning is displayed. 

 Click Yes to select a different autonumber source. 

 Click No to use the same autonumber source. 

Note When you click the AutoNumber button , the number changes automatically. The 
autonumber scheme assigned to the subclass you selected is used, or you are 
prompted to select one (if multiple schemes have been designated). 

4. Agile PLM automatically numbers the change and displays the new number in the Number field, 
and the event is entered on the History tab of the routable object. 
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After a Routable Object is Released 

Releasing a routable object affects the appearance and behavior of the routable object’s tabs, as 
well as the BOM of any items affected by the routable object that were included on the affected 
items list of that routable object. 

On the Cover Page tab of the routable object: 

 The stamp reflects the new status. 

 The Status field reads Released. 

On the Affected Items tab, the Add and Remove buttons (Java Client) or the Add and Delete buttons 
(Web Client) are disabled. 

Note If the workflow has more than one Released status type, the appearance and behavior of 
the routable object are altered only when the routable object enters the first Released 
status type. For more information, see Multiple Released Status Types on page 244. 

 

Switching Routable Objects to Their Final Status 

A routable object’s workflow defines its final status. If the workflow has a status of type Complete, it 
is always the last status in the status list, before any Hold or Cancel status types. 

Note Depending on the assigned workflow, a routable object may not have a Complete status 
type. A Complete status type is not required in a workflow. 

To examine the status lists of the workflows in use at your company, in Java Client, click the View 

Workflows button  in the toolbar. In Web Client, choose Actions > View Workflows. 

If the Released status type is set to autopromote and it immediately precedes the Complete status 
type, the routable object automatically switches to the Complete status type when all the required 
fields for the Released status type are filled in and any approvers have approved the routable 
object. 

You must have the appropriate privileges to switch a routable object to its Complete status type. 
See your Agile administrator if you have questions about your privileges. 

After a routable object has been switched to its final status, you cannot delete it unless you 
unrelease it first. See Deleting Routable Objects on page 249. 

To switch a routable object to its final status in Java Client: 

1. Open the routable object. 

2. If you want, audit the routable object. 

3. Select the Complete status type by using either the Next Status button or the Workflow tab. 

The Change Status dialog box appears. 
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4. Complete the Notify field. 

5. Enter any comments in the Comments field. 

6. Click OK. 

The routable object is switched to its final status. 

To switch a routable object to its final status in Web Client: 

1. Open the routable object. 

2. If you want, audit the routable object. 

3. Select the Complete status type by using either the Next Status button or the Workflow tab. 

The Change Status to Complete status type name page appears. 

4. Complete the Notify field. 

5. Enter any comments in the Comments field. 

6. Click OK. 

The routable object is switched to its final status. 

Redlining through ECOs, MCOs, PCOs and SCOs 

Redlining highlights, in red, changes made to an object. Only ECOs, MCOs, PCOs, and SCOs have 
redlining functions. Use these changes when you need to modify a released item. For information 
about the functions of these types of changes, see the Product Collaboration User Guide. 

Depending on your company policy, when you redline manufacturing data, use an ECO when you 
want to advance the revision of an item, or use an MCO when you do not want to advance the 
revision of an item. 

For information about redlining a BOM, AML, and attachments, see Concepts and Terms in Agile 

PLM Solutions on page 65. 

Redlining through ECOs 

You can redline BOM and AML data and attachments using an ECO. 

ECO changes let you release new items and modify previously released items. When you create an 
ECO, a preliminary revision is created for any items modified by the change (the ones listed on the 
Affected Items tab). When the ECO is released, the preliminary revision is converted to a released 
revision for each modified item. 

Redlining through MCOs 

You can redline AML data using an MCO. 

MCOs are similar in appearance and function to an ECO. However, MCOs do not change the 
revision of an item, unlike an ECO. Instead, the MCO number is displayed alongside the 
corresponding revision number in the Rev drop-down list. For example, if there is a pending MCO 
#M12345 against Rev B of an item, then, on the Rev drop-down list, that revision is listed as (B) 
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M12345. 

Redlining Prices through PCOs 

You can redline prices using a PCO. Using the redlining feature, you can publish the price to your 
customers. For example, if you have renegotiated the price of a particular item with your supplier 
and you want to publish the new price, you can redline the price and route it through a PCO. 

To redline the price through a PCO: 

1. Open the PCO that contains the prices you want to redline. 

2. Click the Affected Prices tab. Click the Do Redlining icon. The Price List Redline appears. 

3. Click the Add button to add one or more prices. The Add Affected Prices Wizard appears. 

4. Search for the prices you want to redline, or create a new price. 

5. Enter the required information, and click Finish. The following fields are required: 

 Ship To 

 Price Effective From Date 

6. The price is added to the Price List Redline tab. The added price is displayed in red. 

7. Click the Back to PCOnumber button. The PCO page appears, with the Has been redlined icon in 
the rows for the prices you have redlined. 

 

Redlining through SCOs 

You can redline site-specific BOM and AML data using an SCO. 

SCOs are similar in appearance and function to ECOs. However, SCOs do not change the revision 
of an item, unlike ECOs. Instead, the SCO number is displayed next to the corresponding revision 
number in the Rev drop-down list. For example, if there is a pending SCO S12345 against revision B 
of an item, then, on the Rev drop-down list, that revision is listed as (B) S12345. 

Deleting Routable Objects 

Agile Java Client and Web Client support ―soft‖ and ―hard‖ deletes. For general information about 
soft and hard deletes, see Working with Business Objects on page 85. 

Note You can undelete a soft-deleted object. You cannot undelete a hard-deleted object. 

You can delete routable objects that meet the following criteria: 

 You are the change analyst or component engineer, and your Agile administrator has given 
change analysts or component engineers the appropriate privileges to delete a routable object. 

 The routable object is at the Pending status type or the Unassigned status. 

If you do not have Discovery and Read privileges for any items on the Affected Items table, you 
cannot delete the routable object. 
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To delete a routable object that has already been released, you must first unrelease the routable 
object. You need the appropriate privileges to unrelease a routable object using the Workflow tab to 
switch it to a different status. See Unreleasing Routable Objects on page 243. 

To soft-delete an unreleased routable object in Java Client: 

1. Open the routable object that you want to delete. 

2. Click the Delete button , and respond Yes to the confirmation prompt. 

The routable object is soft-deleted. It is no longer available for use. However, until it is hard-
deleted, its number is reserved and cannot be reused. 

To soft-delete an unreleased routable object in Web Client: 

1. Open the routable object that you want to delete. 

2. Choose Actions > Delete, and respond OK to the confirmation prompt. 

The routable object is soft-deleted. It is no longer available for use. However, until it is hard-
deleted, its number is reserved and cannot be reused. 

If you think you might want to undelete a soft-deleted routable object in the future, be sure to clear 
its Affected Items tab before you delete it. You can undelete only routable object with no entries on 
the Affected Items tab. If you want to keep the record of affected items but still want to delete the 
routable object, use the Save As command to copy it under another routable object number before 
deleting it. 

To hard-delete a soft-deleted routable object (if you have the appropriate privileges) in Java Client: 

1. From the Recycle Bin Searches folder, run the Deleted Objects search to locate the soft-deleted 
routable object you want to hard-delete. 

2. Open the routable object. 

3. Click the Delete button , and respond Yes to the confirmation prompt. 

To hard-delete a soft-deleted routable object (if you have the appropriate privileges) in Web Client: 

1. From the Recycle Bin Searches folder, run the Deleted Objects search to locate the soft-deleted 
routable object you want to hard-delete. 

2. Open the routable object. 

3. Choose Actions > Delete, and respond OK to the confirmation prompt. 
 

Undeleting Routable Objects 

Since soft-deleted routable objects still exist in the database, you can undelete them if you have the 
necessary privileges, and if the routable objects has no items on the Affected Items tab. 

To undelete a routable object in Java Client: 

1. Find the soft-deleted routable object by running the Deleted Objects search in the Recycle Bin 
Searches folder. 

2. Open the deleted routable object you want to restore. 

3. To undelete the routable object, choose the Undelete button. 
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To undelete a routable object in Web Client: 

1. Find the soft-deleted routable object by running the Deleted Objects search in the Recycle Bin 
Searches folder. 

2. Open the deleted routable object you want to restore. 

3. To undelete the routable object, choose Actions > Undelete. 
 

Printing Routable Object’s Data 

You can print routable objects and other data. With the routable object open, click the Print button 

 (Java Client), or choose Actions > Print (Web Client). You can print the current tab or all tabs. 

Attachments are printed from their native applications or from the AutoVue for Agile viewer. 
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Chapter 9 

Working with Attachments 

This chapter includes the following: 

 What are Attachments? ....................................................................................................................................... 253 
 Working with the Attachments Tab of Business Objects ..................................................................................... 257 
 Basic Procedures on the Attachments Tab ......................................................................................................... 265 
 Adding and Removing Files via the Attachments Tab ......................................................................................... 271 
 Revising Attachment Files ................................................................................................................................... 279 
 About Item Revisions and File Folder Versions ................................................................................................... 283 
 Viewing and Redlining Attachment Files in the AutoVue for Agile Viewer ........................................................... 288 
 Generating Attachment Quick Access URLs ....................................................................................................... 291 
 Scan Utility ........................................................................................................................................................... 296 

 
 

What are Attachments? 

Attachments to Agile business objects contain pertinent information about the object in addition to 
the information recorded on the object tabs. Examples of attachment files are: 

 Drawing files such as CAD drawings or scanned image files in viewable formats 

 Web-based information in the form of URLs 

 Specifications and other documents 

 Non-viewable files, compressed files, and so on 

Use the business object’s Attachments tab to manage and access attachments. Attachments tab 
actions allow you to add, remove, open, view (in the AutoVue for Agile viewer), or get a copy of an 
attachment file. You can also check out and check in an attachment file in order to modify or update 
it. For more information about Attachments tab actions, see Working with the Attachments Tab of 

Business Objects on page 257. 

Attachment file storage and retrieval is managed automatically by your Agile PLM system. 
Attachment files are stored in the Agile File Vault and each attachment file in the vault is associated 
with a numbered Agile file folder object. The concept is similar to the way in which you would file 
and store paper documents: sort the documents into file folders, label or number the file folders, and 
store them in a filing cabinet. 

Attachment Files and Agile File Folders: an Analogy to Papers, Desks, 

and Vaults 

Using numbered file folder objects and a locked Agile File Vault to store attachment files is similar in 
concept to the way you might manage paper documents that you must work with every day. The 
scenario that follows describes a typical office system, which will make the rules that govern Agile 
attachment files and file folders easier to follow. 
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Bob is an engineering manager, and managers at his company have to coordinate the designs of 
their products. Bob has a file cabinet, but he is afraid of losing track of his drawings so he keeps 
stacks of paper drawings on his desk and they never get filed. The drawings are associated with 
various projects that Bob manages. When Carl wants to see a particular drawing, he must ask Bob, 
and Bob searches through the piles on his desk. Bob often has several versions of a drawing, and it 
is difficult for him to locate the specific version that Carl remembers seeing. Of course, this sorting 
process is time-consuming and inefficient. 

Bob decides to get organized, so he sorts the drawings and puts them into manila file folders, and 
he even puts a label on each folder with an identifying name or number. Bob puts all the versions of 
the same drawing in one file folder, newest version in front, oldest version in back. He then files the 
manila folders into his filing cabinet. He can lock the cabinet in order to keep the drawings secure. 
Now when Carl asks for a drawing by project name, folder number, and version—for example, the 
Acme project—Bob locates the Acme drawing that Carl needs. 

However, six months later, Bob’s archive of drawings has continued to grow. His naming of folders 
is somewhat inconsistent, and occasionally he cannot find what he wants. He spends too much time 
fielding requests from his staff, and he hands out various versions of drawings but then forgets who 
has what. When changes are made to a product, there is no control over what version of drawing 
plan should be used. Bob needs someone to help him manage the drawings, and other engineers in 
the company have the same problem. 

Doris is tasked to create and manage the company’s document control vault. Bob and his 
colleagues give all their drawings and file folders to Doris, who files them in a locked vault. Doris 
uses a document system that ensures she will always locate the correct file folder and correct 
version of a drawing. Now when Carl needs a drawing, he requests it from Doris, she locates it in 
the vault and makes a copy of it. She gives the copy to Carl, but the original drawing stays locked in 
the vault. Doris also marks the file folder as Checked Out. When a file folder is checked out, Doris 
does not allow any other person to update the drawings in that file folder. 

When Carl brings Doris the updated drawing, she puts it in the file folder, records the new version 
number on the file folder and marks the file folder as Checked In. Now when Bob asks Doris for the 
Acme folder, he can see the progress of work done on the product by Carl and the other engineers. 

If Bob happens to know the file folder number of the Acme drawing he wants to update, he can ask 
Doris to check out that file folder by its number. But he does not have to know the file folder number 
because Doris keeps track of the relationships between each project, the names and version 
numbers of the drawings for that project, and the file folder numbers where the drawings are stored. 

Agile Document Management: Even More Efficient than Doris 

The scenario above illustrates some problems that companies have as designs, data, and 
information accumulate on projects, as well as solutions that have been developed to manage and 
control the information. Agile PLM manages and controls the product record in electronic form, and 
Agile users have to become familiar with an arena in which design drawings or data are attachment 
files, manila folders are file folder objects, and the venerable file cabinet is accessed through the 
Attachments tab of any Agile business object, or from the Files tab of a file folder object. There is 
nobody named Doris controlling the file vault in Agile PLM, but you should recognize the same kind 
of business rules that have been incorporated into Agile’s system of file security and management. 

Files and URLs that are attached to—associated with—parts or other business objects have always 
been called attachments in Agile. A file folder is simply a numbered container or ―wrapper‖ for 
attachment content. By referencing the same file folder number and version on their Attachments 
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tabs, multiple business objects can use the same file attachment (for example, a single datasheet 
attached to multiple manufacturer parts). This ensures that the attachment content is always in sync 
with the business objects. Re-use of attachment files prevents the proliferation of multiple copies of 
the same file in the file vault. 

The diagram below illustrates the relationships between business object Attachments tabs, file 
folders, and the file vault. Note that one file in a file folder can be attached to one business object, 
and another file in the same file folder can be attached to another business object. 

Attachments to business objects are managed through the Attachments tab; use the Attachments tab 
features to add, remove, get, view, and update attachments. In addition, if your company’s business 
processes require it, file folders can be managed and updated independently of other objects in the 
database. All attachment files are stored in the file vault, part of Agile File Manager (AFM). For more 
information about file folders, see Working with File Folders on page 301. 

It is generally a best practice to limit each file folder to a single, attachable file or URL; however, file 
folders can contain any number of files and URLs. For example, a file folder might contain the same 
file under different formats, such as a CAD drawing that is saved in its native CAD format as well as 
in PDF format. Also, items or other Agile objects can have any number of file folders attached. In 
this way, every file, drawing, or URL that contributes to describing any part, product, or process at 
the enterprise can be referenced by multiple objects in Agile PLM. 
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The following diagram illustrates the relationship between business objects with file folders 
attached, file folder objects, and attachment file content. Once files are added to a file folder, other 
Agile objects can have any combination of those files attached by referencing the file folder. The 
following diagram illustrates a few cases. 

 

 
 

What are Attachment Versions? 

The version of a file folder is important to understand when you work with attachments. This is a 
brief introduction to versions. For more information about versions (of attachments) as well as 
revisions (of items), see About Item Revisions and File Folder Versions on page 283. 

 On the Attachments tab of business objects, the Folder Version field in each row reports the 
version of the file folder that is attached to the object. The file folder version represents the 
version of the attached file. 

 When you use the Add > Files feature of the Attachments tab to add business object attachment 
files from your local disk or network, Agile automatically creates a new file folder container for 
each of the added files and sets the version of each file folder to 1. 

 Each time you modify the attachment file (by checking out the file, editing the file, and then 
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checking in the file), the file folder version number is incremented by one. 

 A business object can attach (that is, point to) only one version of a file folder; you select this 
version when you add the attachment. 

 By editing the attachment row, you can select a different version of the file you want to attach 
or reference from the Attachments tab. For example, if an attachment has file folder versions 1, 
2, and 3, you can select any one of those versions in the attachment row, or you can select 
LATEST. 

 ―Latest-x‖ represents the dynamic ―latest version of a file folder,‖ where x is the highest 
numbered version up to this point. For example, Latest-x is seen as Latest-3 on the business 
object’s Attachments tab. When you select LATEST as the version number, the attachment row 
always refers to the latest version of the file, no matter how many times it has been updated 
(checked out and checked in). 

 When you point to the latest version (that is, either Latest-x or x), you can check out and check 
in attachment files from the object’s Attachments tab. You can checkout only the most recent 
version of the attachment. In this example, the version number must be either Folder Version 
Latest-3 or Folder Version 3. If the attachment row refers to a non-latest version (in this 
example, 1 or 2), the checkout button is disabled. 

 If you have the appropriate privileges, you can open the file folder object by clicking its number 
on the Attachments tab. For more information about file management activities you can perform 
from the file folder object, see Working with File Folders on page 301. 

If you want to access earlier versions of the attachment files, use the Show Versions feature 
Attachments tab to display and select a previous version of the file, as described below. 

Working with the Attachments Tab of Business Objects 

All business objects in Agile have an Attachments tab. Items—parts or documents—and 
manufacturer parts may reference attachment files more often than the other classes in Agile 
because those classes represent physical entities that often require supportive information; 
however, users will likely encounter objects from classes across Agile PLM solutions that have 
attachments. This section describes operations performed from the Attachments tab of any business 
object. 

For more information about items and manufacturer parts, see the Product Collaboration User 
Guide. 

You can use the Attachments tab to: 

 Get a copy of an attachment file and place it in a location of your choice 

 View an attachment file in the AutoVue for Agile viewer 

 Open an attachment file in its native application 

 Show previous versions of an attachment file 

 Print attached files 

 Add and remove attachments 

 Check file folders out, modify them, and check file folders in 
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Buttons on the Attachments Tab 

You need the appropriate privileges to perform any attachment file operation on the Attachments tab. 
The buttons on the Attachments tab are enabled or disabled, depending on your privileges and 
administrative settings. File Validation (Handle File Checksum) on page 326 addresses some of 
these dependencies. 

The buttons in the following table are available to users with the required privileges. To view a file 
using AutoVue for Agile, double-click its File Name (Java Client) or click its File Name link (Web 
Client). If the file format is included on the list of valid viewer file types in Agile Administrator, the file 
opens in the AutoVue for Agile viewer. Otherwise, the file opens in its native application, provided 
the application is installed on your computer. 

Note You cannot make changes to the Attachments tab of incorporated items. Once an item rev 
is incorporated, its attachments cannot be checked out from the item rev without a 
change. However, you can still check out or check in the associated file folder, and the 
folder version still increments upon checkin. 

Attachment tab buttons, Java Client 

Button  Name  Descript ion  

   Get Files Select the rows you want, then click the Get Files from Selected 
Attachments button to place a copy of the selected files in the folder or 
location of your choice. These copies are in native application formats. 

Or 

Click the button and select Batch Get All Files from this Object to place a 
copy of all the object’s attached files in the folder or location of your choice. 
These copies are in native application formats. 

If you selected a row with multiple files (indicated by a file folder icon in the 
row), the Select Files dialog appears, allowing you to select which files you 
want to get. 

   Open Files Click the Open Files button to open the files in file folders on the 
Attachments tab as a unit. In the case of multi-file file folders, you can 
choose an individual referenced file to open. 

 Show Versions Click the Show Versions button to open a table of all versions of selected 
attachment file. From this dialog you can view, get, open, and print a 
selected version. 
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Button  Name  Descript ion  

   View Files Click the View Files button to view the selected files in the AutoVue for Agile 
viewer. 

Or, click the View Files button’s drop-down arrow and select from the 
menu: 

View – view the files in AutoVue for Agile.  

 Cross Probe – crossprobe between PCB and schematic files in two 
windows.  

 Compare – compares the selected files and presents a comparison 
summary.  

 Overlay  – lets you lay the selected files over each other.  

 Digital Mockup – loads multiple selected models into the same 
workspace, where they can be analyzed together. For example, you can 
check them for proper fit. 

 By Search – find other files in the system, which you may want to 
(select from menu) cross probe, compare, overlay, or digital mockup (see 
above), without having to select two files from the same Attachments tab; 
that is, you could search and select one attached file from Part 234 and 
another attached file from Part 765. 

(For more information about Cross Probe, Compare, Overlay and Digital 
Mockup, see Viewer Supplement.) 

   

 

View Redline For item objects, the View Redline button shows whether a file has been 
redlined by AutoVue for Agile. Click the button to view the file and its 
redlines in the AutoVue for Agile. 

   Print Files Click the Print Files button to print the corresponding attachment file. 
AutoVue for Agile is started in a separate browser window and begins the 
printing process. 

   Edit Click the Edit button to edit the Version, File Description, and Folder 
Description of the selected file that you want to attach, as well as any other 
editable, custom fields that your administrator has defined. 

The Add button is disabled if the item is incorporated 
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Button  Name  Descript ion  

  

 

  

 

  

  

Add Files Click the Add button to open the File Uploader.  

Or, click the Add button’s drop-down arrow and select from the menu: 

 Files – displays the File Uploader dialog, which allows you to drag and 
drop the files you want to attach. You can also click Browse for Files 
button to browse your computer or network for the files you want. To add 
multiple files as a single file folder, click the Add all files to a single file 
folder button. If you select the UnZip all zipped files upon upload 
checkbox, the ZIP file is unzipped and the contents are added as individual 
files. 

Note Selecting the UnZip checkbox is not recommended for very large files. 

 URLs – brings up the Add URLs dialog 

 By Search – brings up the Add Files by Search dialog  

 By Scan – permit direct access to a file you want to scan. See Scan 

Utility on page 296. 

The Add button is disabled if the item is incorporated. 

   Remove Files The Remove Files button removes the selected attachment references 
from the Attachments tab. The file remains linked to the file folder object, 
and is not removed from the Agile File Management Server. 

The Remove Files button is disabled if the item is incorporated. 

   Check Out The Check Out button checks a single attachment file or multiple 
attachment files out of the file vault. From the business object, the checkout 
prompts you to get the file or files. You can download and edit the file. If you 
cancel the procedure, the attachment is checked out, but the file is not 

downloaded. When a folder is checked out, a  appears in front of it on 
the Attachments tab.  

Check Out is disabled when the item is incorporated. 

   Check In Click the Check In button to return file(s) to the file vault. The file folder 
version number is advanced. Previous versions are accessible by using the 
Show Versions feature.  

Check In is disabled when the item is incorporated. 

   
Cancel 
Checkout 

Click the Cancel Checkout button to cancel a checkout. It re-locks the 
selected file folder, so it is available to be checked out again. A user who 
has Cancel Checkout privilege can cancel the checkout. 

Cancel Checkout is disabled when the item is incorporated. 

(no icon) Incorporate or 
Un-incorporated 

The information as to whether the part is Incorporated or Unincorporated is 
automatically filled. 
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Button  Name  Descript ion  

   Has Checksum 
Error 

The Has Checksum Error field is checked if the file has been modified 
directly in the file server vault. For more information, see Checksum File 
Validation. 

 

 

Attachment tab buttons, Web Client 

Button  Name  Descript ion  

   
Edit Click the Edit button to modify the Version, File Description, and Folder 

Description of the selected file that you want to attach, as well as any other 
editable, custom fields that your administrator has defined. 

The Edit button is disabled if the item is incorporated. 

 Action: 

Open file in its 
native application 

Click the File Name link. 

If the file format is included on the list of valid viewer file types in Agile 
Administrator, the file opens in the AutoVue for Agile viewer. Otherwise, the 
file opens in its native application, provided the application is installed on 
your computer. 

   Remove Removes all selected files from the Attachments tab.  

The Remove button is disabled if the item is incorporated. 

 

 

 

 

 

Add Click the Add button to open the File Uploader.  

Or, click the Add button’s drop-down arrow and select from the menu: 

  Files – if you are using File Productivity tools, displays the File Uploader 
dialog, which allows you to drag and drop the files you want to attach. You 
can also click Browse for Files button to browse your computer or network 
for the files you want. To add multiple files as a single file folder, click the 
Add all files to a single file folder button. If you select the UnZip all zipped 
files upon upload checkbox, the ZIP file is unzipped and the contents are 
added as individual files. 

  Files – (no File Productivity tools) displays the Add File dialog, which 
allows you to browse for up to five files, add the files to a single file folder, 
and unzip zipped files. 

Note Selecting the UnZip checkbox is not recommended for very large files. 

For more information about File Productivity tools, see Using the Advanced 
File Uploader. 

  URLs – brings up the Add URLs dialog 

  By Search – brings up the Add Files by Search dialog  
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Button  Name  Descript ion  

The Add button is disabled if the item is incorporated. 

Note: Either Advanced File Uploader or Standard File Uploader will be used 
depending on your user profile File Productivity Preference setting. For 
more information see Adding Attachment Files from your Local Disk or 
Network. 

   Get Shortcut Copies a URL to your clipboard, which you can paste into another software 
application, such as an email, document, or spreadsheet. The URL provides 
easy access to Agile attachments. For more information, see Accessing Files 
using URLs.  

   View Click the View Files button to view the selected files in AutoVue for Agile. 

Or, click the View Files button’s drop-down arrow and select from the menu: 

View – view the files in the AutoVue for Agile.  

 Cross Probe – crossprobe between PCB and schematic files in two 
windows.  

 Compare – compares the selected files and presents a comparison 
summary.  

 Overlay lets you lay the selected files over each other.  

 Digital Mockup – loads multiple selected models into the same 
workspace, where they can be analyzed together. For example, you can 
check them for proper fit. 

 By Search – find other files in the system, which you may want to (select 
from menu) cross probe, compare, overlay, or digital mockup (see above), 
without having to select two files from the same Attachments tab; that is, 
you could search and select one attached file from Part 234 and another 
attached file from Part 765. 

(For more information about Cross Probe, Compare, Overlay and Digital 
Mockup, see Viewer Supplement.) 
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Button  Name  Descript ion  

   Get File Click the Get Files button to place a copy of the selected files in the folder or 
location of your choice. These copies are in native application formats. 

If you selected a row with multiple files (indicated by a file folder icon in the 
row), the Select Files dialog appears, allowing you to select which files you 
want to get. 

   Check Out The Check Out button checks a single attachment file or multiple attachment 
files out of the file vault. From the business object, the checkout prompts you 
to get the file or files. You can download and edit the file. If you cancel the 
procedure, the attachment is checked out, but the file is not downloaded. 

When a folder is checked out, a  appears in front of it on the 
Attachments tab.  

Check Out is disabled when the item is incorporated. 

   Check In Click the Check In button to return file(s) to the file vault. The file folder 
version number is advanced. Previous versions are accessible by using the 
Show Versions feature. 

Check In is disabled when the item is incorporate 

   
Cancel Checkout Click the Cancel Checkout button to cancel a checkout. It re-locks the 

selected file folder, so it is available to be checked out again. A user who has 
Cancel Checkout privilege can cancel the checkout. 

Cancel Checkout is disabled when the item is incorporated 

   Print Files Click the Print Files button to print the corresponding attachment file. 
AutoVue for Agile is started in a separate browser window and begins the 
printing process. 

 Show Versions Click the Show Versions button to open a table of all versions of selected 
attachment file. From this dialog you can view, get, open, and print a 
selected version. 

 
 

Fields on the Attachments Tab 

The following table lists fields on the Attachments tab. These apply to both Java and Web Clients, 
although the order of the fields may vary in each client. 

Fie ld  Descript ion  

   
If a file has been modified directly in the file server vault, this icon appears in the field 
to indicate that the file Has checksum error. Click the icon to get information about 
the checksum error. See Checksum File Validation on page 282. 

   

 

   

This icon appears in the field if the file Has been redlined. 

The Do Redlining icon will appear here from the file folder level for any file type that 
is listed in the Supported File Types and Valid Model File Type settings in 
Administrator. Both of these cases allow ad-hoc viewing and redlining. 
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Fie ld  Descript ion  

   This icon appears in the field if the file Has been checked out. 

Filename 

Java Client     

Web Client    

 

The name of the file. This field begins with an icon just before naming the file or files: 
a ―single file‖ icon is present in rows containing single attachment files; a ―file folder‖ 
icon is present in rows containing multiple attachment files (that is, a file folder that 
contains multiple files). 

 In Java Client, the attachment row must be selected in order to print, open, get, or 
view the file using buttons on the menu. 

 In Web Client, click the filename to view the file in the Viewer. 

File Description Description of the referenced attachment files. To change File Description field, see 
Basic Procedures on the Attachments Tab on page 265. 

File Size Size of the file, in Bytes 

File Type The kind of file, for instance, document, graphic, drawing 

Folder Number The ID number assigned to the file folder 

Folder Description The description of the file folder 

Folder Version Reflects which version of the file folder that is being referenced by the business 
object. By default, the most recent version is shown, but you can select an earlier 
version. 

Checkin User Name of the person who checked in the referenced version of the file folder. 

Checkout User Name of the person who checked out the file folder; appears only when file folder is 
checked out 

Checkout Date Date when the file folder was checked out; appears only when file folder is checked 
out 

Modified Date Indicates when the file folder was checked back in after modifications 

Last View Date Date when the file was last viewed. (The History tab records detailed information 
about file viewing.) 

 

Checkout Location When you check out an attachment file and save a copy of the checked out file, 
Agile stores the checkout location (computer name and directory path name) in this 
field. When you check in, Agile uses the Checkout Location information to 
automatically locate the modified file to check in. 

Note In Web Client, this field is completed automatically only 
when using Advanced Productivity Components. See 
also Checking In Revised Attachment Files on page 
281. 

Attachment Type File or Image 
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Basic Procedures on the Attachments Tab 

On the Attachments tab of any business object, you can perform all the actions needed to add, view, 
manage, and update your attachment files. 

Note Your ability to use Attachments tab features is determined by your assigned roles and 
privileges. Contact your Agile administrator if you have questions about your Attachments 
tab privileges. 

 

Getting Attachment Files 

You can copy attachment files to the directory of your choice. This is called getting a file. You can 
get as many copies as you like. If you want to revise an attachment file and make the version 
public, you must check the file out, make changes, and check it back in. This is covered in Checking 

Out Attachment Files on page 280. 

Several users can get the same attachment files simultaneously. You can get files that are checked 
out. Also, you can get a file even though the application used to create that file is not loaded on your 
computer. 

You must have the appropriate privileges to get a copy of the file. If you have questions about your 
privileges, contact your Agile administrator. 

Note When you get an attachment file, the date and time stamps on your copy of the file 
reflects the date and time that you got the file, not the date that the file was attached or 
saved. 

 

Java Client, Getting Attachment Files 

To get copies of one or more attachment files from a business object in Java Client: 

1. Display the Attachments tab of an object. 

2. Select the rows of the files that you want to get. 

3. Click the Get Files button  . 

 If you selected a row with multiple files (indicated by a file folder icon in the row), the Select 
Files dialog opens. 

Select the files you want and click OK. The Select Directory dialog opens. Continue with 
the next step. 

 If you selected one or more rows that consist of a single attached file, the Select Directory 
dialog opens. Continue with the next step. 

4. In the Select Directory dialog, specify the directory where you want to store the copies. 

If you want to get the files together in one ZIP file, click Download the files in one ZIP file. Specify a 
ZIP filename. 

5. Click OK. The files (or ZIP file) are copied to the specified directory. 
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You will be prompted whether you want to open the file or files. 

Java Client, Batch Get 

To batch get copies of all the attachment files of a business object in Java Client: 

1. Display the Attachments tab of an object. 

2. Click the button drop-down menu for Get Files   and select Batch Get All Files from this Object. 

 If the attachments table includes a row with multiple files (indicated by a file folder icon in 
the row), the Select Files dialog opens. 

Select the files you want and click OK. The Select Directory dialog opens. Continue with 
the next step. 

3. In the Select Directory dialog, specify the directory where you want to store the copies. 

If you want to get the files together in one ZIP file, click Download the files in one ZIP file. Specify a 
ZIP filename. 

4. Click OK. The files (or ZIP file) are copied to the specified directory. 

You will be prompted whether you want to open the file or files. 

Web Client, Standard File Productivity, Getting Files 

To get copies of attachment files from a business object in Web Client, using Standard File Productivity 

method: 

1. Display the Attachments tab of an object. 

2. Click the Get button  in the row of a file you want. 

 If you selected a row with multiple files (indicated by a file folder icon in the row), the Select 
Files dialog opens. 

Select the files you want and click Finish. The Select Directory dialog opens. Continue with 
the next step. 

 If you selected one or more rows that consist of a single attached file, the Select Directory 
dialog opens. Continue with the next step. 

3. The Save As dialog appears. Save the files to disk, specifying the directory where you want to 
place the files. Web Client copies the files to the selected directory. If you get copies of multiple 
files, they are placed in a ZIP file. 

4. Click OK. The files (or ZIP file) are copied to the specified directory. 
 

Web Client, Get All Attachments, Standard File Productivity 

To get copies of all the attachment files from a business object in Web Client, using Standard File 

Productivity method: 

1. Display the Attachments tab of an object. 

2. Click the  Get All Files button in the tab menu. 

3. The File Download dialog appears. 
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4. Specify the directory where you want to place the files.  

5. Click Save to save the ZIP file to disk, specifying the directory where you want to place the file. 
Agile PLM copies the files to the selected directory.  

Click Open to open a ZIP file in WinZip that contains all the attachment files. 

Note If there is a single file on the Attachments tab, you are prompted to either open the file 
in its native application or save it in its native format. 

 
 

Web Client, Advanced File Productivity, Getting Files 

To get copies of attachment files from a business object in Web Client, using Advanced File Productivity 

method: 

1. Display the Attachments tab of an object. 

2. Click the Get button  in the row of a file you want. 

 If you selected a row with multiple files (indicated by a file folder icon in the row), the Select 
Files dialog opens. 

Select the files you want and click Finish. The Select Directory dialog opens. Continue with 
the next step. 

 If you selected one or more rows that consist of a single attached file, the Select Directory 
dialog opens. Continue with the next step. 

3. The Save As dialog appears. Save the files to disk, specifying the directory where you want to 
place the files. 

Note When using the Advanced File Productivity method to get multiple files, Web Client 
gives you the choice of downloading individual files or downloading a ZIP. 

4. If you want multiple files in a single ZIP file, check Download the files in one ZIP file and enter a ZIP 
file name. 

Note If you did not select multiple files, the ZIP file option and name field do not appear in 
the Select Directory dialog. 

5. Click OK. The files (or ZIP file) are copied to the specified directory. 

You will be prompted whether you want to open the file or files. 

Web Client, Get All Attachments, Advanced File Productivity 

Note For more information about the Advanced File Productivity preference, see Setting your 

File Productivity Preference on page 314. 

To get copies of all the attachment files from a business object in Web Client, using Advanced File 

Productivity method: 

1. Display the Attachments tab of an object. 

2. Click the  Get All Files button in the tab menu. 
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The Select Directory dialog appears. 

3. Specify the directory where you want to place the files. 

4. To place all the files in a single ZIP file, check the Download the file in one ZIP file checkbox and 
enter a zip file name. 

5. Click OK. The files (or ZIP file) are copied to the specified directory. 
 

Opening Attachment Files in their Native Applications 

To open an attachment file from a business object in Java Client: 

1. Display the Attachments tab of an object. 

2. Select the rows of the files that you want to open. 

3. Click the Open Files button . The files will open in their native application. 

 If you selected a row with a URL attachment, the URL is launched in a web browser. 

 If you selected a row with multiple files (indicated by a file folder icon in the row), the Select 
Files dialog opens. 

Select the files you want and click Finish. 

If a file’s native application is not on your machine, AutoVue for Agile will open and display the 
file. 

You can also select a file and click the View button ; in this case, AutoVue for Agile opens the 
files for viewing. 

To open an attachment file from a business object in Web Client: 

1. Display the Attachments tab of an object. 

2. Click the Filename link. 

The file opens in its native application providing the following conditions are both true: 

 The file is not in a format that is listed as a valid viewer file type. (Viewer valid file types are 
set by your Agile administrator.) 

 The native application installed on your computer. 

Note If the attachment is a URL, clicking the Filename link launches the URL in a web 
browser. 

 

Printing Attachment Files 

You must have the appropriate privileges to print an attachment file. If you have questions about 
your privileges, contact your Agile administrator. 

Note A ―batch print‖ is simply printing the contents of a file folder that has multiple files. You 
still click the Print button and follow the sequence in AutoVue for Agile. 

To print a file on the Attachments tab using AutoVue for Agile in Java Client: 

1. With the Attachments tab displayed, select one or more attachment rows to print. 
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2. Click the Print button . 

You can also select a file and click the View button ; in this case you would start the viewer 
print functions manually. 

3. If the file type is supported by AutoVue for Agile, the viewer opens and begins the printing 
process. Follow the instructions in the displayed dialog boxes to complete the printing process. 
When the printing process is complete, the Viewer automatically closes. 

Note When you print from within AutoVue for Agile, watermarks and banners can appear 
in addition to the contents of the attached file. For more information, see About 

Banners and Watermarks on the Printed Image on page 269. 

To print a file on the Attachments tab using the AutoVue for Agile in Web Client: 

1. With the Attachments tab displayed, click the Print button  in the row you want. 

You can also click the Filename link to open the file in AutoVue for Agile. In this case you would 
start the viewer print functions manually. 

2. If the file type is supported by AutoVue for Agile, the viewer opens and begins the printing 
process. Follow the instructions in the displayed dialog boxes to complete the printing process. 
When the printing process is complete, the viewer automatically closes. 

Otherwise, Web Client starts the file’s native application and opens the file so you can print it 
using that application’s printing commands. Choose the Print command for that application. 

Note When you print from within AutoVue for Agile, watermarks and banners can appear in 
addition to the contents of the attached file. For more information, see About Banners 

and Watermarks on the Printed Image on page 269. 

It is also possible to get a copy of the file, open it in its native application, and use the native 
application’s print functions to print the file. The native application must be installed on your 
computer before you can print the file. Follow the usual printing procedures according to the 
application’s documentation. 

About Banners and Watermarks on the Printed Image 

When printed through AutoVue for Agile, the printed image has a banner above and below the 
image. The banner has six fields: top left, top center, top right, bottom left, bottom center, and 
bottom right. 

The banner labels and contents for each object class are set by the Agile administrator. 

In addition, the Agile administrator can choose to include a printed watermark on the printed image. 

Accessing Different Versions of Attachments 

You can get, open, view, and print any version of an attachment file from the Attachments tab of the 
business object. 

You can easily access history without clicking through to the File Folder object. This is useful when 
a single file is being modified and accessed by multiple people/different functions. For instance, 
user can easily trace and identify which versions another user made their edits in - this is identified 
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from version create date and checkout user. 

The Versions dialog displays, for each version, the Version Creation Date (date the version was 

created), whether that version has redlines (indicated by the Has Been Redlined  icon), and the 
Checkout User (user who created that version). This allows you to easily see the history of an 
attachment from the Attachments tab, including who modified the file, and when it was modified. 

To switch between versions of file folders from an object's Attachments tab in Java Client: 

1. On the Attachments tab, select one or more attachment row that you want to access. 

2. Click the Show Versions button . The Versions dialog appears. 

3. Select the version row or rows that you want to access. 

4. Click the appropriate action button (Get, Open, View, or Print). 

5. Optionally, click the Has Been Redlined  icon to open AutoVue for Agile and display the 
redlines. 

6. Optionally, select two version rows, then choose Compare or Overlay in the View action button 
drop-down menu. 

To switch between versions of file folders from an object’s Attachments tab in Web Client: 

1. On the Attachments tab, click the Show Versions button  in the attachment row you want and 
the Versions dialog appears. 

2. In the version row that you want to access, click the appropriate action button (Get, View, or 
Print). 

3. Optionally, select two version rows, then choose Compare or Overlay in the View action button 
drop-down menu. 

 

Using the File Folder Version Browser 

When a File Folder object is open, you can view information about all versions of the File Folder in 
the Version Browser. 

Note The Version Browser is available only in Web Client.  

To open the Version Browser: 

1. In the Actions menu, choose Version Browser. The Version Browser opens. 

The Version Browser displays the following information about each version: 

Version Browser 
Column  

Descript ion  

Approval An Awaiting Approval icon  in this column indicates that the version is awaiting 
approval; the Routing Slip for that version lists users who have not yet signed off. 

Version The version number. 

Checkin Date The date the version was checked in and the user who performed the check in. 
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Version Browser 
Column  

Descript ion  

Checkin User When the version is checked out, these fields are blank. 

Change Info Indicates how the version was modified before it was checked in. 

Files indicates that the object's files were modified, for example, files were replaced, 
added, or deleted. 

For Design objects, Structure indicates that the Design's Structure tab was modified. 

Label, Revision, 
Revision Date 

These are version-specific editable fields used with Design data model objects. 

 

Actions you can initiate in the Version Browser: 

 View Files: Select any version row and click View to view the file or files in AutoVue for Agile. 

 Compare Files: For single-file versions, select two version rows, and choose Compare in the View 
button drop-down list. The selected files are compared in AutoVue for Agile. 

 

Adding and Removing Files via the Attachments Tab 

This section includes the following topics: 

 Adding Attachment Files from your Local Disk or Network on page 271 

 Add Files by Search Options on page 275 

 Adding a URL on page 276 

 Adding Files by using SaveAs to Create a New Business Object on page 277 

 Removing Attachments from the Attachments Tab on page 277 

 Editing the Attachments Table on page 278 
 

Adding Attachment Files from your Local Disk or Network 

When adding files to a business object Attachments tab, Agile provides a simple and easy-to-use file 
uploader. The File Uploader allows you to drag and drop the files you want from your desktop or 
from an open directory window to the file uploader window. The uploader also has a Browse button 
so you can find the files you want in that manner. 

Note For Web Client only: Depending on your company’s policies, your Agile administrator 
may set a systemwide preference that prevents the use of the Advanced File Uploader. 
In that case, Add >  File operations in Web Client are completed using the Add File dialog, 
as described in Using Web Client’s Standard Add File Dialog on page 315. 
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Using the Advanced File Uploader 

You can add as many files at one time as you like. There are two checkboxes; when checked, one 
will Unzip all zipped files upon upload, and the other will Add all files to a single File Folder. When you are 
ready, click Upload. 

When the upload is completed, depending on Agile PLM system settings, you may be prompted 
―Would you like to delete the uploaded files from your local disk?‖ which is useful if you have loaded 
a file onto your machine only to attach it to an Agile object. When you uploaded the file, Agile File 
Manager created a copy of the file that is always stored in the file vault. 

At any time before clicking Upload, you can Cancel the upload. Click Close to close the uploader 
dialog. 

To add attachment files using Advanced File Loader in both Java Client and Web Client: 

1. Click Add > Files. 

The blank File Uploader window is displayed. The instruction ―Drag Files Here‖ appears in the 
window. 

2. Open a directory window (for example, Microsoft Explorer) and size the window so that you can 
see both the File Uploader window and the directory window on your screen. 

3. Navigate to the directory you want. 

4. Select the file you want and drag it to the File Uploader window and drop it. The file name 
appears in the File Uploader window. 

 If you drag and drop a folder, all the files in the folder are added to the list in the File 
Uploader. 

 You can also click the Browse button in the File Uploader window and browse for the file 
you want. When using the browse function: 

Double-clicking on folder will open the folder's contents. 

Single clicking on folder and then clicking Open will add all contents of that folder (files as 
well as contents of subfolders within that folder) 

5. Continue locating and dragging as many files as you want to want. You can open additional 
directory windows if you choose. 

Note To remove any file from the download dialogue box (for example, if you made a 
mistake and selected a file erroneously), simply click on the file and press the Delete 
key on your keyboard. 

6. When you have selected the files you want, if desired, click the Options button to make 
additional choices: 

 Type — select the file folder type (subclass) you want to create. 

 Unzip all zipped files upon upload — unzips ZIP files so that they are stored in their native 
format. 

If this option is unchecked, a ZIP file is stored in its ZIP format. 

 Add all files to a single File Folder — adds all the selected files to a single file folder. You may 
enter a Folder Description. 



 

 

9.2.2.6 273  

  

If this option is unchecked, each file in the list is assigned its own unique file folder, one 
attachment file to one file folder. By default, Agile assigns attachments to the File Folder 
type (subclass). 

 Edit rows after adding — presents an edit dialog which allows you to edit the newly added 
attachment table rows. 

7. When you are done, click Upload. 

The files are added to the business object Attachment stab. The File Uploader window displays 
progress messages for each file as it is uploaded. 

Note Agile automatically creates a new file folder container for each of the uploaded files 
and sets the version of each file folder to 1. If you selected Add all files to a single File 
Folder, only one file folder container is created and the version is set to 1. 

8. When the files are uploaded, you are asked if you want to delete the uploaded file from your 
local disk. 

 Yes (default) — removes the copy of the file from the directory from which you selected it. 
This ensures that the correct version of the file is maintained in the Agile file vault and you 
do not have any out-of-date copies on your local disk. To view or update the file, use the 
Agile Attachments tab. 

Note The copy of the file on your local disk is removed; it is not moved to your desktop 
recycle bin. 

 No — the copy of the file that you selected to add to the Attachments tab remains on your 
local disk. 

 

Adding Files in Web Client without Advanced File Loader 

If Advanced File Loader is not available to you in Web Client, there are two possible reasons: 

 Due to your company's policies, your Agile administrator has set the system-wide preference 
such that Web Client users are not allowed to use the Advanced File Loader Java applet. 

 Your company does allow Web Client use of the Advanced File Loader, however, your 
personal user profile preference attribute for File Productivity Preference is set to Standard. If 
this is the case, you can change your user profile preference to Advanced, which will allow you 
to use the Advanced File Loader. 

Note By default, your user profile is set to the Prompt preference. By responding to the 
prompt, you can select which file productivity method you prefer without editing your user 
profile. See the description of Prompt responses in Setting your File Productivity 

Preference on page 314. 

 

Setting your File Productivity Preference 

To modify your File Productivity Preference: 

1. In Web Client, select Tools > My Settings to display the My Settings page. 

2. On the My Settings page, click User Profile. Your tabbed user profile appears. 

3. Click the Preferences tab. 
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4. Click Edit. 

5. In the File Productivity Preference drop-down list, select one of the following: 

 Advanced — allows you to use the Advanced File Loader and other File Productivity 
components (providing the Agile system-wide preference is set to allow it). The next time 
you add a file or check in files on the Attachments tab, if it has not been previously installed, 
a Java applet will be installed. See Using the Advanced File Uploader on page 312. 

Note File Productivity components include both Advanced File Loader and Automated 
Checkin. In Web Client, File Productivity also allows you to get (download) a multi-
file attachment row as individual files instead of a ZIP file, and enables the opening 
of an attachment in its native application when you click its Filename link. 

 Standard — Web Client standard Add File dialog is used when you add a file or check in 
files on the Attachments tab. See Using Web Client’s Standard Add File Dialog on page 
315. 

 Prompt — the next time you add a file to an Attachments tab, the Please Choose File Update 
Mode dialog is displayed to prompt you to choose whether to use the advanced 
productivity components (Advanced File Loader) or not. (By default, your File Productivity 
Preference is initially set to Prompt.) 

Your possible choices in the Please Choose File Update Mode dialog are as follows: 

Yes (and check Do not show this dialog box again) — if it has not been previously installed, a 
Java applet will be installed. The File Productivity Preference attribute in your user profile is 
set to Advanced. Every time you use Add > Files or check-in attachments on the Attachments 
tab, the Advanced File Loader is displayed. 

No (and check Do not show this dialog box again) — The File Productivity Preference attribute in 
your user profile is set to Standard. Every time you use Add > Files or check-in attachments 
on the Attachments tab, the standard Add Files dialog is displayed. 

Yes or No (and do not check Do not show this dialog box again) — The File Productivity 
Preference attribute in your user profile is remains set to Prompt. Every time you use 
Add > Files or check-in attachments on the Attachments tab, the Please Choose File Update 
Mode dialog is displayed and you can select the method you want to use. 

Once you respond to the prompts and you also check Do not show this dialog box again, your 
preferred file productivity method will always be used. The Please Choose File Update 
Mode dialog will no longer appear and the File Productivity Preference attribute in your user 
profile is set as described above for the Yes or No choice. 

Note At any time, you can use the above process (beginning with step 1) to edit the File 
Productivity Preference attribute in your user profile to change your preference and 
select the file upload method you prefer. 

 

Using Web Client’s Standard Add File Dialog 

If you want to use the standard Add File dialog, make sure that the File Productivity Preference 
attribute in your user profile is set to Standard. See the Setting your File Productivity Preference on 
page 314 for instructions. 

To use the standard Add File dialog: 

1. In Web Client, on the Attachments tab, click Add > Files. 
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The Add File window appears with rows for up to five attachments. 

2. Use the Browse button to locate and select files to add. You can select electronic files on a local 
drive or on your network. 

3. Add descriptions for the files. You do not have to add a description now. You can add or edit a 
description at any time. 

4. If desired, check the optional checkboxes: 

 Unzip — unzips ZIP files so that they are stored in their native format. 

If this option is unchecked, a ZIP file is stored in its ZIP format. 

 Add All Files to a Single File Folder — adds all the selected files to a single file folder. You may 
enter a Folder Description. 

If this option is unchecked, each file in the list is assigned its own unique file folder, one 
attachment file to one file folder. 

5. Click Finish. The files are added to the Files tab and placed in the file server vault. 
 

Add Files by Search Options 

To reuse existing attachments and file folders, use the Add > By Search function. This option allows 
you to reuse existing attachments when needed. 

To Add attachments by search: 

1. Open the object to which you want to add an attachment, and click the Attachments tab. 

2. Select Add > By Search. The Add Files by Search dialog appears. 

Add > By Search (button or menu choice) opens a dialog with three Search tabs. 

This dialog allows you to search for any business object (for example, items or manufacturer 
parts) and select the attachments of those objects to add to the current object. 

 Search tab lets you create a simple search or an advanced search. You can check to 
search attachment contents, too. 

 Saved Searches tab opens to your navigation pane where you can browse in search folders, 
select a search, and run it. Again, returned results may be moved to the Selected Items 
table, and click OK. 

 Shortcuts tab opens to your navigation pane where you can select objects from My 
Bookmarks or Recently Visited. The system displays shortcuts to only those objects that are 
appropriate to the operation you are performing. 

Note Only business objects with attached files appear in the search results table. For 
example, a business object that you viewed recently will not appear on the Recently 
Visited list of the Shortcuts tab if it has no attachments. 

3. When the results of your search are returned, select a row in the Results table, and the related 
files for that object appear in the Related Files table. 

4. In the Related Files table, select and move attachments to the Selected Files table. 

 If the object is an item, the Related Files table displays only the attachments on the latest 
Released Revision of the item (not pending or older revisions). 
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 For any other (non-item) object, the Related Files table displays only attachments currently 
on that Attachments tab (not previously associated files). 

5. You can continue to run multiple searches or shortcuts until you are finished selecting the 
attachments you want. 

6. If you want to edit the attachment table rows after you add the attachments, check Edit rows 
after adding. 

7. Click OK. 

The current business object now references (or points to) the existing attachments and file folders 
you selected. 

Add by Search for Existing File Folder 

If you have the appropriate privileges, you can use the Add by Search feature described above and 
select File Folders as the object type for your search. 

To add by searching for existing file folders: 

1. Select File Folders as the object type. 

2. Use one of the available search methods: simple search, advanced search, saved search or 
shortcuts. 

3. In the results table, select the file folder you want. 

4. In the Related Files table, select the file folder version number you want to use. By default, the 
latest version is selected. 

5. Move your file selections to the Selected Files table. 

6. You can continue to run searches and select files to add by repeating the above steps. 

7. When you are finished, if desired, check Edit rows after adding, then Click OK. 
 

Adding a URL 

To add a URL to the Attachments tab in both Java Client and Web Client: 

1. Open the object to which you want to add a URL, and click the Attachments tab. 

2. Select Add > URL. The add URL dialog appears. 

3. Enter a URL and description. URLs must include the http syntax. 

Note The URL field is prepopulated with the text string http:// to streamline this process. 

4. To verify that you have typed the correct URL, click Preview. A new browser window opens 
using the URL you have entered. 

If desired, check the option Add All URLs to a Single File Folder. You can enter a Folder 
Description. 

If you leave this option unchecked, a separate file folder will be created for each URL. 

5. Click OK. The URL is added to the Attachments tab. 
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Note If a URL is added to a single file folder (there are no other files or URLs in that file 
folder) and the file folder version remains at Version 1, you can select the URL row 
on the Attachments tab, click Edit, then edit (modify) the URL. All the business objects 
that include the URL on their Attachments tab will display the newly edited URL. 

 

Adding Files by using SaveAs to Create a New Business Object 

When you use Save As to create a new business object (object B), if the object from which you are 
performing the Save As function (object A) has one or more attachments, an Agile system 
preference determines how object B’s attachments are created. 

If your Agile administrator has selected Prompt for this system preference, you will be prompted to 
choose between the following two options. If you are not prompted, the new object is automatically 
created using the specified system preference setting. 

 Create new copy of file(s) means that as object A is being replicated to create new object B, the 
system creates a new copy of the attachment file and also a new (referenced) file folder. Object 
A references FF-1, ver. 5, now version 5 of the file has been copied but, in new file folder FF-2 
referenced by object B, the file is at version 1. 

 Reference existing file(s) means that as the object is being replicated to create a new object, the 
system will use the existing file folder and create a new reference to it. In this case, object A 
references FF-1, ver. 5, and object B also references FF-1, ver. 5; the object was replicated but 
no file folder nor copy of attachment file was created. 

 Do not copy file(s) means that as object A is being replicated to create new object B, the system 
creates object B with no attachment files. Object B's attachment table is empty. 

 Prompt means that the system will always prompt the user who performs a Save As whether 
they want to create a new copy of the attachment, simply reference existing file and folder, or 
create the new object with no attachments. This prompt does not display if object A does not 
have an attachment. 

 

Removing Attachments from the Attachments Tab 

You can modify the Attachments tab by removing attachment table rows. 

Note Removing an attachment table row removes only the reference to the attached file’s file 
folder object. The file folder object and its contents are not deleted. 

To remove attachments from the Attachments tab: 

1. Open the object and click the Attachments tab. 

2. Select the rows you want to remove. 

3. Click the Remove button. 

Note You cannot remove an incorporated item’s attachments. For more information about 
incorporated items and attachments, see About Item Revisions and File Folder Versions 
on page 283. 
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Editing the Attachments Table 

Select the rows you want and use the Edit button to edit the File Description and Version of the 
selected attached file as well as any other editable fields and custom fields that your administrator 
has defined. 

Note Your ability to use Attachments tab features is determined by your assigned roles and 
privileges. Contact your Agile administrator if you have questions about your Attachments 
tab privileges. 

The following attachment row fields can be edited as described below: 

Fie ld  Edi t  method  

Filename If the selected row refers to a file folder that contains multiple files, you can use 
the drop-down list to select a different file. You can select All Files. 

File Description Edit the description for this version of the attached file. 

 File Description is Folder Version specific. For example, if you modify the File 
Description for version 3, the File Description for version 1 remains 
unchanged. Each attachment version can have a different File Description, if 
needed. 

 If the selected row refers to a file folder that contains multiple files and one 
specific file is selected in the Filename field, you can edit the File Description 
field. The File Description field on the file folder object Files tab is updated 
with the new file description. 

 If the select row refers to a file folder that contains multiple files and All Files 
is selected in the Filename field, the File Description field is editable 
depending on your roles and privileges pertaining to the referenced file 
folder. 

 If the selected version is incorporated to an item (which may not be the 
current business object that you are editing), the File Description field is not 
editable. 

Folder Description Edit the description of the file folder which contains the referenced file. 

 If the file folder is referenced by multiple business objects, you must have the 
appropriate modify privileges to edit this field. 

 If the file folder is referenced by multiple business objects and you have the 
appropriate privileges to modify this field, the new Folder Description appears 
on all the business object Attachments tabs that reference this file folder. 

Folder Version Select the attachment version (file folder version) you want. 

 If the selected row refers to a file folder that contains multiple files, if you 
select Latest-x as the version, the Filename field is automatically set to All 
Files. 

 You can select any version in the list. Note that if you select a non-latest 
version, you will not be able to checkout this attachment row. For more 
information about latest and non-latest versions, see What are 

Attachment Versions? on page 256. 



 

 

9.2.2.6 279  

  

Fie ld  Edi t  method  

Other editable fields Your Agile administrator may have defined other custom fields. If you have the 
appropriate privileges, you can modify these additional fields. Contact your Agile 
administrator if you have questions about your Attachments tab privileges 

To edit attachment table rows: 

1. Open the object and click the Attachments tab. 

2. Select the rows you want to edit. 

3. Click the Edit button. 

4. Make the modifications you want. 

5. Click OK (Java Client) or Save (Web Client). 
 

Revising Attachment Files 

When you need to update or revise the attached file, Agile PLM uses Check Out and Check In 
functions to ensure that only one user at a time can revise the file. 

This section includes the topics: 

 Checking Out Attachment Files on page 280 

 Checking In Revised Attachment Files on page 281 

 Canceling Checkouts on page 282 

 Checksum File Validation on page 282 

Using the examples of Bob and Carl, engineers, and Doris, the document control manager. See 
Attachment Files and Agile File Folders: an Analogy to Papers, Desks, and Vaults on page 253, 
the following story illustrates the concepts of the Check Out and Check In features. 

Doris keeps all the company’s documents locked in a document vault. Each document is filed in a 
labeled file folder. When Bob or Carl need a copy of a document, Doris makes a copy and gives it to 
them. See Getting Attachment Files on page 265. 

However, when Carl wants to revise a document, Doris gives him a copy of the latest version, and 
she marks the file folder as Checked Out. When a file folder is checked out, Doris does not allow any 
other person to update the drawings in that file folder, although anyone can still request a copy of 
the drawings. 

When Carl brings Doris the updated drawing, she puts it in the file folder, records the new version 
number on the file folder and marks the file folder as Checked In. 

In Agile PLM, Check Out and Check In features provide the following safeguards: 

 When an attachment is Checked In, no one is allowed to revise the attachment. The attachment 
file is locked in the vault, however, any user with the appropriate privileges can check it out. 
The attachment is locked for all users. 

 When an attachment is Checked Out only the checkout user can revise the attachment. The 
attachment file remains locked in the vault, and it is not available for checkout by any other 
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user. The attachment is unlocked for revision only by the checkout user. 
 

Checking Out Attachment Files 

Note To checkout an attachment file on a business object Attachments tab, the Folder Version 
for that row must specify the latest revision, either the latest revision number (for 
example, 3) or the dynamic Latest-x revision (for example, Latest-3). If the Folder Version 
is a non-latest version, the Check Out feature is not available. For more information see 
What are Attachment Versions? on page 256. 

 Checkout is disabled for URL attachments. 

To check out an attachment row of an object for revision, Java Client: 

1. Display the Attachments tab of the object. 

2. Select one or more attachment rows. 

3. Click the Check Out button.  

If you have selected a row that cannot be checked out, an error message is displayed telling 
you which rows cannot be checked out and why (for example, non-latest version or already 
checked out). 

4. If you have selected an attachment row that includes multiple files (a folder icon appears in the 
Filename field), the Select Files dialog appears. By default, all files are selected. Select the files 
you want, and click OK. 

5. The Select directory dialog appears. Navigate to the directory where you want to save copies of 
the checked out files. 

To save the files in a ZIP file, check Download the files in one ZIP file and enter a ZIP file name. 

The checkout location is recorded on the Attachments tab Checkout Location field; it is also 
logged on the History tab. 

6. Click OK. 

7. The Open Files dialog appears. If you want to open the checked out files, click Yes. 

To check out an attachment row of an object for revision, Web Client: 

1. Display the Attachments tab of the object. 

2. In the row you want to checkout, click the Check Out button . 

If a Check Out button does not appear in that row, the row cannot be checked out (for example, 
non-latest version). 

3. In the Save As dialog, navigate to the directory where you want to save copies of the checked 
out files. 

Click Save. 

Note In Web Client, if you are not using the Advanced Productivity Tools, the Checkout 
Location field is not populated. See also Checking In Revised Attachment Files on 
page 281. 
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Checking In Revised Attachment Files 

When you check in attachment files, Agile PLM verifies that the file has been modified. 

The check in process retrieves the revised file from the Checkout Location recorded on the 
Attachments tab, and replaces the checked out version of the file. The Folder Version is advanced by 
1. For example, If you checked out version 6, when you checkin, the version will be 7. Note that 
version 6 is still stored in the Agile file vault. If you wish to view it, use the Show Versions feature. 
See Accessing Different Versions of Attachments on page 269. 

If the revised file has been moved from the checkout location, or you have changed its name, you 
are prompted to browse for the replacement file. 

When the checkin process is finished, you are prompted to delete the checked-in files from your 
local disk. 

To check in attachment files, Java Client: 

1. Select the checked out rows that you want to check in. 

2. Click the Check In button.  

3. Agile PLM automatically checks in the revised files from the Checkout Location recorded on the 
Attachments tab when the files were checked out. 

4. If any of the revised replacement files are not in the recorded Checkout Location where they 
were originally checked out, the Check In Files dialog appears. 

Note If you have moved the checked out file or changed its name, the Check In Files 
dialog appears so you can specify the check in replacement files. 

Use the Browse button to locate each replacement file. 

5. When you are done, click OK. 

6. When the check in process is complete, you are asked if you would like to delete the checked-
in files from your local disk. The default response is Yes. 

 Click Yes to delete the copy of the checked-in files from the checkout location. 

 Click No to leave the copy of the checked-in files in the checkout location. 

To check in attachment files, Web Client: 

1. In the row you want to check in, click the Check In button.  

2. The checkin process differs depending on your File Productivity Preferences. 

Advanced File Productivity Preference: 

 If your Agile system is set to use File Productivity tools and your user profile File Productivity 
Preference is set to Advanced, then Agile PLM automatically checks in the revised files from 
the Checkout Location recorded on the Attachments tab when the files were checked out. 

 If any of the revised replacement files are not in the recorded Checkout Location where 
they were originally checked out, the Check In Files dialog appears. 

Use the Browse button to locate each replacement file. 
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Note If you have moved the checked out file or changed its name, the Check In Files 
dialog appears so you can specify the check in replacement files. 

Standard File Productivity Preference: 

 If you not using File Productivity tools, then you are prompted to browse to locate the 
revised files. 

Note For more information about File Productivity tools see Using the Advanced File 

Uploader on page 312. 

3. When you are done, click OK. 

4. When the check in process is complete, you are asked if you would like to delete the checked-
in files from your local disk. The default response is Yes. 

 Click Yes to delete the copy of the checked-in files from the checkout location. 

 Click No to leave the copy of the checked-in files in the checkout location. 
 

Canceling Checkouts 

When you wish to discard edits to attachment files that you checked out, you can cancel the 
checkout. 

A checkout can be canceled only by the user who checked out the attachment, or by a user with 
necessary privileges. If you have questions about your privileges, contact your Agile administrator. 

When you cancel a checkout, copies of the attachment files remain in the checkout location you 
selected, but the original files are once more available to be checked out from the Attachments tab. 
Any edits you make to the remaining copies of the files do not appear in the public versions of the 
file (the versions of the file stored in the file vault). 

To cancel a checkout from an object’s Attachments tab in Java Client: 

1. Display the Attachments tab of an object. 

2. Select the checked-out row or rows for which you want to cancel the checkout. 

3. Click the Cancel Checkout button . 

To cancel a checkout from an object’s Attachments tab in Web Client: 

1. Display the Attachments tab on an object page. 

2. Locate the checked-out row for which you want to cancel the checkout. 

3. Click the Cancel Check Out button  in the row for which you want to cancel the checkout. 
 

Checksum File Validation 

To enhance the security of file access and to inform the end-user or administrator of any illegal 
modification or corruption of a file, the Agile system performs file validation on attachment files with 
a utility called Handle File Checksum. The validation reveals when a file in the file server vault has 
been modified directly, that is, bypassing the Agile system. So when you try to view, get, check out, 
check in, or add a file that has been improperly modified, an error message appears and access to 
the file is prevented until the error is resolved. 
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In both Java and Web Clients, the Attachments tab of business objects and the Files tab of file folders 

have a field called Has Checksum Error.   When a file on an attachment row has a checksum error, 
the Has Checksum Error field displays the same symbol. (If the administrator has disabled the 
Checksum Computation systemwide preference, however, this field will not display any errors. If 
you suspect there are security problems with files and this field is never populated, see your Agile 
administrator.) 

You can resolve a checksum error only if you have been assigned the Reset File Checksum 
privilege mask. If you click the Checksum icon that appears on an attachment row and get a 
warning, you cannot resolve the problem; however, the system sends notification to the 
administrator and other designated users. The History tab of the file folder (with the offending 
attachment file) identifies users who have been notified, either during the validation process or 
during the ―handle checksum‖ process. 

Assuming you have been assigned the Reset File Checksum privilege (along with appropriate file 

folder privileges), clicking  in the row of the offending file brings up a dialog that offers several 
options to resolve the problem. Because this privilege is usually assigned to Agile administrators or 
user administrators, more information about resolving checksum errors is found in Agile PLM 
Administrator Guide. See ―Administering Attachments and Files.‖ 

About Item Revisions and File Folder Versions 

This section distinguishes revisions to items (or other business objects) and versions of file folders 
(referencing attachment files), as well as other background information about the Introductory 
revision, the ―Rev‖ list on items, change orders (ECO, MCO, SCO) in regard to items, and pending 
revisions. See Product Collaboration User Guide for more information about items, revisions, and 
the change control process. 

Revision and Version Defined for Agile PLM 

The words ―revision‖ and ―version‖ can be similar or synonymous in a variety of manufacturing 
contexts; here is what they mean in Agile PLM: 

Revision — an item’s state at a point in time; also, a BOM’s structure at a point in time. Revisions 
are advanced in the change control process. (Items and change control are documented in Product 
Collaboration User Guide.) 

Version — A file folder’s state at a point in time; also, an attachment file’s state as it is attached to an 
item or other business object. This latter definition was the only use in Agile 8.5 and earlier. With the 
introduction of file folders in Agile PLM, version primarily refers to how a file folder changes through 
file addition, deletion, and replacement. 

Viewing a Different Revision 

To view a different revision: 

1. If you want to see a revision that pertains to a specific manufacturing site, select that site from 
the Site drop-down list. 
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Note When you select ALL from the Site drop-down list, the default value in the Rev list is 
the latest released change for that item. 

2. Select a revision from the Rev drop-down list above the tabs. When you select a revision, the 
corresponding effectivity date is displayed. 

When you select a different revision, all the tabs display information from the selected revision. 
For example, if the BOM tab is displayed, and you switch from revision C to revision B, the other 
tabs also show revision B. 

Note Not all tabs are revision-specific; for example, the Where Used tab and the History tab 
are not revision-specific. When you view tabs that are not revision-specific, the Rev 
drop-down list is disabled. 

 

Introductory Revisions 

The initial revision of an item—that is, the revision of a newly created, unreleased item—is called 
Introductory. Introductory revisions have no changes against them, the only rev on the list that is not 
associated with a change. It is never assigned a revision letter, for when an item is in the 
Introductory stage, it is not under change control and can therefore be modified directly. 

Introductory revisions are treated the same as released revisions; they are considered to be the 
base revision by Where-used and Object searches, the Where Used tab, changes, and the Save As 
feature. All revision-specific rules that apply to ECO-created revisions also apply to the Introductory 
revision of an item. 

Introductory appears at the bottom of the Rev drop-down list because it is the earliest revision. The 
user can select the Introductory rev and control all the attributes seen on every tab of the object 
(including Attachments tab). Even after pending revisions and released revisions are created, the 
Introductory rev remains a ―baseline‖ with a single record of data about the item before any changes 
took effect. 

How the Revision List Works 

As stated above, a revision labeled Introductory in the Rev list indicates the initial revision of the 
object, with no pending changes. Once the object is listed on a change, a letter sequence of 
revisions is started. 

For released revisions, the number of the releasing ECO is displayed next to its corresponding 
revision. (Remember, an item can be revised only by an ECO.) For example, for a part, if ECO 
E54321 resulted in the release of revision C, then revision C in the Rev drop-down list reads 

 C   E54321 

A revision number or letter inside parentheses indicates that the revision is pending, not yet 
released: 

(A)  C00004 

You may see revisions in the list that are not Introductory and that do not have an assigned revision 
letter. These are referred to as blank revisions. 

Blank revisions occur when an MCO is released against an item before an ECO releases the item. 
That releasing MCO creates a blank revision, as do any subsequent changes that occur before a 
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new ECO revision is created. The Rev list displays the number of the MCO instead of a revision 
letter: 

     M00001 

MCOs and SCOs are based on item revisions, but neither can create a new revision of a part, and, 
therefore, neither has attachment capabilities. MCO and SCO modifications, which you can select in 
the Rev drop-down list, inherit the attachments of the ECO-created revision or the Introductory 
revision upon which they are based. 

The MCO or SCO number is displayed next to the corresponding revision on the Rev drop-down list. 
For example, if there is a pending MCO M12345 against Rev B of a part, then on the Rev drop-down 
list, that revision is listed as ―(B) M12345.‖ 

How Rev and Site Lists are Determined 

All revisions are shown to all users regardless of their default site or site access. However, when 
you open an item, the Rev drop-down list is set to the last change for your default site. 

An item’s default revision shown is based on your default site. Even if you select a different site 
from the Site drop-down list, the default revision still reflects what you see from your default site. 

Samples of Rev Lists with ECO, MCO, and SCO 

Given the following list of revisions on the Rev drop-down list of an item that was initially released as 
an ECO, the second column describes the attachment capability of each revision.  

Rev  l i s t  ent ry  At tachment  capabi l i t ies  

(c) ECO -356 Yes, has attachment capabilities, because it is a pending ECO-created Rev. 

B     SCO-444 No attachment capabilities; it is based on Rev B and inherits Rev B’s attachments. 

B     ECO-233 Yes, has attachment capabilities, because it is an ECO-created Rev. 

A     MCO-888 No attachment capabilities; it is based on Rev A and inherits Rev A’s attachments. 

A     ECO-222 Yes, has attachment capabilities, because it is an ECO-created Rev. 

INTRODUCTORY Yes, has attachment capabilities, because it is an introductory revision. Introductory 
revisions have the same features as an ECO-created revision. 

In the case of an item initially released by an MCO to create a blank revision: 

Rev  l i s t  ent ry  At tachment  capabi l i t ies  

(B)  MCO-934 No attachment capabilities; pending MCO based on Rev B and inherits Rev B’s 
attachments. 

B     ECO-572 Has attachment capabilities, because it is an ECO-created Rev. 

A     SCO-444 No attachment capabilities; it is based on Rev A and inherits Rev A’s attachments. 

A     MCO-788 No attachment capabilities; it is based on Rev A and inherits Rev A’s attachments. 

A     ECO-333 Has attachment capabilities, because it is an ECO-created Rev. 
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Rev  l i s t  ent ry  At tachment  capabi l i t ies  

       MCO-766 No attachment capabilities; it is based on the Introductory revision and inherits the 
Introductory revision’s attachments. 

INTRODUCTORY Has attachment capabilities, because it is an introductory revision. Introductory 
revisions have the same features as an ECO-created revision. 

 
 

Working with Pending Revisions 

You can create a pending revision of an item. When you create an ECO against an item, the ECO 
creates a pending revision of that item. Pending revisions let you incorporate (lock) attached files 
into the item. When the preliminary ECO affecting the item is released, the attached files stay with 
the new revision of the item and are incorporated (unless your Agile administrator has opted to alter 
this behavior). 

A pending revision is identified by parentheses around the revision number in the Rev field, for 
example, (A). 

The pending revision is always based on the latest released revision of the item. If there is an 
existing pending revision —the item is already on the Affected Items tab of an unreleased change 
order—and you choose to add the item anyway, the pending revision associated with your change 
order is based on the latest released revision, not the existing pending revision. So, if ECO-1 has an 
existing pending rev on Part 123, and ECO2 is created by SaveAs of ECO-1, then ECO-2 pending 
rev does not reflect any ECO-1 pending rev BOM redlines, manufacturer redlines, attachment 
redlines, or attachment additions/deletions made to ECO-1 pending rev. 

Attachments on Pending Revisions 

By default, when a pending revision is created, it inherits whatever files are attached to the current 
default revision. If any files are then either added to or removed from the current default revision, 
those modifications are not reflected on the Attachments tab of the pending revision. 

The administrator sets your system to either allow or disallow attachments to be copied to a new 
pending revision. 

Effects of CopyFilesToRev SmartRule 

The CopyFilesToRev (Copy Files to Rev) SmartRule setting determines how pending revision item 
attachments are created or referenced. The Agile administrator sets the Agile PLM system to either 
copy, copy with warning, reference, reference with warning or disallow the list of attachments to be 
copied to a new pending revision. 

When you add an item to the Affected Items table of a pending ECO, you create a pending revision 
of an item. Depending on the Agile PLM Copy Files to Rev SmartRule setting, pending revision 
attachments are processed as followed: 

 Copy - For the item's new pending revision, Agile creates a new file folder and creates a new 
copy of the attachment file, which is placed in the new file folder. 

 Reference - Agile uses the existing file folder and creates a new reference to it on the item's new 
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pending revision Attachments tab. 

 Disallow - The new item pending revision is created with no attachments. 

 Copy with Warning - The same as the Copy setting, with the option of choosing no attachments 
for the new pending revision. 

When you add items to the pending ECO, you are presented with a warning dialog that 
includes a row for each item you are adding.  

 To add the item and to copy the attachments, check both the Add checkbox and the 
Attachments checkbox.  

 To add the item with no attachments, check only the Add checkbox. 

 Reference with Warning - The same as the Reference setting, with the option of choosing no 
attachments for the new pending revision. 

When you add items to the pending ECO, you are presented with a warning dialog that 
includes a row for each item you are adding.  

 To add the item and to reference the existing attachments, check both the Add checkbox 
and the Attachments checkbox.  

 To add the item with no attachments, check only the Add checkbox. 

When this SmartRule is set to Reference or Reference with Warning, if there are multiple versions of 
any attachment file, only the reference to the latest version is used for the new reference on the 
pending revision. 

For example, if you create an ECO against Part 456, Rev C (thus creating a pending Rev D), all the 
attachment files that are attached to Rev C are also attached to pending Rev D. (The file and file 
folder references on the Attachments tab of released Rev C are duplicated on the Attachments tab of 
pending Rev D.) Any attachment files that are added to the Attachments tab of Rev C, or any other 
Rev C Attachments tab modifications (for example, modifying the file folder version numbers) after 
the creation of the ECO are not copied to pending Rev D. 

Note Attachment files that are added to the Introductory revision after the object is associated 
with a change (that will result in released Rev A) will not be copied to subsequent revs. 
This SmartRule does not affect MCO or SCO revisions because MCOs and SCOs do not 
create separate new revisions.  

 

Availability of Attachment Operations 

Certain situations affect access to attachment operations. If operations are disabled, check for the 
following: 

 Are you looking at the desired version of the attachment? Always check the number in the 
Version column to ensure you are looking at the latest version, or other specific version you may 
want to revise. 

 Are you viewing an item MCO revision? Attachment operations are not available on MCO 
revisions. 

For more information about item revisions and attachment capabilities, see Samples of Rev 

Lists with ECO, MCO, and SCO on page 285. 
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 Have you been granted sufficient privileges? Check with your Agile administrator. You may be 
granted certain privileges for some files but not for others. 

 Is the item released? Your privileges may allow you to modify the attachments of an 
unreleased item, however, you may not have sufficient privileges to modify the attachments of 
a released item. Check with your Agile administrator. 

 Is the item revision incorporated? You cannot modify the attachments of an incorporated 
revision. 

More specifically, once an item revision is incorporated, that revision’s attachments cannot be 
checked out from the item Attachments tab. (If you select an unincorporated revision of the item, 
including pending revisions, you can check out from the item Attachments tab.) However, you 
can still check out or check in the associated attachment files in the file folder. Modifications to 
the file folder (adding, removing, or editing the attachment file) will not affect the incorporated 
item revision’s attachment, since the version of folder (holding the attachment) is fixed when 
the item’s revision is incorporated; while modifications to the file folder will bring about a new 
version number upon checkin. 

For more information about items, incorporation, and changes (for example, ECOs and MCOs), see 
the Product Collaboration User Guide. 

See also: Adding Files by using SaveAs to Create a New Business Object on page 277. 

Viewing and Redlining Attachment Files in the AutoVue 

for Agile Viewer 

With appropriate privileges, you can view attachment files in AutoVue for Agile, redline them, and 
print them with datestamps, timestamps, and other banner and watermark information. 

For more information about working with AutoVue for Agile, see Viewer Supplement. 

To view a file using the AutoVue for Agile, starting from Java Client: 

1. Display the Attachments tab of the object. 

2. Select one or more rows in the files or attachments table. 

3. Click the View button . The attachment file opens in AutoVue for Agile. 

To view a file using the AutoVue for Agile in Web Client: 

1. Display the Attachments tab of the object. 

2. Click the name of a file. 

When you click the filename link, the results are as follows: 

 If the file folder holds a single file, and the file is viewable with AutoVue for Agile, the 
attachment file opens in the viewer. 

 If the file folder holds a single file, and the file is not viewable with AutoVue for Agile, the 
attachment file opens in the native application, if it is installed on your computer, provided 
you are using Advanced File Productivity tools. For more information, see Using the 

Advanced File Uploader on page 272. 
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 If the file folder holds multiple files, and at least one of the files is viewable with Viewer, the 
viewable file opens in the viewer. If multiple files are viewable, they are all opened in one 
Viewer window; use Viewer menu selection View > Multicontent to select another file to 
view. 

 If the file folder holds multiple files, and none of the files are viewable with AutoVue for 

Agile, the filename is not a link. Click the Get button  to get a copy of the file. 
 

Redlining or Marking Up Files in AutoVue for Agile 

With AutoVue for Agile, you can add redline layers or ―markup files‖ to attachment files that are 
referenced by Agile items. To redline or mark up attachment files associated with an item, that item 
must be on the Affected Items tab of an ECO. From the ECO, you click the Redline Attachments tab, 
open the attachment files, and mark up or redline using AutoVue for Agile. 

Note For more information about ECO redlining and ad hoc file folder redlining, see Viewer 
Supplement. 

Attachment files can be redlined in two ways: 

 Use an engineering change order (ECO). You cannot use the other routable objects to redline 
files. 

See Marking Up or Redlining Attachment Files from an ECO on page 289. 

 ―Ad hoc redlining‖ can be done from the Files tab of a file folder that holds the object. 

See Ad Hoc Redlining or Marking Up of Attachment Files from the File Folder (on page 323). 

Attachment-file redlines follow these rules: 

 You must have appropriate privileges to redline attachment files. 

 Only the file folders referenced by parts and documents can be ECO-redlined. 

 Multiple users may redline a file at the same time. If that happens, Agile saves the redlines 
from the first user and closes the file. When the other users attempt to save their redlines, they 
see a warning message and can save the redlines to a different location. 

 Each user can redline in a different color. 

 For a specific file, for example, FILEA.txt, ECO-created redlines and ad hoc file folder redlines 
are separate from each other. To view ECO-created redlines, you must open the ECO object or 
the affected item object; ad hoc file folder redlines are not visible via the ECO. To view ad hoc 
file folder redlines, you must open the file folder object; ECO-created redlines are not visible via 
the file folder object. 

 

Marking Up or Redlining Attachment Files from an ECO 

One method to mark up or redline an attachment file is to create a change order for an item with an 
attachment, and approach the attachment via the Redline Folders tab of the change. 
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Note When redlining an attachment through an ECO, the pending revision attachment Folder 
Version must be set to a specific version number; if the Folder Version is set to LATEST-x, 
you will not be able to create redline markups. However, you can edit the Folder Version 
on the Attachments tab of the pending revision so that it refers to a specific Folder 
Version. 

For example, if the pending revision of the item refers to Folder Version LATEST-7 of the file folder, 

select that row on the Attachments tab, click the Edit  button and use the Folder Version drop-down 
list in the Edit dialog box to select 7. Click OK to complete the edit process. You will now be able to 
create redline markups for that attachment. Select the added item on the Affected Items tab of the 
ECO. 

To mark up or redline an attachment file from an ECO in Java Client: 

1. If you have not already done so, add an item with an attachment to the Affected Items tab of an 
unreleased ECO. The item now has a pending revision associated with the unreleased ECO. 

2. Select the added item on the Affected Items tab of the ECO. 

3. On the Redline Attachments tab, select the row containing the file you want to redline. 

4. Click the View button. 

5. When AutoVue for Agile appears, click the Markup button. (This button is available only when 
markups are allowed.) 

6. Use the tools described in the viewer online Help to redline the attachment. To view online 
Help, choose Help > Content in the menu bar. 

Note ECO markups are saved against and associated with the pending revision of the 
item. 

To mark up or redline an attachment file from an ECO in Web Client: 

1. If you have not already done so, add an item with an attachment to the Affected Items tab of an 
unreleased ECO. The item now has a pending revision associated with the unreleased ECO. 

2. On the Affected Items tab, click the Do Redlines button  next to the item to open the Redlines 
page. 

3. If the item has already been redlined, the Has Redlines button  will be displayed in the same 

column. Click either  or  to access the redlines page. 

4. On the Redline Folders tab, click the Do Redlines button (or Has Redlines button) on the row of the 
file you want to redline. (This button is available only when markups are allowed.) 

5. Use the tools described in the viewer online Help to redline the attachment. To view online 
Help, choose Help > Content in the menu bar. 

Note ECO markups are saved against and associated with the pending revision of the 
item. 

For information about redlining 3D files from a change order, and about viewing change order 
redlines on the Pending revision of the item’s Attachments tab, please see Viewer Supplement. 
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Configuring File Associations for Opening Files in Web Client 

When you are using Web Client, you can open attachment files in your browser. This feature works 
for those file formats for which you have the corresponding applications installed, and when the file 
association is set up for your browser between those applications and file formats. Web Client relies 
on the file format associations, which are set up in your operating system, to open the appropriate 
application with which to open a file. 

Your system administrator can help you determine the file format associations that need to be set 
up in your system to handle the file formats you are working with. 

Some examples of common file formats and their associations are shown in the following table: 

Fi le  fo rmat  F i le  extension   App l icat ion of ten associated  

Microsoft Word document DOC Microsoft Word for Windows 

Microsoft Excel file XLS Microsoft Excel for Windows 

JPEG graphic JPEG, JPG Default browser 

GIF graphic GIF Default browser 

HTML HTML, HTM Default browser 

PDF PDF Adobe Acrobat Reader 

For UNIX users, Web Client attempts to display the file within a new instance of the browser 
window. The file types that can be displayed depend on a number of factors, including the UNIX 
vendor and the version of Netscape Communicator that has been installed. If you have questions, 
see your system administrator for assistance. 

If you cannot view the file, you can get a copy instead (using the Get button), and view it in the file’s 
associated application. 

Generating Attachment Quick Access URLs 

Attachment URLs allow you to do the following: 

 Generate a URL for an attachment on item objects. 

 Generate a URL for a file on file folder objects. 

 Generate a URL for a file on the Content tab of Program objects. 

 Paste URLs from Agile to another application 

 Externally open files outside of the Agile application. 

You can generate attachment URLs from Items, Activities, and File Folders by two methods:  

 Using Agile PLM commands to copy a URL to your clipboard: 

Agile-Generated Attachment Quick Access URLs on page 292 

 Manually typing an Attachment Smart URL in an easy-to-understand format: 
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User-Generated Attachment Quick Access Smart URL Formats on page 292 

The URL format enables you to identify which object and files are being referenced. Because of the 
easy-to-understand format, you can generate your own URLs to point to specific file attachments 
without logging into the Agile system, if you know where the files are located. 

Agile-Generated Attachment Quick Access URLs 

From Web Client, you can only generate Attachment Quick Access URLs from the Attachments tab 
of any object, the Content tab of Activities, and Files tab File Folders by clicking Get Shortcut after 
performing one of the following scenarios: 

 Selecting only one row from the Attachments, Content, or Files tab to generate a URL that points 
to the folder corresponding to the file on that row. 

 Selecting all the rows on the Attachments, Content, or Files tab to generate a URL that points to 
the collection of files on the tab. 

Note You must have Read privileges for an object in order to generate a URL for the object. 

Caution If you select more than one row on the Attachments, Content, or Files tab, the Get 
Shortcut link is disabled. 

The URL is copied to your clip board. You can then paste it into another application or file, such as 
a word processing file, a spreadsheet file, or an email. 

User-Generated Attachment Quick Access Smart URL Formats 

With the easy-to-understand Smart URL format, you can generate your own URLs to point to 
specific file attachments without logging into the Agile system, if you know where the files are 
located.  

The formats of user-generated attachment Smart URLs depend on the object type, and fall into 
three main categories: 

 Item Attachment Quick Access URL Formats (on page 292) 

 File Folders Quick Access URL Formats (on page 294) 

 Program Content Quick Access URL Formats (on page 295) 
 

Item Attachment Quick Access Smart URL Formats 

You can generate Smart URLs for item attachments in the following format: 

http://<server:port>/<VirtualPath>/link/<ObjectType>/<ObjectNumber>[/Re

vision/ChangeNumber]/files/Folder/<FolderNumber>[/<FileAction>] 

or 

http://<server:port>/<VirtualPath>/link/<ObjectType>/<ObjectNumber>[/Re
vision/ChangeNumber]/files/<FileName>[/<FileAction>] 

where 
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<Server:Port> /<Vi rtual  Path>  
e lement  

Ident i f ies  the  Ag i le  instance  

link The text "link" identifies the URL as a special attachment URL to the 
Agile server. 

ObjectType Refers to the subclass of the Item, File Folder, or Program/Activity. 

ObjectNumber Refers to the actual object number for the object type. 

Revision Identifies an item revision by specifying the change number 
corresponding to that revision. 

ChangeNumber Identifies a unique revision (Released or Pending) of the item. If the 
number is not specified, the latest released revision is attached. If the 
number is not specified and the item does not have a released 
change, the Introductory revision is attached. 

Folder Indicates that the object is a file folder, not the actual file. 

FolderNumber Identifies the file folder related to the selected row. The version of the 
file retrieved is the most current version, based on the specific 
revision of the item.  

FileName Refers to the name of the specific file attached to the specified 
revision of the item. 

FileAction Determines the action performed with the retrieved files. Values are 
GET or VIEW. If FileAction is not specified, a GET is performed. 

If the parameters specified in the URL point to a single file, the file is 
retrieved in its native format. If the parameters specified in the URL 
point to a collection of files, then all the files are returned as a zipped 
file called "Download.zip".  

If the specific revision of an item has multiple files contained in the same folder on the Attachments 
tab, but is referenced from different versions of the folder, then a Folder-based URL may not reflect 
the actual set of attachments from the item revision’s Attachments tab. 

Examples of user-generated URLs for item attachments: 

 http://myappserver/mycompany/Link/Document/DOC0001/files/Folder/Folder001 

Returns a zipped file containing all files from Folder001 that are attached to the latest released 
revisions of DOC0001. 

 http://myappserver/mycompany/Link/Document/DOC0001/files/Folder/Folder001/VIEW 

Opens all files from FOLDER001 that are attached to the latest released revision of DOC0001 
in AutoVue for Agile. 

Limitations for Item Object Attachment Quick Access Smart URLs 

The following limitations apply to retrieving the attached files of item objects: 

 In the case where a specific revision of an item has multiple files on its Attachments tab that 
belong to the same folder, but are referenced from different versions of the folder, a folder-
based URL may not reflect the true set of attachments from that item+revision's Attachments tab. 
For example, consider an item P0001, whose revision A has two attachments: 

http://myappserver/mycompany/Link/Document/DOC0001/files/Folder/Folder001
http://myappserver/mycompany/Link/Document/DOC0001/files/Folder/Folder001/VIEW


 

 

294 Agile Product Lifecycle Management 

  

P0001_3dmodel.dwg and P0001_specs.pdf, both in Folder1. Assume that the DWG file is from 
version 2 of the file folder, and the PDF file is from version 5 of the file folder. In this case, the 
following URL: 

http://server:port/<VirtualPath>/link/Part/P0001/Revision/C0001/files/Folder/Folder1 

returns all the files contained in either version 5 or version 2 (results are not predictable) of 
Folder1.  

However, the following URL: 

http://server:port/<VirtualPath>/link/Part/P0001/Revision/C0001/files/ALL 

returns the complete set of files belonging to revision A of the item, including 
P0001_3dmodel.dwg from version 2 of Folder1 and P0001_specs.pdf from version 5 of 
Folder1. 

 You cannot generate an item-based URL that will return a file from a historical version of a file 
folder referenced on an item's attachments tab. The user can, however, generate a folder-
based URL to achieve this. 

 In case of the following format example, 

http://server:port/<VirtualPath>/link/ObjectType/ObjectNumber[/Rev/ChangeNumber]/files/
FileName[/FileAction] 

If two files of the same name (filename + file extension) exist on the attachments table, and a 
user generate a URL using filename, only the first encountered file is retrieved. If the "ALL" 
option is used to access files from the Attachments tab of an item where there are multiple files 
by the same name on the attachments table, or if a URL is generated to return all the files of a 
file folder where there are more than one file with the same name, an error is displayed 
indicating that there are multiple files by the same name and therefore a valid zip archive of 
files cannot be generated.  

 If the ALL option is used to access files from a Program's Content tab where multiple files with 
the same name exist, an error is displayed indicating that there are multiple files by the same 
name and therefore a valid zip archive of files cannot be generated. 

 

File Folders Quick Access Smart URL Formats 

You can generate Smart URLs for file folders in the following format: 

http://<server:port>/<VirtualPath>/link/<ObjectType>/<ObjectNumber>/fil

es/<FileName>[/</version][/<FileAction>] 

where 

<Server:Port> /<Vi rtual  Path>  
e lement  

Ident i f ies  the  Ag i le  instance  

link The text "link" identifies the URL as a special attachment URL to the 
Agile server. 

version Identifies the specific version of the file folder. The value can be a 
number, or the string, LATEST (default). 

FileName Refers to the name of the specific file from the folder or string ALL 
which attaches all the files in the specified version of the folder. 

If more than one file of the same name exists in a specific version of a 

http://server:port/%3cVirtualPath%3e/link/Part/P0001/Revision/C0001/files/Folder/Folder1
http://server:port/%3cVirtualPath%3e/link/Part/P0001/Revision/C0001/files/ALL
http://server:port/%3cVirtualPath%3e/link/ObjectType/ObjectNumber%5b/Rev/ChangeNumber%5d/files/FileName%5b/FileAction
http://server:port/%3cVirtualPath%3e/link/ObjectType/ObjectNumber%5b/Rev/ChangeNumber%5d/files/FileName%5b/FileAction
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folder and a URL is generated based on filename, only the first version 
of the file is attached. You cannot use the ALL value to access files 
from a folder where more than one file of the same name exists. 

FileAction Determines the action performed with the retrieved files. Values are 
GET or VIEW. If fileaction is not specified, a GET is performed. 

If the parameters specified in the URL point to a single file, the file is 
retrieved in its native format. If the parameters specified in the URL 
point to a collection of files, then all the files are returned as a zipped 
file called "Download.zip".  

Examples of user-generated URLs for file folder attachments: 

 http://myappserver/mycompany/Link/FileFolder/Folder0001/files/abc.txt/1 

Gets the abc.txt file from version 1 of Folder0001. 

 http://myappserver/mycompany/Link/FileFolder/Folder0001/files/ALL/VIEW 

Opens all files from the latest version of FOLDER001 in AutoVue for Agile. 

Program Content Quick Access Smart URL Formats 

You can generate Smart URLs for files on the Content tab of Programs and Activities. The Content 
tab allows specification of any object as valid content and allows the addition of external files, just 
like the Attachments tab. However, the Content tab stores the folder object related to an attached file 
as valid content. So, when retrieving, you must attach the entire folder. 

The Smart URL for files on the Content tab is generated in the following format: 

http://<server:port>/<VirtualPath>/link/<ObjectType>/<ObjectNumber>/con
tent/Folder/<FolderNumber>[/<FileAction>] 

where 

ObjectType Represents the subclass of the Program object. 

ObjectNumber Represents the identifier of the Program object. 

Content Indicates the Content tab. 

Folder Indicates that a specific folder is being retrieved. 

FolderNumber Refers to the number of the folder being retrieved from the Content tab. The most 
current version of the folder is always retrieved. 

FileAction Determines the action performed with the retrieved files. Values are GET or VIEW. 
If fileaction is not specified, a GET is performed. 

If the parameters specified in the URL point to a single file, the file is retrieved in its 
native format. If the parameters specified in the URL point to a collection of files, 
then all the files are returned as a zipped file called "Download.zip". 

 
 

Accessing Attachment Files using Quick Access URLs 

After clicking or opening an Attachment Quick Access URL, a login popup appears and you must 

http://myappserver/mycompany/Link/FileFolder/Folder0001/files/abc.txt/1
http://myappserver/mycompany/Link/FileFolder/Folder0001/files/ALL/VIEW
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log into the Agile system to view the attachment. Agile PLM then validates that you have the 
appropriate privileges to get or view the file or set of files specified in the URL. The attachments are 
viewable in all supported browsers, AutoVue for Agile, or the native application. 

For example: 

1. In an email, the user clicks the Attachment Quick Access URL and an Agile login popup is 
displayed. 

2. The user enters her login information. 

Agile PLM verifies that the user has the appropriate privileges to read and view the file. 

Note If the URL returns a collection of files and the user does not have the appropriate Get or 
View privilege for one or more files, those files are excluded from the returned collection. 
However, a collection of files is returned to the user containing the rest of the files for 
which he does have the appropriate Get or View privileges. 

 

Scan Utility 

The Scan utility lets you scan drawings and documents for use in Agile. After the scanned image file 
is created, it is referenced by a file folder, which can be attached to a business object. The name 
and description that you give the image appears on the Attachments tab of any object that points to 
that file folder. The Scan utility is accessed by choosing File > Scan Files or by selecting Add > By 
Scan on either the business object’s Attachments tab or the Files tab of file folders. 

Agile PLM uses the application TWAINER (twainer.exe) installed on an appropriate scanner to 
perform its scan function. Scan runs smoothly with or without a Kofax driver installed. You must 
install a Twain-driver–driven scanner, such as CanoScan N650U/N656U. Agile’s TWAINER reads 
data from a standard TWAIN data source. 

Kofax VRS is an electronic checkpoint for scanned images, working with its certified scanners and 
connection interfaces. If Kofax VRS is associated with such a scanner, like CanoScan 
N650U/N656U with TWAIN driver installed and USB connection, then it's a candidate for 
TWAINER’s data source. 

Scan supports all objects that can be created in Agile PLM. Scan does not require any roles or 
privileges. However, your Discover, Read, and Modify privileges may affect Scan. 

Installing a Scanner 

To install a scanner on your machine: 

1. Connect the scanner to the computer and install the scanner. 

2. Install Kofax driver. 

3. Go to Start > Settings > Control Panel > Scanners and Cameras. 

4. Double-click KSM (32-bit) to start the Kofax Source Manager wizard. 

5. Click Next. Remove all configured sources. 

6. Create a new source. In Source Properties dialog, define Source Name and Source Type as 
follows: 
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Source Name: Canon 

Source Type: TWAIN scanning 

7. In Select TWAIN Source dialog, select Canon CanoScan N650U/N656U. 

8. Click Finish. 
 

Using the Scan Utility 

The following is a general sequence for using the Scan utility. 

1. From an object’s Attachments tab, select Add > By Scan . 

Note You can also select File > Scan File  in the Java Client main menu. 

2. Java Client creates the twainer.exe file in %USERPROFILE%\.AgileCM\twainer.exe. 

Java Client is suspended while twainer.exe completes its execution. 

3. Twainer.exe retrieves a list of the TWAIN supporting devices on the client machine and 
displays the Select Source dialog showing available TWAIN devices. 

4. Select one of the devices, and twainer.exe displays the TWAIN user interface for that device. 

5. You can scan your images or documents and exit the user interface. Any scanned files are 
stored by twainer.exe in a temp directory. 

6. Twainer.exe write status and scan information to its standard output stream and terminates. 
Java Client is reactivated and reads the status information. 

7. Java Client converts images from the TWAIN standard BMP format to PNG and adds the 
scanned files as an attachment file to the file folder. If an error occurred, Java Client displays 
an appropriate error message. 

8. Java Client deletes all temporary scanned files and also deletes the twainer.exe program after 
logging off Java Client. 
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Chapter 10 

Working with File Folders 

This chapter includes the following: 

 What are File Folders? ........................................................................................................................................ 299 
 Working with File Folders .................................................................................................................................... 301 
 File Folder Tabs, Buttons and Menus .................................................................................................................. 301 
 Switching Between Versions ............................................................................................................................... 310 
 Printing Contents of File Folders ......................................................................................................................... 310 
 Creating File Folders ........................................................................................................................................... 311 
 Adding Attachment Files and URLs to File Folders ............................................................................................. 311 
 Deleting Attachment Files and URLs from File Folders ....................................................................................... 316 
 Purging Unused File Folder Versions .................................................................................................................. 317 
 Getting and Revising Attachment Files and File Folders ..................................................................................... 318 
 Other File Folder Operations ............................................................................................................................... 324 

 
 

What are File Folders? 

Attachment file storage and retrieval is managed automatically by your Agile PLM system. 
Attachment files are stored in the Agile File Vault and each attachment file in the vault is associated 
with a numbered Agile file folder object. The concept is similar to the way in which you would file 
and store paper documents: sort the documents into file folders, label or number the file folders, and 
store them in a filing cabinet. 

The relationships between attachments files, file folders, and business objects is explained in detail 
in: 

 Attachment Files and Agile File Folders: an Analogy to Papers, Desks, and Vaults on page 
253. 

 Agile Document Management: Even More Efficient than Doris on page 254. 
 

Why Use and Modify File Folders Directly? 

If you have the appropriate privileges, you can perform file maintenance actions on file folder 
objects directly. Updating and maintaining documents from the file folder object is useful when 
those documents are attached to many different business objects. 

For example, you can update and maintain a document that describes a company-wide procedure 
by checking out and checking in the associated file folder object. The procedure document (and its 
associated file folder) may appear on the attachments table on the Attachments tabs of many Agile 
business objects, but you do not need to open each of those business objects in order to update the 
procedure attachment. 

File folders can be managed and updated independently of other objects in the database. All 
attachment files are stored in the file vault, part of Agile File Manager. 
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Examples of file folder content are: 

 Drawing files such as CAD drawings or scanned image files in viewable formats 

 Web-based information in the form of URLs 

 Specifications and other documents 

 Non-viewable files, compressed (ZIP) files, and so on 

It is generally a best practice to limit each file folder to a single, attachable file or URL; however, file 
folders can contain any number of files and URLs. 

Advantages of File Folders 

The file folder object was developed to manage documents and URLs that support your company’s 
manufacturing, production, or specification processes. These are some specific advantages of file 
folder objects: 

 You can create, modify, or delete file folders. Like any other object in Agile, you can search for 
file folders and bookmark them. 

 You can view, redline, and print files from the file folder. 

 You can search for file folders by file folder attributes, including Filename or File Type, 
regardless of what business objects the file folders may be attached to. 

For more information about searching for attachment content, see Full Text Search for Content 

in Attachment Files on page 154. 

 File folders can be sent to reviewers for approval without using the change control process. 
You can track who has received, reviewed, and accepted or rejected file folder content files. 

 Files that are referenced in a file folder are subject to version control. On the Attachments tab, in 
the Folder Version field, if you edit the row and select Latest Version, the object always 
references the latest version of the file folder, even when the item’s revision changes. 

 File folders can be created by users manually as well as automatically. A file folder is created 
automatically when you attach a file or URL to an object; the file folder is generated, and it is 
already associated with the object. Now that the file folder exists, it can be associated with 
other objects. 

It may be useful to create a file folder object manually, for instance, when specifications and 
related design and drawing files are brought together before the part objects (that they 
describe) have been created in the Agile system. These are later associated with any object in 
Agile on each object’s Attachments tab. 

 With appropriate roles and privileges, files (2D and 3D) can be redlined from the Files tab of file 
folder object. 

See Viewing and Redlining Attachment Files in the AutoVue for Agile Viewer on page 288. 
There is additional information about marking up and redlining attachment files in the Viewer 
Supplement. 
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Working with File Folders 

The next sections describe tabs, buttons, actions, fields, and other user-interface elements that you 
encounter in your work with file folders. 

 A file folder’s Files tab lists files and URLs, and you can add and remove files and URLs in the 
file folder. You can check out and check in file folders from here and then get and edit single or 
multiple attachment files. See Working with the Files Tab of File Folders on page 306. 

 A file folder’s Where Used tab is populated automatically with a link to any business object that 
references the file folder on the object’s Attachments tab. 

 

File Folder Tabs, Buttons and Menus 

File folders are listed in a window (Java Client) or page (Web Client) with the following elements: 

 Tabs on file folder objects include Title Block, Files, Routing Slip, Relationships, Where Used, and 
History. The contents and operations of the Files tab are described in Working with the Files 

Tab of File Folders on page 306. 

The contents and operations of the Attachments tab of objects that reference file folders are 
described in Working with the Attachments Tab of Business Objects on page 257. 

 Buttons on the main toolbar of file folder objects in both clients are CheckOut, CheckIn, Cancel 
CheckOut. 

 Java Client buttons also include Approve, Reject, and Comment. 

Additional buttons in Java Client are Send, Print, Delete, Comment, and Add Bookmark. A final 
button, More, is a drop-down menu offering these functions: Subscribe, SaveAs, Sharing, 
Process Extensions, Mass Update, and Get All Files. 

 For Web Client, the Approve and Reject buttons are visible when you are listed as an 
approver or observer of the selected version.  

Checkout, Checkin, and Cancel Checkout are described in Getting and Revising Attachment 

Files and File Folders on page 318. Approve, Reject, and Comment are described in Routing 

and Reviewing File Folders on page 325. Subscription and sharing are discussed in Chapter 5, 
―Working with Business Objects.‖ Mass update is covered in Performing a Mass Update of a 

File Folder on page 324. 

 Drop-down menus include: 

 The Version list shows the number of times a file has been checked out and checked back 
in, unless it was modified. By default, the most recent version is shown, but you can select 
an earlier version. Each time an attachment file is checked out and modified, a new 
version is created. 

If the most recent version is a checked out version, the version number is enclosed in 
brackets, for example, [4]. 

 The Actions drop-down menu in Web Client offers these actions to perform on the object: 
Bookmark, Subscribe, Save As, Delete, Print, Purge Folder Version, Version Browser, Copy URL to 
Clipboard, Get All Files, Mass Update, Print, Send, Sharing, or Comment. Any existing process 
extensions are also listed. 
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The Actions shortcut menu in Java Client opens when you right-click anywhere on the file 
folder object. It offers these actions to perform on the attachment: Cut, Copy, Paste, Add 
Bookmark, Subscribe, Save As, Delete, Print, Send, Sharing, Process Extensions, Mass Update, Get 
All Files, Check Out, Check In, and Cancel Check Out. 

File Folder Tabs 

File folders include the following tabs. Some tabs may not be visible in your Agile system, 
depending on how your Agile administrator has configured Agile PLM. 

This table lists the tabs found on all file folder objects, with file folder–specific definitions. 

Tab  Descript ion  

Title Block Provides general information about the file folder, such as a description, the object number, 
and the date the file folder was last modified. Your administrator may have added Page Two 
and Page Three sections (which may be named differently) that contain additional 
information—class-specific and subclass-specific, respectively. 

Files Lists all the contents of the file folder object, and it is where you add and remove files and 
URLs in the file folder. For details about the Files tab, see Working with the Files Tab 

of File Folders on page 306. 

Routing Slip Allows you to route the file folder for approval, and shows a signoff summary for the file 
folder—a record of which users have viewed and signed off on it. You can add or remove 
approvers and observers for the file folder object on this tab. 

Relationships The Relationships tab allows you to create relationships with other Agile objects and to 
create dependencies (relationships with rules) between the current file folder object and 
other routable objects.  

For more information about relationships and relationship rules, see Relationships and 
Dependencies Between Objects. 

Where Used Populated automatically with any business object that references the file folder on the 
object’s Attachments tab. To open an object listed on the tab, click its Number or Name 
link. 

History The History tab is a record of actions taken on the file folder and the users who performed 
those actions. The History tab is populated automatically. 

  
 

Where Used Tab, File Folder 

Note The File Folder object Where Used tab is version-specific and displays the where-used 
status of the currently selected version. 

When you select a different version in the Version drop-down list, the Where Used table displays 
information about the selected version only. 

The Attachments table lists all the Agile business objects where the currently selected version of the 
File Folder object is attached, that is, all the Agile business objects that have the current version of 
the File Folder object listed on their Attachments tab. 
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Buttons on the Files Tab 

You need the appropriate privileges to add or remove files on the Files tab. The buttons on the Files 
tab are enabled or disabled, depending on your privileges and administrative settings. File 

Validation (Handle File Checksum) on page 326 addresses some of these dependencies. If you 
have questions about your privileges, contact your Agile administrator. 

The buttons described in the following tables are available to users with the required privileges on 
Agile object pages. Many of the operations in this and subsequent tables are elaborated on later in 
this chapter. 

Buttons on Files tab in Java Client 

Button  Name  Descript ion  

    
Get 
Files 

Places copies of the files in the location of your choice. Click the drop-down arrow 
and select Get files from selected attachments or Batch Get all files from this 
object. These copies are in native application formats. 

Select the rows you want, then click the Get Files from Selected Attachments 
button to place a copy of the selected files in the directory folder or location of your 
choice. These copies are in native application formats. 

Or 

Click the button and select Batch Get All Files from this Object to place a copy of 
all the file folder’s files in the folder or location of your choice. These copies are in 
native application formats.  

 If you selected more than one file, you are prompted to choose whether or not a 
ZIP file containing the selected files is created and placed in the folder or location 
of your choice.  

 If you choose to create a ZIP file, you can fill in a ZIP filename; if you choose no 
ZIP file, the individual files are placed in the specified location. 

   
Open 
Files 

With a file or files selected, opens the file(s) in its native application, if possible. 

   
Print 
Files 

With a file or files selected, prints the corresponding files. The Viewer is started in a 
separate browser window and begins the printing process. 
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Button  Name  Descript ion  

   
View 
Files 

Click the View Files button to view the selected files in the Viewer. 

Or, click the View Files button’s drop-down arrow and select from the menu: 

 View – view the files in the Viewer.  

 Cross Probe – crossprobe between PCB and layout ECAD files. (For more 
information, see Viewer Supplement.)  

 Compare – visually compare two files in a third compare viewer window.  

 Overlay – lets you lay other files over the current active file. (For more 
information, see Viewer Supplement.) 

 Digital Mockup – mockup designs from disparate MCAD and ECAD systems in 
a virtual workspace. Loads the selected files into the same workspace in the 
Viewer, where you can manipulate them. (For more information, see Viewer 
Supplement.) 

 By Search – find other files in the system, which you may want to (select from 
menu) cross probe, compare, overlay, or digital mockup (see above), without 
having to select two files from the same folder; that is, you could search and 
select one file in file-folder A and another file in file-folder B. You can search for 
file folder objects or for any other object type with attachments. 

   
Edit Modify the File Description field of the selected file or files, and any other editable, 

custom fields that your administrator has defined. The Edit button is disabled if the 
file folder is checked in. 

  

 

  

 

  

Add 
Files 

 

 

Add 
URL 

 

Add 
Scan 

Click the Add drop-down menu button to add to the Files tab. It can be a file, URL, 
or you can scan a document to create an attachment.  

Click the Add button to open the File Uploader.  

Or, click the Add button’s drop-down arrow and select from the menu: 

  Files – displays the File Uploader dialog, which allows you to drag and drop 
the files you want to attach. You can also click Browse for Files button to 
browse your computer or network for the files you want. To add multiple files as a 
single file folder, click the Add all files to a single file folder button. If you select 
the UnZip all zipped files upon upload checkbox, the ZIP file is unzipped and 

the contents are added as individual files.  

Note Selecting the UnZip checkbox is not recommended for very large files. 

  URLs – brings up the Add URLs dialog 

  By Scan – permit direct access to a file you want to scan. (Windows only, 
Java Client only) Runs a Windows application that scans documents using a 
TWAIN interface. The resulting images are added as file types that are specified 
by the user using Agile Scan; see Scan Utility on page 296. 

   
Replace 
Files 

Replaces a file that has been revised (the file folder object must be checked out). 
Click Replace to remove the file and add a new version of the file, then check the 
folder in. 



 

 

9.2.2.6 305  

  

Button  Name  Descript ion  

   
Remove Removes all selected files from the Files tab (the file folder object must be checked 

out). The Remove button is disabled if the file folder is checked in. 

     
Handle 
File 
Checks
um 
Error 

Shows whether files have been modified directly in the file server vault. For more 
information, see File Validation (Handle File Checksum) on page 326. 

Buttons on Files tab in Web Client 

Button  Name  Descript ion  

   Get The Get button places copies of the selected, referenced files in a location of 
your choice.  

The method used depends on your File Productivity Preference. See Setting 

your File Productivity Preference on page 314. 

These copies are in native application formats. If you select more than one file, a 
ZIP file containing the selected files is created and placed in the folder or location 
of your choice. 

 

     View Click the View Files button to view the selected files in the Viewer. 

Or, click the View Files button’s drop-down arrow and select from the menu: 

  View – view the files in the Viewer. 

  Cross Probe – crossprobe between PCB and layout ECAD files. (For 
more information, see Viewer Supplement.) 

  Compare – visually compare two files in a third compare viewer window. 

  Overlay – lets you lay other files over the current active file. (For more 
information, see Viewer Supplement.) 

  Digital Mockup – mockup designs from disparate MCAD and ECAD 
systems in a virtual workspace. Loads the selected files into the same 
workspace in the Viewer, where you can manipulate them. (For more 
information, see Viewer Supplement.) 

  By Search – find other files in the system, which you may want to (select 
from menu) cross probe, compare, overlay, or digital mockup (see above), 
without having to select two files from the same folder; that is, you could 
search and select one file in file-folder A and another file in file-folder B 

   
Print  With a file or files selected, prints the corresponding files. The Viewer is started in 

a separate browser window and begins the printing process. 

   
Edit Click the Edit button to modify the File Description field of the selected file, and 

any other editable, custom fields that your administrator has defined. The Edit 
button is disabled if the file folder is checked in. 
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Button  Name  Descript ion  

   Remove Removes all selected files from the Files tab (the file folder object must be 
checked out). The Remove button is disabled if the file folder is checked in. 

 Add  Click the Add drop-down button to add a folder reference to the object. It can be 
a file or a URL. This button is disabled when the file folder is checked in. 

Click the Add button to open the File Uploader.  

Or, click the Add button’s drop-down arrow and select from the menu: 

 Files – if you are using File Productivity tools, displays the File Uploader 
dialog, which allows you to drag and drop the files you want to attach. You 
can also click Browse for Files button to browse your computer or network 
for the files you want. To add multiple files as a single file folder, click the Add 
all files to a single file folder button. If you select the UnZip all zipped files 
upon upload checkbox, the ZIP file is unzipped and the contents are added 
as individual files. 

 Files – (no File Productivity tools) displays the Add File dialog, which allows 
you to browse for up to five files, add the files to a single file folder, and unzip 
zipped files. 

Note Selecting the UnZip checkbox is not recommended for very large files. 

For more information about File Productivity tools, see Using the Advanced 

File Uploader on page 312. 

Note Either Advanced File Uploader or Standard File Uploader will be used 
depending on your user profile File Productivity Preference setting. For 
more information see Setting your File Productivity Preference on 
page 314. 

Note URLs – brings up the Add URLs dialog 

 

 
 

Working with the Files Tab of File Folders 

You can use the Files tab of file folders to: 

 Add files and URLs to the file folder 

 Delete files or URLs from the file folder 

 ―Get‖ a copy of an attachment file (but not revise it) 

 With the file folder checked out, get a file for revision, then replace the version of the file 

 Print files 

 View and redline an attachment file 

 Open a file without being prompted to download it (Java Client only). 



 

 

9.2.2.6 307  

  

To display the Files tab of a file folder: 

1. Open a file folder. (You may wish to use a Quick Search for FOLDER*.) 

 In Web Client, click the folder number in the Attachments tab to open the folder object. 

 In Java Client, double-click the folder number on the Attachments tab to open the folder 
object. 

2. Click the Files tab to display the contents of the file folder. 

To open a file or files in a file folder in Java Client: 

1. On the Files tab of the folder, select the file or files you want to open. 

2. Click the Open Files button . The attachment file opens in its native application, if possible. 

To open a file or files in a file folder in Web Client: 

1. On the Files tab of the folder, click the filename of the file or files you want to open. 

2. If the file is a supported file format (see Agile PLM Administrator Guide for a list of supported 
file formats), the file opens in AutoVue for Agile. With the appropriate privileges, you can use all 
viewer features, as described in Viewing and Redlining Attachment Files in the AutoView for 

Agile Viewer on page 288. 

If the file is not a supported file format, the attachment file opens in its native application, if 
possible. 

Fields on the Files Tab 

The following table lists fields on the Files tab. 

Fie ld  Descript ion  

   
If a file has been modified directly in the file server vault, this icon appears in the field to 
indicate that the file Has checksum error. Click the icon to get information about the 
checksum error. See File Validation (Handle File Checksum) on page 326. 

   
This icon appears in the field if the file Has been redlined.  

The Do Redlining icon will appear here from the file folder level for any file type that is 
listed in the Supported File Types and Valid Model File Type settings in Administrator. 
Both of these cases allow ad-hoc viewing and redlining. 

File Name The name of the file. 

 In Java Client, the files table row must be selected in order to print, open, get, or view 
the file. 

 In Web Client, click the filename to view the file in the Viewer. 

File Path Can be manually set. 

File Type The format of the file 

File Size The size of the file, in bytes 
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Fie ld  Descript ion  

Last Viewed Date Date when the file was last viewed (The History tab records detailed information about 
file viewing.) 

 

Checkout 
Location 

Records where checked out files were placed during the check out procedure. 

If you are using the Java Client or you are using Web Client with Advanced File 
Productivity preference selected, Checkout Location is used to automatically locate 
and checkin the checked-out files. 

File Description Description of the file 

Document Text If needed, this field will be filled in automatically by the Agile system. 

 
 

Opening and Viewing Contents of File Folders 

This section includes the topics: 

 Java Client, Getting File Folder Files on page 308 

 Java Client, Batch Get on page 308 

 Web Client, Standard File Productivity on page 309 

 Web Client, Advanced File Productivity on page 309 
 

Java Client, Getting File Folder Files 

To get copies of files from a file folder in Java Client: 

1. Display the Files tab of the file folder. 

2. Select the rows of the files that you want to get. 

3. Click the Get Files button  . 

The Select Directory dialog opens. 

4. In the Select Directory dialog, specify the directory where you want to store the copies. 

If you selected more than one row, and you want to get the files together in one ZIP file, click 
Download the files in one ZIP file. Specify a ZIP filename. 

5. Click OK. The files (or ZIP file) are copied to the specified directory. 

You will be prompted whether you want to open the file or files. 

Java Client, Batch Get 

To batch get copies of all the files from a file folder in Java Client: 

1. Display the Files tab of the file folder. 

2. Click the button drop-down menu for Get Files  and select Batch Get All Files from this Object. 
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3. In the Select Directory dialog, specify the directory where you want to store the copies. 

If you want to get the files together in one ZIP file, click Download the files in one ZIP file. Specify a 
ZIP filename. 

4. Click OK. The files (or ZIP file) are copied to the specified directory. 

You will be prompted whether you want to open the file or files. 

Web Client, Standard File Productivity 

To get copies of files from a file folder in Web Client, using Standard File Productivity method: 

1. Display the Files tab of the file folder. 

2. Select the rows of the files that you want to get. 

3. Click the Get button . 

The Select Directory dialog opens. 

4. The Save As dialog appears. Save the files to disk, specifying the directory where you want to 
place the files. Web Client copies the files to the selected directory. If you get copies of multiple 
files, they are placed in a ZIP file. 

5. Click OK. The files (or ZIP file) are copied to the specified directory. 
 

Web Client, Advanced File Productivity 

To get copies of files from a file folder in Web Client, using Advanced File Productivity method: 

1. Display the Files tab of the file folder. 

2. Select the rows of the files that you want to get. 

3. Click the Get button . 

The Select Directory dialog opens. 

4. The Save As dialog appears. Save the files to disk, specifying the directory where you want to 
place the files. 

Note When using the Advanced File Productivity method to get multiple files, Web Client 
gives you the choice of downloading individual files or downloading a ZIP. 

5. If you want multiple files in a single ZIP file, check Download the files in one ZIP file and enter a ZIP 
file name. 

Note If you did not select multiple files, the ZIP file option and name field do not appear in 
the Select Directory dialog. 

6. Click OK. The files (or ZIP file) are copied to the specified directory. 

You will be prompted whether you want to open the file or files. 



 

 

310 Agile Product Lifecycle Management 

  

Switching Between Versions 

To switch between versions of a file folder from within the file folder in Java Client: 

From the Version drop-down list at the top of the folder object, select the version you want to 
view. 

To switch between versions of a file folder from within the file folder in Web Client: 

From the Version drop-down list at the top of the folder object, select the version you want to 
view. 

Note A version number in brackets, for example [4], indicates a version that has not yet been 
checked in. In this example, when version 3 was checked out, a pending version [4] 
was created. Selecting [4] in the version drop-down list allows you to view and work 
with the pending version. 

 

Printing Contents of File Folders 

You must have the appropriate privileges to print an attachment file. If you have questions about 
your privileges, contact your Agile administrator. 

Note A ―batch print‖ is simply printing the contents of a file folder that has multiple files. You 
still click the Print button and follow the sequence in AutoVue for Agile. 

To print a file on the Files tab using the AutoVue for Agile: 

1. With the Files tab displayed, select the rows you want to print. 

2. Click the Print button . 

You can also select a row and click the View button ; in this case you would start the viewer 
print functions manually. 

3. If the file type is supported by AutoVue for Agile, the viewer opens and begins the printing 
process. Follow the instructions in the displayed dialog boxes to complete the printing process. 

Otherwise, Web Client starts the file’s native application and opens the file so you can print it 
using that application’s printing commands. Choose the Print command for that application. 

Note When you print from within AutoVue for Agile, watermarks and banners can appear in 
addition to the contents of the attached file. For more information, see About Banners 

and Watermarks on the Printed Image on page 269. 

It is also possible to get a copy of the file, open it in its native application, and use the native 
application’s print functions to print the file. The native application must be installed on your 
computer before you can print the file. Follow the usual printing procedures according to the 
application’s documentation. 
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About Banners and Watermarks on the Printed Image 

When printed through AutoVue for Agile, the printed image has a banner above and below the 
image. The banner has six fields: top left, top center, top right, bottom left, bottom center, and 
bottom right. 

The banner labels and contents for each object class are set by the Agile administrator. 

In addition, the Agile administrator can choose to include a printed watermark on the printed image. 

Creating File Folders 

There are two ways to create a file folder: automatically, when you attach a file or URL to a 
business object in the Attachments tab of the object, and manually, using the create object functions 
of Java Client and Web Client. 

To create a file folder manually: 

1. Create the file folder using the New button in Java Client or the Create button in Web Client. 

2. The file folder that you have created is an empty container, that is, it has no files in it. To add 
files to the file folder, see Adding Attachment Files and URLs to File Folders on page 311. 

For more information on creating business objects, see Creating Objects on page 92. 

Revising File Folders 

Revising or editing a file folder object requires the appropriate modify privileges, just as editing any 
Agile object requires the appropriate modify privileges. In addition, you must also have privileges 
that allow you to check out and check in a file folder. 

To revise the Files tab, or the content of the file folder, you must check out the file folder, modify 
files, add files or remove files, then check in the file folder. For details, see: 

 Adding Attachment Files and URLs to File Folders on page 311. 

 Deleting Attachment Files and URLs from File Folders on page 316. 

 Getting and Revising Attachment Files and File Folders on page 318. 
 

Adding Attachment Files and URLs to File Folders 

You must have the appropriate privileges to add attachment files to file folders. If you have 
questions about your privileges, contact your Agile administrator. 

Each time you add a file to the Agile system, it is copied into the Agile File Manager vault as an 
independent file with a unique numeric vault filename. 

You can also include a URL (Internet address) in a file folder. URL attachments point to Internet 
sites; they are not, themselves, documents on the Agile File Manager file server. 
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Note When you check out a file folder, the Version field increments by 1, however, other users 
are still able to view the current version. When you check the file folder in, and it has 
been changed, the new version number holds. The system will not let an unchanged file 
folder be checked in. If you did not make a change to the file folder, complete the action 
by clicking Cancel Checkout, and the version number reverts to the previous numeral. 

Deleting attachment files is covered in Deleting Attachment Files and URLs from File Folders on 
page 316. 

When adding files to a file folder Files tab, Agile provides a simple and easy-to-use file uploader. 
The File Uploader allows you to drag and drop the files you want from your desktop or from an open 
directory window to the file uploader window. The uploader also has a Browse button so you can find 
the files you want in that manner. 

Note For Web Client only: Depending on your company’s policies, your Agile administrator 
may set a systemwide preference that prevents the use of the Advanced File Uploader. 
In that case, Add >  File operations in Web Client are completed using the Add File dialog, 
as described in Using Web Client’s Standard Add File Dialog on page 315. 

 

Using the Advanced File Uploader 

You can add as many files at one time as you like. When adding to the Files tab, the Advanced File 
Loader includes one checkbox; when checked, it will Unzip all zipped files upon upload. When you are 
ready, click Upload. 

When the upload is completed, depending on Agile PLM system settings, you may be prompted 
―Would you like to delete the uploaded files from your local disk?‖ which is useful if you have loaded 
a file onto your machine only to attach it to an Agile object. When you uploaded the file, Agile File 
Manager created a copy of the file that is always stored in the file vault. 

At any time before clicking Upload, you can Cancel the upload. Click Close to close the uploader 
dialog. 

To add attachment files to the file folder Files tab using Advanced File Loader in both Java Client and Web 

Client: 

1. Open the file folder you want and, if it is not already checked out, click the Check Out button. 

2. On the Files tab, select Add > Files. 

The blank File Uploader window is displayed. The instruction ―Drag Files Here‖ appears in the 
window. 

3. Open a directory window (for example, Microsoft Explorer) and size the window so that you can 
see both the File Uploader window and the directory window on your screen. 

4.  Navigate to the directory you want. 

5. Select the file you want and drag it to the File Uploader window and drop it. The file name 
appears in the File Uploader window. 

 If you drag and drop a folder, all the files in the folder are added to the list in the File 
Uploader. 

 You can also click the Browse button in the File Uploader window and browse for the file 
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you want. When using the browse function: 

 Double-clicking on folder will open the folder's contents. 

 Single clicking on folder and then clicking Open will add all contents of that folder (files 
as well as contents of subfolders within that folder) 

6. Continue locating and dragging as many files as you want to want. You can open additional 
directory windows if you choose. 

Note To remove any file from the download dialogue box (for example, if you made a 
mistake and selected a file erroneously), simply click on the file and press the Delete 
key on your keyboard. 

7. When you have selected the files you want, if desired, check the optional checkbox. 

8. Unzip all zipped files upon upload — unzips ZIP files so that they are stored in their native format. 

If this option is unchecked, a ZIP file is stored in its ZIP format. 

9. When you are done, click Upload. 

The files are added to the file folder’s Files tab. The File Uploader window displays progress 
messages for each file as it is uploaded. 

10. When the files are uploaded, you are asked if you want to delete the uploaded file from your 
local disk. 

 Yes (default) — removes the copy of the file from the directory from which you selected it. 
This ensures that the correct version of the file is maintained in the Agile file vault and you 
do not have any out-of-date copies on your local disk. To view or update the file, use the 
Agile Files tab. 

 No — the copy of the file that you selected to add to the Files tab remains on your local 
disk. 

11.  When you are finished, remember to check in the file folder by clicking the Check In button. 
 

Adding Files in Web Client without Advanced File Loader 

If Advanced File Loader is not available to you in Web Client, there are two possible reasons: 

 Due to your companies policies, your Agile administrator has set the system-wide preference 
such that Web Client users are not allowed to use the Advanced File Loader Java applet. 

 Your company does allow Web Client use of the Advanced File Loader, however, your 
personal user profile preference attribute for File Productivity Preference is set to Standard. If 
this is the case, you can change your user profile preference to Advanced, which will allow you 
to use the Advanced File Loader. 

Note By default, your user profile is set to the Prompt preference. By responding to the 
prompt, you can select which file productivity method you prefer without editing your user 
profile. See the description of Prompt responses in Setting your File Productivity 

Preference on page 314. 
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Setting your File Productivity Preference 

To modify your File Productivity Preference: 

1. In Web Client, select Tools > My Settings to display the My Settings page. 

2. On the My Settings page, click User Profile. Your tabbed user profile appears. 

3. Click the Preferences tab. 

4. Click Edit. 

5. In the File Productivity Preference drop-down list, select one of the following: 

 Advanced — allows you to use the Advanced File Loader and other File Productive 
components (providing the Agile system-wide preference is set to allow it). The next time 
you add a file or check in files on the Files tab, if it has not been previously installed, a Java 
applet will be installed. See Using the Advanced File Uploader on page 312. 

Note File Productivity components include both Advanced File Loader and Automated 
Checkin. In Web Client, File Productivity also allows you to get (download) a multi-
file attachment row as individual files instead of a ZIP file, and enables the opening 
of an attachment in its native application when you click its Filename link. 

 Standard — Web Client standard Add File dialog is used when you add a file or check in 
files on the Files tab. See Using Web Client’s Standard Add File Dialog on page 315. 

 Prompt — the next time you add a file to an Files tab, the Please Choose File Update Mode 
dialog is displayed to prompt you to choose whether to use the advanced productivity 
components (Advanced File Loader) or not. (By default, your File Productivity Preference is 
initially set to Prompt.) 

Your possible choices are as follows: 

* Yes (and check Do not show this dialog box again) — if it has not been previously installed, a 
Java applet will be installed. The File Productivity Preference attribute in your user profile is 
set to Advanced. Every time you use Add > Files or check-in attachments on the Files tab, the 
Advanced File Loader is displayed. 

* No (and check Do not show this dialog box again) — The File Productivity Preference attribute in 
your user profile is set to Standard. Every time you use Add > Files or check-in attachments 
on the Files tab, the standard Add Files dialog is displayed. 

* Yes or No (and do not check Do not show this dialog box again) — The File Productivity 
Preference attribute in your user profile is remains set to Prompt. Every time you use 
Add > Files or check-in attachments on the Files tab, the Please Choose File Update Mode 
dialog is displayed and you can select the method you want to use. 

Once you respond to the prompts and you also check Do not show this dialog box again, your 
preferred file productivity method will always be used. The Please Choose File Update 
Mode dialog will no longer appear and the File Productivity Preference attribute in your user 
profile is set as described above for the Yes or No choice. 

Note At any time, you can use the above process (step 1 through step 5) to edit the File 
Productivity Preference attribute in your user profile to change your preference and 
select a the file upload method you prefer. 
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Using Web Client’s Standard Add File Dialog 

If you want to use the standard Add File dialog, make sure that the File Productivity Preference 
attribute in your user profile is set to Standard. See Setting your File Productivity Preference on 
page 314 for instructions. 

To use the standard Add File dialog: 

1. In Web Client, open the file folder you want and, if it is not already checked out, click the Check 
Out button. 

2. On the Files tab, select Add > Files. 

The Add File window appears with rows for up to five attachments. 

3. Use the Browse button to locate and select files to add. You can select electronic files on a local 
drive or on your network. 

4. Add descriptions for the files. You do not have to add a description now. You can add or edit a 
description at any time. 

5. If desired, check the optional checkboxes: 

 Unzip — unzips ZIP files so that they are stored in their native format. 

If this option is unchecked, a ZIP file is stored in its ZIP format. 

6. Click Finish. The files are added to the Files tab and placed in the file server vault. 

7. Click Check In to check in the file folder. 
 

Adding URLs 

Note If a URL is added to a single file folder (there are no other files or URLs in that file folder) 
and the file folder version remains at Version 1, you can select the URL row on the Files 
tab, click Edit, then edit (modify) the URL. All the business objects that include the URL 
on their Attachments tab will display the newly edited URL. 

To add a URL to the Attachments tab in both Java Client and Web Client: 

1. Open a file folder, and click the Check Out icon  to check out the file folder. 

2. Click the Files tab to display its contents. 

3. Select Add > URL. The add URL dialog appears. 

4. Enter a URL and description. URLs must include the http syntax. 

Note The URL field is prepopulated with the text string http:// to streamline this process. 

5. To verify that you have typed the correct URL, click Preview. A new browser window opens 
using the URL you have entered. 

6. Click OK. The URL is added to the Files tab. 

7. Click Check In to check in the file folder. 
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Editing the Files Table 

When a file folder is checked out, you can modify the editable fields on the Files tab. 

To edit the files table in either Java Client or Web Client: 

1. Open the file folder you want and, if it is not already checked out, click the Check Out button. 

2. Click the Files tab to display it. 

3. Select the rows you want to edit, and click the Edit button. 

 Web Client — the Files tab is displayed in edit mode. Make the desired modifications and 
click Save. 

 Java Client — the Edit dialog appears. Make the desired modifications and click OK. 

Note If a URL is added to a single file folder (there are no other files or URLs in that file folder) 
and the file folder version remains at Version 1, you can select the URL row on the Files 
tab, click Edit, then edit (modify) the URL. All the business objects that include the URL 
on their Attachments tab will display the newly edited URL. 

If there are multiple files or URLs on the Files tab, or the file folder has been advanced from Version 
1, you will not be able to edit the URL. However, if the file folder is checked out, you can delete the 
URL row from the table and use Add > URL to add a new URL row. 

Deleting Attachment Files and URLs from File Folders 

When you delete a referenced attachment file, Agile removes the file from the File Management 
vault. The outside file at its original location is untouched; only the Agile copy in the vault is deleted. 

Each time you use an outside file to create a referenced attachment file, it is copied into the File 
Management vault as an independent file with a unique numeric vault filename. This is true even if 
you add the same outside file to several different file folders. You can delete the file from one file 
folder without affecting any of the copies. 

You must have the appropriate privileges to delete files and URLs from the Files tab. If you have 
questions about your privileges, contact your Agile administrator. 

Note If the file you want to delete has been checked out from the Attachments tab of the 
business object that references it, (unless you have sufficient privileges) you cannot 
delete it from the file folder until it has been checked back in on the Attachments tab. 

To delete files and URLs from a file folder in Java Client: 

1. On the Files tab of the checked-out file folder, select the files and URLs that you want to delete. 

2. Click the Delete button . 
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Note Be sure to use the Delete Attachments button  on the Files tab. Do not use the Delete 

command on the File menu and do not use the Delete Object button  in the object 
window toolbar. This deletes the entire object you are working with, not just the 
attachment. 

To delete files and URLs from a file folder in Web Client: 

1. On the Files tab of the checked-out file folder, select the files and URLs that you want to delete. 

2. Click the Delete button. 

Note Be sure to use the Delete button on the Files tab. Do not use the Delete command on the 
Actions menu. This deletes the entire object you are working with, not just the 
attachment. 

 

Purging Unused File Folder Versions 

If you have the appropriate privileges, you can purge checked-in file folder versions that are not 
referenced by any Agile object. Purging a file folder version removes from the File Management 
vault all the files checked in for that version. The version number is also removed from the file folder 
drop-down list. 

Purging a file folder version and deleting attachment files have similar results because both actions 
remove files from the Agile file vault. These actions differ in the following ways: 

 When deleting files or URLs from a file folder, the file folder must be checked out. While the file 
folder is checked out you can selectively delete or replace files and URLs in that checked-out 
file folder version. When you check in the file folder version, any files or URLs you deleted are 
removed from the File Management vault. For more information, see Deleting Attachment Files 

and URLs from File Folders on page 316. 

 Purging an unused file folder version action can be performed only to a checked-in file folder 
version. The checked-in file folder version cannot be referenced by any Agile object and it 
cannot contain any redlined files. Purging a file folder version removes all the files and URLs in 
that version from the Agile File Management vault.  

Mary has checked out the Version 5 file attachment from an Item object Attachments tab. Mary works 
on her local copy of the file, and then checks in the Version 6 file attachment for the Item object. 
After she has checked in, Mary realizes that the file she checked in is incorrect. She checks out the 
attachment again, replaces it with the correct file and checks in Version 7. The incorrect file in file 
folder Version 6 remains in the file vault. Even though Version 6 can be considered only an 
historical document, and the Item attachment table no longer points to Version 6, Mary would like to 
remove Version 6 completely because it is incorrect. 

To remove an unused file folder version: 

1. Before you begin, you can verify that the file folder version you want to purge is not referenced 
by any other Agile object, on an Attachments tab or a Content tab.  

a. Navigate to the file folder object and click the Where Used tab. 

b. In the Version drop-down list, select the version you want to purge. 
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If the Where Used table for the selected version is empty, the file folder version is not in 
use. 

c. If the Where Used table for the selected version lists one or more objects, if you have the 
appropriate privileges, you can modify those objects so they use a different file folder 
version: 

 Navigate to each object and edit the Attachments tab or the Content tab of the object to 
select a version of the file folder other than the version you wish to purge. You can 
choose an earlier version, a more recent version, or the latest version (providing the 
version you want to purge is not the latest version). 

2. With the file folder object open, from the Version drop-down list, select the version you wish to 
purge. 

3. From the Web Client Actions menu or the Java Client More... menu, select Purge Folder Version. 

4. Confirm the prompt. 

Agile PLM checks whether the selected file folder version meets the requirements that allow it 
to be purged: 

 If the selected file folder version is in use (on an Agile object Attachments tab or Content tab) 
or if the file folder version has been incorporated to an item object, Agile PLM displays a 
warning message and the file folder version is not purged. 

 If the selected file folder version contains redlined files, Agile PLM displays a warning 
message and the file folder version is not purged. 

 If the selected file folder version is checked out, Agile PLM displays a warning message 
and the file folder version is not purged. 

If the file folder version meets the requirements, it is purged. All files and URLs are removed 
from the Agile File Management vault and the version number is removed from the file folder's 
Version drop-down list. 

The Purge Folder Version menu selection is disabled if: 

 The user does not have the Purge Folder Version privilege. 

 The latest version of the file folder is zero (0). 
 

Getting and Revising Attachment Files and File Folders 

If you have searched and found an attachment file that you are interested in, you may want to read 
it, revise it, or print it, among other possibilities. To print the file, see Printing Attachment Files on 
page 268. 

If you want to read the file without revising it (or, revise the file as you wish without other people 
being able to access your revised version through Agile), or review the contents of a file folder 
without revising it, you will just perform a ―Get‖ procedure, as described below. 

Note In Web Client, the Get procedure differs depending on your File Productivity Preference 
user profile setting. See Setting your File Productivity Preference on page 314. 

You must have the appropriate privileges to check out and check in a file folder and to cancel a 
checkout, whether you are performing the operation at the file folder itself or from the Attachments 
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tab of a business object. If you have questions about your privileges, contact your Agile 
administrator. If you are going to work with file folders often, it may be appropriate that you be 
assigned the File Folder Administrator or File Folder Manager role. 

Getting Attachment Files or File Folders 

You can copy files on the Files tab of a File Folder object or a Design object to the directory of your 
choice. This is called getting a file. You can get as many copies as you like. If you want to revise an 
attached file and make the version public, you must check the File Folder object out, make 
changes, and check it back in. This is covered in Checkout and Checkin to Revise Attachment Files 

or File Folders on page 321. 

Several users can get the same attachment files simultaneously. You can get files that are checked 
out. Also, you can get a file even though the application used to create that file is not loaded on your 
computer. 

You must have the appropriate privileges to get a copy of the file. If you have questions about your 
privileges, contact your Agile administrator. 

Note When you get an attached file, the date stamp on your copy of the file reflects the date 
that you got the file, not the date that the file was attached or saved. 

 

Java Client, Batch Get 

To batch get copies of all the attachment files of a file folder object in Java Client: 

1. Display the Files tab of the file folder. 

2. Click the button drop-down menu for Get Files   and select Batch Get All Files from this Object. 

3. In the Select Directory dialog, specify the directory where you want to store the copies. 

If there is more than one file on the Files tab, and you want to get the files together in one ZIP 
file, click Download the files in one ZIP file. Specify a ZIP filename. 

4. Click OK. The files (or ZIP file) are copied to the specified directory. 

You will be prompted whether you want to open the file or files. 

Java Client 

To get copies of attachment files from a file folder object in Java Client: 

1. Display the Files tab of the file folder. 

2. Select the rows of the files that you want to get. 

3. Click the Get Files button . 

In the Select Directory dialog, specify the directory where you want to store the copies. 

If you selected more than one file, and you want to get the files together in one ZIP file, click 
Download the files in one ZIP file. Specify a ZIP filename. 

4. Click OK. The files (or ZIP file) are copied to the specified directory. 

You will be prompted whether you want to open the file or files. 
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Web Client, Standard File Productivity 

To get copies of attachment files from a file folder object in Web Client, using Standard File Productivity 

method: 

1. Display the Files tab of the file folder. 

2. Select the rows of the files that you want to get. 

3. Click the Get button  in the row of a file you want. 

4. The Save As dialog appears. Save the files to disk, specifying the directory where you want to 
place the files. Web Client copies the files to the selected directory. 

Note If you get copies of multiple files, they are automatically placed in a ZIP file. 

5. Click OK. The files (or ZIP file) are copied to the specified directory. 
 

Web Client, Get All Files, Standard File Productivity 

To get copies of all the files from a File Folder object or Design object in Web Client, using Standard File 

Productivity method: 

1. Display the Files tab of an object. 

2. Click the  Get All Files button in the tab menu. 

3. The File Download dialog appears. 

4. Specify the directory where you want to place the files.  

5. Click Save to save the ZIP file to disk, specifying the directory where you want to place the file. 
Agile PLM copies the files to the selected directory.  

Click Open to open a ZIP file in WinZip that contains all the attachment files. 

Note If there is a single file on the Files tab, you are prompted to either open the file in its 
native application or save it in its native format. 

 

Web Client, Advanced File Productivity 

Note For more information about the Advanced File Productivity preference, see Setting your 

File Productivity Preference on page 314. 

To get copies of attachment files from a file folder object in Web Client, using Advanced File Productivity 

method: 

1. Display the Files tab of the file folder. 

2. Select the rows of the files that you want to get. 

3. Click the Get button  in the row of a file you want. 

The Select Directory dialog opens. 
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Note When using the Advanced File Productivity method to get multiple files, Web Client 
gives you the choice of downloading individual files or downloading a ZIP. 

4. If you want multiple files in a single ZIP file, check Download the files in one ZIP file and enter a ZIP 
file name. 

Note If you did not select multiple files, the ZIP file option and name field do not appear in 
the Select Directory dialog. 

5. Click OK. The files (or ZIP file) are copied to the specified directory. 

You will be prompted whether you want to open the file or files. 

Web Client, Get All Files, Standard File Productivity 

To get copies of all the files from a File Folder object or Design object in Web Client, using Standard File 

Productivity method: 

1. Display the Files tab of an object. 

2. Click the  Get All Files button in the tab menu. 

3. The File Download dialog appears. 

4. Specify the directory where you want to place the files.  

5. Click Save to save the ZIP file to disk, specifying the directory where you want to place the file. 
Agile PLM copies the files to the selected directory.  

Click Open to open a ZIP file in WinZip that contains all the attachment files. 

Note If there is a single file on the Files tab, you are prompted to either open the file in its 
native application or save it in its native format. 

 

Checkout and Checkin to Revise Attachment Files or File Folders 

There are several factors that determine how you check an attachment file out for modification and 
check it back in, and how you check out a file folder for revision and check it back in. To revise an 
attachment file means, of course, to alter the contents of the file itself. To revise a file folder means 
making structural changes to the file folder’s contents, such as adding a file, deleting a file, 
replacing one file with another, or editing the File Description. 

Note When you download a file for revision, you simply get a copy of the file, make your 
revisions, and replace the original file when you are checking it back in. 

A file folder can contain one file or multiple files. All the files are stored in the file vault, part of Agile 
File Manager, each file identified with its file folder. In order to modify a file in the file vault, you must 
first check out its file folder. 

When you check out a file folder, the system makes the attachment files available for modification 
by the Checkout User only—unlocks them—and renders the file folder inaccessible for modification 
by others. You can download and edit the file(s), which no one else can do until you either check 
the folder in or cancel the checkout. 



 

 

322 Agile Product Lifecycle Management 

  

Important To many people in manufacturing industries and from Agile business objects, to 
―check out a file‖ means a one-step operation in which the checked out file is 
automatically downloaded to the user’s computer. In Agile PLM File Folders, think of 
CheckOut as synonymous with unlocking a file, making it available to only the file folder 
Checkout User for modification. After modifying and replacing the referenced file(s), 
CheckIn is synonymous with locking the file in the file vault. 

Once you have modified an attachment file and checked a containing folder back in, every user who 
views objects that reference that file, from the same or another file folder object, will see the 
modified version of the file—provided the user accesses the Latest Version of the folder object. 

By default, only you or a user with ―file folder administration‖ privileges can check in a file folder that 
you checked out, or cancel a checkout. However, your Agile administrator can alter the privilege 
masks so that anyone can check in any file folder. Also, with appropriate privileges, you can edit the 
filenames when you check in the attachment. 

The following procedure works from a file folder’s Files tab. For information about checking out from 
a business object Attachments tab, see Checking Out Attachment Files on page 280. 

To check out a file folder and get attachment files for modification: 

1. Open a file folder. 

2. Click the Check Out button . 

 In Java Client, ―[Checked out]‖ appears in red type at the upper-right portion of the object. 

 In Web Client, a checked out file folder icon  appears in the upper-left portion of the 
object page. 

The Version number of the folder is advanced, from the latest previous version to the next 
number. If the checkout is canceled, the version number will revert. 

On the Title Block tab of the file folder, the checkout information is filled in, for example, 
Checkout User and Checkout Date. 

3. Click the Files tab. The files in the file folder are listed (URLs are listed too). 

4. To change the file folder itself, click the Edit, Add > Files, or Add > URLs button. Note that Edit 
button gives you the control information about the folder, and you are not editing the file itself. 
You can edit the File Description field or the File Path field. 

To change the contents of attachment file(s), having checked the folder out, now select the files 

you want and click the Get Files button  . 

5. Revise and save the files. 

6. Return to the checked-out file folder from which you got the attachment file you have modified. 

7. Replace the file on the Files tab with the file you modified, using the appropriate instructions 
below for either Java Client or Web Client. 

When you have completed all your modifications (Replace, Add, Delete, and Edit) click the 

Check In button . The file folder is checked in, and the version increments. 

Java Client, replace files: 

a. Select the row to enable the Replace File button. 
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b. Click the Replace File button . 

c. The Select File dialog appears. 

d. Select the modified file or navigate to the directory you want and select the file. 

e. Click Open to complete the replacement process. 

Web Client, replace files: 

a. In the file row you want to replace, click the Replace File button . 

b. The Replace File dialog appears. 

c. Click the Browse button to navigate to the directory you want and select the file. 

d. When you are done, click Finish. 

Note From the Files tab of the file folder, you can choose to replace a file at any time the 
file folder is checked out. 

The modified file writes over the previous version of the file. 

Checking in a file folder increases the version number of the attachment. 

When you check out a file folder and get an attachment file, a copy of the attachment file is stored in 
a specified directory. When you check the file folder in, the files remain in the directory until you 
delete them manually. 

If you placed the file on the network or in a shared drive or directory (during the Get operation), you 
can check in the file from any computer that provides access to that drive or directory. If you place 
the file into a directory that is not a shared directory, it must be checked in from that same 
computer. See your Microsoft documentation for more information about shared directories. 

Canceling Checkouts 

When you wish to discard edits to files on a file folder that you checked out, you can cancel the 
checkout. 

A checkout can be canceled only by the user who checked out the attachment, or by a user with 
necessary ―file folder administration‖ privileges. If you have questions about your privileges, contact 
your Agile administrator. 

When you cancel a checkout, copies of the attachment files remain in the checkout directory you 
selected, but the original files are once more available to be checked out from the Files tab. Any 
edits you make to the remaining copies of the files do not appear in the public versions of the file 
(the versions of the file stored in the file vault). 

To cancel a file folder object checkout: 

1. Display the file folder object. 

2. Click the Cancel Checkout button . 
 

Ad Hoc Redlining or Marking Up of Attachment Files from the File Folder 

The other method to mark up or redline an attachment file is called ―ad hoc redlining‖ in which the 
attachment is approached via the Files tab of the file folder. 
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To ad hoc redline or mark up an attachment file from a file folder object in the Java Client: 

1. On the Files tab of the file folder object, select a file you want to redline. 

2. Click the View button. 

3. When AutoVue for Agile appears, click the Markup button. (This button is available only when 
markups are allowed.) 

4. Use the tools described in the viewer online Help to redline the attachment. To view online 
Help, choose Help > Content in the AutoVue for Agile menu bar. 

Note Ad hoc markups are saved against and associated with the version of the file folder 
object. 

To ad hoc redline or mark up an attachment file from a File Folder object in the Web Client: 

1. On the Files tab of a file folder object, click the Do Redlines button  (or Has Redlines button  ) 
on the row of the file you want to redline. (This button is available only when markups are 
allowed.) 

2. Use the tools described in the viewer online Help to redline the attachment. To view online 
Help, choose Help > Content in the AutoVue for Agile menu bar. 

Note Ad hoc markups are saved against and associated with the version of the file folder 
object. 

For more information about AutoVue for Agile, see Viewer Supplement. 

Other File Folder Operations 

Performing a Mass Update of a File Folder 

You can remove or replace a file-folder attached to multiple objects at one time. For example, if File 
Folder 2 is created, and File Folder 1 becomes obsolete, you can replace the attachment of File 
Folder 1 with File Folder 2 on all of the objects that include a reference to File Folder 1. 

 Remove a file folder reference from all or some of the objects that reference the file folder. 

 Replace a file folder reference in all or some of the objects that reference the file folder. 

 Add a file folder to the Attachments tab of multiple specified objects. 

To perform a bulk file folder operation in Java Client: 

1. Open the file folder that you want to remove, replace, or add. 

2. Right-click and choose Mass Update. 

3. Select the version of the file folder on which you want to perform the bulk operation. 

4. Select the attachment files you want to include in the operation, and click Next. 

5. Specify whether you want to add, remove, replace the file folder or replace the version of the 
file folder, and click Next. 
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6. Depending on which function you selected in step 5 above, use the wizard search tools to find 
and select the objects you want to be affected by this bulk operation or, select the objects you 
want to be affected from the displayed list. 

7. Click Finish. 

To perform a bulk file folder operation in Web Client: 

1. Open the file folder that you want to remove, replace, or add. 

2. Choose Actions > Mass Update. 

3. Specify whether you want to add file, remove file, replace file, or replace version, and click Next. 

4. Select the version of the file folder on which you want to perform the bulk operation. 

5. Select the attachment files you want to include in the operation, and click Next. 

6. Using the wizard search tools, find and select the objects you want to be affected by this bulk 
operation. 

7. Click Finish. 
 

Routing and Reviewing File Folders 

The Default File Folders Workflow applies to all file folder objects that users create in the File 
Folders base class, which includes both the File folders class and the Designs class. This workflow 
is read only and, with only a single Review status, is a simple review-and-signoff system—although 
the signoff can still be an approval or a rejection. 

Each file folder version has its own Routing Slip. Each version can have a different set of approvers 
and observers. 

To add approvers or observers: 

1. Open the file folder object. 

2. Select the Routing Slip tab. 

3. In the Version drop-down list, select the version you want. 

Note The selected version must be checked in. For example, you cannot add approvers 
to version [4] which has not yet been checked in. 

4. Click the Add Approvers/Observers button. The Add Approvers and Observers dialog box opens. 

5. Select the approvers and observers you want to add, and enter a comment, if desired. Click 
OK. 

Similarly, you can use the Remove Approvers or Observers button to remove reviewers for a file 
folder. 

Approving or Rejecting a file folder: 

Approving or rejecting a file folder object uses the same process as approving or rejecting any 
routable object. For detailed information, see: 

 Approving Routable Objects on page 228 
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 Rejecting Routable Objects on page 231 

Important Approvals and rejections are version-specific. Your approval or rejection applies only 
to the selected version of the file folder object. 

 

File Folders and the Effects of CopyFilesToRev SmartRule 

See Effects of CopyFilesToRev SmartRule on page 286. 

File Folders and Viewing 

For information about AutoVue for Agile, see Viewer Supplement. 

File Validation (Handle File Checksum) 

See Checksum File Validation on page 282. 
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Chapter 11 

Working with Design Objects 

This chapter includes the following: 

 What are Design Objects? ................................................................................................................................... 327 
 Design object Actions Menu ................................................................................................................................ 327 
 Design Title Block Tab ......................................................................................................................................... 329 
 Design Object Files Tab ...................................................................................................................................... 330 
 Structure Tab of Design Objects .......................................................................................................................... 331 
 Routing and Reviewing Design Objects .............................................................................................................. 337 
 Where Used Tab, Design Object ......................................................................................................................... 337 

 
 

What are Design Objects? 

Note Design objects are available in your Agile PLM system only if your Agile administrator 
has enabled them for use. Design objects are available only in Web Client. 

Design objects are an additional type of File Folder object. The File Folder base class includes two 
classes of objects: 

 File folders 

 Designs 

A Design object is another type of file container object intended for use with CAD models. Design 
objects have all the capabilities of file folder objects described in the chapter Working with File 

Folders on page 301.  

Design objects have additional features that allow you to create a parent-child structure of related 
design objects, and .to record and modify the version of each design object in the model structure. 

Typically, Design objects are used with an Agile PLM Engineering Collaboration (EC) CAD 
integration. Most of the tasks related to the creation, modification, and maintenance of CAD data 
model structures associated with Agile Design objects are managed by the integration application. 
Although you can create and modify Design objects yourself, just like any other Agile object, an 
Agile PLM EC CAD integration will perform many of these tasks automatically. 

Contact your Agile administrator if you have questions about how Design objects are used at your 
company. For additional information about Design objects, see Agile Administrator Guide. 

Design object Actions Menu 

For information about the Web Client Actions menu, see Actions Menu on page 85. 

For information about Design object actions, see: 



 

 

328 Agile Product Lifecycle Management 

  

 Using the Design Object Version Browser 

 Save As, Design Model Objects on page 328 
 

Using the Design Object Version Browser 

When a Design object is open, you can view information about all versions of the Design in the 
Version Browser. 

Note The Version Browser is available only in Web Client.  

To open the Version Browser: 

1. In the Actions menu, choose Version Browser. The Version Browser opens. 

The Version Browser displays the following information about each version: 

Version Browser 
Column  

Descript ion  

Approval An Awaiting Approval icon  in this column indicates that the version is awaiting 
approval; the Routing Slip for that version lists users who have not yet signed off. 

Version The version number. 

Checkin Date 

Checkin User 

The date the version was checked in and the user who performed the check in. 

When the version is checked out, these fields are blank. 

Change Info Indicates how the version was modified before it was checked in. 

Files indicates that the object's files were modified, for example, files were replaced, 
added, or deleted. 

For Design objects, Structure indicates that the Design's Structure tab was modified. 

Label, Revision, 
Revision Date 

These are version-specific editable fields used with Design data model objects. 

 

Actions you can initiate in the Version Browser: 

 View Files: Select any version row and click View to view the file or files in AutoVue for Agile. 

 Compare Files: For single-file versions, select two version rows, and choose Compare in the View 
button drop-down list. The selected files are compared in AutoVue for Agile. 

 

Save As, Design Objects 

When you use Save As in the Design object Actions menu to create a new Design object, Save As 
copies the Structure tab of the latest checked-in version of the Design object. 
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Design Title Block Tab 

By default, the Design object Title Block tab contains the fields listed in the following table. Agile 
administrators determine which fields are enabled and visible on the Title Block tab. 

In Web Client, the Title Block can contain two additional sections, called Page Two and Page Three by 
default. (Design objects are not supported in Java Client). Agile administrators can add custom 
class fields to Page Two section and custom subclass fields to the Page Three section. The Agile 
administrator determines whether these sections are enabled, and what they are called. 

The following table describes each Title Block tab field and how it is completed. 

Fie ld  Descript ion  

Number The Design object's number, completed when the file object is created. 

Type The subclass of this Design object. Depending on Agile system settings, this 
field is automatically completed when the Design object is created. 

Lifecycle Phase Current lifecycle; selected from a list. For example, Concept or Maintenance. 

Description Text describing the Design object 

Version The currently selected version of the Design object; version-specific. 

Label Version-specific text field which indicates a label identifier for the version. Users 
with the appropriate privileges can modify this field on any checked in or 
checked out version. 

Component Type List field which indicates the type of component represented by the Design 
object. 

Last Modified Date Date the Design object was last modified. Completed automatically. 

Checkout Status Indicates whether the Design object is currently checked out or checked in. 
Completed automatically. 

Checkout User When the Design object is checked out, displays the user who checked out the 
object. Completed automatically. 

Checkout Date When the Design object is checked out, displays the checkout date. Completed 
automatically. 

Checkout Location When the checkout user's File Productivity Preference is set to Advanced, the 
checkout location is automatically filled in. 

Create Date The date the Design object was created. 

Component Type List field which indicates the type of component represented by the Design 
object. 

Revision Version-specific text field which indicates the targeted Revision for the Design 
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Fie ld  Descript ion  

version. 

Revision Date Version-specific date field which indicates a revision date for the Design version. 

Checkin User Indicates the user who checked in the currently selected version; completed 
automatically. 

 
 

Design Object Files Tab 

Fields on the Files Tab of Design Objects 

The following table lists fields on the Files tab of Design objects. 

Fie ld  Descript ion  

   
If a file has been modified directly in the file server vault, this icon appears in the field to 
indicate that the file Has checksum error. Click the icon to get information about the 
checksum error. See File Validation (Handle File Checksum) on page 326. 

   
This icon appears in the field if the file Has been redlined.  

The Do Redlining icon will appear here from the file folder level for any file type that is 
listed in the Supported File Types and Valid Model File Type settings in Administrator. 
Both of these cases allow ad-hoc viewing and redlining. 

File Name The name of the file. 

In Web Client, click the filename to view the file in the Viewer. 

File Path Can be manually set. 

File Type The format of the file 

File Size The size of the file, in bytes 

Last Viewed Date Date when the file was last viewed (The History tab records detailed information about 
file viewing.) 

Checkout 
Location 

Records where checked out files were placed during the check out procedure. 

If you are using Web Client with Advanced File Productivity preference selected, 
Checkout Location is used to automatically locate and checkin the checked-out files. 

File Category Category selected from a list. 

File Description Description of the file 

Document Text If needed, this field will be filled in automatically by the Agile system. 
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Adding Files to the Design Object Files Tab 

The Files tab of the Design class object has the same functions as the Files tab of the File Folder 
class object. 

For information about working on the Files tab, see Adding Attachment Files and URLs to File 

Folders on page 311. 

Note Design objects are available in Web Client only. Any instructions related to Java Client 
do not apply to Design objects. 

 

Structure Tab of Design Objects 

Each row in the structure table includes information about the child Design object in each structure 
table row. 

 Structure rows can reference checked in or checked out versions of child objects. 

 A parent can be checked in while using a checked out version of a child. 

 You cannot Cancel Checkout a version that is in use; an error message is displayed. 

The following table describes the fields included in the structure table. 

St ructure  Table  F ie ld  Descript ion  

 Icon indicates that the Design data model has a file attached to 
its Files tab. 

 Icon indicates that the Design data model is linked to an Agile 
business object; that is, whether the Design object appears on 
the Attachments tab of an Agile object, for example, the 
Attachments tab of an item object. 

 Icon indicates that the Design object is currently checked out. 

Checkout User When the Design object is checked out, this field displays the 
user who performed the checkout. Completed automatically. 

Checkin User When the Design object is checked out, displays the user who 
checked out the Design object. Completed automatically. 
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St ructure  Table  F ie ld  Descript ion  

Number 

 

 

 

The number of the Design object. 

 indicates a Design object with no children, that is, a leaf 
node. 

 indicates a Design object with structure, that is, a Design 
object with children design objects listed on its Structure tab. 

Click the number to open the Design object. 

Click the Show Details icon  next to the number to display 
details about the Design object. See Structure Tab Show 

Details Display on page 334. 

Version 

 

The version of the Design object included in the structure. The 
version included in the structure can be any version of the 
Design data model. 

A Not Latest icon  indicates that the specified Design object 
version is not the latest version. 

Label Version-specific text field which indicates a label identifier for the 
version. 

Component Type List field which indicates the type of component represented by 
the Design object. 

Last Modified Date Date the Design object was last modified. 

Checkout Status Indicates whether the Design object is currently checked out or 
checked in. 

Checkout User When the specified version of the Design object is checked out, 
displays the user who checked out the object. 

Checkout Date When the specified version of the Design object is checked out, 
displays the checkout date. 

Checkin Date Date the specified version was checked in. 

Create Date Date the Design object was created. 

Checkout Location When the Design object is checked out and the checkout user's 
File Productivity Preference is set to Advanced, the checkout 
location is automatically completed. 

 
 

Structure Tab Buttons 

The following table explains the Structure tab buttons and the actions you can perform on the 
Structure tab. 

Note You must select a checked out Design object version in order to Add or Remove rows, or 
to Edit rows. If all versions are checked in, you must checkout the object before adding, 
removing, or editing Structure table rows. 



 

 

9.2.2.6 333  

  

 

Button  Descript ion  

 Edit 
Note You must select a checked out version in order edit Structure table rows. 

Lets you edit Structure row details by displaying the selected rows on an Edit page. 
The editable fields are in the form of text boxes, list boxes, and so on. 

 Remove Note You must select a checked-out version in order remove Structure table rows. 

Removes the selected rows from the Structure table. 

 Add 

 Add 

 Add 

Note You must select a checked-out version in order add Structure table rows. 

Add — Adds a Design object to the Structure table. Depending on which option you 
choose, you can: 

  Create a Design object while adding it. 

  Search for an existing Design object. 

  Type in Known Number(s) of one or more existing Design objects. 

 

Multi-level... 
   Expand 
   Collapse 

Multi-level > Expand expands all the sub-structures in the Structure table. All levels of 
the Structure are displayed. 

Multi-level > Collapse collapses all expanded structure levels. Only the top level of the 
structure is displayed. 

Go To Takes you to a specific Design object based on the criteria you enter in the Go To 
dialog box. 

The Go To search can be limited to a particular Design data model column and to the 
specified number of levels. For example, specifying level 3 searches through levels 1, 
2, and 3. 

 
 

The Structure Go To feature allows you to search for a specific Design object in the parent/child 
design structure. 

To use the Go To Design in Structure feature in Web Client: 

1. On the Structure tab, click the Go To button. 

2. In the Go To Design in Structure dialog box, define your search: 

a. Enter the text you want to find. The Go To search finds any Design object that includes 
(contains) the specified text in its attribute fields. You can use any type of character, 
including numerals and punctuation. 

b. In the drop-down list, choose which Structure table column you want to search. You can 
choose all columns or one specific column. 

c. Check Match Case if you want to perform a case-sensitive search where text capitalization 
matters. 

d. Choose how many Structure levels you want to search: Enter a number or check All levels. 
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3. To start the search, click Find Next. The fist Design object that matches the search criteria is 
highlighted in the Structure table. 

4. Use the Find Next and Find Previous buttons to scroll up and down the Structure table, 
highlighting Design objects that match the search criteria. 

5. When you have found the Design object you want, click Close in the Go To Design in Structure 
dialog box. The last Design object you highlighted in the Structure table remains highlighted. 

 

Structure Tab Show Details Display 

When viewing the Structure tab, you can click the Show Details icon  next to the object number to 
see more details about that object. 

When you click the  icon, the details dialog is displayed, showing the following types of 
information: 

Deta i ls  d ia log featu re  Descript ion  

 Close button. Click the  button to close the details dialog. 

Number 
Version 

At the top of the dialog, the Design data model object number 
and version are displayed. 

Files table This table lists all the files attached to the Design object on 
the Files tab. The information includes File Name, File 
Description, File Size, File Type, and File Category. 

Click the file name link to open the file in its native application. 

Select a row to highlight it, then click View to view the file in the 
Agile Viewer or click Get to download a copy of the file to your 
computer. 

Where Used as an Attachment 
table 

This table lists Agile business objects to which the Design is 
attached, that is, the Design data model object appears on the 
business object Attachments tab. 

Information includes Type, Number/Name, Rev, Description, 
and Lifecycle/Status. 

Click the business objects unique identifier link in the 
Number/Name column to open it. 

Where Used on Designs table This table lists the parent Design objects of the current object. 
The Design data model objects in this table include the 
current object on their Structure tabs as a child object. 

Information includes Number, Description, Version, 

Attachment icon , Link icon , Checked Out icon , 
Label, Component Type, and Checkin User. 

Click the number link to open the Design data model object. 
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Routing and Reviewing Design Objects 

The Default File Folders Workflow applies to all file folder objects that users create in the File 
Folders base class, which includes both the File folders class and the Designs class. This workflow 
is read only and, with only a single Review status, is a simple review-and-signoff system—although 
the signoff can still be an approval or a rejection. 

Each Design object version has its own Routing Slip. Each version can have a different set of 
approvers and observers. 

To add approvers or observers: 

1. Open the Design object. 

2. Select the Routing Slip tab. 

3. In the Version drop-down list, select the version you want. 

Note The selected version must be checked in. For example, you cannot add approvers 
to version [4] which has not yet been checked in. 

4. Click the Add Approvers/Observers button. The Add Approvers and Observers dialog box opens. 

5. Select the approvers and observers you want to add, and enter a comment, if desired. Click 
OK. 

Similarly, you can use the Remove Approvers or Observers button to remove reviewers for a 
Design object. 

Approving or Rejecting a Design object: 

Approving or rejecting a Design object uses the same process as approving or rejecting any 
routable object. For detailed information, see: 

 Approving Routable Objects on page 228 

 Rejecting Routable Objects on page 231 

Important Approvals and rejections are version-specific. Your approval or rejection applies only 
to the selected version of the Design object. 

 

Where Used Tab, Design Object 

Note The Design object Where Used tab is version-specific and displays the where-used status 
of the currently selected version. 

When you select a different version in the Version drop-down list, the Where Used tables display 
information about the selected version only. 
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The Design object Where Used tab includes two tables: 

 Attachments 

The Attachments table lists all the Agile business objects where the currently selected version 
of the Design object is attached, that is, all the Agile business objects that have the current 
version of the Design object listed on their Attachments tab. 

 Design 

The Design table lists all the Design objects that are structure parent objects for the current 
Design object version. That is, the selected version of the Design object appears on the 
Structure tab of the listed Design objects as a child object. Only the direct (one level) parents of 
the current version of the Design object version are listed. 
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